


Fontos tudnivalók: Jogi tudnivalók
Federal Communications Commissions (FCC) Megfelelőségi tanúsítványa

(csak az USA-ban)

Felelős fél: Brother International Corporation
100 Somerset Corporate Boulevard
Bridgewater, NJ 08807-0911 USA

kijelenti, hogy a terméke

Termék megnevezése:Brother USB-író
Típusjelzése:  PE-Design

A készülék megfelel az FCC előírások 15. szakaszában foglaltaknak. A használat a következő 
két tényező feltétele: 1. a készülék nem okoz ártalmas elekromágneses zavart (interferenciát), 
és 2. a készülék kezeli bármely felé érkező elektromágneses zavart, beleértve a nem kívánt 
működést okozó interferenciát.

A készülék tesztelésre került, és a „B” osztályba sorolt digitális eszközökre vonatkozó 
korlátozásoknak megfelelt, az FCC előírások 15. szakaszában foglaltaknak megfelelően. Ezen 
korlátozások rendeltetése a háztartási használat során az ártalmas interferencia elleni 
hatékony védelem. A készülék felhasznál, előállít és sugározhat elektromágneses hullámokat, 
és amennyiben nem az utasításoknak megfelelően telepítjük, használjuk, káros interferenciát 
okozhat rádiókommunikációs eszközökkel. Azonban nem garantálható, hogy adott telepítés 
során nem lép fel interferencia. Ha a készülék a rádió vagy televízió vételekor káros 
interferenciát okoz (amely a varrógép egyszerű ki- és bekapcsolásával megállapítható), a 
felhasználónak ajánlott a következő műveletekkel megpróbálni a hibát elhárítani:

• A vevőantenna áthelyezésével, elforgatásával.
• A készülék és a vevő távolabbra helyezésével.
• Forduljunk a márkaszervizhez vagy híradástechnikai szakemberhez segítségért.
A Brother Industries által írásos formában nem engedélyezett bármely módosítás, átalakítás 
esetén a felhasználó elveszíti a készülék használatára vonatkozó jogosultságát.

Elektromágneses interferenciára vonatkozó engedély
(Egyesült Államok és Kanada területén kívül)

A készülék megfelel az EN55022 (CISPR 22 kiadvány) / „B” osztályra vonatkozó szabványnak.



Köszönjük, hogy terméknket választotta!
Köszönjük, hogy termékünket választotta. A készülék biztonságos és hatékony használata 
érdekében kérjük figyelmesen olvassa át a Használati útmutatót, és későbbi használat céljából 
őrizze meg.

Kérjük használatbavétel előtt olvassa át
Látványos hímzési minták tervezése

• A rendszerrel hímzőminták széles választékát hozhatjuk létre, valamint számos varrási 
beállítást hozzárendelhetünk a mintákhoz (pl. öltéssűrűség) Azonban a végeredmény 
alapvetően a használt varrógép típusától függ. Ajánlott egy próbavarrás készítése a tervezett 
mintával, mielőtt a végső felhasználásra szolgáló anyagra varrnánk.

Biztonságos működtetés
• Ügyeljünk, hogy ne ejtsük a tűt, vezetékdarabot vagy egyéb fém tárgyat a készülékbe vagy a 

kártyafoglalatba.
• Ne tároljunk semmit a készüléken.

A készülék megkímélése
• Készülék tárolása során kerüljük a közvetlen napfényt és a nagy páratartalmú helyeket. Ne 

tároljuk a készüléket fűtőtest, vasaló vagy egyéb hősugárzó test közelében.
• Ne öntsünk vizet vagy egyéb folyadékot a készülékre vagy a kártyára.
• Ne ejtsük le vagy üssük meg a készüléket.

Javítás, állítás
• Meghibásodás esetén beállítás szüksége esetén forduljunk a legközelebbi szervizbe.

Értesítés
A használati útmutató és a telepítési útmutató sem ismerteti a számítógép használatát Windows® 
mellett. Tanulmányozzuk a Windows® kézikönyvét.

Szerzői jogi tudnivalók
Windows® a Microsoft Corporation regisztrált védjegye. A használati útmutatóban és telepítési 
útmutatóban szereplő termékmegnevezések megfelelő vállalataik védjegyei és bejegyzett 
védjegyei.

Fontos
A készülékkel történő, hímzőkártyákon, újságban, magazinban szereplő anyagok kereskedelmi 
forgalmazási célú másolása a szerzői jogi törvénybe ütközik és szigorúan bűntetendő.

Vigyázat
A termékhez tartozó szoftver a szerzői jogi törvény hatálya alá esik. A szoftver a szerzői jogi 
törvénynek megfelelően használható, másolható.

További kiegészítő információkat és frissítéseket találunk a http://
www.brother.com/ vagy http://solutions.brother.com honlapokon.

ŐRIZZÜK MEG A HASZNÁLATI ÚTMUTATÓT
A terméket lakossági, háztartási használatra tervezték.
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Bármilyen grafikából 
készíthet hímzést a 
PE-DESIGN segítségével

Tervezés kész mintákkal
(15. oldal)

Nagy méretű minták
(176. oldal)

A szoftver digitalizálási és 
grafikai, szerkesztési funkciói 
révén korlátok, megkötések 
nélkül tervezhetünk egyéni 
hímzési mintákat. 
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Fotó öltés (Photo stitch) funkció (24. és 127. oldal)
Hímzést digitális kamerával készített fénykép alapján is gond nélkül létrehozhatunk.

Összeforgatás háttérképpel
(42. oldal)

Egyedi logók tervezése
(20., 70., 77., 80., 90. és 126. oldal)

Fotó öltés 1
(szépia)

Fotó öltés 1 (színes)

Fotó öltés 1
(mono)

Fotó öltés 2
(színes)

Fotó öltés 2
(mono)
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Milyen lehetőségeket rejt a 
PE-DESIGN szoftver

Valósághű hímzés fotó, grafika alapján
A Tervező és Szerkesztő funkció révén képeket, fényképeket automatikusan alakíthatunk át hímzési 
mintákká, amely levarrható a kívánt öltéssel.

Autom lyukasztó funkció
(20., 126. oldal)

Grafikákat, fényképeket alakíthatunk át hímezhető 
mintával. Ezenfelül a szín és az öltéstípus tetszés 
szerint módosítható.

Alakzatok létrehozása hímzési 
mintákhoz

(29., 70., oldal)

Keresztöltés funkció
(27., 134. oldal)

Grafikákat, fényképeket alakíthatunk át 
keresztöltéses hímzéssé. Ezenfelül a 
keresztöltések mérete módosítható.

Hímzési minták együttes 
alkalmazása

(38., 47., 52. oldal)
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Számtalan variáció különféle öltésekkel, színekkel
A szoftver 10 féle öltést ismer kitöltő varráshoz, és ötféle öltést vonal varrásához. Az öltések és a színek 
módosításával ugyanaz a grafika teljesen más megjelenést is kaphat. Próbálkozzunk a különféle 
beállításokkal.

Részletesen lásd a „Fonal színének és a varrás típusának beállítása” szakaszban a 94. oldalon.

Megnövelt betűkészlet-állomány
Hímzés nem kizárólag a szoftverhez tartozó betűkészletekkel tervezhető, felhasználhatjuk a számítógépre 
telepített TrueType betűkészleteket (ún. fontokat).

Monogramok (emblémák)
(lásd a 90., 171. oldalon)

Embléma kiválasztásához egyszerűen válasszuk ki 
a betűtípust, gépeljük be a szöveget, majd 
válasszunk ki egy díszítő mintát, melyek széles 
skálája áll rendelkezésre.

Szerkesztés könnyedén
(35., 80. oldal)

Tetszés szerint módosíthatjuk a szövegelhelyezést.
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Varrás-típusok
Az egyes varrási típusok jellemzői eleinte az alapbeállítások szerinti értéket veszik fel, azonban később ezek 
a varrási jellemzők tetszés szerint módosíthatók, így egyedi öltésekkel is dolgozhatunk.

Részletesen lásd a „Vonal-varrás jellemzői” szakaszban a 98. oldalon és a „Kitöltő varrás jellemzői” 
szakaszban a 101. oldalon..

Vonal-varrási típusok

Cikcakk öltés Futó öltés/Hármas öltés

Sorminta (motívum) öltés E/V öltés

Kitöltő öltéstípusok

Szatén (gobelin) öltések Kitöltő öltések

Programozható kitöltő öltések Minta öltések
6



Keresztöltések Koncentrált köröket adó öltés

Sugaras öltés Spirál öltés

Sarkos öltés Sarkos öltés (ism. mintával)

Steppelő (quilt) öltés Steppelő (quilt) öltés (ism. mintával)

Részletesen lásd a 103. oldalon a „Tervezhető kitöltő öltések” c. szakaszban, a 105. oldalon a „Sarkos 
öltések” szakaszban, az „Sormintás öltések” szakaszban a 106. oldalon és a „Steppelő (quilt) öltések” 
szakaszban a 108. oldalon.

Jegyezzük meg:
A tervezhető kitöltő öltések és az ismétlődő mintás öltések a kiválasztott öltési mintától függnek.
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Alapműveletek áttekintése
A csomag öt program áll.

Hímzési minták létrehozása mind a négy alkalmazással
A fő alkalmazást, a Layout & Editing szoftvert a Design Center (tervező központ), a Font Creator (betűkép 
tervező), a Programmable Stitch Creator (öltéstervező) és a Design Database (terv rendszerező) programok 
egészítik ki.

Adatkezelés Layout & Editing (47. old.) További egyedi kialakítások

Hímző minták létrehozása
Font Creator

(217. oldal)
Saját betűkép hímzése
A szövegben egyedi 
betűtípusokat használhatunk. 
Szimbólumok, dupla bájtos 
karakterek szintén 
tervezhetők, és később 
bármikor használhatók.

• Fényképek automatikus átalakítása
hímzési tervekké

• Egyedi feliratozás

• Egyedi kialakítás

• DigitalizálásDesign 
adatbázis

(187. oldal)

Grafika fájlok kezelése
• Fájlok keresése

• Fájlok megnyitása

• Fájlok szervezése

• Fájlok átalakítása

• Írás a kártyákra

Design Center
(145. oldal)

Kézi hímzési minta fénykép 
alapján
A Design Center kiemelhetjük 
a kép körvonalát, 
szerkeszhetjük a vonalak és 
foltok alakját, majd a minta 
minden részletéhez egyedi 
varrási beállítást és színt 
rendelhetünk.

Hímzési minták szerkesztése/
összedolgozása

Programmable 
Stitch Creator

(199. oldal)
Egyedi öltési minta tervezése
Kitöltő/bélyegzőminta és 
sormintás öltések létrehozása, 
szerkesztése.

• Grafikák összeforgatása

• Pozíció, méret, alakzat beállítása

• Varrási jellemzők meghatározása

• Bélyegzőminták készítése

Írás adatkártyára/
Mentés USB-adathordozóra

Hímzés a készülékkel
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Új funkciók a 8-as verzióban
Öltés tervező funkciók

Ismétlődő minta rendelhető a steppelő (quilt) öltéshez.

Az alávarrás öltési funkció további fejlesztéseken ment keresztül.

- Új alávarrás öltési mintákat találunk szövegek kitöltő varrásainak beállításai között és a kézi 
lyukasztású minták között.

- A felületek alávetített öltéseinek sűrűsége három fokozatban állítható: sűrű (dense), közepes 
(medium), ritka (light).

Funkciók szerkesztése és felhasználói felület
Layout & Editing

A Remove Overlaps (átfedések törlése) és Merge (összeolvasztás) parancsokkal bővült az alakzat-
szerkesztő funkció:

- Átfedések törlése: Az alakzatok egymást átfedő felületei törlésre kerülnek.

- Összeolvasztás: Az alakzatok egymást átfedő felületei egy alakzattá olvadnak össze.

Olyan grafikákat hozhatunk létre, melyek hátteréül egy fénykép szolgál, előtérben egy hímzési minta 
szerepel. Vasalható transzfer fólia vagy nyomtatható textília használatával nyomtassuk a textíliára a 
képet, majd hímezzük le a mintát. A pozícionáló ív segít a hímzés pontos illesztésében.

A Tervező képernyő bal oldalán és tetején vonalzók segítik a tervezést. Mértékegységként a milliméter 
és az inch között választhatunk.

Több fájlt is megnyithatunk egyidejűleg. Az adatok másolhatók, illeszthetők egymás között.

A Sewing Attribute Setting (varrás jellemzők) párbeszédablak, Thread Color (fonal színe) 
párbeszédablak, és a Text Attribute Setting (szöveg jellemzők) párbeszédablak egy közös ablakban 
jelennek meg, így használatuk egyszerűsödik.

A hímzési grafikák betöltésére szolgáló Import párbeszédablak funkciói fejlesztésre kerültek.

A Sewing Order/Lock (varrási sorrend/lezárás) ablak funkciói fejlesztésre kerültek.

- Hímzési minták lezárhatók (nincs módosítás, áthelyezés, nagyítás/kicsinyítés, szerkesztés).

- A különböző színű elemek varrási jellemzői külön állíthatók.

Az Öltés varázsló fénykép funkciói bővültek, javultak.

- Szépia móddal bővült a Fotó öltés és Keresztöltés funkció.

- Felületi alakzat vonallá alakítható amikor hímző mintát automatikusan konvertálunk az Auto Punch 
(kézi körberajzolás) funkcióval.

- Különálló keresztöltés és fonáköltés is szerkeszthető fénykép hímzési mintává alakítása során a 
Keresztöltés funkcióval.

A fényképek 90°-os lépésekkel elforgathatók.

Szabadkézi rajzolásra alkalmas eszközök jelentek meg.

Mintából kiválasztott szöveg görbére, ívre írható. 

Öltési jellemzőket színenként különíthetjük el.
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Design Center
Radír eszközzel bővült az Eszköztár a Vonalas kép fázisnál.

A vonalas kép ábrákból felépített képpé alakításakor használatos Thinning Process (vékonyítási 
művelet) maximális értéke növekedett, így vastagabb alakzat nyújtó vonalak jöhetnek létre.

Font Creator
A TrueType betűkép sablonként is megnyitható. Ezenfelül egyedi betűkészlet, font hozható létre 
automatikusan egy TrueType betűkészletből.

Betűkön, ábécé karaktereken kívül számok és szimbólumok is alkalmazhatók.

Amennyiben egy sablonként szolgáló kép volt megnyitva, amikor egyedi font adatokat mentünk PEF 
formátumban, az adatokkal a sablon kép is mentésre kerül.

Általános változások
Új mintaként szolgáló hímző fájlokkal bővült a Design Library mappa.

A grafika jellemzői között szerepel a becsült levarrási idő.

A Design Page Property (Tervező munkafelület tulajdonságai) ablakban 200 x 200 mm és 200 x 300 
mm hímző gyűrű méretek is szerepelnek.

Az alábbi képformátumok is megnyithatók sablonként vagy eredeti fényképként.

- GIF(.gif) formátum is támogatott.

- LZW-tömörítésű .tif formátum is támogatott.
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Tudnivalók az útmutatóról
A szoftverhez az alábbi használati útmutatók tartoznak.

Telepítési útmutató
A szoftver használatát megelőző előkészületi műveleteket ismerteti az útmutató. Kövessük az útmutatóban 
foglalt utasításokat a szoftver telepítéséhez, előkészítéséhez.

Használati útmutató (kezdő - jelen útmutató)
Jelen útmutató ismerteti a Layout & Editing és a Design Center szoftverek működését.

Az alkalmazások működését legjobban példákon keresztül lehet érzékeltetni. Kövessük ezen példa műveleti 
sorokat az alkalmazások alapvető funkcióinak elsajátításához.

Óvintézkedések, kiegészítő tudnivalók és az egyes funkciók részletes ismertetése követi a példákat. 
Ügyfélszolgálati elérhetőségek is szerepelnek az útmutatóban.

Használati útmutató (kezdő és haladó)
Jelen útmutató PDF-formátumban szerepel a mellékelt CD-ROMon. A fentieken túl a következő 
információkkal egészült ki a dokumentáció.

A Design adatbázis, a Programmable Stitch Creator (öltéstervező) és a Font Creator jellemzői. Ezen 
alkalmazások működését példák szemléltetik. Ezenfelül biztonsági figyelmeztetések, kiegészítő tudnivalók és 
az egyes funkciók részletes ismertetése, valamint a beállítási variációk is szerepelnek.

A PE-DESIGN műveleteinek jobb megértését szolgálják a bővített oktatóanyag, tippek, fogások leírása, 
valamint a menük, eszközök listái. Ezenfelül az útmutató hibaelhárítási tudnivalókat is tartalmaz, melyet 
érdemes fellapoznunk, ha problémába ütköztünk a szoftver használata során.

Útmutató megnyitása (PDF-formátum)
Kattintsunk a Minden program, PE-DESIGN 8, majd Instruction Manual pontokra.

Vagy bármelyik program menüjében kattintsunk a Súgó (Help), Instruction Manual pontokra .

Használati útmutató nyomtatása (PDF-formátum)
Adobe® Reader® programból történő nyomtatással kapcsolatosan tájékozódjunk az Adobe® Reader® 
súgójából.

Megjegyzés:

• Adobe® Reader® szükséges a PDF fájlok megtekintéséhez, nyomtatásához.
• Amennyiben az Adobe® Reader® nincs telepítve a készüléken, a http://www.adobe.com honlapról 

letölthetjük.
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Ügyfélszolgálat
Probléma esetén forduljunk a Műszaki ügyfélszolgálathoz. Lépjünk fel a http://www.brother.com/ honlapra 
tartózkodási helyünkön illetékes műszaki ügyfélszolgálat elérhetőségeihez. A GYIK és szoftverfrissítés 
tudnivalóit a http://solutions.brother.com/ honlapon találjuk.

Online regisztráció
Amennyiben tájékoztatást kívánunk kapni a rendelkezésre álló frissítésekről és a jövőbeni fejlesztésekről, 
regisztráljuk termékünket interneten keresztül a következő egyszerű művelettel.
Kattintsunk az Online Registration pontra a Layout & Editing szoftver Help menüjében az internetes 
böngésző megnyitásához, és ezen belül a Brother honlapján a regisztrációs oldal megnyitásához.
A regisztrációs oldal jelenik meg a böngészőn, ha a címsorba a következőt gépeljük be: 
http://www.brother.com/registration/

A szoftver legutolsó frissítésének 
lekérése
Kattintsunk a Layout & Editing szoftver Help menüjében a Check for updates pontra.
A szoftver leellenőrzi, hogy saját verziója a legutolsó verzió-e. Amennyiben az alábbi ablak jelenik meg, a 
szoftver a legutolsó kibocsátott verzió.

Amennyiben az alábbi üzenet jelenik meg, nem a legutolsó verziójú szoftvert használjuk. Kattintsunk a Yes 
(igen) gombra a szoftver legutolsó verziójának letöltéséhez.

a Megjegyzés:
• A fenti honlapon először ki kell választanunk az országot, csak utána a terméket.
• Készítsük elő az alábbi információkat a Műszaki ügyfélszolgálat felkeresése előtt:

• Ellenőrizzük, hogy számítógépünk operációs rendszerén minden frissítést végre legyen hajtva.
• Állapítsuk meg a számítógép és a Windows® operációs rendszer gyártmányát, típusát, és vessük 

össze a telepítési útmutatóban szereplő rendszerkövetelményekkel.
• A hibaüzenet tartalmát írjuk ki. Ezzel megkönnyítjük a hiba okának megállapítását.

Megjegyzés:
Egyes régiókban online regisztráció nem lehetséges.

Megjegyzés:
Amennyiben Always check for most recent 
version at startup (indításkor mindig 
ellenőrizze, van-e újabb verzió) kapcsolót 
kipipáljuk, a szoftver automatikusan 
indításkor elvégzi ezt az ellenőrzést.
14
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Alapismeretek

A

lapism
eretek
Jelen fejezet ismerteti a Layout & Editing szoftver műveleteit egy hímzési minta létrehozásán keresztül. 
Először nézzük át a hímzési minta létrehozásának lépéseit, majd tanulmányozzuk az alapműveleteket.

1 Hímzési minta betöltése (15. oldal)

Indítsuk el a Layout & Editing szoftvert, majd töltsük be a mintát. Ezután töltsük át a behozott hímzési mintát 
egy saját kártyára.

2 Automatikusan alakítsuk át a képet hímzési mintává (19. oldal)
A Fényképből hímzés varázslóval hímzési mintát készíthetünk.

3 Hímzési grafika tervezésekor alakzatok rajzolása (29. oldal)
A Shape (alakzat) eszközökkel grafikákat hozhatunk létre, melyekhez varrási jellemzőket rendelhetünk.

4 Szöveg bevitele(35. oldal)

Feliratot hozhatunk létre, melyet alakzatba torzíthatunk, görbére vetíthetünk.

5 Hímzési minták összekapcsolása (38. oldal)

Saját terv létrehozása különféle hímzési minták összekapcsolásával.

6 Nyomtatás és öltés (42. oldal)

Saját terv létrehozása egy nyomtatott fénykép és hímzési minta összeforgatásával.

1. Hímzési minta betöltése
A szoftverhez tartozik néhány bemutató jellegű hímzési minta. Ezeket betölthetjük a Layout & Editing 
szoftverbe, ráírhatjuk egy adatkártyára, majd levarrhatjuk a hímzőgéppel.

A következőkben elindítjuk a Layout & Editing szoftvert, betöltünk egy hímzési mintát, majd kiírjuk egy 
kártyára.

1. lépés Layout and Editing indítása
2. lépés Hímzési minta betöltése
3. lépés Grafika letöltése saját adatkártyára
15



Alapismeretek
1. lépés Layout & Editing indítása

Kattintsunk a  ikonra, válasszuk ki a 
Programok, PE-DESIGN 8 majd PE-DESIGN 
8 (Layout & Editing) pontokra.

1. lépés Hímzési minta betöltése

Betöltjük a virágos, pillangós, napocskás mintákat.

Kattintsunk a ikonra az Eszköztárban.

Kattintsunk a  ikonra.

→ A Design Library (grafikákat tartalmazó 
mappa) megjelenik.

Lásd a 48. oldalon a „Grafika betöltése” c. 
szakaszban.

Kattintsunk a Category (kategória) 
kiválasztóra. A legördülő menüben léptessünk 
le a Floral3 grafikáig, majd kattintsunk rá.

Húzzuk a virágot a munkafelületre, az ábrán is
látható módon.

A Kategória kiválasztóban válasszuk az
Animals (állatok) pontot, majd húzzuk a
pillangót a munkaterületre.

A Kategória kiválasztóban válasszuk a
Children (gyerekek) pontot, majd húzzuk a
napocskát a munkaterületre.

1

1

2

Design Library (grafika mappa)

3

1. kattintás

2. Húzzuk le

3. kattintás

4

5

6
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Alapismeretek
A

lapism
eretek
A minták elhelyezéséhez kattintsunk a
mozgatni kívánt mintára, majd vigyük a
mutatót a minta fölé. Amikor a mutató -ra
változik, húzzuk a mintát a kívánt helyre.

2. lépés Grafika letöltése 
adatkártyára

A mintát adatkártyára írva levarrhatjuk azt 
varrógépünkkel. Az alábbi példában letöltjük a 
grafikát egy adatkártyára.

Helyezzük be az adatkártyát az USB-kártyaíró
modulba.

Kattintsunk a File menüre, majd a Write to
Card (írás a kártyára) pontra.

Kattintsunk az OK-ra.

Amikor az írással végeztünk, az alábbi
(Kártyára írás befejeződött) üzenet jelenik
meg. Kattintsunk az OK-ra.

Megjegyzés:
Ha nagyítjuk, kicsinyítjük az öltési mintát, a 
hímzés minősége romolhat. Ezért nem 
javasolt a minták nagyítása, kicsinyítése.

A 237. oldalon olvashatunk a 
minták nagyításáról, 
kicsinyítéséről.

Megjegyzés:
Floppy lemezre, CompactFlash kártyára, 
USB-cserélhető háttértárra is menthetjük a 
mintát. Varrógépünk által kezelt adathordozót 
alkalmazzuk.

7

1

Megjegyzés:
A kártyán lévő összes korábbi adat törlésre 
kerül az írás során. Saját kártya használata 
esetén ellenőrizzük, hogy a kártyán lévő 
grafikákra még szükségünk van-e, és a 
szükséges adatokat mentsük ki 
merevlemezre vagy egyéb adathordozóra.

A hímzőkártyákról a 49. oldalon 
olvashatunk.

Megjegyzés:
• Amennyiben a kártyaírót nem 

csatlakoztattuk megfelelően, a „No card 
writer module is connected. Please 
connect card writer module.” (Kártyaíró 
nincs csatlakoztatva. Kérjük csatlakozzon 
a kártyaíróra.) üzenet látható.

• Amennyiben az adatkártyát rosszul 
helyeztük be vagy az hibás, a “No original 
card is inserted. Please insert an original 
card.” (nincs kártya, helyezzen be kártyát) 
üzenet látható.

2

3

4
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Alapismeretek
A hímzési minták mentéséről a 22. 
oldalon olvashatunk.

Jegyezzük meg:
Az öltési adatok tömörítve kerülnek a kártyára 
a hatékonyabb tárhely-kihasználás 
érdekében. A tömörítési módtól függően az 
adat mérete változhat. Átlagosan max. 
200.000 öltés fér egy kártyára. Azonban a 
mintákban az öltés száma a varrógép 
típusától függően változhat.

Jegyezzük meg:
Figyelmeztetések a kártyaíró 
használatával kapcsolatosan
• A kártya akkor került a helyére, amikor 

behelyezéskor kattanást hallunk.
• Soha ne húzzuk ki a kártyát, és ne húzzuk 

ki az USB-kábelt, amíg a LED-lámpa 
villog.

• A varrógép használati útmutatójában 
foglaltaknak megfelelően helyezzük be 
vagy vegyük ki az adatkártyát.
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Alapismeretek
A

lapism
eretek
2. Fénykép automatikus átalakítása 
hímzési mintává 

Hímzési mintát hozhatunk létre a digitális kamerával készített fénykép, szkennelt kép, clip art gyűjteményből 
származó grafika alapján. A Fényképből varrási minta varázsló használatával a képből hímzési mintát 
készíthetünk. Először válasszunk a következő három hímzési minta típus közül.

Körberajzolás (Auto Punch)
Clip art (ábra gyűjteményből származó) ábrából vagy szkennelt grafikából készít hímzési mintát. Kevés, jól 
elkülönülő színeket tartalmazó képek a legmegfelelőbbek.

Fotó öltés (Photo Stitch)
Hímzési mintát készítük fényképből. A minta gazdag, részletes és átfedő öltésekkel bír.

Világos, éles, kontúros fényképek az ideálisak, ezek remélhetőleg tisztán jelennek meg a hímzésen. Portrék 
hímzésekor az arc mérete a fényképen legalább 100 x 100 mm legyen.

Keresztöltés (Cross Stitch)
A fényképből keresztöltéses hímzési minta jön létre.

Kevés, jól elkülönülő színekből álló képek megfelelők, valamint ahol a hímzendő alak élesen kiválik a képből.

Képek fájlformátum
A következő formátumban tölthetünk be képeket:

- Windows bitmap (.bmp), Exif (.tif, .jpg), ZSoftPCX (.pcx), Windows Metafile (.wmf), Portable Network 
Graphics (.png), Encapsulated PostScript (.eps), Kodak PhotoCD (.pcd), FlashPix (.fpx), JPEG2000 
(.j2k), GIF (.gif)

A fenti formátumoknak megfelelő fájlok vasalható transzfer fóliára nyomtatandó képként is betölthetők, a 
Design Centerben saját fényképként, valamint kézi lyukasztási minták, egyedi fontok, öltési minták 
sablonjaiként is szolgálhatnak.

Ebben a fejezetben a kézi körberajzolás (Auto Punch) funkcióval hímzési mintát hozunk létre egy fénykép 
alapján, ezenfelül elsajátíthatjuk, miként tekinthetünk megegy nézőképet, és hogyan menthetünk hímzési 
mintát.

Megjegyzés:
• A Fényképből hímzési minta varázsló használatáról a 125. oldalon, a „Fénykép automatikus 

átalakítása hímzési mintává” szakaszban olvashatunk.
• A hímzési minták méretei és a képek méretei az állapotsorban láthatók. A mértékegység lehet 

milliméter vagy inch.

Két pont közötti távolság méréséről az 51. oldalon, a mértékegység módosításáról a 69. 
oldalon olvashatunk.

Az útmutatóban megjelenő értékek milliméterben értendők.

Megjegyzés:
• Amennyiben EPS formátumú fájl nem tartalmaz nézőképet (preview), a képernyőn csak szürke 

téglalap látható. Az EPS fájl mentésekor ügyeljünk, hogy nézőképet is mentsünk.
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Alapismeretek
Auto Punch (körbrajzolás) funkció

1. lépés Adat betöltése a Layout & 
Editing szoftverbe

Első lépésként be kell töltenünk a minta 
eredetijeként szolgáló fényképet.
A példában a penguin.bmp képet fogjuk 
felhasználni, amely a szoftver bemutató anyagai 
között szerepel.

Kattintsunk az Image, Input, majd from File
(fájlból) pontra.

Kattintsunk kétszer a Dokumentumok\
PE-DESIGN8\Tutorial\Tutorial_2 mappában a
fájl nevére.

Amikor telepítettük a szoftvert, a 
Dokumentumok mappában megjelenik a PE-
DESIGN 8 almappa. Amikor először töltünk be 
képet, ennek a mappának a tartalma jelenik 
meg.

1. lépés Fénykép betöltése a Layout & Editing szoftverbe
2. lépés Fénykép automatikus átalakítása hímzési mintává
3. lépés Hímzési minta nézőképének megjelenítése
4. lépés Hímzés lementése

1

2
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Alapismeretek
A

lapism
eretek
Válasszuk ki a penguin.bmp fájlt, kattintsunk
az Open pontra, vagy kétszer a fájl ikonjára.

→ A kép megjelenik a tervezőasztalon.

A fogantyúkkal húzzuk a megfelelő méretűre a
kiválasztott képet.

Vigyük a mutatót a kép fölé, majd húzzuk a
képet a kívánt helyre.

2. lépés Kép automatikus átalakítása 
hímzési mintává

Következő lépésként megtörténik a kép 
automatikus átalakítása hímzési mintává.

Kattintsunk az Image > Image to Stitch
Wizard pontokra.

Válasszuk az Auto Punch pontot, majd
kattintsunk a Next pontra.

Megjegyzés:

Ismételjük meg a  - . lépéseket másik 

kép kiválasztásához. Ha . lépéstől eltérő 
módon töltünk be képet, szkennerből, digitális 
kameráról, vágólapról is letölthetünk képet, 
vagy a portré funkcióval egyedi képet 
hozhatunk létre, melyet ugyanígy 
betölthetünk.

Képek betöltése a 120. oldalról.

Megjegyzés:
Ha a fogantyúk eltűnnek, jobb egérgombbal 
kattintsunk a képre, majd a Modify Image 
pontra a legördülő menüben.

3

1 3

1

4

Fogantyú

Állapotsor mutatja a kép méreteit
(szélesség, magasság).

5

1

2
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Alapismeretek
Kattintsunk a Result View pontra a konverzió
eredményének megtekintéséhez, majd kat-
tintsunk a Finish (Befejezés) gombra.

→ A program által konvertált hímzési minta 
megjelenik.

3. lépés Hímzés nézőképének 
megtekintése

A kész hímzés nézőképének megtekintése.

Kattintsunk a Display (Nézet)> Realistic
Preview (valósághű nézőkép) pontokra.

Normál nézetre való visszalépéshez
kattintsunk újra a Display (Nézet)> Realistic
Preview pontra, majd nyomjuk le az 
gombot.

4. lépés Hímzési minta mentése

Miután elkészült a hímzési minta, elmenthetjük 
későbbi használat céljából.

Kattintsunk a File > Save pontokra.

Megjegyzés:
A kiválasztott felületek vonalas varráshoz 
alakíthatók, pl. cikcakk öltésekkel.

Az Auto Punch funkcióról a 126. 
oldalon olvashatunk.

3

1

2

Esc

1
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Alapismeretek
A

lapism
eretek
Válasszuk ki a meghajtót, a kívánt mappát,
majd gépeljük be a fájl nevét.

Kattintsunk a Save (Mentés) gombra.

A grafikák adatkártyára való letöltéséről a 
17. oldalon olvashatunk.

Megjegyzés:
A Clipart mappában számos ábra közül 
válogathatunk. A mappát abban a mappában 
találjuk, melybe a PE-DESIGN-t telepítettük. 
Például: válasszuk ki a meghajtót, melyre a 
PE-DESIGN-t telepítettük, majd lépjünk be a 
Program Files mappába, Brother mappába, 
PE-DESIGN 8 mappába, majd a ClipArt 
mappába. Gyakoroljunk ezeken a minta 
fájlokon.

2

3
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Alapismeretek
Photo Stitch funkció

A Fotó öltés funkcióval fényképek alapján készíthetünk hímzési mintát. Kétféle átalakítási mód közül 
választhatunk, valamint meghatározhatjuk a felhasználható színeket is.

Photo Stitch 1 (1. mód):
A hímzési minta nagyban meg fogja közelíteni az eredeti képet, egy de akár több színben is. A minta 
aprólékos és átfedő öltéseket is tartalmazhat.

A hímzési minta lehet színes (color), szépia vagy szürkeárnyalatos (sepia), vagy monokróm (egyszínű - 
Mono).

Photo Stitch 2 (2. mód):
Egy vagy négyszínű mintát készít a szoftver. A minta ismétlődő cikkcakk öltésből épül fel.

A hímzési minta lehet négyszínes (color) vagy egyszínű (mono).

A következő példa a Photo Stitch 1 eljárás Color beállítású eredményét mutatja. A példából megismerhetjük, 
miként választhatjuk ki a hat minta közül a megfelelőt, melyek mindegyike eltérő automatikus korrekción ment 
keresztül.

1. lépés Fotó betöltése a Layout & 
Editing szoftverbe

Lásd a 20. oldalon „Adat betöltése a Layout & 
Editing szoftverbe” szakaszban. Válasszuk a 
Tutorial_2 mappát, majd a girl2-face.bmp fájlt.

1. lépés Kép automatikus átalakítása 
hímzési mintává

Következő lépésként a szoftver automatikusan 
hímzési mintát hoz létre a kép alapján.

Kattintsunk az Image > Image to Stitch
Wizard (képből hímzési minta varázsló)
pontokra.

1. lépés Kép betöltése a Layout & Editing szoftverbe
2. lépés A kép automatikus átalakítása hímzési mintává

1
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Ezután kattintsunk a Photo Stitch 1 > Color
> Next.

Kattintsunk az Auto Generate pontra.

→ Egyszínes, homogén háttér esetén 
(ahogy a példában is), az Auto Generate 
funkció automatikusan feltérképezi a kép 
körvonalát.

Kattintsunk a Next pontra a folytatáshoz.

Kattintsunk a Fit to page (oldal méretére
nagyít) pontot a véső méret megadásához.

→ Ezen a méreten a minta pontosan kitölti a 
tervezőfelületet.

Ellenőrizzük az átalakításra kijelölt területet,
majd kattintsunk a Next gombra a folytatás-
hoz.

Ne feledjük:
A sepia (szépia) beállítás szépia színvilágú 
vagy szürkeárnyalatos mintát ered-
ményezhet. A mono beállítás fekete-fehér 
egyszínű mintát hoz létre.

Lásd a 129. oldalon, a Photo 
Stitch 1 (Sepia) esetén, és a 130. 
oldalon a Photo Stitch 1 (Mono) 
szakaszokban.

2

3

4

Ne feledjük:
• A maszk körvonalát módosíthatjuk: 

áthelyezhetjük, törölhetünk vagy 
beszúrhatunk pontot a körvonalba.

• Ezenfelül előre elmentett sablonok közül is 
kiválaszthatjuk a maszk alakját.

Lásd a 127. oldalon, a Photo 
Stitch 1 (Color) esetén.

Ne feledjük:
• A hímzési minta befoglaló mérete az ablak 

bal-alsó sarkában jelenik meg. Ezen a 
képernyőn szabadon állíthatjuk a méretet.

• A legjobb eredményt akkor kapjuk, ha 
valamelyik alábbi méretet választjuk.

• Csak arc: 100 × 100 mm
• Fejek, vállak is: 130 × 180 mm

Lásd a 127. oldalon, a Photo 
Stitch 1 (Color) esetén.

5

Hímzési minta mérete

6
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Kattintsunk a Select from Candidates 
pontra.

→ Hat minta látható eltérő fényerővel, 
kontraszttal.

Válasszuk ki a nekünk tetszőt, majd kattint-
sunk az OK-n.

→ A nézőképen a kiválasztott kép fog 
megjelenni.

Kattintsunk a Finish (befejez) pontra.

→ A kép alapján létrehozott hímzési minta 
megjelenik.

Hímzési minták mentéséről a 22. oldalon 
olvashatunk. Az adatkártyákra való 
mentésről a 17. oldalon olvashatunk.

Látványos hímzési minta 
létrehozása

• Válasszunk egy nagy méretű fényképet. 
(Részletgazdag, rajzos kép, pl. sok elemből álló 
fénykép nem megfelelő.)

• Növeljük a kontrasztot.

• Olyan képet válasszunk, melynek szélessége és 
magassága 300 és 500 pixel közé esik.

• Tekintsük meg a fényképet.
A következő típusú fotók nem alkalmas hímzési 
mintává átalakításhoz.

• Túl kis fényképek, pl. az indexlapokon lévő 
fotók.

• Fotók, melyeken az alak(ok) túl sötétek, 
pl. beltérben készült fotók, vagy erős 
háttérfénnyel készült fotók.

• Ha a minta nem hozza a kívánt minőséget, 
módosítsuk a Photo Stitch 1 Parameters 
ablakban a beállításokat.
Brightness (fényerő): növeljük a kép 
fényerejét.
Max. Number of Colors: növeljük a használt 
színek számát.

Lásd a 131. oldalon a „Szín beállítások” 
szakaszt.

• Ha a létrehozott hímzési minta olyan színeket is 
tartalmaz, melyeket nem kívánunk kiemelni (pl. 
szürke foltok az arcon), a Sewing Order/Lock 
ablakban módosítsuk a varrási sorrendet, így a 
nem kívánt színek az összes többi szín előtt 
kerülnek levarrásra.

Lásd a 118. oldalon a Varrási sorrend 
szerkesztése pontokat.

7

8

9
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Cross Stitch (keresztöltés) funkció

A funkció keresztöltéses hímzési mintát hoz létre kép alapján. Clip art ábrát, kis vonalas grafikákat is 
használhatunk.

1. lépés Kép betöltése a Layout & 
Editing szoftverbe

Lásd a 20. oldalon, a Kép betöltése a Layout & 
Editing szoftverbe szakaszban. Válasszuk a 
Tutorial_2 mappát, majd a tulip.bmp képfájlt.

2. lépés Kép automatikus átalakítása 
keresztöltéses mintává

A következőkben a képet automatikusan hímzési 
mintává alakítjuk.

Kattintsunk az Image majd Image to Stitch
Wizard pontokra.

Válasszuk a Cross Stitch (keresztöltés)
opciót, majd a Color (színes) módot, majd
kattintsunk a Next gombra.

Kattintsunk a Next gombra.

Az ablakban a színek számát és a kereszöltés 
méretét adhatjuk meg. A példában az 
alapbeállításokat fogjuk alkalmazni.

1. lépés Kép betöltése a Layout & Editing szoftverbe
2. lépés Kép automatikus átalakítása keresztöltéses mintává

1

Ne feledjük:
A Sepia beállítás szépia vagy 
szürkeárnyalatos hímzési mintát hoz létre.

Lásd a 136. oldalon a 
Keresztöltés (szépia) 
kiválasztása esetén szakaszban.

2

3
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Kattintsunk a Finish (befejez) gombra.

Az alábbi ablakban öltéseket szúrhatunk be, 
törölhetünk, módosíthatunk, a színeket 
állíthatjuk, valamint az egyes öltések ismétlési 
számát adhatjuk meg. A példában az 
alapbeállításokat fogjuk alkalmazni.

→ A program által tervezett hímzési minta 
megjelenik.

A hímzési minta mentéséről a 22. oldalon 
olvashatunk. Az adatkártyára történő 
lementésről a 17. oldalon.

Ne feledjük:
A keresztöltés egy adott elemén belül minden 
egyes öltést külön módosíthatunk.

Lásd a 134. oldalon a Cross Stich 
(color) kiválasztása esetén 
szakaszban.

4
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3. Hímzési minta részét képező alakzatok 
rajzolása

Jelen fejezet ismerteti, miként hozhatunk létre különféle alakzatokat, és állíthatunk össze belőle teljes hímzési 
mintákat. A Layout & Editing szoftverben az Alakzat eszközök szolgálnak különféle formák rajzolására. Ezen 
eszköz segítségével egy virágot fogunk rajzolni, szárral, levelekkel, szirommal, vázával.

1. lépés Alakzat rajzolása, 
mozgatása

Az alábbi műveletsort kell végrehajtanunk alakzat 
rajzolásához.

1 Válasszuk ki az Alakzat eszközt.

2 Adjuk meg a vonalak fonalszínét és öltéstípusát.

3 Adjuk meg a felületek fonalszínét és 
öltéstípusát.

4 Húzzuk a mutatót a tervezőfelületre az alakzat 
rajzolásához.

Rajzoljuk meg a szárat.

(1) Kattintsunk a  majd a  ikonra.

(2) Kattintsunk a  ikonra a színtár 

megjelenítéséhez.

(3) Kattintsunk a LIME GREEN (zöld) színre.
Ha a kiválasztott szín nem látható, húzzuk 
a görgetősávot, amíg meg nem jelenik.

1. lépés Alakzatok rajzolása, mozgatása
2. lépés Alakzatok megkettőzése, tükrözése, mozgatása
3. lépés Lyuk varrása
4. lépés Öltési minta hozzárendelése
5. lépés Pontok szerkesztése, alakzatok módosítása

4

5

1

2

6

3

Vonal színe gomb
Vonal öltéstípusa kiválasztó

Felület színe gomb
Felület öltéstípus kiválasztó

Alakzat eszköz Fonal szín paletta
Kiválasztott fonalszín és annak elnevezése

1
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(4) Kattintsunk a Line sew type (vonal 
öltéstípus) kiválasztóban a Zigzag Stitch 
(cikcakk öltés) beállításon.

(5) Kattintsunk az 1-es kezdőponton, majd 
kétszer a 2-es befejező ponton.

Rajzoljuk meg a jobb oldali levelet.
Ahogy a szárral is tettük, meg kell adnunk a 
színt és az öltéstípust, csak ezután rajzoljuk 
meg az alakzatot. Ezúttal mivel az alakzat 
felülettel is rendelkezni fog, ennek is 
megadjuk a színét és öltéstípusát.

(1) Kattintsunk a  majd  ikonokon.

(2) Kattintsunk a vonal színének  ikonján, 
majd válasszuk a LIME GREEN színt a 
színtárban.

(3) Kattintsunk a Line sew type (vonal 
öltéstípus) kiválasztóban a Zigzag Stitch 
(cikcakk öltés) beállításon.

(4) Kattintsunk a felületi szín  ikonján, 
majd válasszuk a LIME GREEN színt a 
színtárban.

(5) Kattintsunk a Region sew type (Felület 
öltéstípus) kiválasztón, majd válasszuk a 
Fill Stitch (kitöltő öltés) beállítást.

(6) Miközben nyomva tartjuk a  
gombot, húzzuk a mutatót a 
tervezőfelületre, az alábbi ábrának 
megfelelően.

(7) Vigyük a mutatót a levél fölé: a mutató 
alakja -ra változik, ezután húzzuk a 
levelet a kívánt pozícióba.

2. lépés Alakzat megkettőzése, 
tükrözése, mozgatása

A következőkben készítünk egy másolatot a jobb 
oldali levélről, vízszintes tengely mentén 
megtükrözzük, majd áthelyezzük a szár bal 
oldalára.

Kettőzzük meg a jobb oldali levelet.

(1) Jobb egérgombbal kattintsunk a levélre.

(2) Kattintsunk a Duplicate (megkettőz) 
gombra.

1

2
2

A kiválasztott szín vonalra vagy felületre is
vonatkozhat, ezt a Color gombbal vagy az

alábbi helyen választhatjuk ki.

(1)

(2) (3) (4) (5)

(1)

Ne feledjük:
A színt, öltési jellemzőket és a méretet az 
alakzat megrajzolása után is módosíthatjuk.

Ne feledjük:
Az alakzat rajzolása közben a szélesség-
magasság arányának rögzítéséhez a mutató 
húzása közben nyomjuk le a  gombot.

Shift

Shift

1
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Tükrözzük meg a levelet.

(1) Jobb egérgombbal kattintsunk a levél 
másolaton .

(2) Kattintsunk a Mirror (tükrözés) majd 
Vertical (függőleges) pontokon.

Húzzuk a levél másolatát a szár bal oldalára.

Igazítsuk el a leveleket mind a jobb, mind a bal
oldalon.
(1) Tartsuk lenyomva a  gombot, 

közben jobb egérgombbal kattintsunk a 
jobb oldali levélen, majd kattintsunk a bal 
oldali levélen.

(2) Kattintsunk az Align (igazít) majd Top 
(tetejéhez állít) ponton.

3. lépés Lyuk varrás

Ezután megrajzoljuk a virágszirmot és középre egy 
kört. Ezután beállítjuk úgy a varrást, hogy az 
egymást átfedő felületek ne kerüljenek kétszer is 
levarrásra. 

Rajzoljuk meg a szirmokat.

(1) Kattintsunk a  majd a  ikonra.

(2) A vonalhoz válasszuk a RED (piros) színt 
és a Zigzag Stitch (cikkcakk) öltést.

(3) Válasszuk a felülethez a PINK színt és a 
Radial Stitch (sugaras) öltést.

(4) Tartsuk lenyomva a  gombot, 
közben húzzuk a mutatót a 
tervezőfelületen, ahogy az az ábrán is 
látható.

Húzzuk meg a kört a középpontban.

(1) Kattintsunk a  majd  ikonra.

(2) Válasszuk a vonal színének a YELLOW 
(sárgát) színt és Zigzag Stitch (cikkcakk) 
öltést.

(3) Kitöltésnek válasszuk a YELLOW (sárga) 
színt és a Concentric Circle Stitch 
(körkörös) öltést.

(4) Tartsuk lenyomva a  gombot, 
közben húzzuk a mutatót a 
tervezőfelületen, ahogy az az ábrán is 
látható.

(5) Húzzuk meg a kört a virágszirmok 
közepén.

Ne feledjük:
A következő módokon több mintát is 
kiválaszthatunk egyszerre.
• Kattintsunk az első mintára, tartsuk 

lenyomva a  gombot, majd 
kattintsunk a következő mintára.

• Húzzuk el a kiválasztani kívánt elemek 
felett a mutatót egy kiválasztó keret 
rajzolásához.

2

3

4

Ctrl

Ctrl

1

Shift

(1)

(2) (3)

(4)

(1)

(2) (3)

2

Shift
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Válasszuk ki a mintákat, amelyeken a 
lyukvarrást végre kívánjuk hajtani.

(1) Kattintsunk a  ikonon.

(2) Kattintsunk a sárga körön, ezután 
nyomjuk le hosszan a  gombot, 
közben kattintsunk a virágszirmokon.

Állítsuk be a lyukvarrást.

(1) Kattintsunk a Sew > Set hole sewing 
(lyukvarrás beállítás) pontokra.

(2) Kattintsunk az OK-n.

4. lépés Minta alkalmazása egy 
öltésre

A Sewing Attribute Setting (varrási jellemzők) 
ablakban pontosan beállíthatjuk a vonal és kitöltési 
felület jellemzőit. A következőkben a váza felületi 
jellemzőit fogjuk megadni.

Adjuk meg a körvonal és a felület színét,
öltéstípusát.

(1) Kattintsunk a  majd  ikonra.
(2) Válasszuk a CLAY BROWN 

(agyagbarna) színt és Zigzag Stitch 
(cikkcakk) öltést a vonalnak.

(3) Válasszuk a DEEP GOLD (arany) színt a 
és Prog. Fill Stitch öltést a felületnek.

Adjuk meg a varrási jellemzőket.

(1) Kattintsunk a  ikonon.
(2) A Varrási jellemzők ablak kétféle 

megjelenítési móddal bír. A példában mi a 
Kezdő (beginner) módot választottuk. 
Amennyiben az ablak haladó (expert) 
módban jelenne meg, kattintsunk a To 
Beginner mode gombra a kezdő módba 
történő váltáshoz.

(1)
(1)

(5)

(4)

(2) (3)

(2) (3)

3

Ctrl

1

(2)

(1)

4

Megjegyzés:
Lyukvarrás csak úgy varrható le, ha 
mindegyik minta teljesen magába foglalja a 
másikat..

Lásd a 75. oldalon, a „Átfedő 
öltések megelőzése (lyuk 
varrás) c. szakaszban.

Ne feledjük:
Átfedő mintákra is alkalmazhatjuk a 
lyukvarrást, ehhez vagy az egymást átlapoló 
felületeket vagy törölnünk, vagy 
összeolvasztanunk kell.

Lásd a 75. oldalon, az „Átfedő 
minták alakjának módosítása” c. 
szakaszban.

1

(1)
(1)

(2) (3)

(2) (3)

2
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(3) Húzzuk a Density (sűrűség) csúszkát 5.0 
vonal / mm-re.

(4) Húzzuk a piros nyílat a Direction (irány) 
mezőben 90 fokos irányba.

(5) Kattintsunk a  ikonon a 
Programmable fill (programozható 
kitöltés) szakaszban.

(6) Válasszuk ki a net4 mintát, majd OK.

(7) Vigyük a csúszkát 7,6 x 7,6 mm-es 
értékig.

A megadott beállítások eredményét 
előzetesen megtekinthetjük a kis 
nézőképen. A nézőkép a Show 
Hint/Hide Hint gombbal ki- és 
bekapcsolható.

Alapbeállítások
visszaállítása

(3)

(4)

(2)

Ne feledjük:
Haladó (expert) módban részletesen 
állíthatjuk be az öltési jellemzőket..

Lásd a 96. oldalon, a „Varrási 
jellemzők megadása” 
szakaszban.

A kiválasztott minta megjelenik.
33



Alapismeretek
5. lépés Pontok és alakzatok 
szerkesztése

A következőkben törölni fogjuk a pentagon legfelső 
sarokpontját a váza kialakításához.

Rajzoljuk meg a vázát.

Húzzuk el a mutatót a tervezőfelületen, ahogy 
az az ábrán is látható.

Töröljük a pontot.

(1) Kattintsunk a  majd  ikonon.

(2) Kattintsunk az alakzaton.

→ Az ötszög alakzat pontjai megjelennek.

(3) Kattintsunk a jobb egérgombbal a felső 
ponton, majd kattintsunk a Delete 
gombra.

→ A pontot törölve egy trapéz formát 
hoztunk létre.

Ezzel elkészült a mintát.

A 22. oldalon olvashatunk a hímzési 
minták mentéséről, a 17. oldalon az 
adatkártyára történő lementésről.

1

2

(3)

(2)
(3)

(1)
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4. Szövegbevitel
A következő példában feliratot tartalmazó hímzési mintát fogunk létrehozni.
A Layout & Editing pontban számos hímzési mintát rendelhetünk szöveghez, feliratokhoz. 

Beépített betűtípusok:  A szoftver 35 beépített betűtípust tartalmaz.

TrueType fontok: TrueType betűtípusok kerültek a számítógépre, melyekből hímzési mintákat is 
létrehozhatunk.

Kisebb fontok: Ezen kis betűtípusok 3-6 mm közötti méretűek.
Méretük miatt kisebb feliratok varrásához ideálisak.

Monogramok: Egyedi monogramokat hozhatunk létre feliratok és díszítőminták ötvözésével.

Egyedi fontok: Saját tervezésű betűtípusokat hozhatunk létre a Font Creator szoftverrel.

Felirat igazítása: A feliratot egy körvonalra írhatjuk vagy egy ívre igazíthatjuk.

Átalakítás: A felirat 26 féle előre elmentett formára igazítható.

Részletesen lásd a 80. oldalon a „Felirat létrehozása” szakaszban.

Jelen fejezet ismerteti egy felirat begépelésének módját és körvonalra igazítását.

1. lépés Kör rajzolása

Rajzoljunk egy kört, amelyre a kört ráigazíthatjuk.

Kattintsunk a  majd a  ikonra.

Válasszuk körvonalnak a YELLOW (sárga)
színt és Zigzag Stitch (cikkcakk) öltést.

Lásd a 29. oldalon az „Alakzatok rajzolása, 
mozgatása” szakaszban.

Kapcsoljuk ki a felület varrást.

Kattintsunk a  ikonra, a  ikon és a 
Region sew type kiválasztó eltűnik.

1. lépés Kör rajzolása
2. lépés Felirat bevitele
3. lépés Szöveg formára igazítása

1

2

3

35



Alapismeretek
Húzzuk a mutatót a tervezőfelületen, az ábrán
is látható módon.

2. lépés Felirat begépelése

Kattintsunk a  majd  ikonon.

Kattintsunk a tervezőfelületen.

A billentyűzeten gépeljük a “ABCDE” 
karaktersort.

Kattintsunk az OK-n.

→ A felirat megjelenik a tervezőfelületen.

3. lépés Felirat alakzatra írása 

Válasszuk ki a kört és a feliratot.

Lásd a 31. oldalon a „Ne feledjük!” 
bekezedést.

A mutatót vigyük az ellipszis vagy a felirat fölé,
várjuk meg, amíg a  alakra vált,
kattintsunk jobb egérgombbal, majd
kattintsunk a Fit Text to Path Setting
(görbére írás beállítása) pontra.

A Fit Text to Path Attribute Setting ablakban 
válasszuk ki a kívánt igazítási formát. A 
példában az alapbeállításoknál maradunk.
„Horizontal alignment” – vízszintes igazítás
„Vertical alignment” – függőleges igazítás

Ne feledjük:
Az Insert Character alatti táblázatra kattintva 
is begépelhetünk szöveget, vagy az Insertre 
kattintva.

4

1

2

3

A begépelt szöveg

Ne feledjük:
A betűtípust, a betűméretet, színt és öltési 
típust bármikor módosíthatjuk.

Lásd a 81. oldalon a szöveg 
jellemzők megadását.

4

1

2

36



Alapismeretek
A

lapism
eretek
Kattintsunk az OK-n.

→ A felirat az ellipszis ívét fogja követni.

Ezzel a minta elkészült.

A hímzési minták mentéséről a 22. 
oldalon olvashatunk. A minta 
adatkártyára történő mentéséről a 17. 
oldalon olvashatunk.

3

Ne feledjük:
• A görbére írt szöveg az alakzat bármely 

pontjára eltolható. Válasszuk ki csak magát 
a szöveget és kezdjük el húzni a görbe, 
alakzat mentén az alábbi ábrán látható 
módon.

• A felirat számtalan módon kialakítható.

Felirat elrendezéséről lásd a 87. 
oldalon 

• A szöveget alakzatra torzítását másik 
módon kell kiviteleznünk.

Lásd a 84. oldalon.
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5. Több hímzési minta összeállítása
A következő példában saját hímzési mintát fogunk létrehozni egy képből átalakított hímzési minta, egy feliratot 
tartalmazó hímzési minta, és a szoftver előre elkészített mintáinak egyikének felhasználásával. Egyúttal át is 
méretezzük majd a mintákat, és átrendezzük őket.

1. lépés Hímzési minta létrehozása az Auto 
Punch funkcióval kép alapján

Megnyitjuk a tulipán képfájlt, majd hímzési mintává 
alakítjuk.

Kattintsunk az Image > Input > from File 
(fájlból) pontokat.

Töltsük be a tulip.bmp fájlt.
Válasszuk ki a tulip.bmp fájlt a 
Dokumentumok > PE-DESIGN 8 > Tutorial 
> Tutorial_5 mappában.

Lásd a 20. oldalon a Képi adat betöltése a 
Layout & Editing szoftverbe c. 
szakaszban.

Tartsuk nyomva a  gombot, közben
húzzuk a fogantyút a kép kicsinyítéséhez.

Kattintsunk az  ikonra az Eszköztárban.

Válasszuk az Auto Punch funkciót, majd
kattintsunk a Next gombra.

1. lépés Az Auto Punch (körberajzolás) funkcióval fogunk egy kép alapján hímzési mintát létrehozni
2. lépés Felirat hozzáadása és karakterköz állítása
3. lépés Ellipszis rajzolása és a felirat ráírása
4. lépés Hímzési minta betöltése és forgatása

1

2

3

1

2

3 Shift

4

5
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Kattintsunk a Finish gombra.

→ A tulipánt ábrázoló hímzési minta 
elkészült.

2. lépés Felirat létrehozása és a 
karakterköz állítása

Kattintsunk a  majd  ikonra.
Kattintsunk a tulipán alsó élére.

A billentyűzettel gépeljük be a „Tulip” feliratot,
majd kattintsunk az OK-n.

→ A felirat begépelése megtörtént.

Kattintsunk az  majd  ikonon.

Kattintsunk a feliraton, majd kattintsunk a „p”
betű bal-alsó pontján.

Vigyük a mutatót a „p” betű fölé, majd amikor
a mutató  alakra vált, húzzuk jobbra a
betűt a felirat ritkításához.

Ugyanígy húzzuk el a többi karaktert is az 
egyenletes szövegkép létrehozásához.

6
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2
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3. lépés Ellipszis hozzáadása és a 
felirat ráírása

Kattintsunk a  majd  ikonon.

Kapcsoljuk ki a vonal és felületi varrást.

Lásd a 35. oldalon a Kör rajzolása 
szakaszban.

Rajzoljuk meg az ellipszist és igazítsuk
helyére.

Vigyük a mutatót a munkaterületen belül egy 
nagy kör rajzolásához, majd húzzuk helyére.

Válasszuk ki a „Tulip” szót. Tartsuk lenyomva
a  gombot, majd válasszuk az ellipszist.

Vigyük a mutatót az ellipszis vagy a felirat fölé,
majd amikor  alakra vált, jobb egér-
gombbal kattintsunk, ezután kattintsunk a Fit
Text to Path Setting beállításra.

Kattintsunk a the other side (túlsó oldal)
kapcsolóra, majd az OK-ra.

→ A felirat a kör belső ívére íródik.

Kattintsunk az éppen kiválasztott elemen
kívülre, hogy semmi se legyen kiválasztva,
majd válasszuk ki a feliratot, és húzzuk el a
körív mentén.

Lásd a 37. oldal „Ne feledjük” rovatában, 
és a 87. oldalon a Felirat igazítása 
szakaszban.

1
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4. lépés Töltsük be és forgassuk el 
a hímzési mintát

A következőkben betöltjük a pillangót ábrázoló 
hímzési mintát, majd állítjuk annak szögét.

Kattintsunk a File > Import parancsokra.

Kattintsunk a  ikonra.

Ha a  gomb nincs kiválasztva, 
kattintsunk rá.

A Category (kategória) kiválasztóban
válasszuk az Animals (állatok) ikont, majd
húzzuk a pillangót a tervezőfelületre.

Kattintsunk a pillangó gombra a kiválasz-
táshoz, majd kattintsunk a  ikonra az
Eszköztárban.

Húzzuk el a forgatásra szolgáló fogantyút a
pillangó szögének állításához.

Ezzel a minta elkészült.

A minta elmentéséről a 22. oldalon 
olvashatunk, a minta adatkártyára történő 
mentéséről a 17. oldalon.

1

2

Galéria megtekintése gomb

3

4
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6. Nyomtatás és varrás
A következő példából elsajátíthatjuk, miként hozhatunk létre mintát kép és hímzés ötvözésével.

Betöltünk egy képet a Layout & Editing szoftverbe, majd hozzunk létre egy mintát, amelyet a képbe fogunk 
beemelni. Ezután kinyomtatjuk egy felvasalható transzfer fóliára vagy nyomtatható textilre, majd a 
hímzőgéppel belevarrjuk a mintát a szövetre felvitt képbe.

1. lépés Háttérképpel ötvözött 
hímzési terv létrehozása

Először egy képet kell betöltenünk, majd vagy 
létrehozunk egy hímzési mintát, vagy betöltünk egy 
kész mintát. Jelen példában az ajándékdoboz 
(Bear_Background.jpg) fájlt használjuk fel, és a 
medve hímzési mintát (Bear.pes), amely a szoftver 
előre elmentett mintái között található.

Indítsuk a Layout & Editing szoftvert.

A tervezőfelület mérete legyen 130 x 180 mm.

Lásd a 68. oldalon a tervezőfelület 
méretének és színének beállítását.

Kattintsunk az Image > Input > from File
(fájlból) pontra.

Töltsük be a Bear_Background.jpg fájlt a
Dokumentumok > PE-DESIGN 8 > Tutorial
> Tutorial_6 pontokat.

Képek betöltéséről a 120. oldalon 
olvashatunk.

Kattintsunk az  ikonon.

1. lépés Háttérképpel összeforgatott hímzési terv létrehozása
2. lépés Háttérkép nyomtatása
3. lépés Az igazítást segítő ív nyomtatása
4. lépés Hímzés

A háttérkép nyomtatása az anyagra.

Hímzés

1

2

3
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Töltsük be a Bear.pes mintafájlt.

Válasszuk ki a Bear.pes fájlt a Documents > 
PE-DESIGN 8 > Tutorial > Tutorial_6 
pontokra kattintva.

Hímzési minta betöltéséről a 48. oldalon 
olvashatunk.

Gépeljük be a szöveget.
Válasszuk ki a 30-as számú betűtípust, 
fonalszínnek a DEEP ROSE (mélyvörös) 
színt.

A 80. oldalon olvashatunk szöveg, kisebb 
felirat begépeléséről.

Formázzuk úgy a szöveget, hogy igazodjon a
kép formavilágához.

(1) Kattintsunk az  ponton.

(2) Válasszuk a Transform (formáz) 
kapcsolót, majd kattintsunk a  
ikonon.

(3) Kattintsunk a ikonon, majd húzzuk el 
a forgató fogantyút a minta szögének 
módosításához.

(4) Húzzuk el a  ikont, vagy a fogantyúkat 
a minta méretezéséhez.

Felirat szabad torzítása a 84. oldalon, a 
minták forgatásáról az 54. oldalon 
olvashatunk.

A grafika elkészültét követően valamely 
kompatibilis adathordozóra mentsük le a 
hímzési adatokat, így hímzési mintával 
levarrhatjuk azt.

Minta mentéséről a 22. oldalon, a minta 
adatkártyára történő mentéséről a 17. 
oldalon olvashatunk.

2. lépés Háttérkép 
nyomtatása

Nyomtassuk ki a háttérképet egy felvasalható 
transzferfóliára vagy nyomtatható textíliára.

Kattintsunk a File > Print Setup pontokra.

5

6

7

(2)

(2)

(1)

(3)

(4)

8
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Adjuk meg a nyomtatási beállításokat.

(1) Adjuk meg a kívánt nyomtatót.

(2) A Paper (papír) és Orientation (tájolás) 
beállítások alatt válasszuk ki a 
transzferfóliát vagy a nyomtatható 
textíliát.

(3) Válasszuk az Image print mode (kép 
nyomtatási mód) opciót.

(4) Válasszuk a Print the image on 
printable fablic or an iron-on transfer 
sheet (kép nyomtatása textíliára vagy 
transzferfóliára) kapcsolót.

(5) A transzferfólián a fotó tükrözött 
nyomtatásához kapcsoljuk be a Print a 
flipped image (tükrözött kép nyomtatása) 
kapcsolót.
Egyes nyomtatók automatikusan 
tükrözött képet nyomtatnak, ha 
hordozóként transzferfóliát adunk meg. 
Ilyen nyomtatóknál vegyük ki a pipát a 
Print a flipped image kapcsolóból.
Részletesen lásd a nyomtatóhoz kapott 
dokumentációban.

Kattintsunk a Change Position (elhelyezés a
lapon) gombra.

Ellenőrizzük a nyomat elhelyezését.

Ha a kép bármely pontja túllógna a nyomatási 
területen, húzzuk el a képet.

Kattintsunk az OK-n.

Kattintsunk a Print ponton.

Adjuk meg a kívánt beállításokat a Nyomtató
beállításai ablakban, majd kattintsunk az OK-
ra.

Nyomtatásról lásd a 143. oldalon.

→ A nyomtatás elindul.

2

(1)

(2) (2)

(3)

(4)
(5)

3

Memo:
A nyomtatási nézőkép megtekintéséhez 
kattintsunk a Print Preview gombra.

Ne feledjük:
Transzferfóliára, nyomtatható textíliára 
történő nyomtatás előtt tanulmányozzuk a 
fóliához, textilhez kapott utasításokat.

4
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3. lépés Illesztőlap 
nyomtatása

Nyomtassunk egy lapot a kép és a hímzés 
illesztéséhez.

Adjuk meg a nyomtatási beállításokat.

(1) A Paper (papír) és Orientation (tájolás) 
beállításoknál adjuk meg a hordozópapír 
jellemzőit.

(2) Válasszuk a Print a sheet of paper for 
aligning the printed image and the 
embroidery (lap nyomtatása a kép és a 
hímzés illesztéséhez) kapcsolót.

Kattintsunk a Print gombon.

A Nyomtatás ablakban adjuk meg a 
jellemzőket, majd kattintsunk az OK-n.

c Nyomtatásról lásd a 130. oldalt.

→ A nyomtatás elkezdődik.

4. lépés Hímzés

Ha vasalható transzferfóliát használunk,
vasaljuk rá a képet a textiliára.

Fűzzük a textíliát egy hímzőkeretbe.

Helyezzük az illesztőlapot a textíliára, úgy
hogy pontosan illeszkedjen a nyomtatott
képhez.

• Ha az illesztőlap túl nagy volna, vágjuk 
akkorára, hogy könnyedén igazíthassuk a 
megfelelő helyre.

• Ragasszuk az illesztőlapot a textíliára, 
hogy véletlenül se mozduljon el.

Csatlakoztassuk a hímzőkeretet a 
hímzőgéphez.

Fontos hogy az illesztőlap ne mozduljon el.

Ne feledjük:
A nyomtatási nézőkép megtekintéséhez 
kattintsunk a Print Preview gombra.

1

(1) (1)

(2)

2

3

Ne feledjük:
Transzferfóliáról textíliára történő vasalásos 
átvitelhez tanulmányozzuk a fóliához kapott 
utasításokat.

1

2

3

4

45



Alapismeretek
Igazítsuk a tűt az illesztőlap közepén lévő
jelhez.

• Ha a hímzőgép beépített kamerával 
rendelkezik, nyomjuk le a start gombot a 
illesztőjel automatikus érzékeléséhez és a 
hímzés automatikus igazításához.

• Kamera nélküli készülékeken kézzel 
igazítsuk a pozíciót.

Miután a tű pozícionálása megtörtént, 
távolítsuk el az illesztőlapot.

Indítsuk el a hímzést.

Ne feledjük:
• A hímzőgép használatáról részletesen a 

készülékhez kapottt dokumentációban 
olvashatunk.

• Az alábbi mappában hat kész bemutató 
tervet találunk a Nyomtatás és hímzés 
fejezethez.
Dokumentok \ PE- DESIGN 8 \ Sample \ 
Layout & Editing \ Print and Stitch.

5

6

7
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Layout & Editing munkaablak

1 Eszközsáv
Ikonok a menüparancsok gyors eléréséhez.

2 Varrási jellemzők beállítósáv
Vonalak, felületek varrási jellemzőit adhatjuk 
meg (szín, öltéstípus).

3 Eszköztár
Minták létrehozására, kiválasztására, 
szerkesztésére szolgál.

4 Áttekintő ablak
A munkaterületen lévő összes minta 
megjelenítésére szolgál, így egy kisebb 
részleten dolgozva sem veszítjük el az 
összképet.

Az áttekintő ablak használatáról a 66. 
oldalon olvashatunk.

5 Tervezőfelület 
A munkafelületnek azon része, amely 
ténylegesen levarrható, menthető.

6 Munkafelület
7 Fonalszín, varrási jellemzők, szöveg 

formázók
A fonalak színeit, a varrási jellemzőket, és a 
feliratok jellemzőit adhatjuk meg az ablakban. 
A felső fülekre kattintva válthatunk a három 
beállítási téma között.

Hímzési terv megnyitása/betöltése

Új hímzési terv létrehozása

Eszközsáv ikon: 

1. Kattintsunk az  ikonon, vagy a File > 

New pontra.

→ Egy teljesen új tervezőfelület jelenik meg.

53

6

4

21

7

Ne feledjük:
A tervezőfelület alapértelmezett mérete 
100 x 100 mm.

Ne feledjük:
• A párbeszédablak megjelenítéséhez 

kattintsunk a  vagy  ikonra, vagy 
válasszuk a Sew - Sewing Attribute 
Setting vagy Text - Text Attribute Setting 
menüpontokat. Az ablak bezárásához 
kattintsunk a  jelre.

• A program első indításakor az ablak a 
képernyő jobb széléhez rögzítve jelenik 
meg. Áthelyezhetjük az ablakot, vagy 
egyszerűen húzzuk el, vagy kattintsunk a 
címsorán kétszer (az ablak tetején lévő 
sávon). Az ablak jobb szélre történő 
visszahelyezéséhez húzzuk el jobbra, vagy 
kattintsunk kétszer a címsoron.

Ne feledjük:
Egyszerre több fájlt is megnyithatunk a Layout & Editing szoftverben, és az egyidőben megnyitott fájlok között 
adatokt másolhatunk át, illeszthetünk be.

Ne feledjük:
A tervezőfelület mérete módosítható.

A 68. oldalon olvashatunk a 
tervezőfelület méretének, 
színének megadásáról.
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Layout & Editing fájl 
megnyitása

Layout & Editing fájlként (.pes formátum) elmentett 
hímzési mintát később bármikor megnyithatunk.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a File > 

Open pontra.

2. Válasszuk ki a meghajtót és a mappát.

• Ha a Preview kapcsolót kipipáljuk, a 
kiválasztott fájl tartalma megjelenik a 
nézőképen.

3. Fájl megnyitásához válasszuk ki azt, majd 
kattintsunk az Open gombra, vagy kattintsunk 
kétszer a fájl ikonján.

→ A tervezőfelületen megjelenik a fájlban 
tárolt terv.

Hímzési terv betöltése

Eszközsáv ikon: 

1. Kattintsunk a  ikonon, vagy 

a File > Import menüpontokon.

2. A legördülő menüből válasszuk ki a kívánt 
kategóriát.

1 Design Library (galéria) nézet 
2 Mappa nézet
3 Kártya nézet

Ne feledjük:
• A kiválasztott mappában a Browse (tallóz) 

ablakban kis miniatúrák formájában 
válogathatunk a tervek között.

A tervet kiválasztva és a Preview gombra 
kattintva egy egészablakos méretben 
láthatjuk a nézőképet.

• A fájl megnyitásához kattintsunk az Open 
parancsra.

Megjegyzés:
• Ha a lista üre, .pes fájl nem szerepel a 

mappában. Válasszunk másik mappát.
• Ha a kiválasztott fájl nem .pes formátumú, 

az “Unexpected file format” (ismeretlen 
formátum) hibaüzenet jelenik meg a 
Preview mezőben.

Ne feledjük:
Fájl még a következő módokon nyitható meg:

• A Windows Intézőben listázzuk ki a 
kívánt hímzési fájlt, majd húzzuk át a 
Layout & Editing ablakába.

• A Windows Intézőben listázzuk ki a 
kívánt hímzési fájlt, majd kattintsunk 
annak ikonján kétszer.

21 3
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3. Válasszuk ki a kívánt tervet tartalmazó fájlt, 
majd kattintsunk az Import parancsra, vagy 
kattintsunk kétszer a fájl ikonján.

→ A hímzési terv megjelenik a 
tervezőfelületen.

4. Az Import ablak bezárásához kattintsunk a  
jelre a jobb-felső sarokban.

Megnyitás a galériából (Design 
Library)

1. Kattintsunk a  gombon a galéria 
ablakának megnyitásához.

2. A Category (kategória) kiválasztóban 
válasszunk egy kategóriát a vonatkozó tervek 
megnyitásához.

Megnyitás mappából
1. Kattintsunk a  gombon a mappa 

nézethez.

2. Kattintsunk a  ikonon.

→ A Browse (tallóz) ablak mutatja a mappa 
aktuális tartalmát.

3. Válasszunk egy mappát, majd kattintsunk az 
OK-n.

4. A File Type (fájltípus) ablakban válasszuk ki a 
kívánt fájlformátumot.

Megnyitás adatkártyáról
1. Helyezzük be a kártyát az USB-kártyaíró 

egységbe.

Lásd a 17. oldalon, a Terv letöltése 
adatkártyára szakaszban.

2. Kattintsunk a  gombon.

→ Miután a kártya beolvasása befejeződött, 
kártya nézetben megjelenik egy ablak, amely 
a kártyán tárolt terveket mutatja.

Ne feledjük:
• A fájlt úgy is megnyithatjuk, hogy az Import 

ablakból áthúzzuk az ikont a 
tervezőfelületre.

• Több fájl egyidejűleg nem tölthető be.

Megjegyzés: 
Ha más gyártótól származó tervet töltünk be, 
ügyeljünk, hogy a kiválasztott terv ráférjen a 
tervezőfelületre.

A kiválasztott mappa elérési útja

Ne feledjük:
Mivel a .dst fájlok fonalszínre vonatkozó 
adatokat nem tartalmaznak, betöltéskor 
ideiglenes színek rendelődnek a tervhez. 
Így a .dst tervek színei betöltéskor a várt 
színvilágtól eltérhetnek. A Sewing Order/Lock 
paranccsal bármikor módosíthatjuk a 
fonalszíneket.

A 118. oldalon olvashatunk a 
színek módosításáról.

Megjegyzés:
Szerzői jogvédelmi okokból egyes 
hímzőkártyák nem működnek együtt ezzel a 
funkcióval.
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Hímzési terv betöltése a 
Design Centerből

A Design Centerben tárolt hímzési minta közvetlenül 
betölthető a Layout & Editing szoftver tervezőfelületére.

Lásd a 153. oldalon a Hímzési minta 
készítése kép alapján manuálisan c. 
szakaszban.

Eszköztár ikon: 

1. Indítsuk el a Design Centert és nyissuk meg a 
fájlt.

Lásd a 146. oldalon a Saját kép 
alkotása szakaszban és a 155. oldalon 
a Fájl megnyitása szakaszban.

2. Kattintsunk a  ikonon vagy a File > 

Import from Design Center (betöltés a 
Design Centerből) menüpontokra.

3. Az Import Size (betöltés mérete) ablakban 
gépeljük be vagy válasszuk ki az átméretézési 
arányt százalékosan.

4. Az Orientation (tájolás) pont alatt adjuk meg a 
kívánt formátumot.

5. A betöltéshez kattintsunk az Import pontra.

Megjegyzés:
A legnagyobb nagyítási mérték az az érték, 
melyen a terv éppen kitölti a 
tervezőfelületet. A mininális (kicsinyítési) 
mérték a 25%.
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Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Hímzési minták megtekintése
Nagyítás/kicsinyítés

Nagyíthatunk a terv egy részletének alaposabb 
megtekintéséhez, vagy kicsinyíthetünk, ha a kívánt 
részlet már nem látható teljesen az aktuális 
nézetben.

Kattintsunk az Eszköztárban a  ikonra, a 

 ikonsor jelenik meg. 

Kattintsunk a megfelelő ikonra:

 : A tervezőfelületre kattintva ránagyítunk a 
tervre. Adott terület kinagyításhoz vigyük a 
mutatót a kívánt területre, majd húzzuk el 
(lenyomott egérgomb mellett) átlósan a 
mutatót a kívánt terület felett. 

 : Kattintsunk a tervezőfelületre kicsinyített 
(távolabbi) nézet megjelenítéséhez.

 : A tervezőfelület valós méretű megjelenítése.

 : Jelöljük ki egy elemet, majd kattintsunk az 
ikonra. A tervezőfelület olyan nagyításban 
jelenik meg, hogy csak a kijelölt elemek 
lesznek láthatók.

 : A teljes tervezőfelület az ablakot kitöltő 
méretben lesz látható.

Két pont közötti távolság 
mérése

1. Kattintsunk az  ikonra az Eszköztárban.

2. Vigyük a mutatót az elem kezdeti pontjához, 
majd tartsuk lenyomva az egérgombot.

→ Egy kis kör jelenik meg, jelezve a mérés 
kezdeti pontját.

3. Húzzuk a mutatót: az állapotsorban láthatjuk a 
mérési adatokat a kezdőpont és az egér 
aktuális pozíciója között.

Hosszúság

Szélesség

Magasság
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Hímzési tervek kezelése (Layout & Editing)
Hímzési minták szerkesztése
Jelen fejezet ismerteti a különféle szerkesztési lehetőségeket, pl. mozgatási, nagyítási, kicsinyítési, forgatási 
műveleteket. Szerkesztés előtt ki kell választanunk a kívánt mintát.

Minta kiválasztása

1. Az Eszköztárban kattintsunk a  ikonon.

2. Kattintsunk a mintára.

→ Kis fogantyúk jelennek meg a minta körül.

3. További minta egyidejű kijelöléséhez tartsuk 
lenyomva a  gombot, majd kattintsunk a 
másik mintára.

Összes hímzési minta 
kiválasztása

1. Kattintsunk az Eszköztárban a  ikonra.

2. Kattintsunk az Edit > Select All pontra.

Minták áthelyezése

1. Vigyük a mutatót a kiválasztott minta vagy a 
kiválasztott minták csoportja fölé.

2. Húzzuk a mintát a kívánt helyre.

Hímzési minta középre helyezése
1. Válasszunk ki egy vagy több mintát.

2. Kattintsunk az Edit > Center pontokon.

→ A kiválasztott minták a tervezőfelület 
közepére ugranak.

Ne feledjük:
• Az állapotsor mutatja a minta méreteit 

(szélesség, magasság).
• A minta kiválasztásának megszünte-

téséhez kattintsunk egy másik mintára, 
vagy a tervezőfelület egy üres pontjára, 
vagy az Eszköztárban egy másik eszközre.

Ne feledjük:
A mutatót a kívánt minták felett elhúzva is 
kiválaszthatjuk.

Ne feledjük:

Nyomjuk le a  gombot a létrehozásuk 
ideje szerinti sorban a következő minta 
kiválasztásához.

Fogantyúk

Ctrl

Tab

Ne feledjük:
• A minta vízszintes vagy függőleges 

mozgatásához tartsuk lenyomva a  
gombot, és így húzzuk el a mintát.

Ne feledjük:
• A nyíl gombokkal 0,5 mm-rel léptethetjük a 

kiválasztott mintát a nyíl irányába. A nyíl 
gombot hosszan nyomva tartva folytonosan 
fog elmozdulni a minta a nyíl irányában.

• Ha a Snap to Grid (rácsra igazít) funkció be 
van kapcsolva a Display > Grid Setup 
ablakban, a nyíl minden egyes 
lenyomására egy rácsköznyit ugrik a minta.

A rács beállítását lásd a 69. 
oldalon.

• A nyíl gombok nem alkalmasak görbére írt 
szöveg arrébb léptetésére a görbére 
mentén, amikor csak maga a felirat van 
kijelölve. A görbét is ki kell választani a nyíl 
gombokkal való mozgatáshoz.

Lásd a Felirat igazítása 
szakaszban a 87. oldalon.

Shift
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Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Hímzési minták igazítása
1. Válasszuk ki a mintákat.

2. Kattintsunk az Edit > Align (igazít) > Left 
(bal), Center (közép), Right (jobb), Top 
(felülre), Middle (középre - függőlegesen), 
vagy Bottom (alulra) pontokra.

→ A kiválasztott minták az alábbi ábra 
szerint kerülnek igazításra.

Minták méretezése

Kézi méretezés
1. Válasszuk ki a mintákat.

2. Húzzuk el a fogantyút a kiválasztott minta(ák) 
átméretezéséhez.

Méretezés százalékosan, adott 
méretre

1. Válasszuk ki a mintákat.
2. Kattintsunk az Edit > Numerical Setting > 

Size menüpontokat.
3. A szélesség és magasság arányának 

megtartásához pipáljuk ki a Maintain aspect 
ratio (nagyítási arány tartása) kapcsolót.

4. Határozzuk meg a szélesség/magasság 
módosulást százalékosan vagy a konkrét 
méretek módosulásával.

5. Gépeljük vagy válasszuk ki a kívánt 
szélességet, magasságot.

6. A kiválasztott minta átméretezéséhez az 
eredeti öltéssűrűség megtartása mellett 
pipáljuk ki a Keep density and fill pattern 
(öltéssűrűség és kitöltési minta megtartása) 
kapcsolót.

7. Kattintsunk az OK-n.

Ne feledjük:

• A fogantyú húzása közben a  gombot 
lenyomva a méretezés a minta 
középpontjától kerül kiszámolásra.

• A fogantyú húzása közben az aktuális 
méret megjelenik az állapotsorban.

Megjegyzés:
• Bélyegzőminta beállításokat (stamp) nem 

érinti annak a mintának a módosulása, 
melyen végrehajtásra kerültek. Amennyiben 
a bélyegzőt tartalmazó mintát módosítjuk, 
ellenőrizzük a bélyegzőmintát a módosítást 
követően.

Lásd a Bélyegzőminta készítése, 
szerkesztése szakaszban a 114. 
oldalon.

BottomRightCenterLeft

Middle

Top

Fogantyúk

Shift

• Egyes hímzőkártyákról betöltött minták 
nem méretezhetők.

• Amikor öltési mintát méretezhetünk, az 
öltések száma állandó marad, vagyis 
minőségromlás következik be. Az 
öltéssűrűség megtartásához méretezés 
közben tartsuk lenyomva a  gombot.

Lásd a PDF formátumú 
útmutatóban a 237. oldalon az 
Öltési minta nagyítása, 
kicsinyítése.

Ne feledjük:
A Keep density and fill pattern kapcsoló 
csak az öltési adatok kiválasztása esetén 
aktív.

Lásd a PDF formátumú 
útmutatóban a 237. oldalon az 
Öltési minta nagyítása, 
kicsinyítése.

Ctrl
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Hímzési tervek kezelése (Layout & Editing)
Minták tükrözése 
vízszintesen, függőlegesen

Eszközsáv ikon: , 

1. Válasszuk ki a mintá(ka)t.

2. Kattintsunk az Edit > Mirror (tükrözés) > 

Horizontal (vízszintes) pontra vagy  

pontra.

Kattintsunk az Edit > Mirror > Vertical 

(függőleges) pontra vagy  ikonra.

Minták forgatása

Forgatás kézzel

Eszközsáv gomb: 

1. Válasszuk ki a mintá(ka)t.

2. Kattintsunk az Edit > Rotate (forgatás) 

pontokra vagy  ikonra.

3. Húzzuk el a fogantyút.

Megjegyzés:
Egyes hímzőkártyákról betöltött minták nem 
tükrözhetők.

Ne feledjük:
15°-os léptetéssel történő forgatáshoz a 
fogantyú húzása közben tartsuk lenyomva a 

 gombot.

2. A mutató alakja -ra vált.

3. Forgatás

1. A fogantyúkat kisebb 
négyzetek váltják fel.

Shift
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Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Forgatás fok megadásával
4. Válasszuk ki a mintá(ka)t.

5. Kattintsunk az Edit > Numerical Setting 
(számadatokkal) pontra majd a Rotate pontra.

6. Gépeljük be vagy válasszuk a kívánt 
elforgatási szöget.

7. Kattintsunk az OK-n.

Minták csoportba foglalása 
és a csoport bontása

Minták csoportba foglalása
Különálló mintákat egy csoportba foglalva 
elérhetjük, hogy a végrehajtott módosítások a 
csoport összes tagján egyformán végrehajtásra 
kerülnek.

1. Válasszuk ki a mintákat.

2. Kattintsunk az Edit > Group (csoport) pontra.

→ A kiválasztott minták egy csoportot 
alkotnak.

Csoport bontása
1. Válasszunk egy hímzési minta csoportot.

2. Kattintsunk az Edit > Ungroup (csoport 
bontás) pontokon.

→ A minták újra különállóan kijelölhetőek 
lesznek, a csoport megszűnt.

Csoport tagjainak különálló 
szerkesztése

A csoport létrehozása után is szerkeszthetők a 
minták különállóan.

1. Egy csoport tagjának különálló 

kiválasztásához tartsuk lenyomva az  
gombot, közben kattintsunk a kívánt mintára. 
Egy csoportba tartozó több minta 
kiválasztásához tartsuk lenyomva a  és 

 gombokat, közben kattintsunk a kívánt 
mintákra.

2. Tetszés szerint módosítsuk az elemet.

Ne feledjük:

• A szöget a  körben lévő piros nyíl 
elhúzásával is állíthatjuk.

Ne feledjük:
Ha egy olyan minta kerül kijelölésre csoportba 
foglalás céljából, amely lyukvarrást vagy 
egyéb görbére igazítást is tartalmaz, a teljes 
minta a csoport részét fogja képezni.

Ne feledjük:
Vékony kék keret jelenik meg a csoport körül, 
akárhányszor a csoport vagy annak tagja 
kiválasztásra kerül.

Ne feledjük:
A csoport megszűnik, ha a kiválasztott minták 
törlésre kerülnek, és csak egy minta maradna 
a csoportban.

Alt

Alt

Ctrl
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Hímzési tervek kezelése (Layout & Editing)
Hímzési minta torzítása
Pontok kijelölése

1. Az Eszköztárban kattintsunk az  ikonra.

→ Két ikon jelenik meg: .

2. Kattintsunk az  ikonon.

3. Kattintsunk a mintán.

→ A mintában szereplő csomópontok kis 
üres négyzetekként jelennek meg.

4. Egy csomópont kijelöléséhez kattintsunk az 
üres négyzetre.

• A kiválasztott pont kis fekete négyzetként 
lesz látható.

Ne feledjük:
Ilyen minta lehet egy tört vonal, görbe, íves 
alakzat, csillag alak, körszelet, kézzel rajzolt 
grafika, öltési adat.

Ne feledjük:
Több pont egyidőben a következő módokon 
jelölhető ki:
• Húzzuk el a mutatót.

→ A téglalapba eső pontok mind 
kijelölésre kerülnek.

• Tartsuk lenyomva a  gombot, 
miközben a pontokra kattintunk.
→ Minden pont, amelyre kattintunk, 

kijelölésre kerül.
→ Pont kijelölésének 

megszüntetéséhez kattintsunk a már 
kijelölt pontra.

• A pontokra kattintás közben tartsuk 
lenyomva a  gombot.
→ A pontok, melyekre kattintunk, és a 

közéjük eső összes pont kijelölésre 
kerül.

• A  vagy  gombok lenyomása 

közben tartsuk lenyomva a  gombot.
→ Az utolsó pont felé eső következő 

pont hozzáadódik a kijelöléshez.
→ Pont kijelölésének 

megszüntetéséhez nyomjuk le a 

 vagy gombot.

• A  vagy  gombok lenyomása 

közben tartsuk lenyomva a  gombot.
→ Az első pont felé eső következő pont 

hozzáadódik a kijelöléshez.
→ A pont kijelölésének 

megszüntetéséhez nyomjuk le a 

 vagy gombot.

Ezenfelül a kijelölés iránya (kezdő vagy 
befejező pont felé) az alábbi módokon 
váltható.

• A  vagy  gombok lenyomása 

közben tartsuk lenyomva a  gombot.
→ A kijelölés iránya az utolsó pont felé 

fog mutatni.

• A  vagy  gombok lenyomása 

közben tartsuk lenyomva a  gombot.
→ A kijelölés iránya az első pont felé fog 

mutatni.
• Öltési mintán belül egyes öltési pontok 

kijelöléséről részletesen a 62. oldalon 
olvashatunk.
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zési tervek kezelése (Layout &

 Editing)
Pontok áthelyezése

1. Jelöljünk ki egy pontot.

Lásd az 56. oldalon a Pont kijelölése 
szakaszban.

2. Húzzuk a mutatót az új pozícióba.

Megjegyzés:
Húzzuk el a kiválasztott pontot. Ha a minta 
körvonalán egy üres pontra kattintva kezdjük 
el húzni a mutatót, egy új pont kerül 
beszúrásra, vagy a kiválasztott pontok 
kijelölése megszűnik.

Kijelölt pont

Húzás

Ne feledjük:
• Az összes kijelölt pont ugyanabba az 

irányba fog elmozdulni.
• Tört vonal, görbe, kézzel rajzolt grafikai 

mintájú vagy öltési adat vízszintes, 
függőleges irányba történő elmozdításához 
tartsuk lenyomva a  gombot húzás 
közben.

• A nyíl gombokat lenyomva a kijelölt pont 0,5 
mm-rel léptetéssel kerül elmozdításra a 
lenyomott nyíl gomb irányába. 
Folyamatosan nyomva tartva a nyíl gombot 
a körvonal az adott irányba folytonosan fog 
elmozdulni.

• Ha a Snap to Grid kapcsolót bekapcsoljuk, 
a nyíl gomb minden egyes lenyomására a 
pont egy rácsköznyit ugrik arrébb.

• A nyíl gombok nem használhatók ív, csillag 
alakzat végpontjainak áthelyezéséhez.

• Lyukvarrásra kijelölt minták pontjai is 
áthelyezhetők. Azonban a pont nem 
mozdítható el úgy, hogy körvonalat 
keresztezzen. Ilyen művelethez először 
kapcsoljuk ki a lyukvarrást.

Shift
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Hímzési tervek kezelése (Layout & Editing)
Pontok beszúrása

Új pontot is beszúrhatunk a minta alakjának 
módosításához. Ha az új pont egy görbére került 
beszúrásra, a fogantyúval az új pont érintő 
egyenesét is állíthatjuk.

1. Kattintsunk a  majd  ikonra.

2. Kattintsunk a mintára.

3. Kattintsunk a körvonalra a pont 
beszúrásához.

Pont törlése

1. Válasszuk ki a pontot.

Lásd az 56. oldalon a Pont kijelölése 
szakaszban.

2. Kattintsunk az Edit > Delete pontra vagy 

nyomjuk le a  billentyűt a pont 
törléséhez.

Egyenes szakasz átalakítása görbe 
szakasszá és fordítva

1. Jelöljük ki a pontot.
Lásd az 56. oldalon a Pont kijelölése 
szakaszban.

2. Kattintsunk az Edit > Point (pont) > To Curve 
(görbévé) vagy kattintsunk a To Straight 
(egyenessé).

Kattintsunk

Ne feledjük:
Görbe átalakításához egyenes szakasszá, 
kattintsunk a görbén a pontra, majd válasszuk 
az Edit > Point > To Straight pontokat.

Delete

Kijelölt pont

törlés

görbévé egyenessé
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Ív kisimítása 
csomópontnál

1. Jelöljük ki a pontot, ahol az ívet ki kívánjuk 
simítani.

Lásd az 56. oldalon a Pont kijelölése 
szakaszban.

2. Kattintsunk az Edit > Point (pont) >To 
Smooth (simít) pontokra.

→ A pontnál a görbe sima ívben hajlik.

3. Húzzuk el az érintőpontokat az állításhoz. 

Csomópont érintőpontjainak 
szimmetrikus állása

1. Jelöljük ki a pontot, melynek érintőponjtait 
szimmetrikusra kívánjuk állítani.

Lásd az 56. oldalon a Pont kijelölése 
szakaszban.

2. Kattintsunk az Edit > Point (pont) >To 
Symmetry (szimmetrikus) pontokra.

3. Húzzuk az ívet az állításhoz.

→ Az érintőpontok szimmetrikus állást 
vesznek fel.

Csúcspont kialakítása

1. Válasszuk ki a pontot, ahol törést szeretnénk 
bevinni az ívbe.

Lásd az 56. oldalon a Pont kijelölése 
szakaszban.

2. Kattintsunk az Edit > Point (pont) >To Cusp 
(csúcsos) pontokra.

→ A kiválasztott pontban a görbe megtörik, 
csúcspont alakul ki.

3. Húzzuk az érintőpontokat az állításhoz.
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Hímzési tervek kezelése (Layout & Editing)
Belépő/kilépő pontok, 
középpont mozgatása
Belépő/kilépő pontok mozgatása

Az öltések állításának egy módja, hogy az eszköztár 
eszközeivel készült tárgyak belépő és kilépő 
pontjainak áthelyezése.

1. Kattintsunk az Eszköztárban a  ikonra.

→ A  ikonsor jelenik meg.

2. Kattintsunk a  ikonra.

3. Kattintsunk az elemre.

→ Az elem kilépő és belépő pontjai jelennek 
meg.

A körvonal öltéssor belépő pontja. 
Az előző minta ehhez a ponthoz 
kapcsolódik.

Ez a körvonal öltéssor kilépő pontja. 
Az öltések ettől a ponttól indulnak a 
következő minta felé.

A belső kitöltő felületi öltések belépő 
pontja. Az előző minta ehhez a 
ponthoz kapcsolódik.

A belső felületi öltések kilépő pontja. 
Az öltések innen folytatódnak a 
következő minta felé.

4. Húzzuk el a pont körüli nyílat a pont tetszés 
szerinti áthelyezéséhez.

Belépő és kilépő pontok 
optimalizálása

Az öltések ideális igazítását végzi el a kilépő és 
belépő pontokat automatikusan optimalizáló 
funkció.

1. Kattintsunk a Sew > Optimize Entry/Exit 
points parancsra. A parancs előtt pipa kell 
szerepeljen, ekkor aktív az optimalizáló 
funkció.

→ Ha a pipa megjelenik a parancs előtt, a 
kapcsolódó öltések ki- és belépő pontjai 
optimalizálásra kerülnek, vagyis a lehető 
legkisebb távolság mellett fognak 
kapcsolódni.

Megjegyzés:
Amennyiben a belépő és kilépő pontok 
optimalizálásra kerültek (a Sew menüben az 
Optimize Entry/Exit points parancs előtt 
pipa áll), a minta ezen pontjai nem 
szerkeszthetők. A szerkesztéshez a Sew 
menüben vegyük ki a pipát a parancs elől.

Ne feledjük:
Amennyiben a felülethez sugaras (radial) 
vagy koncentrikus körökből álló öltés került 
beállításra, az öltés középpontja látható.

Lásd a 61. oldalon a Középpont 
mozgatása szakaszban.

Megjegyzés:
Öltési adatok, felirat, kézzel rajzolt 
grafikakilépő és belépő pontjai nem 
szerkeszthetők.

Ne feledjük:
Amennyiben a körvonal a belső felülethez 
nincs varrás hozzárendelve, a vonatkozó 
pontok nem jelennek meg.

Megjegyzés:
• Kizárólag a kör, téglalap, körvonal 

eszközökkel létrehozott minták belépő és 
kilépő pontjai szerkeszthetők. A szöveg 
vagy kézi körberajzolás eszközökkel 
létrehozott minták, öltési minták nem 
szerkeszthetők.

• Amennyiben a Sew > Optimize Entry/
Exit points (kilépő és belépő pontok 
optimalizálása) parancsot kipipáljuk, az 
összes belépő és kilépő ponton végzett 
módosítás elveszik, ezek automatikusan 
átrendezésre kerülnek.
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→ Amennyiben a Optimize Entry/Exit points 
(kilépő és belépő pontok optimalizálása) 
parancs mellett nincs pipa, ezen pontok 
nem kerülnek optimalizálásra. Ha a funkciót 
kikapcsoljuk, a pontok megmaradnak a 
funkció által kijelölt helyen, azonban ezután 
már szabadon szerkeszthetők a Belépő/
Kilépő pont szerkesztő eszközzel.

Középpont mozgatása
A koncentrikus körökből álló vagy sugaras 
öltéstípusú felületek középpontja áthelyezhetők, 
ezzel még látványosabbá válik a hímzés.

5. Kattintsunk a  majd  ikonra.

6. Kattintsunk a koncentrikus körös vagy 
sugaras öltésű felületre.

→ Az elem középpontja, valamint a ki- és 
belépő pontok megjelennek.

7. Húzzuk a középpontot a kívánt helyre.

Megjegyzés:
• Kizárólag a kör, téglalap, körvonal 

eszközökkel létrehozott minták belépő és 
kilépő pontjai szerkeszthetők. 

• Amennyiben a Sew > Optimize Entry/
Exit points (kilépő és belépő pontok 
optimalizálása) funkció aktív, a Belépő/
Kilépő pont szerkesztő eszközzel a 
pontok nem szerkeszthető.

Optimize Entry/Exit points parancs nem aktív

Optimize Entry/Exit points parancs aktív

Középpont
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Öltési minta szerkesztése
Az öltési mintákban az öltések folytonos vonalként ( ), az ugró öltések pontozott vonalként jelennek meg 
( ).

Elem átalakítása öltési 
mintává

A Layout & Editing szoftver eszközeivel rajzolt 
elemek öltési mintává alakíthatók, ezzel lehetővé 
válik, hogy az öltések egyedi áthelyezésével 
aprólékos módosításokat hajtsunk végre.

Lásd a 70. oldalon, az Alakzatok rajzolása 
szakaszban.

1. Válasszuk ki az elemet.

2. Kattintsunk a Sew > Convert to Stitches 
(öltéssé alakít) pontra.

A kiválasztott minta öltési mintává alakul.
 

→ Az átalakított minta körüli pontozott vonal 
jelzi, hogy öltési mintából áll. Az 
átalakított minta minden egyes öltése 
szerkeszthető a Pont szerkesztő 
eszközzel.

Öltési minta öltési 
pontjainak kijelölése

1. Kattintsunk a , majd a  ikonra.

2. Kattintsunk az elemen.

→ Az öltési mintában az öltési pontok kis 
üres négyzetek formájában jelennek meg.

3. Egyetlen öltési pont kiválasztásához 
kattintsunk egy üres négyzetre.

→ A kiválasztott öltési pont kis fekete 
négyzetként jelenik meg.

Ne feledjük:
• Ha egy csoportba foglalt elemet, 

lyukvarrásra jelölt elemet, alakzatra írt 
feliratot választunk ki, a csoport minden tagja 
öltési mintává alakul.

• Minták, melyek öltési mintává alakításkor 
varrási jellemzőkkel nem rendelkeznek, 
törlődnek.

• Elemek alatt az Alakzat, a Szöveg vagy a 
Kézi körberajzolás eszközökkel létrehozott 
mintákat értjük.

Megjegyzés:
Az öltési mintákat pontozott vonal veszi 
körbe. Ha a pontozott körvonal hiányzik, az 
elem nem szerkeszthető. Öltési pont csak 
öltési minta esetében szerkeszthető.

Ne feledjük:
• Ha ugró öltésen kattintsunk, a két végén 

lévő mindkét pont kijelölésre kerül.
• Több öltési pont is kijelölhető; a hímzési 

minta pontjaihoz hasonló módon.

Lásd a Pont kijelölése szakaszt 
az 56. oldalon.

• A következő szín összes öltési pontjának 
kijelöléséhez nyomjuk le a gombot. 
Az előző szín összes öltési pontjának 
kijelöléséhez tartsuk lenyomva a  
gombot, és így nyomjuk le a  gombot.

Tab

Shift
Tab
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Öltési pontok mozgatása
1. Húzzuk a kijelölt öltési pontot az új helyre.

Öltési pontok és ugról öltések 
beszúrása

1. Kattintsunk két öltési pont közötti vonalra az új 
pont beszúrásához.

Öltési pontok törlése
1. Nyomjuk le a  gombot a kiválasztott 

öltési pont törléséhez.

Öltési minta átalakítása 
tömbös alakzattá

Az öltési mintákká alakított importált öltési adatok 
vagy minták tömbökké alakíthatók (kézi 
körberajzolási adattá), így bizonyos varrási 
jellemzőiket módosíthatjuk, valamint egyedi színeket 
vihetünk bele az öltési minőség megtartása mellett.

1. Válasszuk ki az öltési mintát.

2. Kattintsunk a Sew > Stitch to Block (öltésből 
tömbbe) pontra.

3. Húzzuk a csúszkát a kívánt érzékenységi 
szintre.

4. Kattintsunk az OK-n.

→ Az öltési minta csoportba foglalt kézi 
körberajzolása (manual punching) adattá 
válik.

A kézi körberajzolási adatok csoportba 
foglalásáról és a csoport bontásáról, valamint 
ennek szerkesztéséről az 55. oldalon, a 
Minták csoportba foglalása és a csoport 
bontása szakaszban olvashatunk.

Ne feledjük:

• Nyomjuk le a  és  gombokat.
→ Az első fonalszín belépő pontja 

kijelölésre kerül.
• Nyomjuk le a  és  gombokat.

→ Az utolsó fonalszín kilépő pontja 
kiválasztásra kerül.

• Válasszuk ki egy adott szín legalább egy 
pontját, majd nyomjuk le a  gombot.
→ A szín belépő pontja kiválasztásra 

került.
• Válasszuk ki egy adott szín legalább egy 

pontját, majd nyomjuk le az  gombot.
→ A szín kilépő pontja kijelölésre kerül.

Megjegyzés:
Amikor öltési pontokat jelölünk ki, fontos 
hogy rákattintsunk az öltési pontra (ne a 
tervezőfelület üres területére), egyébként az 
összes kijelölt pont kijelölése megszűnik.

Ne feledjük:
Öltési pontokat a hímzési minták pontjaihoz 
hasonlóan helyezhetünk át. Azonban ha a nyíl 
gombokat használjuk, minden egyes 
gombnyomással 0,1 mm-t ugrik arrébb az 
öltési pont.

Lásd az 57. oldalon a Pontok 
áthelyezése szakaszban.

Ne feledjük:
Új öltési pont beszúrásához és az előző vonal 
ugró öltéssé alakításához tartsuk lenyomva a 

 és gombokat, közben 
kattintsunk a vonalon.

Ctrl Home

Ctrl End

Home

End

Ctrl Shift

Delete

Ne feledjük:
Ha egy ugró öltés végpontját töröljük, az ugró 
öltés szakasz törlődik, és az ugró öltés előtti 
és utáni öltések kapcsolódnak össze.

Ne feledjük:
A Normal beállítás általában megfelelő 
eredményt hoz, de a minta összetettségétől 
függően választhatunk durvább (coarse) 
vagy finomabb (fine) érzékenységi szintet.

Megjegyzés:
A Stitch to Block parancs egyes 
hímzőkártyákról betöltött öltési minták 
esetén nem használható.

Lásd a PDF formátumú 
útmutatóban az Öltési minták 
nagyítása/kicsinyítése 
szakaszban.
63



Hímzési tervek kezelése (Layout & Editing)
Öltési minta részeinek 
felosztása

1. Kattintsunk az Eszköztárban a  ikonra.

2. Kattintsunk az öltési adatra.

→ Az összes egyéb öltési adat eltűnik a 
képernyőről.

3. Kattintsunk a tervezőfelületnek azon pontjára, 
ahonnan a körbejelölő vonalak rajzolását 
indítani kívánjuk.

4. Kattintsunk tovább a kivágást befoglaló keret 
sarokpontjainak kijelöléséhez.

→ A pontozott vonal amely a mutató 
elmozdításával megjelenik a képernyőn 
folytonos vonal lesz a következő pont 
kijelölésekor.

5. Kattintsunk kétszer a tervezőfelületen a 
kétfelé osztandó szakaszok kijelöléséhez.

6. Tetszés szerint módosítsuk a kivágott 
szakaszt.

Öltési adatok színbontása
Öltési adatok színbontása

Öltési adatok színekre bonthatók.

1. Válasszunk valamely öltési adatot.
2. Kattintsunk a Sew > Divide Stitches by 

Color (öltés bontása színenként) pontra.
→ Pontozott vonal jelenik meg az öltési adat 

alkotóelemei körül.

Ne feledjük:
Az eszköz kizárólag öltésekhez használható.

Megjegyzés:
Rajzoló, szöveg eszközökkel készített 
mintákat öltéssé kell alakítani mielőtt az 
Osztó eszközzel elvágjuk.

Lásd a 62. oldalon az Elemek 
átalakítása öltési mintává 
szakaszban.

Ne feledjük:
• Az utolsó bevitt pont elvetéséhez 

kattintsunk az egér jobb gombjával. Minden 
egyes jobb oldali kattintás töröl egy pontot, 
egyenként, a bevitellel ellenkező irányba. 
Amikor az összes pont törlésre került, az 
Eszköztár eszközei újra elérhetővé válnak, 
azonban alkalmazás Osztott öltési módban 
marad.

• Kivágás csak öltési adat esetében 
végrehajtható. Ha a bezárt elemek öltési 
adatokat nem tartalmaznak, hibaüzenet 
jelenik meg, a kivágási forma törlődik, 
azonban az alkalmazás Osztott ötlési 
módban marad.

Megjegyzés:
• Egyszerre csak egy szakasz vágható ki. 

Újabb darabok kivágásához ismételjük 
meg a műveletsort.

• A kivágott darab a varrási sor végére 
kerül, és a fonalszín sor az eredeti 
mintához összeállított sornak megfelelően 
jelenik meg.

Ne feledjük:
A funkció csak öltési adat kijelölése esetén 
működik, pl. csoportba foglalt hímzési adat 
esetén, amely öltési adattól eltérő adatot 
tartalmaz, már nem működik.

Színbontás előtt

Színbontás után
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Hímzés nézőképének 
megtekintése

Miután elkészültünk a hímzési mintával, nézőképen 
ellenőrizhetjük az öltések kapcsolódását, valamint 
valósághű nézőképen tekinthetjük meg a grafika 
kinézetét.

Nézőkép

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a Display > 

Preview (nézőkép) pontra.

→ A hímzési minta nézőképe megjelenik.

2. A nézőképből való kilépéshez ismételjük meg 

az 1. lépést, vagy nyomjuk le a  
gombot.

Valósághű nézőkép
Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy kattintsunk a 

a Display > Realistic Preview pontra.

→ Valósághű nézőképen jelenik meg a 
hímzési minta.

3. A valósághű nézőképből való kilépéshez 
ismételjük meg az 1. lépést vagy nyomjuk le a 

 gombot.

Esc

Megjegyzés:
• A hímzési minta nem szerkeszthető a 

valósághű nézőképen.
• A tervezőfelületre betöltött kép is 

megtekinthető a nézőképen, ha a Display 
Image (kép megjelenítése) funkciót úgy 
állítjuk be.

Lásd a 123. oldalon a 
Háttérkép megjelenítése c. 
szakaszban.

Ne feledjük:

Valósághű nézőkép beállításának 
módosítása
Állítsuk be igény szerint a valósághű 
nézőkép megjelenését.

1. Kattintsunk a Display > Realistic 
Preview Attribute Setting beállítás 
pontra.

→ A Realistic Preview Attribute 
Setting ablak jelenik meg.

2. Ha szükséges, állítsuk át a fonal 
szélességet (thread width), a 
kontrasztot (contrast) és a fényerőt 
(brightness).

3. Kattintsunk az Apply gombra a 
beállítások hatásának 
megtekintéséhez (ha éppen a 
valósághű nézőkép látható).

Vagy, kattintsunk az OK-ra ha a 
valósághű nézőkép nem látható, ekkor 
csak a következő megjelenítéskor 
érzékelhető a beállítások hatása.

Esc
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Öltés ellenőrzése

Egy öltés szimulátor funkció szolgál a hímzőgép 
által majd kivitelezett varrás előzetes 
megtekintésére.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra vagy kattintsunk a 

Display > Stitch Simulator pontra.

A Stitch Simulator ablak jelenik meg, és a 
hímzési terv eltűnik a tervezőfelületről.

2. Kattintsunk a  gombra a szimulációs 
nézet indításához.

A következő műveletekre van lehetőség a 
szimulátor képernyőn:

 : Megállítjuk a szimulációt és 
visszalépünk az előző képernyőre.

 : Ideiglenes felfüggesztjük a 
szimuláció lejátszását. Az 

újraindításhoz kattintsunk a  
gombra.

 : A csúszka elhúzásával 
állítjuk a szimuláció varrási 
sebességét.

 : Az előző szín elejére ugrunk vissza.

 : A következő szín elejére ugrunk.

 : Visszafordítjuk az öltést a stitches/
step (öltés/lépés) mezőben megadott 
öltésszámmal.

 : A stitches/step (öltés/lépés) mezőben 
megadott öltésszámmal előre ugrunk 
a varrással.

*: Visszalépünk az előző keretszakasz 
kezdetére.

*: Előre ugrunk a következő 
keretszakasz kezdetére.

* Kizárólag egyedi méretű tervezőfelület 
esetén jelenik meg.

A számok a következőket jelentik.

3. Kattintsunk a  ikonra az ablak jobb-felső 
sarkában a bezáráshoz.

Terv megtekintése az 
áttekintő ablakban

Az áttekintő ablak egy átfogó képet ad a grafikáról, 
amikor éppen egy adott részletre ránagyítva 
dolgozunk. Piros keret jelzi a tervezőfelületen éppen 
kinagyított részletet.

Eszközsáv ikon: 

A  ikonnal ki- és bekapcsolhatjuk az áttekintő 

ablakot, ugyanezt megtehetjük a Display > 
Reference Window menüpontokkal vagy a 

funkciógombbal.

Nagyítás/kicsinyítés
Az áttekintő ablak úgy is beállítható, hogy a 
tervezőfelület teljes egészét mutassa vagy csak a 
hímzési mintát.

Ne feledjük:
• A csúszka mutatja a szimulációban az 

aktuális helyzetét. A csúszkább arrébb 
húzva módosítjuk a szimuláció helyzetét.

• Az öltés részletesebb megszemléléséhez a 
szimulációs ablak megnyitása előtt 
nagyítsunk rá a tervre.

Ne feledjük:
Amennyiben a szimulátor megjelenítésekor 
egy minta ki volt választva, csak a kiválasztott 
minta jelenik meg a szimulátor ablakban.

Aktuális öltésszám

Levarrandó színek száma

Megjelenített szakasz

Öltések teljes száma

Összes használt szín száma

A mintában szereplő 
keretszakaszok száma
(kizáróleg egyedi méretű 
tervezőfelület esetén)

F11
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1. Kattintsunk a  ikonon.

→ Az áttekintő ablakban megjelenő kép 
módosul.

A képernyőt jelző piros keret 
elmozdítása

A tervezőfelületen megjelenő grafika az áttekintő 
ablakból is állítható.

1. Vigyük a mutatót a piros kereten belül.

2. Húzzuk a keretet úgy, hogy magába foglalja a 
megtekinteni kívánt részletet.

→ A terv piros keret által befoglalt része 
megjelenik a tervezőfelületen.

A piros keret újrarajzolása
A piros jelölő keretet nem csak áthelyezhetjük, újra 
is rajzolhatjuk a tervezőfelületen a minta kívánt 
részletének megtekintéséhez.

1. Kattintsunk a megjeleníteni kívánt területen, 
vagy húzzuk a mutatót az áttekintő ablakban a 
kívánt részlet körül.

→ A piros téglalap újrarajzolásra kerül, és a 
tervezőfelületen a kijelölt részlet látható.

Piros jelölő keret méretezése
1. Vigyük a keret a piros keret sarkához.

2. Húzzuk el a sarkot a jelölő keret kívánt 
méretre igazításához.
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Tervezőfelület színének, méretének állítása
A háttér színének állításán felül állíthatjuk a tervezőfelület színét, méretét. Válasszunk a hímzőgépben 
használni kívánt keretnek megfelelő méretet a tervezőfelülethez. A később megosztani kívánt és több 
lépésben hímzendő minták esetén is egyedi méretet adjuk meg a tervezőfelületnek.

1. Kattintsunk az Option > Design Page 
Property (tervezőfelület tulajdonságok) 
pontot.

2. Adjuk meg a tervezőfelület méretét.

Keretmérethez is igazíthatjuk a tervezőfelület 
méretét, ehhez válasszuk ki a Hoop Size 
legördülő menüben a kívánt méretet.

Egyedi méretű tervezőfelület kialakításához 
válasszuk a Custom Size gombot, majd 
gépeljük be a kívánt szélességet (width), 
magasságot (height).

Lásd a használati útmutató 167. oldalán, 
az Osztott hímzési minta létrehozása 
szakaszt.

3. A Page (oldal) kiválasztóban adjuk meg a 
kívánt színt.

4. A Background (háttér) kiválasztóban adjuk 
meg a háttér színét.

5. Kattintsunk az OK-ra.

Ne feledjük:
A tervezőfelület 90 fokos elforgatására is 
lehetőség van a Rotate 90 Degrees 
kapcsolóval.

Ne feledjük:
Az alapbeállításra való visszalépéshez (100 × 
100 mm), kattintsunk a Default (alapbeállítás) 
gombra.

Megjegyzés:
• A 130 × 300 mm, 100 × 172 mm-es 

tervezőfelület méreteket kis „*” jelöli; ezek 
a méretek több állású hímzési mintákhoz 
valók, melyek olyan speciális keretben 
kerülnek hímzésre, amelyeket három 
állásban helyezhetünk a hímzőgépbe.

Lásd a 182. oldalon a Hímzési 
minta tervezése több állású 
kerethez c. szakaszban.

• Ne válasszunk a hímzőgéphez 
használható legnagyobb keretnél 
nagyobb keretméretet.
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Program beállításainak módosítása
Rács beállítása

Folytonos vagy pontozott vonalakból álló rács 
jeleníthető meg vagy rejthető el, valamint a rácsköz 
állítható.

1. Kattintsunk a Display > Grid Setup 
(rácsbeállítás) pontra.

2. A rács megjelenítéséhez pipáljuk ki a Show 
Grid pontot.
A rács elrejtéséhez vegyük ki a Show Grid 
kapcsolót.

3. A minták rácsra igazításához vagy azonos 
méretű minták használatához válasszuk ki a 
Snap to Grid (rácsra igazít) kapcsolót.

4. A rácsköz állításához gépeljünk be vagy 
válasszunk ki egy értéket a Grid Interval 
mezőben.

5. A rács folytonos vonalként való 
megjelenítéséhez pipáljuk ki a with Axes 
kapcsolót.
A metszéspontok és a középvonalak 
megjelenítéséhez vegyük ki a with Axes 
kapcsolóból a pipát.

6. Kattintsunk az OK gombra a módosítások 
végrehajtásához és az ablak bezárásához.

Mértékegység állítása 
(mm vagy inch)

A mérési értékek megjelenhetnek milliméterben 
vagy inchben.

1. Kattintsunk az Option > Select System Unit 
(mértékegység kiválasztása) pontra, majd 
válasszuk ki a kívánt mértékegységet.

Vonalzó beállítása

A vonalzó megjeleníthető, elrejthető.

1. Kattintsunk a Display > Ruler (vonalzó) 
pontot.

→ Amikor a parancs mellett megjelenik a 
kapcsoló, a vonalzó láthatóvá válik.

A vonalzó elrejtéséhez kattintsunk a Display 
> Ruler parancsra, hogy a pipa eltűnjön.

Ne feledjük:
A mutató a Grid Interval (rácsköz) mezőben 
megadott értékkel fog arrébb ugrani.
Az igazító funkció akkor is működik, ha a rács 
rejtve van.

Erre az ikonra kattintva válthatunk a 
milliméter és az inch között.
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Alakzatok rajzolása
A Téglalap, Kör és Alakzat eszközökkel normál és lekerekített sarkú téglalapokat, íves alakzatokat (normál 
köröket, ellipsziseket, csillagformákat, íveket) rajzolhatunk.

Téglalap, kör és ív rajzolása

Az íveken kívül az összes alakzat rendelkezik egy 
körvonallal és egy belső felülettel, és ezek külön is 
állíthatók. Az ívek egyszerű körvonalak.

Téglalap, kör vagy ív 
rajzolása

1. Kattintsunk az  ikonra az Eszköztárban.

→ Hat ikon jelenik meg: .

2. Kattintsunk a rajzolni kívánt alakzatra.

→ A varrási jellemzők ablak jelenik meg.

3. Húzzuk a mutatót az alakzat rajzolásához.

Téglalap 
A pont, ahol a mutatót húzni kezdjük, a téglalap 
sarokpontja lesz. A pont ahol az egérgombot 
felengedjük, a téglalap átellenes sarokpontja lesz.

Téglalap lekerekített sarkokkal 

Kattintsunk a  ikonra a lekerekítési sugár 
aktuális értékének megtekintéséhez.

A sarkok kerekítési sugárának állításához 
kattintsunk az Edge radius kiválasztóra, majd 
gépeljük be a kívánt értéket, nyomjunk -t, 
vagy válasszunk a listából.

Húzzuk a mutatót a téglalap megrajzolásához az 
imént beállított sarkokkal.

Ne feledjük:
• A színt és a varrási jellemzőket az alakzat rajzolása előtt és után is bármikor módosíthatjuk.

Lásd a 94. oldalon a „Fonalszín és varrási jellemző beállítása” szakaszban.

• A Varrási jellemzők (Sewing Attribute Setting) ablakban is megadhatjuk az alakzat egyéb jellemzőit.

c A 96. oldalon olvashatunk a varrási jellemzőkről.

Megjegyzés:
Az eszköz használatakor rajzolás előtt 
válasszunk egy alakzatot. Nem rajzolhatunk 
kört, majd rögtön egy ívet.

Téglalap

kör ellipszis ív

körcikk körszelet

Ne feledjük:
Négyzet rajzolásához tartsuk lenyomva a 

 gombot a mutató húzása közben.Shift

Enter
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Kör vagy ellipszis 
A pont, ahol az egeret húzni kezdjük, az ellipszis 
képzeletbeli befoglaló téglalapjának sarokpontja 
lesz. A felengedés pontja ennek a téglalapnak az 
átellenes sarokpontja lesz. Az ellipszist ez a 
téglalapot fogja kitölteni, hosszabbik tengelye 
egyezni fog a téglalap hosszabbik oldalával, 
rövidebbik tengelye a kisebbik oldallal lesz azonos.

Ív, , körszelet  körcikk 
4. Tegyünk ugyanúgy, mintha kört vagy ellipszist 

rajzolnánk.

→ Sugárirányú vonal jelenik meg az 
ellipszisen, amikor az egérgombot 
felengedjük.

5. Vigyük a mutatót az ív kezdőpontjára, majd 
kattintsunk.

→ A sugaras vonal eltűnik.

6. Vigyük a mutatót, amíg az ív, körszelet, 
körcikk el nem éri kívánt alakját, majd 
kattintsunk.

Ne feledjük:
Ha sima Téglalap eszközzel rajzolunk egy 
eszközt, a sarkok utólagos kerekítésére az 
Edge radius beállítással bármikor 
lehetőségünk van.

Ne feledjük:

Kör rajzolásához tartsuk lenyomva a  
gombot a mutató húzása közben.

1. példa
Ker. sugár: 0.0 mm

2. példa
Ker. sugár: 20.0 mm

Shift

ív

kattintsunk a kezdőponton

vigyük a befejező pont fölé

kattintsunk e felett

kattintsunk a kezdőponton

körszelet

vigyük a befejező pont fölé

kattintsunk e felett
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Kész alakzatok rajzolása

Az Alakzat eszközzel 24 féle alakzatot, szívecskét, 
csillagot, sokszöget rajzolhatunk. Mindegyik alakzat 
külön állítható körvonallal és belső felülettel 
rendelkezik.

1. Kattintsunk az eszköztárban a  ikonra.

→ A 24 féle alakzat megjelenik.

2. Kattintsunk a kívánt alakzatra.

3. Húzzuk a mutatót a tervezőfelületen.

A pont, ahol elkezdtük húzni a mutatót, az 
alakzat képzeletbeli befoglaló téglalapjának 
sarokpontja lesz. A pont, ahol felengedjük az 
egeret, a téglalap átellenes sarokpontja lesz. 
Az alakzat a képzeletbeli téglalapot fogja 
kitölteni.

Egyenes vonal és ívek

A Körvonal eszközök szolgálnak egyenes vonalak 
és ívek rajzolására.

•
A fenti ikonokkal csak zárt alakzatokat 
hozhatunk létre. A zárt alakzatok külön állítható 
körvonallal és belső felülettel is rendelkeznek. 

•
A fenti ikonokkal nyitott íveket rajzolhatunk. 
A nyitott alakzat csak körvonalból áll, belső 
felülete nem lehet, öltési típus és szín csak a 
vonalhoz rendelhető.

Ha egy képet sablonként kívánunk használni, a 
 és  eszközök félig automatikusan 

lekövetik a kép körvonalát.

körcikk

kattintsunk a kezdőponton

vigyük a befejező pont fölé

kattintsunk e felett

Ne feledjük:
Az alakzat eredeti szélesség-magasság 
arányának megtartása melletti rajzolásához 
tartsuk lenyomva a  gombot.

Ne feledjük:
Ha az alakzat vonalai egymást metszik, a 
belső felület nem kaphat kitöltést. A vonalak 
nem keresztezhetik egymást, a belső felület 
kitölthető valamely színnel.

Shift
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Egyenes vonal és görbe 
rajzolása

1. Kattintsunk az eszköztárban a  ikonra.

→ Nyolc ikon jelenik meg 

 : Egyenes vonalakból álló zárt alakzatot 
rajzolhatunk.
(Billentyűparancs: )

 : Egyenes szakaszokból álló nyitott 
vonalat rajzolhatunk.
(Billentyűparancs: )

 : Zárt görbe rajzolása.

(Billentyűparancs: )

 : Nyitott görbe rajzolása.

(Billentyűparancs: )

 : Sablonként szolgáló képet 
megjelenítve kattintsunk a kép 
körvonala mentén a kép automatikus 
leképezéséhez zárt alakzatokkal.
(Billentyűparancs: )

 : Sablon kép megjelenítésekor 
kattintsunk a körvonal mentén a kép 
nyitott vonalakból álló leképezéséhez.
(Billentyűparancs: )

 : Húzzuk a mutatót zárt szabadkézi 
görbe rajzolásához.

 : Húzzuk a mutatót nyitott szabadkézi 
vonal rajzolásához.

2. Kattintsunk a rajzolni kívánt alakzat ikonjára.

→ A varrási jellemzők sáv megjelenik.

3. Kattintsunk a tervezőfelületen vagy kezdjük el 
húzni a mutatót a vonal rajzolásához.

Egyenes vonal/görbe
A következő leírás az Egyenes vonal eszköz 
használatát ismerteti, azonban a Görbe és Fél-
automatikus eszközök ugyanezen módon 
működnek.

1. Kattintsunk a tervezőfelületen a kezdő pont 
kijelöléséhez.

záró pont

kezdő pont

nyitott vonal zárt vonal

A zárt alakzat vonalai egymást keresz-
tezik, kitöltés nem lehetséges.

záró pont

kezdő pont

nyitott görbe zárt görbe

A zárt görbe vonala önmagát keresz-
tezi, kitöltés nem lehetséges.

Z

Z

X

X

C

C
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2. Kattintsunk a tervezőfelületen a következő 
pont kijelöléséhez.

3. Folytassuk így a további sarokpontok 
kijelöléséhez, majd kattintsunk kétszer az 
utolsó ponton, vagy nyomjuk le az  
gombot.

Szabadkézi vonalak
1. Húzzuk a mutatót a vonal rajzolásához.
2. Engedjük fel az egérgombot a rajzolás 

befejezéséhez.

Vonalvégek jellemzőinek 
módosítása

A vonalvégek jellemzőit a Körvonal eszközzel rajzolt 
elemeknél módosíthatjuk.
1. Válasszunk egy elemet, amely a Körvonal 

eszközzel készült.
Lásd az 52. oldalon a Minta kiválasztása 
szakaszban.

→ A Görbe alakja (görbe alakja) kiválasztó 
jelenik meg a Varrási jellemzők ablakban.

2. Válasszuk ki a megfelelő záródási jellemzőt: 
„open path” - görbe nyitása; „close path” - 
görbe zárása.

→

Ne feledjük:
Az utolsó bevitt pont törléséhez kattintsunk a 
jobb egérgombbal, vagy nyomjuk le a 

 gombot.BackSpace

Enter

Ne feledjük:
• Szabadon válthatunk a vonal típusok 

között, akár másik ikonra kattintva, akár 
másik billentyűparancs lenyomásával.

• Egyenes vonal vízszintes vagy függőleges 
rajzolásához, a mutató húzása közben 
tartsuk lenyomva a  gombot. 

• A Fél-automatikus eszközök használatához 
egy sablonként szolgáló képre is szükség 
van. Ha nincs kép, az eszköz az Egyenes 
vonal eszközzel egyezően működik.

Lásd a 120. oldalon a Képi adat 
betöltése szakaszban.

• A minta megrajzolása után is átalakíthatjuk 
a görbe szakaszokat egyenessé és 
fordítva.

Lásd az 58. oldalon, az Egyenes 
szakasz átalakítása görbévé 
szakaszban.

Shift
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Öltések átfedésének 
megelőzése

A lyukvarrás megadásával az egymást átfedő 
felületek nem kerülnek kétszer levarrásra. 
Lyukvarrás csak abban az esetben állítható be, 
ha az egyik felület teljesen körülveszi a másikat.

1. Válasszunk ki mintapárokat, pl. egy kört egy 
ellipszisen belül.

2. Kattintsunk a Sew > Set hole sewing 
(lyukvarrás beállítása) pontra.

→ Amennyiben a kijelölt pár alkalmas 
lyukvarrásra, a következő üzenet jelenik 
meg (a lyukvarrás beállítás sikeres volt):.

→ Amennyiben a pár lyukvarrásra nem volt 
alkalmas, hibaüzenet jelenik meg.

3. Kattintsunk az OK-n az üzenet törléséhez.

Lyukvarrás elvetése
1. Válasszunk egy mintát, amelyet lyukvarrásra 

már kijelöltünk.
2. Kattintsunk a Sew > Cancel hole sewing 

(lyukvarrás elvetése) menüpontra.
A párt alkotó két minta most már egymástól 
függetlenül mozgatható.

Átfedő minták alakjának 
módosítása

A Téglalap, Kör, Ív eszközökkel létrehozott hímzési 
minták esetében az Alakzat vagy Körvonal 
eszközökkel eltávolíthatjuk az átfedő részeket, vagy 
összeolvaszthatjuk ezeket.

Átfedés törlése
Az átfedő minták kiválasztása után lehetőség 
van az egymást átfedő részek törlésére.
Amikor ezt több minta kijelölése mellett végezzük 
el, a többi minta által átlapolt felület is törlésre 
kerül.

1. Válasszuk ki a két vagy több egymást átfedő 
mintát.

2. Kattintsunk a Sew > Remove Overlaps 
pontokra.
→ Az egymást átfedő részek törlésre 

kerülnek.

→ Amennyiben a kiválasztott minták 
esetében a művelet nem végrehajtható, 
hibaüzenet jelenik meg.

Ne feledjük:
Csak akkor végrehajtható a lyukvarrás, ha az 
egyik minta teljesen körbeveszi a másikat, és 
nem tartalmaznak feliratot, kézi 
körberajzolású mintát vagy öltési adatot.

megfelelő

Nem megfelelő

Kétszeri levarrás
egyszeri 
levarrás

lyukvarrás nincs 
beállítva

lyukvarrás beállítva

Ne feledjük:
• Amikor egy mintapárt lyukvarrásra 

állítottunk, az egyik mintát arrébb helyezve 
a másik minta is együtt mozdul vele.

• Amikor a lyukvarrást három vagy több 
elemre aktiváljuk, először két elemre 
állítsuk be, majd jelöljük ki az első két 
csoportba foglalt elemet, ezután a 
harmadikat, és ismét adjuk meg a 
lyukvarrást.

• A körvonal, körcikk és körszelet 
eszközökkel rajzolt elemek körvonala 
szerkeszthető a Pont szerkesztő eszközzel.

Mejegyzés:
A lyukvarrás hatásának részletesebb 
ellenőrzéséhez a művelet előtt és után is 
tekintsük meg a nézőképet.

Lásd a 65. oldalon a Hímzés 
nézőképének megtekintése 
szakaszban.
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• Részleges átfedés esetén

• Az egyik minta körbeveszi a másikat

• A varrási sorban az utolsó minta teljesen lefedi a 
másikat.

Összeolvasztás
Az átfedő minták egymásba olvaszthatók. 
Amennyiben ez kettőnél több mintánál történik, 
az utolsó minta (legfelső) színét és varrási 
jellemzőjét kapja meg az összeolvasztott minta.

3. Válasszunk ki két vagy több átfedő elemet.

4. Kattintsunk a Sew > Merge (összeolvasztás) 
pontot.

→ Az összes kijelölt minta összeolvasztásra 
kerül.

→ Ha ez a kijelölt minták esetében nem 
végrehajtható, hibaüzenet jelenik meg.

• Részleges átfedés

• Teljes átfedés

• Amikor a többi mintát a varrási sorban az utolsó 
minta fogja körbe

Varrási sorban az első minta

Varrási sorban a második minta

Varrási sorban a harmadik minta

A varrási sorban az első minta

A varrási sorban a második minta

A varrási sorban a harmadik minta
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Professzionális minőségű hímzési minta 
létrehozása (kézi körbarajzolás)
Amikor kitöltő öltést vagy szatén (gobelin) öltést rendelünk egy felülethez, az öltések állásszöge, iránya lehet 
akár egységesen azonos vagy az alakzattól függően változó. Azonban a Kézi körberajzoló (manual punch) 
eszközökkel az öltések iránya tetszőlegesen változtatható úgy, hogy a létrehozott minta a lehető legjobban 
emlékeztessen egy kézi hímzésre.

Például ha a kitöltő öltések vagy szatén (gobelin) öltések a következő alakzatnak megfelelően változnak, az 
öltések az alábbiaknak megfelelően alakulnak.

Ha a kézi körberajzolású minta létrehozásakor a fenti kép szolgált sablonként, az öltési minta az alábbiak 
szerint fog mutatni.

A kézi körberajzolású mintákhoz lágyított szegély beállítások adhatók meg. Az öltéssűrűség csökkentésével 
vagy az öltéshossz rögzítésével a minta körvonalát ellágyíthatjuk.

Lásd a 108. oldalon a „Lágyított szegélyek” pontot a Kézi körberajzolás szakaszban.

<Alakzat>
Szatén öltés Kitöltő öltés

<Kézi körberajzolás>
Szatén öltés Kitöltő öltés

A mintában szereplő vonalak az 
öltések irányát jelzik. Az 
öltésminta a sugaras öltések 
középpontja körül megfordul.

A sík alakzatból térbeli megjelenés hozható ki.

Példa: kitöltő öltés

Különféle variáció a virágsziromra.
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A következő példa azt mutatja, miként rajzolhatunk 
a Kézi körberajzoló eszközzel szakállat a szarvas 
köré (Rudolph.bmp), amely sablonként fog 
szolgálni.

A sablon és a befejezett minta az alábbi mappában 
található: Dokumentumok \ PE-DESIGN8 \
Sample \ Layout & Editing \ Manual Punch.

1. Töltsük be a Rudolph.bmp fájlt.

A 120. oldalon a Képi adatok betöltése 
szakaszt.

2. Kattintsunk az Eszköztárban a  ikonra.

→ Öt ikon jelenik meg: 

.

: Egyenesekkel határolt tömbökből álló 
mintákkal történik a körberajzolás 
(felületi kitöltő varrás). 
(Billentyűparancs: )

: Görbékkel határolt tömbökből álló 

mintákkal történik a körberajzolás 
(felületi kitöltő varrás).
(Billentyűparancs: )

: Egyenesekkel határolt tömbökből álló 

körberajzoló minták fél-automatikus 
létrehozása. Fél-automatikus 
leképezés esetén a program a sablon 
vonalai mentén pontok kijelölése 
történik. (Billentyűparancs: )

: Folytonos vonalú körberajzolási minta 

létrehozása (vonal varrás).

(Billentyűparancs: )

: Pontozott vonalú körberajzolási minta 

létrehozása (ugró öltések).
(Billentyűparancs: )

Lásd az útmutató 238. oldalán az Ugró 
öltések c. szakaszban.

Kézi körberajzolású minta létrehozásakor 
válthatunk a különféle eszközök között. Ezt a 
billentyűparancsok használata nagyban 
megkönnyíti.

3. Kattintsunk a  ikonra a folytonos vonalú 
minta rajzolásához.

→ A Varrási jellemzők sáv jelenik meg.

4. Válasszuk a Fill Stitch (kitöltő öltés) pontot a 
tömb öltési típusának megadásához, és a 
SILVERt mint kitöltő színt.

Ne feledjük:
Ha a fél-automatikus tömbös körberajzoló 
eszközöket kívánjuk használni, egy 
sablonként szolgáló képre is szükség lesz.

Z

X

Ne feledjük:
• A minta létrehozása után a szín és az 

öltéstípus bármikor módosítható.

Lásd a 95. oldalon a Szín és a 96. 
oldalon az Öltéstípus szakaszt.

• A Varrási jellemzők ablakban is 
végrehajthatjuk a módosításokat.

A 96. oldalon olvashatunk a 
Varrási jellemzőkről.

Ha nem módosítjuk időben ezeket a 
beállításokat, az aktuális beállítások 
kerülnek végrehajtásra. Azonban bármikor 
módosíthatjuk a varrási jellemzőket.

C

V

B

78



Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
5. Kattintsunk a tervezőfelületen az 1-12. pontok 
kijelöléséhez.

6. Miután kijelöltük a 12-es pontot (a folytonos 
vonal típusú minta utolsó pontját), kattintsunk 

a  ikonra, majd kattintsunk a tervező-
felületre a 13-15. pontok kijelöléséhez.

→ A vonalak által körbefogott terület 
tömbként kerül kialakításra.

7. Kattintsunk a tervezőfelületen a 16-23. pontok 
kijelöléséhez.

→ Az „A”–„E”-ig jelölt blokkok létrejönnek a 
megfelelő sorrendben.

8. Kattintsunk a tervezőfelületen a 24-48. pontok 
kijelöléséhez.

9. Kattintsunk a 49. pont kijelöléséhez (a minta 
utolsó pontja), majd nyomjuk le az  
gombot vagy kattintsunk kétszer a ponton a 
minta befejezéséhez.

Ne feledjük:
Az utoljára megadott pont törléséhez nyomjuk 
le a  gombot, vagy kattintsunk a 
jobb egérgombra.

1
2

3
45

6
7

89
10

11
12

BackSpace

13

15 14

23

A

21
19

17 16
18
20

22

B

C

E
D

Ne feledjük:
• Amennyiben az alakzat a Kézi körberajzoló 

eszközökkel nem rajzolható meg szépen, 
az alakzat pontjai utólag szerkeszthetők.

Lásd az 56. oldalon a Hímzési 
minta szabad szerkesztése 
szakaszban.

• A ,  vagy  eszközökkel rajzolt 
minták körvonalai mentén vonalas varrás 
nem lehetséges.

25

27 29
31

33
35

37
39

41

43
45
47

48
46

44
42

40
38

36
34

32

30
28

26
24

Enter

49
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Felirat létrehozása
Felirat/apró betűs szöveg 
bevitele

1. Kattintsunk az Eszköztárban a  ikonra.

→ Három ikon jelenik meg: .

2. Kattintsunk a  vagy  ikonra.

 : Felirat

 : Kisbetűs szöveg

→ A varrási jellemzők sáv megjelenik.

3. Igény szerint módosítsuk a betűtípust, felirat 
méretét, szín és az öltéstípust.

4. Kattintsunk a tervezőfelületre.
→ Az Edit Text Letters (szövegbevitel) 

ablak jelenik meg, benne egy táblázattal a 
kiválasztott betűtípus által tartalmazott 
összes karakterrel.

5. Gépeljük be a feliratot.

6. Kattintsunk az OK-n.
→ A szöveg megjelenik a tervezőfelületen.

Ne feledjük:
• Bármikor, a felirat előtt és után is 

módosíthatjuk a betűtípust, felirat méretét, 
színt és az öltéstípust.

A 81. oldalon a betűtípus 
állításáról, a 83. oldalon a 
betűméretről, a 95. oldalon a 
színről és a 96. oldalon az 
öltéstípusról olvashatunk.

• A Varrási jellemzők ablakban további 
jellemzőket állíthatunk be a szöveghez.

Lásd a 83. oldalon a 
Szövegjellemzők megadása 
szakaszban.

• A Varrási jellemzők ablakban további 
jellemzőket állíthatunk be a szöveghez.

Lásd a 96. oldalon a Varrási 
jellemzők megadása 
szakaszban.

Megjegyzés:
• Amennyiben az alkalmazáshoz kapott 

valamelyik fontot (01- 35) vagy saját fontot 
választunk ki, a vonal öltéstípus nem 
állítható.

• Az öltéstípus kis méretű felirathoz nem 
állítható.

Ne feledjük:
• Nyomjuk le az  gombot új sor 

beszúrásához.
• Karaktert úgy is bevihetünk, ha kiválasztjuk 

azt a táblázatban, majd kattintsunk az 
Insert gombra, vagy egyszerűen 
kattintsunk kétszer az adott karakteren. 
Ez különösen hasznos ha ékezetes 
karaktert kívánunk bevinni, amely a 
billentyűzeten nem megtalálható.

Ne feledjük:
• Ha szerkeszteni kívánjuk a bevitt 

szöveget, jelöljük ki azt majd válasszuk a 
Text – Edit Letters (szöveg 
szerkesztése) menüpontokat. 
A megjelenő Edit Text Letters 
(szövegszerkesztő) ablakban 
módosítsuk a szöveget.

Lásd a 83. oldalon „Bevitt szöveg 
szerkesztése szakaszt.

• A  Kisbetűs szöveg eszköz feliratok 
létrehozására szolgál, ahol a karakterek 
közötti ugró öltéseket nem kell elvágni.

Megjegyzés:
• Ha a megadott karakterek nem 

szerepelnek a kiválasztott betűtípus 
készletében vagy a szöveg nem 
alakítható hímzési mintává, egy 
hibaüzenet jelenik meg. Kattintsunk az 
OK gombra az üzenet bezárásához és az 
Edit Text Letters ablakhoz való 
visszalépéshez, ahol módosíthatjuk a 
szöveget.

Enter
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Felirat jellemzőinek 
megadása

A Font (betűtípus) kiválasztóban és a Text Size 
(betűméret) kiválasztóban adjuk meg a jellemzőket.

Font  kiválasztó

1. Kattintsunk a Font (betűtípus) kiválasztót.

→ A betűtípusok listája megjelenik ha a jobb 
oldali nyílra kattintunk.

2. Kattintsunk a kívánt betűtípusra.
→ A beállítás vonatkozik az összes ezután 

létrehozott feliratra, egészen addig, amíg 
a beállítást nem módosítjuk.

→ Ha a feliratot vagy abban szereplő 
karaktereket kijelölünk, a beállítás a 
kijelölt karaktereken is végrehajtásra 
kerül.

A választható betűtípusok és karakterfajták az 
alábbi listában találhatók.

• Programhoz járó betűtípusok

Megjegyzés:
Tudnivalók a kisbetűs szövegekhez
• A szokásosnál kisebb fonalfeszességet 

alkalmazzunk hímzésnél.
• A szokásosnál kisebb sebességgel 

varrjunk hímzés során. (A fonalfeszesség 
és a varrási sebesség állításáról a 
hímzőgéphez kapott használati útmutatót 
tanulmányozzuk.)

• Apró betűs feliratoknál akkor kapjuk a 
legjobb eredményt, ha a karakterek között 
nem vágjuk el az ugró öltéseket. (A fonal 
elvágásáról részletesen a hímzőgéphez 
járó útmutatóban tájékozódhatunk.)

Ne feledjük:
A Font és a Text Size kiválasztó akkor jelenik 
meg, amikor az Eszköztárból kiválasztjuk a 

 ikont. Akkor is megjelenik, amikor a 
tervezőfelületen a felirat kijelölésre kerül.

Mejegyzés:
Felirat hímzése

• Kisbetűs szövegtől eltérő betűtípust kis 
betűméret mellett alkalmazva a hímzés 
problematikus lehet. 10 mm-nél kisebb 
betűméretet lehetőség szerint ne 
alkalmazzunk.

• Egyes grafikáknál előfordulhat, hogy 
TrueType fonttal készített szöveg 
hímzési mintává alakítása nem lesz 
megfelelő. Válasszunk egyenletes 
vastagságú vonalas betűtípust, pl. 
Arialt.

Felirat

Rendelkezésre álló 
karakterfajtákFontminta

Font sorszáma
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• Egyedi fontok

Lásd a 225. oldalon az Egyedi fontok 
létrehozása Font Creatorral szakaszban.

• TrueType fontok

A TrueType fontok az egyedi betűtípusok után 
jelennek meg a listában.

Lásd a a 80. oldalon a Szövegbevitel/Kis 
felirat létrehozása c. szakaszt.

Felirat

Kisebb méretű feliratok

Angol ábécé nagybetűs változat

Angol ábécé kisbetűs változat

Számjegyek

Elválasztójelek, zárójelek és 
egyéb szimbólumok

Nagybetűs és kisbetűs ékezetes 
karakterek
Kisebb méretű feliratok (csak 
kisebb méretű betűtípusoknál 
jelenik meg)

Ne feledjük:
Csak a beépített fontok alkalmasak kisebb 
betűs feliratokhoz.

A Font Creatorral létrehozott és a PE-
DESIGN telepítési helyén található 
MyFont mappába bemásolt PEF-
fájlok felhasználói fontként jelennek 
meg az előző listában, ezeket a „UD” 
felirat jelöli.

Ne feledjük:
A formázásokat a TrueType Font Attribute 
Setting (TrueType betűtípus beállító) ablak, 
amely a Text – TrueType Font Attribute 
Setting menüpontok kiválasztásával 
érhetünk el.

Lásd a 89. oldalon a TrueType 
felirat jellemzőinek megadása 
ablakban.

Megjegyzés:
Egyes TrueType fontokkal létrehozott 
feliratok nem alakíthatók át megfelelően 
hímzési mintává a karakter formájából 
adódóan. Ezen karakterek nem hímezhetők 
le megfelelően. Végezzünk próbavarrást. 
Ezenfelül bizonyos TrueType fontok 
karakterei egyáltalán nem alakíthatók 
hímzési mintává.

beépített fontok

egyedi fontok

TrueType fontok
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Felirat mérete
1. Kattintsunk a Felirat mérete kiválasztóra.

2. Gépeljük be a kívánt magasságot, majd 

nyomjuk le az  gombot vagy 
kattintsunk a kívánt értékig.
→ A beállítás vonatkozik az összes ezután 

létrehozott feliratra, egészen addig, amíg 
a beállítást nem módosítjuk.

→ Ha a feliratot vagy abban szereplő 
karaktereket kijelölünk, a beállítás a 
kijelölt karaktereken is végrehajtásra 
kerül.

Lásd a a 80. oldalon a Felirat/apró betűsz 
szöveg bevitele c. szakaszt.

Bevitt szöveg szerkesztése

A bevitt szöveg bármikor könnyedén szerkeszthető.
1. Válasszuk ki a feliratot vagy a kis méretű 

szöveget.

2. Kattintsunk a Text > Edit Letters (szöveg 
szerkesztése) pontot.

3. A kiválasztott felirat megjelenik a szöveg 
mezőben.

4. Igény szerint módosítsuk a szöveget.
5. Kattintsunk az OK-n.

→ A módosított szöveg megjelenik a 
tervezőfelületen.

Lásd a a 80. oldalon a Felirat/apró betűs 
szöveg bevitele c. szakaszt.

Felirat jellemzőinek 
megadása

Számos formázási lehetőség áll rendelkezésre a 
Text Attribute Setting ablakban.

A kijelölt szöveg minden egyes beállításnál 
módosulni fog.
1. Válasszuk ki a feliratot vagy a kis betűméretű 

szöveget.

2. Kattintsunk a Text > Text Attribute Setting 
(szöveg jellemzők beállítása) pontokra.

Lásd a 47. oldalon a Fonalszín, varrási 
jellemzők, szöveg formázás szakaszt.

3. Ha szükséges, módosítsuk a szöveg 
jellemzőket.

Megjegyzés:
Egyidőben egynél több mintát nem 
szerkeszthetünk. Ha egynél több feliratot 
jelölünk ki, a menüparancs nem elérhető.

Enter

Ne feledjük:
Az alapértelmezett beállítások 
visszaállításához kattintsunk a beállítások 

melletti  ikonra.

Kerning 
(alávágás - 
egalizálás)

Két egymás melletti 
karakter közötti távolság 
állítása

0.0 mm 

5.0 mm (“A” és 
“b” között) 

Vertical 
Offset 
(függől. 
eltolás)

Felirat függőleges 
eltolása

0.0 mm 

2.0 mm 

Rotate 
angle 
(döntési 
szög)

Elforgatja a karaktereket, 
dönti a szöveget

0 fok

20 fok
83



Hímzési tervek kezelése (Layout & Editing)
Felirat szabad torzítása
Előre elmentett formába torzíthatjuk a feliratot.

1. Jelöljük ki a feliratot.

2. Pipáljuk ki a Transform kapcsolót majd 
kattintsunk az alakzatba torzító gombokra.

→ A kiválasztott alakzattól függően 

pontozott vonal és  vagy  

nyílak jelennek meg a felirat körül.

4. Húzzuk a  nyílat a felirat torzításához.

A szöveg eredeti alakjába történő 
visszaállításához vegyük ki a pipát a 
Transform kapcsolóból.

Karakter-
köz

A karakterek közötti ritkí-
tás a teljes szövegben.

0.0 mm 

2.0 mm 

Line 
Spacing 
(sorköz)

A karakter 
magasságának 
százalékában adhatjuk 
meg a sorok közötti 
távolságot.

100%

150%

Alignment 
(igazítás)

A teljes tömböt balra, 
középre, és jobbra 
zárhatjuk.

Bal

Közép

Jobb

Direction 
(szöveg-
folyatási 
irány)

Megadhatjuk, hogy a 
karaktereket jobbra vagy 
balra igazítsuk-e

Vízszintesl

Függőlegesl

Ne feledjük:
• A függőleges folyatású felirat függőlegesen 

jelenik meg a tervezőfelületen.
• Mind a Kerning (alávágás) mind a 

Character Spacing (karakterköz) beállítás 
a karakterek közötti távolságot befolyásolja. 
A Kerning két betű távolságát állítja, a 
Character Spacing a teljes feliratra fog 
vonatkozni. A szövegben egyes karakterek 
különálló kijelöléséről a 85. oldalon, a 
Karakterek kijelölése szakaszban 
olvashatunk.

Ne feledjük:
Kis betűméretű felirat nem torzítható.

Megjegyzés:
A TrueType fontból létrehozott felirati minta 
mind vonalas mind felületi öltést tartalmaz. 
Így amennyiben ezt a parancsot választjuk 
ki, a TrueType fonttól függően kis köz, rés 
jöhet létre a körvonal és a belső kitöltő felület 
között. 

Ne feledjük:

•  csak függőleges torzításra alkalmas.

•  csak vízszintes torzításra alkalmas.

Ne feledjük:
• A feliratot akár íves alakzatba is torzíthatjuk 

a  és  ikonnal.

• Az itt végrehajtott módosítások minden ezután 
létrehozott feliratra érvényesek lesznek, amíg 
ezeket újból nem módosítjuk.
84



Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Karakterek kijelölése

A betűtípus, a betűméret, a fonalszín, az öltéstípus 
és az egyéb jellemzők minden egyes kijelölt 
karakternél különállóan módosíthatók.

1. Kattintsunk a  majd  ikonra.

2. Kattintsunk a feliratra vagy a kis betűméretű 
szövegre.

→ A karakterekhez tartozó mozgatópontok 
kis üres négyzetekként jelennek meg.

3. Egy adott karakter kijelöléséhez kattintsunk a 
karakterhez tartozó pontra.

Több karakter egyidejű kijelöléséhez tartsuk 

lenyomva a gombot, majd kattintsunk 
az egyes karakterekhez tartozó pontokra, 
vagy húzzuk a mutatót a pontok felett.

→ A kiválasztott karaktereknél a pontok kis 
fekete téglalapokként jelennek meg.

→ A fogantyúk jelennek meg a karakterek 
körül.

→ A Varrási jellemzők sáv megjelenik.

1 Forgató fogantyú
2 Méretező fogantyú
3 Függőleges eltolás fogantyú

Betűméret és jellemzők gyors 
szerkesztése

Az egérmutatóval könnyedén hajthatunk végre 
formázási műveletek, a karakterköz, a függőleges 
eltolás, elforgatás állítását feliratokon, kis 
betűméretű szövegen, monogrammokon.

Betűméret állítása
1. Hozzuk a mutatót a  fogantyú fölé.

2. Húzzuk a fogantyút.

→ A betű pontozott körvonala mutatja a 
módosított méretet.

3. Az egérgombot felengedve a karakterméret 
módosul.
→ A Varrási jellemzők sávban megjelenik az 

új méret.

Ctrl

21

3

Ne feledjük:
• Több pont is kijelölhető egyidejűleg és a 

kijelölt pontok a hímzési pontokkal egyező 
módon szerkeszthetők.

Lásd az 56. oldalon a Pontok 
kijelölése szakaszban.

• TrueType font használata esetén a 
körvonal levarrása ki- és bekapcsolható, 
valamint színt és varrási jellemzőt is 
hozzárendelhetünk.

Ne feledjük:
A kis betűméretű felirat karaktermérete is 
megnövelhető. Azonban az öltések minősége 
romolhat, durvává válhatnak.
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Karakterköz állítása

1. Vigyük a mutatót a betűtestre a   

és  ikonok területén kívül, majd kezdjük el 
húzni a karaktereket vízszintesen.

→ A karatkerek pontozott vonallal jelölt 
körvonala a húzás irányába elmozdul.

2. Az egérgombot felengedve a karakterköz 
módosul.

→ Az új alávágás a Text Attribute Setting 
ablakban válik láthatóvá.

Szöveg függőleges eltolása

1. Vigyük a mutatót az alsó  fogantyú fölé.

2. Húzzuk a mutatót függőlegesen.

→ A karatkerek pontozott vonallal jelölt 
körvonala a húzás irányába elmozdul.

3. Az egérgombot felengedve a felirat az új 
függőleges helyzetet veszi fel.

→ Az új pozíció a Text Attribute Setting 
ablakban válik láthatóvá.
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Karakterek elforgatása

1. Vigyük a mutatót a  fogantyú fölé.

2. Húzzuk el a fogantyút.

→ A karatkerek pontozott vonallal jelölt 
körvonala a húzás irányába elfordul.

3. Amikor felengedjük az egérgombot, a karakter 
állásszöge módosul.

→ A Text Attribute Setting ablakot 
megnyitva a karakter az új elforgatással 
jelenik meg.

Felirat igazítása

A feliratsort vonalra, görbére írhatjuk.

Lásd a 70. oldalon az Alakzatok rajzolása 
szakaszban.

Eszköztár ikon: 

1. Válasszuk ki a feliratot vagy kis betűméretű 
szöveget és a görbét.

2. Kattintsunk a ikonra vagy  vagy 

válasszuk a Text > Fit Text to Path Setting 
(szöveg görbére igazítása) pontot.

3. A Horizontal Alignment (vízszintes ig.) 
Vertical Alignment (függőleges ig.) és Text 
Orientation (dőlés) kiválasztókban adjuk meg 
a kívánt igazítási módot.

4. Kattintsunk az OK-n a beállítások 
végrehajtásához.

Ne feledjük:
Monogram karakterek nem forgathatók.

Ne feledjük:
• A Text Attribute Setting (szövegjellemzők) 

ablakban elvégzett módosítások az összes 
kiválasztott karakteren végrehajtásra 
kerülnek.

• Az alapértelmezett beállítást a  ikonnal 
állíthatjuk vissza.

• A Text Attribute Setting ablak módosításai 
az összes ezután létrehozott feliratra 
vonatkoznak majd, egészen amíg nem 
módosítjuk ezeket.

Ne feledjük:
A görbe ellenkező oldra igazításához pipáljuk 
ki a the other side (túloldalra) kapcsolót.

Megjegyzés:
Amikor a feliratot görbére igazítjuk, a szöveg 
torzítása törlődik. Egy görbére csak egy 
feliratsor igazítható.

Ne feledjük:
A feliratot áthelyezhetjük a görbén: jelöljük ki 
a feliratot, majd húzzuk arrébb. Lásd a 37. 
oldalon a „Ne feledjük” rovatban.
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Felirat igazításának 
A felirat görbére igazítását megszüntethetjük.

Eszközsáv ikon: 

1. Jelöljük ki a görbére igazított feliratot vagy kis 
betűméretű szöveget. 

2. Kattintsunk a  ikonra, vagy válasszuk a 

Text > Release Text from Path (görbére 
igazítás feloldása) pontot.

Lásd a 87. oldalon a Felirat igazítása 
szakaszt.

Horizontal Alignment 
(vízszintes igazítás)

A karaktereknek a görbe mentén való 
elosztását állíthatjuk be

Vertical Alignment 
(függőleges igazítás)

Állítsuk be a felirat és a görbe közötti 
távolságot

Text Orientation 
(szöveg dőlése)

A karakterek görbére való felfekvését, 
dőlését állíthatjuk be.

The other side 
(túloldalra) kapcsoló

A görbe túlsó oldalára igazíthatjuk a 
szöveget.
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TrueType szöveg 
formázása

Számos karakter jellemző, pl. betűváltozat állítható 
a hímzési mintává alakított TrueType fontból 
készített feliratokon
1. Jelöljük ki a TrueType feliratot.
2. Kattintsunk a Text > TrueType Font 

Attribute Setting beállítást.
→ Az ablak megjelenik. Ha bármely 

TrueType fontból átalakított karaktert 
kiválasztunk, az adott karakter jellemzői 
megjelennek.

3. A betűváltozat módosításához a Font style 
listából válasszunk. 

4. A fonthoz tartozó karakterkészlet cseréjéhez 
válasszuk ki a kívánt karakterkészletet a 
Script kiválasztóból.

5. Kattintsunk az OK-ra a jellemzők 
módosításához és az ablak bezárásához.
→ A módosítás az összes ezután, TrueType 

fontból készített feliratnál érvényben lesz, 
egészen addig, amíg újból nem 
módosítjuk.

Lásd a 80. oldalon a Felirat/apró betűs 
szöveg bevitele szakaszt, valamint a 83. 
oldalon a Felirat jellemzőinek megadása 
szakaszt.

Felirat körvonalának 
mintává alakítása

TrueType fontból létrehozott felirat körvonalas 
mintává alakítható.

1. Válasszuk ki a TrueType fontot.

2. Kattintsunk a Text > Convert to Outline 
Object (körvonalas elemmé alakítás) pontra.

→ A kiválasztott felirat körvonala marad 
meg.

Varrási jellemző nem került 
hozzárendelésre a körvonalhoz, ezért 
pontozott vonalként jelenik meg. Igény 
szerint adjuk meg a varrási jellemzőket.

Lásd a 240. oldalon a Körvonalas 
karakterek létrehozása (Felirat 
átalakítása körvonalas elemmeé 
eszközzel) c. szakaszt.

Megjegyzés:
• A Font style vagy Script opciók a 

kiválasztott fonttól függően eltérőek 
lehetnek.

• Ha több TrueType betűtípusból kialakított 
feliratot választunk ki, a parancs nem 
elérhető. Valamint ha azonos betűtípusból 
de eltérő változatból vagy készletből 
szöveget jelölünk ki, az ablak az első 
karakter jellemzőit fogja mutatni. A két 
utóbbi eset bármelyikében a feliratból 
egyetlen karaktert kijelölve az ablak a 
kijelölt karakter jellemzőit fogja mutatni.

Ne feledjük:
Hogy a minta megőrizze alakját, foglaljuk 
csoportba a körvonalat, vagy rendeljünk 
hozzá lyukvarrást.
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Monogram létrehozása
A monogram egy, kettő vagy három nagybetűs karakterből és körülötte díszes keretből áll. 

1. Kattintsunk az Eszköztárban a  ikonra.

→ Három ikon jelenik meg: .

2. Kattintsunk a  ikonra.

→ A varrási jellemző sáv jelenik meg.

3. Ha szükséges, módosítsuk a betűtípust, a 
felirat méretét, színét és az öltéstípust.

4. Kattintsunk a tervezőfelületre.

5. Gépeljük be a monogram szövegét 
(nagybetűs karakterekkel).

6. A monogramot díszítő mintával tehetjük 
látványosabbá: válasszuk az Add Decorative 
Pattern (díszítő minta hozzáadása) 
kapcsolót, majd kattintsunk Select Pattern 
(minta kiválasztó) gombon.

7. Kattintsunk egy tetszetős mintán, majd 
kattintsunk a Select gombon (vagy kattintsunk 
kétszer a mintán). A Decorative Pattern 
ablak bezárul, a minta megjelenik az Edit 
Monogram Letters (Monogram szerkesztő) 
ablak nézőképén.

8. Kattintsunk az OK-n.

→ A monogram megjelenik a 
tervezőfelületen a kiválasztott díszítő 
mintával.

9. Kattintsunk a  ikonra az Eszköztárban, 
válasszunk egy díszítő mintát, majd állítsuk be 
ennek méretét, helyzetét.

Ne feledjük:
• Diamond és Script fontok kizárólag 

monogram készítésére szolgálnak. 
Emellett más fontokat is használhatunk.

• Ha egy TrueType betűtípust kijelölünk, 
a Varrási jellemzők sáv az alábbiaknak 
megfelelően jelenik meg, így a vonalas 
fonalszín és az öltéstípus kiválasztható.

Ne feledjük:
• A monogram létrehozása előtt és után is 

bármikor módosíthatjuk a betűtípust, 
szöveg méretét, színét. 

Lásd a 91. oldalon a Monogram 
font és Monogram méret 
szakaszt, a Szín szakaszt a 95. 
oldalon és az Öltéstípus szakaszt 
a 96. oldalon.

• A Sewing Attribute Setting ablakban is 
megadhatjuk a monogram egyéb jellemzőit.

Lásd a 96. oldalon a Varrási 
jellemzők megadása 
szakaszban.

Ne feledjük:
• A karaktereket a karaktertáblából kijelölve 

is begépelhetjük: jelöljük ki, majd 
kattintsunk az Insert gombra, vagy 
kattintsunk a karakterre kétszer.

• A monogram funkcióval legfeljebb három 
karaktert adhatunk meg.

Megjegyzés:
Több sorból álló szöveget nem adhatunk 
meg. Ha lenyomjuk az  gombot, az 
ablak bezáródik, és a monogram megjelenik 
a tervezőfelületen.

Enter
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10. Ha szükséges, módosítsuk a fonalszínt és az 
öltéstípust a Varrási jellemzők sávban.

Monogram szerkesztése

A Monogram betűtípus és Monogram méret 
ablakban állíthatjuk a monogram jellemzőit.

Monogram betűtípus
1. Kattintsunk a betűtípus kiválasztóra.

→ A monogram fontok listája jelenik meg.

2. Kattintsunk a kívánt fontra.

→ A beállítás az összes ezután létrehozott 
monogramra is igaz lesz, egészen addig, 
amíg nem módosítjuk újból.

→ Amennyiben egy monogram mintát 
kiválasztottunk előzőleg, a beállítások 
ezen is végrehajtásra kerülnek.

Monogram méret
1. Kattintsunk a Monogram méret kiválasztón.

2. Adjuk meg a kívánt magasságot, majd 

nyomjuk le az  gombot vagy 
kattintsunk a kívánt értéken.

→ A beállítás az összes ezután létrehozott 
monogramra is igaz lesz, egészen addig, 
amíg nem módosítjuk újból.

→ Amennyiben egy monogram mintát 
kiválasztottunk előzőleg, a beállítások 
ezen is végrehajtásra kerülnek.

Monogram szövegének 
szerkesztése

1. Válasszuk ki a monogramot.

2. Kattintsunk a Text > Edit Letters (szöveg 
szerkesztése) menüponton.

→ Az Edit Monogram Letters ablak jelenik 
meg, ahol a szöveg mezőben a kijelölt 
monogram szövege látható.

3. Tetszés szerint módosítsuk a szöveget.

Ne feledjük:
• Húzzuk a fogantyút a a kiválasztott minta 

kívánt méretre igazításához.

Lásd a Minták méretezése 
szakaszt az 53. oldalon

• A mutató a -ra vált, amikor a kijelölt 
elem mozgatható.

Ne feledjük:
A Monogram font kiválasztó és Monogram 
Size kiválasztó jelenik meg a Varrási 
jellmezők sávban, amikor az Eszköztárban a 

 ikont kiválasztjuk. A tervezőfelületen 
kijelölve a monogramot ugyancsak 
megjelennek.

Megjegyzés:
Egyidőben csak egy monogramot 
szerkeszthetünk. Több monogramot 
kijelölve a funkció nem elérhető.

Ne feledjük:
• A díszítő minta módosításához kattintsunk 

a Select Pattern gombon, majd válasszunk 
egy új mintát a megjelenő ablakban. Ezután 
jelöljük ki a régi mintát a tervezőfelületen, 
és töröljük azt. 

Enter
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4. Kattintsunk az OK-n.

→ A módosított monogram megjelenik a 
tervezőfelületen.

Lásd a 90. oldalon a Monogramok 
létrehozása szakaszban.

Különálló karakterek 
szerkesztése

A fonalszín, karakterméret, karakterköz, és 
függőleges eltolás a monogram minden egyes 
karakterénél különállóan szerkeszthető. Ugyanúgy 
kell eljárnunk, mint a feliratoknál. A karakterek nem 
forgathatók.

Lásd a 85. oldalon a Karakterek kijelölése 
szakaszban és a 85. oldalon a 
Karakterméret és jellemzők gyors 
módosítása szakaszban.
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Varrási jellemző megadása vonalra 
és felületre
A Varrási jellemző sávval a következő jellemzőket 
adhatjuk meg:

• alakzati jellemzőket (téglalap sarkának 
lekerekítése, görbe alakja)

• szöveg jellemzőket (font, méret)

• hímzési jellemzőket (fonalszín és 
öltéstípus, körvonal és belső felület 
kivétele, beemelése)

A varrási jellemzők az Eszköztárban kiválasztott 
eszköztől, valamint a kiválasztott hímzési mintától 
függően változnak.

1. példa: Téglalap kijelölésekor.

2. példa: Szöveg kijelölésekor.

Amikor a mutatót egy gomb vagy kiválasztó fölé 
visszük a Varrási jellemzők sávban, egy címke 
jelenik meg a beállítás nevével. A következő 
ismertetés során ezen címkékkel fogjuk jelölni a sáv 
egyes elemeit.

Általános szabály, hogy egy adott minta jellemzői a 
létrehozás előtt megadhatók, de utólag is bármikor 
módosíthatók. Például egy téglalap rajzolásakor a 
szín és a lekerekítési sugár azután is megadható, 
hogy elkezdtük rajzolni a téglalapot. Amikor a 
téglalapot megrajzoltuk, kiválaszthatjuk és 
módosíthatjuk annak jellemzőit.

Alakzati jellemzők

Szöveg jellemzők

Hímzési jellemzők

Lekerekítési sugár: Téglalap 
sarkának lekerekítése.

Lásd a 70. oldalon.
Görbe alakja: Görbe zárása, 
megnyitása.

Lásd a Vonalvégek záródása 
szakaszt a 74. oldalon.

Font: Szöveg betűtípusa.
Lásd a 81. oldalon a Font 
szakaszban.

Méret: Betűméret megadása

c Lásd a 83. oldalon a Felirat 
mérete szakaszban.

Vonal varrás: Vonal varrásának 
ki- és bekapcsolása. Ha a körvonal 
varrását kikapcsoljuk, az nem kerül 
hímzésre (szín és öltéstípus sem 
állítható).

Lásd a 94. oldalon a Vonal 
varrás/felületi varrás 
szakaszt.

Felület varrás: Felület varrásának 
ki- és bekapcsolása. Ha 
kikapcsoljuk a belső felületet, az 
nem kerül lehímzésre (színe és 
öltéstípusa nem állítható).

Lásd a 94. oldalon a Vonal 
varrás/felületi varrás 
szakaszt..

Vonal színe, felület színe, szöveg 
színe, körberajzolás színe: 
A fonal színét adhatjuk meg a fenti 
elemekhez.

Lásd a 95. oldalon a Fonal 
színe beállításnál.

Különleges színek
Lásd a 95. oldalon a 
Különleges színek 
szakaszban.

Vonal öltéstípus:
Lásd a 96. oldalon az 
Öltéstípus szakaszban.

Felület öltéstípusa: Felület, 
szöveg, kézi körberajzolás belső 
kitöltő felületéhez rendelhetünk 
öltéstípust.

Lásd a 96. oldalon az 
Öltéstípus szakaszt.
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Fonalszín és öltéstípus 
megadása

Minden mintához rendelhető legalább egy szín és 
öltéstípus. A körvonalas és belső felülettel 
rendelkező minták két eltérő fonalszín és öltéstípus 
is rendelhető. Ha egy felületet színátmenettel 
töltünk ki, egy további színt kell megadnunk az 
átmenet létrehozásához (részletesen lásd a 115. 
oldalon). Ezenfelül egy feliratban minden egyes 
karakterhez egyedi fonalszín és öltéstípus 
rendelhető.

Minták körvonallal és belső felülettel: TrueType 
fontból átalakított felirat, körök, körcikkek, ívek, 24 
féle alakzat, téglalapok, zárt görbék. Ezen mintáknál 
külön-külön ki- és bekapcsolhatjuk a körvonal és 
felület levarrását.

Minták csak körvonallal: ívek, nyitott egyenes 
szakaszokból álló vonalak, nyitott görbék. Ezen 
mintáknál a körvonal varrása kapcsolható csak ki és 
be.

Minták csak felülettel: a programhoz kapott 
fontokkal készített feliratok, egyedi fontokkal 
készített feliratok, és kézi körberajzolású elemek. 
Ezen mintáknál csak a belső felület varrását 
kapcsolhatjuk ki és be.

Kézi körberajzolású minták: színt és öltéstípust 
rendelhetük a kézi körberajzolású elemhez.

Vonal  / felület  varrása 

 ikon a vonal varrását kapcsolja ki és be, a 

 ikon a felület varrásával teszi ugyanezt.

A két beállítás között a gombokra kattintva 
válthatunk.

Be (on): A szín kiválasztó és az öltéstípus 
kiválasztók megjelennek .

Ki (off): A szín kiválasztó és az öltéstípus 
kiválasztó nem jelennek meg.

Vonalvarrás be: Vonalvarrás ki:

Lásd a 96. oldalon az Öltéstípus 
szakaszban és a 95. oldalon a Szín 
szakaszban.Ne feledjük:

• A szín és az öltéstípus beállítás később az 
összes azonos típusú elemre érvényes 
lesz, amíg újból nem módosítjuk. Az egyes 
kategóriák szín jelölő gombjai mutatják az 
adott kategória aktuális színét.

• Egy mintát kijelölve a szín és öltéstípus 
mezők a kijelölt mintára jellemző beállítást 
fogják mutatni.

Ne feledjük:
• Ha a vonal vagy felületi varrást 

kikapcsoljuk, az nem kerül levarrásra (és a 
szín, öltéstípus nem adható meg).

Megjegyzés:
A Felületi varrás jellemző nem adható meg 
olyan zárt görbe alakzat esetén, melynek 
vonala önmagát metszi, hiába készült az 
alakzat egyenes vonalú vagy görbe vonalú 
eszközzel zárt alakzatként.

vonal 

vonal szÍne vonal öltéstípusa

felület
színe

öltéstípusa

Felület levarrva Fel. varrás kikapcs.
94



Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Szín 
Körvonal, belső felület, felirat és kézi körberajzolás 
színét adhatjuk meg ezzel a gombbal.

1. Kattintsunk a Color gombra.

• Színtár mód

• Lista mód

2. A Fonal táblázatból válasszunk egy márkát, 
vagy saját fonaltáblázatot adjunk meg.

3. A fonalszínek listájából válasszuk ki a kívánt 
színt.

Saját fonal típus táblázat kialakításáról, 
illetve a hímzőgépek fonalszín kezelési 
műveleteiről a 110. oldalon olvashatunk.

Az öltési mintákban a fonalszínek 
módosításáról a 118. oldalon 
olvashatunk.

Különleges színek

• Nincs megadva: Egyes hímzőgépeken a 
fonalszín automatikusan megjelenik a 
kijelzőn, a megadott színt mutatva. Ilyen 
gépet használva egyszínű minta esetén a 
szín kézi megadásához válasszuk ki a 
nincs megadva gombot.

• Foltvarrás (appliqué) színek: Három 
színt adhatunk meg foltvarrás 
készítésekor. 
APPLIQUE ANYAGA jelöli a folt 
anyagából kivágott felület színét.
APPLIQUE HELYE jelöli a hordozó 
anyagon a folt helyét jelölő varrás színét.
APPLIQUE a folt levarrásának színe a 
hordozó anyagra.

Ne feledjük:
• A fonalszín jellemzőinek megtekintéséhez 

válasszuk a To List mode (lista módba 
vált) gombot a Fonalszín ablak bal-alsó 
sarkában.

• A színek adatok nélküli megtekintéséhez 
kattintsunk a To Palette mode gombra az 
ablak bal-alsó sarkában.

Ne feledjük:
A TrueType fontokból készített mintáknál 
megjelenő Fonalszín ablak tetején 
kiválaszthatjuk a kijelölt színhez tartozó 
öltéstípust. Az elemek a következők:
Line: vonal színe
Region1: felület színe
Region2: további szín az átmenethez
(Region 2 kizárólag átmenet, színátfutás 
beállítása mellett jelenik meg).

Lásd a 115. oldalon a 
Színátmenet létrehozása 
szakaszban.

Nincs 
megadva

APPLIQUE ANYAGA

APPLIQUE

APPLIQUE
HELYE
95



Hímzési tervek kezelése (Layout & Editing)
Öltéstípus 

A körvonalak, belső felületek, kézi körberajzolás 
öltéstípusát adhatjuk meg.

1. Kattintsuk a legördülő listára.

→ A kiválasztott elemtől függően a 
választási lehetőségek is eltérnek..

2. Kattintsunk a kívánt öltéstípuson.

Lásd a 94. oldalon a Vonal / Felület varrás 
szakaszt és a Varrási jellemzők 
megadása szakaszt a következő 
hasábban.

Varrási jellemzők 
megadása

Különféle varrási jellemzőket rendelhetünk 
vonalakhoz, felületekhez a Sewing Attribute 
Setting (Varrási jellemzők beállítása) ablakban.

1. Válasszunk egy öltési mintát, majd a Rajz 
vagy Szöveg eszközt.

2. Kattintsunk a Sew > Sewing Attribute 
Setting (varrási jellemző megadása) ablakra.

Lásd a 47. oldalon a Munkaterület 
szakaszban.

Kezdő módban:

Haladó módban:

Ne feledjük:
Az Appliqué Varázsló használatával 
könnyedén hozhatunk létre foltvarrásokat.

Lásd a 137. oldalon az Appliqué 
készítése szakaszban.

Elem 
típusa

Vonal 
öltéstípus Felület öltéstípus

Felirat
(beépített, 
egyedi 
fontból)

Nincs

Satin, Fill (kitöltő) és 
Prog. Fill (programozható 
kitöltő) öltésekFelirat

(TrueType 
fontból)

Zigzag - 
cikkcakk, 
Running - elő, 
Triple - 
hármas, Motif, 
és E/V öltések

Text
(kis méret) Nincs Nincs

Kézi 
körberajz. 
minta

Nincs

Satin - szatén, Fill - 
kitöltő, Prog. Fill 
(programozható kitöltő), 
Piping-zsinórszegő és 
Motif-motívum öltések

Egyéb

Zigzag-
cikkcakk, 
Running-elő, 
Triple-hármas 
Motif, és E/V 
Stitch

Satin, Fill-kitöltő, Prog. 
Fill (programozható kitöltő), 
Piping-zsinórszegő, Motif-
motívum, Cross-kereszt, 
Concentric Circle - 
koncentrikus körök, Radial-
sugaras, Spiral - spirál és 
Stippling-pontozó

Állítás a 
csúszkával

1

2

3
4

5

Adjunk meg 
egy értéket

1

2

3
4

5
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Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
1 Alapértelmezett beállítás visszaállítása.
2 Mód váltása.
3 Varrási beállítások mentése/betöltése.
4 A tippek ablak megjelenítése, elrejtése.
5 Tippek ablak

A beállítás módosításának hatása az öltésről 
megjelenő nézőképen ellenőrizhető.

3. Az alapvető varrási jellemzők és 
legegyszerűbb beállításokhoz válasszuk a To 
Beginner mode(kezdő módba) gombot.
Az összes beállítás megtekintéséhez 
kattintsunk a To Expert mode (haladó 
módba) gombra.

4. Ha szükséges, módosítsuk a varrási 
jellemzőket a Vonal varrás és Felület varrás 
mezők alatt.

→ A beállítások minden egyes 
módosításakor a hímzési minta ennek 
megfelelően változik.

A különféle varrási jellemzők és 
beállítások a 98. oldalon kerülnek 
ismertetésre, a felületi varrási jellemzők a 
101. oldalon. Ezenfelül a gyakran 
használt varrási jellemzők elmenthetők. 
Részletesen lásd a 109. oldalon a 
„Beállítások mentése lista formájában” 
szakaszban.

Ne feledjük:
Az ablakban megjelenő varrási jellemzők a 
kiválasztott öltéstípustól függően változnak.

Ne feledjük:
A haladó módban megadott beállítások 
megmaradnak, amikor kezdő módba váltunk, 
még ha ezen beállítások nem is láthatók.

Megjegyzés:
• Az ablak beállításai a módok közötti 

váltástól függetlenül megmaradnak 
egészen addig, amíg nem módosítjuk 
ezeket.

• Az öltéstípus kis betűméretű szöveghez 
nem állítható.
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Hímzési tervek kezelése (Layout & Editing)
Vonal varrási jellemzők
A rendelkezésre álló beállítások a kiválasztott öltéstípustól függően változnak.

Cikkcakk öltés

Running (elő) öltés

Triple (hármas) öltés

Under sewing 
(alávarrás)

Az alávarrás öltésének beállításához pipáljuk ki a 
kapcsolót. Az alávarrással megelőzhetjük, hogy az 
anyag összeugorjon a hímzés során.

Ki Be

Zigzag width 
(cikkcakk öltés 
szélessége)

Adjuk meg a szatén öltés szélességét.

Keskeny Széles

Density (sűrűség) Az egy milliméterre eső fonal számával adjuk meg 
az öltéssűrűséget.

Durva Finom

Half Stitch (fél 
öltés)

A beállításhoz pipáljuk ki a kapcsolót.
Ha a cikkcakk öltés egyik fele sűrű, fél öltések 
kerülnek levarrásra automatikusan még 
egyenletesebb öltéseloszlás kialakításához.
A rajzoló eszközökkel létrehozott feliratoknál, 
elemeknél érvényes.

Off On

Sharp Corners 
(éles sarkok)

Adjuk meg, hogy a csúcsos sarkok miként 
kerüljenek levarrásra.

Run pitch 
(öltéshossz) Öltéssűrűség megadása (egy öltés hosszának).

Rövid Hosszú

Run time(s) 
(lefutások száma) A körvonal levarrása hányszor ismétlődjön meg.

Egyszeri levarrás Ötszöri levarrás

Run pitch 
(öltéshossz) Öltéshossz megadása (egy öltés hossza).

Rövid Hosszú

belső öltések 
sűrűbbek

a belső öltések 
egyenletesek
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Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Motíf (motívum) öltés

Válaszunk egy mintát a motívum öltéshez.

Kattintsunk a  ikonra a Tallóz ablak megnyitásához. Válasszuk ki a kívánt mappát, majd a kívánt 
mintát (.pmf formátum) a megjelenő fájlok közül.

Adjuk meg a minta méretet. A minta nagyítható, 
kicsinyíthető, miközben a szélesség-magasság 
arány állandó marad.

Kisebb Nagyobb

1 - magasság Minta magassága.

Kicsi Magasl

2 - szélesség Adjuk meg a minta szélességét.

Kicsi Nagy

H-Arrange
(vízszintes 
elrendezés)

A minták vízszintes tengely mentén történő 
igazítása. A minták együtt és külön is tükrözhetők a 
tengely mentén.

 Normal

 Tükör

 Váltak.

V-Arrange
(függőleges 
elrendezés)

A minták függőleges tengely mentén történő 
igazítása. A minták együtt és külön is tükrözhetők a 
tengely mentén.

 Normal

 Tükör

 Váltak.

Elosztás A minták közötti távolságot adhatjuk meg.

Szoros Laza

Run pitch 
(öltéshossz) Öltéshossz megadása.

Rövid Hosszú

1

2
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Hímzési tervek kezelése (Layout & Editing)
E/V öltés

Válasszunk az „E” és a „V” öltés között.

„E” öltés

1 - köz A húzások közötti 
távolság.

Kicsi Nagy

2 - húzás 
magass. Húzás magassága

Kicsi Magas

3 - öltés-
hossz Öltéshossz.

Rövid Hosszú

Run time(s) - lefutások 
száma

Az öltés hány alkalommal kerüljön 
levarrása.

Egyszeri levarrás Ötszöri levarrás

Stroke time(s) - Húzások 
levarrásának száma

Megadhatjuk, hogy a húzások hány 
alkalommal kerüljenek levarrásra.

Egyszeri levarrás Háromszori levarrás

Arrange - igazítás A húzás irányának megadása (belső/
külső).

„V” öltés

1 - köz A húzások közötti 
távolság.

Kicsi Nagy

2 - húzás 
széless. Húzás magasság.

Rövid Hosszú

3 - öltés-
hossz Öltéshossz.

Rövid Hosszú

Run time(s) - lefutások 
száma

Megadhatjuk, hogy az öltés hány 
alkalommal kerüljön levarrása.
„V” öltés esetén a vonal és a 
húzások ugyanannyi alkalommal 
kerülnek levarrásra.

Egyszeri levarrás Ötszöri levarrás

Arrange - igazítás A húzás iránya (belső/külső).

1 2

3

1 2

3
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Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Felületi varrás beállítása
Az elérhető jellemzők a kiválasztott öltéstípustól függően változnak.

Satin - gobelin öltés

Under 
sewing - 
Alávarrás

Az alávarrás megadásához pipáljuk ki a kapcsolót, majd adjuk meg a következő paramétereket.
Az alávarrás az anyag hímzés során bekövetkező összehúzódását előzi meg.
Adjuk meg a levarrni kívánt alávarrás öltéstípust.
• Felirat és kézi körberajzolásos minta esetén. • Egyéb minta esetén

Sűrűség
Válasszunk a Dense (sűrű), Medium (közepes) vagy Light (könnyű) beállítások közül az alávarrás 
sűrűségének.

Density - 
Sűrűség

Adjuk meg az egy milliméterre eső fonalak számát.

Durva Finom

Gradation (átmenet)
Átmenetet (árnyékolást) rendelhetünk a sűrűséghez a 
kapcsoló kipipálásával.
Az alábbi esetekben átmenet nem hozható létre:
• A varrási irány Variable (változó).
• Felirat, vagy kézi körberajzolású mintáról van szó.
Kattintsunk a Pattern gombra egy átmeneti minta 
kijelöléslhez.

Lásd a 115. oldalon az Átmenet készítése 
szakaszban.

Off - nincs átmenet On - van átmenet

Csak szegély

Csak felület (egyetlen cikkcakk 
alakú öltésekből álló réteg)

Csak felület (egyetlen zsinórszegély 
alakú öltésekből álló réteg)

Szegély és felület (egyetlen 
cikkcakk alakú öltésekből álló réteg)

Csak felület (kettős, egy 
zsinórszegély alakú öltésekből álló 
réteg és egy cikkcakk öltésekből álló 
réteg)

Egyszeri: A megadott varrási irányra 
merőlegesen varr.

Dupla: A megadott varrási irányra 
45°-os és –45°-os szögben varr.
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Hímzési tervek kezelése (Layout & Editing)
Direction 
(irány)

Adjuk meg a varrási irányt.
Felirathoz és kézi körberajzolású mintához nem alkalmas.
Constant (állandó): Varrás adott irányszögben.
Húzzuk a  piros nyílat vagy adjuk meg a szöget.

Constant

Variable (változó): Automatikusan változtatja a varrás 
irányát a felület alakjának megfelelően.

Variable

Half 
Stitch (fél 
old. öltés)

Fél oldalas öltéshez pipáljuk ki a kapcsolót.
Amennyiben a cikkcakk öltés egyik oldala sűrű, a fél 
oldalas öltés úgy kerül automatikusan levarrásra, hogy 
egyenletesebb legyen az öltéseloszlás.
Csak akkor választható opció, ha a varrási irány 
Constantra (állandóra) van állítva.

Off (ki) On (be)

Running 
Stitch 
Path (elő- 
öltés 
görbe)

Adjuk meg az előöltések görbéjét a belső felülethez.

Felület (a legrövidebb útvonal az alakzaton belül)

Körvonal mentén (legrövidebb út az alakzat 

körvonala mentén)

Körvonalon (legrövidebb út a körvonalon)

A felület belső tulajdonsága nem állítható, ha a Gradation 
(átmenet) kapcsoló nincs kijelölve.
A következő esetekben a beállítás nem elérhető:
• A varrási irány Variable (változóra) van állítva.
• Felirat és kézi körberajzolású minta esetén.

 Belső felület

 Körvonal mentén

 Körvonalon

Pull 
compen-
sation 
(húzás 
kiegyen-
lítés)

Meghosszabbítja a varrási irányba a felületet, így 
ellensúlyozza a minta varrás során bekövetkező 
összehúzódását.

Nincs Leghosszabb 
kiegyenlítés

Ne feledjük:
Lásd a 77. oldalon a „Professzionális hímzési minta létrehozása (kézi körberajzolás) c. szakaszt.

A belső öltés sűrűbb Az öltések egyen-
letesen oszlanak el
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H

ím
zési tervek kezelése (Layout &

 Editing)
Fill (kitöltő) öltés

Programozható kitöltő öltés

Under 
sewing 
(alávarrás)

Lásd a Satin (gobelin) öltés szakaszt a 101. oldalon.Density 
(sűrűség)
Direction 
(irány)

Stitch 
Type 
(öltés-
típus)

Adjuk meg az öltéssor visszatérő végéinek alakját.
Változó öltési irány esetén nem elérhető a beállítás.

Half Stitch 
(fél old. 
öltés)

Lásd a 102. oldalon a Fél oldalas öltések és Elő öltések görbe szakaszt.Running 
Stitch Path 
(előöltés 
görbe)

Step pitch 
(öltés-
hossz)

Öltéshossz (egy öltés hossza).

Rövid Hosszú

Frequency 
(gyako-
riság)

Adjuk meg az öltések közötti eltolást.

0% 50%

Pull 
compen-
sation 
(húzás ki-
egyenlít-
és)

Lásd a 102. oldalon a Húzás kiegyenlítés szakaszt.

Alávarrás

Lásd a 101. és 102. oldalon a Felület varrási jellemzők szakaszt.

Sűrűség
Irány
Fél oldalas öltés
Elő öltés görbe
Húzás kiegyenlítés
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Hímzési tervek kezelése (Layout & Editing)
Programozható kitöltés
Válasszunk egy mintát a programozható kitöltő öltéshez.

Kattintsunk a ikonra a Tallóz ablak megnyitásához. Válasszunk egy mappát, majd 

válasszuk ki a kívánt mintát (.pas fájt) a megjelenő listából.

Adjuk meg a minta méretét. A minta 
nagyítható, kicsinyíthető a szélesség/
magasság arányának megőrzése 
mellett.

Kisebb Nagyobb

1 -es 
magasság

Adjuk meg a minta 
magasságát.

Kicsi Magasl

2-es 
szélesség

Adjuk meg a minta 
szélességét.

Keskeny Széles

Direction (irány)
Húzzuk a  piros nyílat a varrási irány 
megadásához.

Offset 
(elto-
lás)

row (sor) Adjuk meg a mintasor eltolásának 
irányát.

0%

column 
(oszlop)

Adjuk meg a mintasor eltolásának 
értékét.

Sor - 50% Oszlop - 50%

Base Sewing 
(alapvarrás) A beállításhoz pipáljuk ki a kapcsolót, majd adjuk meg a következő jellemzőket.

Stitch Type 
(öltéstípus)

Adjuk meg az öltések visszatérő 
végeinek alakját.
A beállítás nem él, ha a varrási irány 
változó.

Step Pitch 
(öltéshossz)

Adjuk meg az öltéshosszt (egy öltés 
hosszát).

Rövid Hosszú

Frequency 
(gyakoriság) Adjuk meg az öltések közötti távolságot.

0% 50%

1

2

0°

45°90°
135°

180°

225°
270°

315°

A terület, ahova a dombor 
vagy bemetszés effektus 
kivitelezni kívánjuk

Ez a terület a programozható kitöltő öltés 
alapvarrásánál megadott varrási beállításokkal 
kerül levarrásra.

A felület a minta fájlban megadott öltési 
beállításokkal kerül levarrásra.

Minta
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H

ím
zési tervek kezelése (Layout &

 Editing)
Piping - sávos - öltés

Az öltések a tömbök teljes hossza mentén futnak végig.

Direction (irány)

Adjuk meg a varrási szöget.

Húzzuk a  piros nyílat az irány 
megadásához.
Kézi körberajzolású minta esetében 
nem él a beállítás.

Ha nem motívum (motif) öltési mintát használunk, adjuk meg a következő beállításokat.

Density (sűrűség) Egy milliméterre eső fonalak száma.

Durva Finom

Run pitch (öltéshossz) Adjuk meg a vonalak öltéshosszát.

Rövid Hosszú

Frequency (gyakoriság) Adjuk meg az öltések közötti távolságot.

0% 50%

Use Motif (motívum használata) Pipáljuk ki a kapcsolót motívum öltések használatához, majd adjuk meg a következő 
jellemzőket.

Motí-
vum Lásd a 106. oldalon a Motívum öltés pontot a Felület varrási jellemzők 

szakaszban.

Pattern1 (1. minta)/
Pattern2 (2. minta)

Lásd a 99. oldalon a Motívum öltés pontot a Vonal varrási jellemzők szakaszban.

A motívum öltés 
mérete, típusa
H-Arrange (vízszintes 
elrendezés)
V-Arrange (függőleges 
elrendezés)
H-Spacing (vízszintes 
elosztás)
V-Spacing (függőleges 
elosztás) Lásd a 106. oldalon a Motívum öltés pontot a Felület varrási jellemzők 

szakaszban.Row offset (sor eltolás)
Run pitch (öltéshossz)

0°

45°90°
135°

180°

225°
270°

315°
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Hímzési tervek kezelése (Layout & Editing)
Motívum öltés

Motívum
Válasszuk ki a motívum öltéshez használatos 
mintát.
Pattern1 only: Csak az 1. minta használatos.
Pattern2 only: Csak a 2. minta használatos.
Pattern1 and 2: Mindkét minta használatos 

váltakozó sorminta létrehozásához.

Pattern1 only Pattern2 only

Pattern1 and 2

Pattern1/Pattern2 Adjuk meg az alábbi beállításokat mind a két mintához.
A motívum minta 
öltéstípusa és mérete

Lásd a 99. oldalon a Motívum öltés pontot a Vonal varrási jellemzők szakaszban.

H-Arrange (vízszintes 
igazítás)
V-Arrange 
(függőleges igazítás)
H-Spacing
(vízszintes elosztás)
V-Spacing
(függőleges elosztás) Adjuk meg a minta függőleges 

elosztását.

Keskeny Széles

Direction (irány)
Húzzuk a  piros nyílat az irányszög 
megadásához.

Row offset (sor eltolása) Adjuk meg a mintasor eltolását.

Kisebb Nagyobb

Run pitch (öltéshossz) Lásd a 99. oldalon a Motívum öltés pontot a Vonal varrási jellemzők szakaszban.

0°

45°90°
135°

180°

225°
270°

315°
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H

ím
zési tervek kezelése (Layout &

 Editing)
Keresztöltés

Koncentrikus kör öltés, sugaras öltés és spirál öltés

A koncentrikus kör és sugaras öltések esetében a 61. oldalon, a Középpont mozgatása szakaszban 
olvashatunk a középpont eltolásáról.

Size (méret)

Adjuk meg a rácsminta vízsszintes és függőleges
méretét.
Haladó módban milliméterben vagy öltésszámban 
adjuk meg a méretet. Ha az értéket csak az egyik 
mértékegység szerint határoztuk meg, az azonnal 
átszámításra kerül és megjelenik a másik 
mértékegység szerint is.

Kisebb Nagyobb

Times (levarrások 
száma)

Válasszunk a Single (egyszeri) Double (kétszeri) 
vagy Triple (háromszori) beállítások között, amely 
azt jelzi, hogy a minta hány alkalommal kerül 
levarrásra. Alkalmanként két varrás történik.

Single (egyszer) Triple (háromszori)

Density (sűrűség) Az egy milliméterre eső fonalak számával adjuk 
meg az öltéssűrűséget.

Koncentrikus kör öltés 
- durva

Sugaras öltés - durva

Spirál öltés - durva

Koncentrikus kör öltés 
- finom

Sugaras öltés - finom

Spirál öltés - finom

Run pitch 
(öltéshossz) Adjuk meg az öltéshossz.

rövid hosszú
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Hímzési tervek kezelése (Layout & Editing)
Stippling - steppelő - quilt öltés

Kézi körberajzolás
Amennyiben a kézi körberajzolású mintához felületi öltéstípusként satin (szatén - gobelin), kitöltő és 
programozható kitöltő öltést választunk, lágyított él hatást érhetünk el.

Run pitch (öltéshossz) Adjuk meg az öltéshosszt.
Motívum öltés esetén nem alkalmazható.

Rövid

Az elfordulások 
finomabbak.

Hosszú

Az elfordulások 
sarkosabbak.

Spacing (elosztás) Adjuk meg a szomszédos öltések közötti 
távolságot.

Keskeny

A minta finomabb.

Széles

A minta durvább.
Use Motif (motívum 
használata)

A mintában motívum öltés használatához pipáljuk ki a kapcsolót, majd adjuk meg a 
szükséges beállításokat.

Motívum mérete és 
öltéstípusa

Lásd a 99. oldalon a Motívum öltés pontot a Vonal varrási jellemzők szakaszban.

H-Arrange (vízszintes 
igazítás)
V-Arrange (függőleges 
igazítás)
Spacing (elosztás)
Run pitch (öltéshossz)

Feathered 
edge 
(lágyított 
él)

Adjuk meg az öltések szélét, ahol 
az éllágyítást végrehajtani 
kívánjuk. 
Amikor a kapcsolót kipipáljuk, a 
tervezőfelületen megjelenik az 
éllágyított minta. Tekintsük meg a 
nézőképet, majd válasszuk ki a 
szegélyt, ahol az éllágyítást végre 
kívánjuk hajtani.

Válasszuk ki az éllágyítani kívánt mintát.

Kattintsunk a  ikonra a Browse ablak megnyitásához. 

Válasszuk ki a kívánt mintát a listából.

Minta teteje
<pattern11>

Minta alsó éle
<pattern18>

Csak a felső él

Csak az alsó élel

Felső és alsó él

Adjuk meg a lágyított él szélességét.

Rövid Hosszú

Lágyított él effekt nélkül Eltérő lágyított él effektek
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Felületi varrási jellemzők

Tudnivalók a programozható kitöltő 
öltésről és a bélyegzőmintáról
Amikor programozható kitöltő öltés vagy 
bélyegzőminta öltéstípusát, mintasor irányát állítjuk 
be, a vonalak nem kerülnek levarrásra, ha a fenti 
beállítások eredményeként az öltéssor a 
mintasorral azonos irányba áll.

A Nézőkép funkcióval pontosan megállapíthatjuk, 
hogy az öltési minták miként kerülnek levarrásra, 
ezután állítsuk be az öltés irányát és a minta irányát 
a kiválasztott öltéstípusnak vagy az elérni kívánt 
hatásnak megfelelően. A legjobb eredmény 
érdekében tegyünk próbákat a különféle 
beállításokkal.

Példák programozható kitöltő öltésre:

Lásd a 65. oldalon a Hímzés 
nézőképének megtekintése szakaszt, és 
a 205. oldalon a Egyedi öltési minták 
létrehozása szakaszt.

Gyakran használt varrási 
beállítások mentése

A sűrűn alkalmazott varrási beállításokat 
elmenthetjük, és a varrási jellemzők megadásakor 
megnyithatjuk.

Beállítások mentése listás 
formában

1. Nyissuk meg a Sewing Attribute Setting 
(varrási jellemzők) ablakot.

Lásd a 96. oldalon a Varrási jellemzők 
megadása szakaszt.

2. Szükség szerint módosítsunk a beállításokon, 
majd kattintsunk a  ikonra.

3. Kattintsunk a Save As (mentés mint) pontra.

4. Nevezzük el a beállítás együttest, majd 
kattintsunk az OK-ra a mentéshez.

1. példa
Öltési irány: 45° (alapértelmezett)

2. példa
Öltési irány: 90°

3. példa
Öltési irány: 0°

Ne feledjük:
A beállítások mind kezdő (Beginner mode) , 
mind haladó (Expert mode) módban 
menthetők.
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Beállítások csoportjának törlése a 
listából

1. A Load/Save Default Settings (beállítások 
mentése/betöltése) ablakban válasszuk ki a 
törölni kívánt beállítás együttest.

2. Kattintsunk a Delete gombra a kijelölt 
beállítások tartalmazó fájl törléséhez.

Beállítások tartalmazó fájl 
megnyitása a listából

1. A Load/Save Default Settings (beállítások 
mentése/betöltése) ablakban válasszuk ki a 
megnyitni kívánt beállítás együttest.

2. Kattintsunk a Load (betöltés) parancsra.

→ A Sewing Attribute Setting ablakban a 
beállítások a megnyitott fájl által 
tartalmazott beállításokra módosulnak.

Egyedi fonalszín lista 
kialakítása

Egyedi fonalszín listát állíthatunk össze az általunk 
leggyakrabban alkalmazott fonalakból. A program 
által ismert fonal adatokat is felhasználhatjuk, de 
teljesen új adatokat is bevihetünk.

1. Kattintsunk az Option > Edit User Thread 
Chart (egyedi fonal lista kialakítása) pontra.

Új fonal-lista létrehozása
1. Kattintsunk a New Chart (új lista) pontra.

2. Gépeljük be a lista nevét, majd kattintsunk az 
OK-n a lista megadott név alatti mentéséhez.

Ne feledjük:
Az alapbeállítás (default) nem törölhető.

Ne feledjük:
• A módosított beállítások mentéséhez 

kattintsunk a  ikonra. Kattintsunk a 
Save As gombra, majd kattintsunk a OK 
gombra, így ugyanazon néven fogjuk 
elmenti az új beállításokat.

• A mentett beállítások másik számítógépen 
is megnyithatók, használhatók. Egyszerűen 
másoljuk a PE-DESIGN 8 program alatti 
Settings mappából sastu.txt fájlt a forrás 
számítógépről a célszámítógépen lévő 
ugyanezen elérési út alatti Settings 
mappába.

Ne feledjük:
Korábban mentett lista a a User Thread 
Chart (egyedi fonal-lista) kiválasztóban 
nyitható meg, ezután tetszés szerint 
szerkeszthetjük.
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Lista törlése
1. A User Thread Chart (egyedi fonal-lista) 

kiválasztóban válasszuk ki a listát.

2. Kattintsunk a Delete Chart (lista törlése) 
pontra.

→ Az alábbi üzenet jelenik meg.

3. Kattintsunk a Yes (igen) gombra a kiválasztott 
táblázat törléséhez.

Lista szerkesztése
1. A User Thread Chart (egyedi fonal-lista) 

kiválasztóban jelöljük ki a listát.

Elem hozzáadása fonal-listából
1. A Thread Chart (Fonal lista) kiválasztóban 

válasszuk ki a fonal márkáját.

2. Az ablak alján lévő listából kattintsunk a 
fonalszínekre.

3. Kattintsunk a gombra.

→ A kiválasztott elem hozzáadódik az 
egyedi fonal-listához.

Megjegyzés:
Ha nem jelölünk ki listát, szerkesztési 
művelet nem hajtható végre.

Ne feledjük:
Több elem hozzáadásához tartsuk lenyomva 
a  vagy gombot a fonalszínek 
kijelölése alatt.

Shift Ctrl
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Új elem hozzáadása
1. Kattintsunk a New Item pontra.

2. Új szín létrehozásához kattintsunk a Mix 
(színkeverő) gombra.

→ A fenti ablak jelenik meg.

3. Adjuk meg a színt, majd kattintsunk az OK-ra 
a szín hozzáadásához az Edit Thread (fonal 
szerkesztő) ablakban.

4. Ha szükséges, gépeljük be a kódot, a márkát 
(brand) és a leírást (description).

5. Kattintsunk az OK-ra az új elem 
hozzáadásához az egyedi fonal-listához.

Elem törlése
Egyedi fonal-listában szereplő elem törléséhez 
jelöljük ki az adott elemet, majd kattintsunk a Delete 
Item gombra.

Ne feledjük:
A kódban kizárólag számok szerepelhetnek.

Ne feledjük:
Csillag (*) szimbólum jelenik meg az általunk 
létrehozott vagy szerkesztett elemek 
mutatószáma előtt.
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Elem szerkesztése
Egyedi fonal-listában szereplő elem utólag is 
szerkeszthető: módosíthatjuk a színt vagy a fonal 
számát.

1. Az egyedi fonal-listából válasszuk ki a 
módosítani kívánt elemet, majd kattintsunk az 
Edit Item gombra.

→ Az alábbi ablak jelenik meg.

2. A létrehozáshoz hasonló módon 
szerkeszthetjük az elemet.

Elemek sorrendjének módosítása
Az egyedi fonal-listában jelöljük ki az áthelyezni 
kívánt elemet, majd kattintsunk az Up (fel) és Down 
(le) gombokra az elemek sorrendjének 
módosításához.

Ne feledjük:
Az újonnan hozzáadott elemekhez hasonlóan 
a szerkesztett elemek előtt is megjelenik a 
csillag (*) szimbólum.

Megjegyzés:
Előfordulhat, hogy a programmal létrehozott 
mintákban szereplő fonalszínek a 
hímzőgépen másképp jelennek meg.
1. Szín megjelenítésére szolgáló funkció 
nélküli hímzőgépek esetén
A megadott fonal tulajdonságok egyes 
gépeken nem megjeleníthetők.
2. Szín megjelenítésére szolgáló funkcióval 
ellátott hímzőgépek esetén
A fonal tulajdonságok közül egyedül a 
fonalszín jelenik meg a készüléken. 
Azonban a fonalszín megnevezése a 
készülékbe programozott fonalszín nevekre 
korlátozódik. Így a fonalszínek 
megnevezései során használjunk a 
készülékbe programozott nevekhez lehető 
legközelebb álló megnevezéseket.
3. Fonalszín mutatóval ellátott hímzőgépek 
esetén
Egyes készülékek alkalmasak a 
programban megadott fonal tulajdonságok 
kijelzésére (szín, szín megnevezése, típus, 
fonal száma). Azonban az általunk 
módosított vagy létrehozott elemeknél (*-gal 
jelölt elemek) kizárólag a fonal száma jelenik 
meg.

Ne feledjük:
A módosított egyedi fonal-lista is 
megjeleníthető másik számítógépen. 
Egyszerűen a PE-DESIGN 8 telepítési helyén 
belüli Color mappában lévő chart2.btc fájlt 
másoljuk át a másik számítógép ugyanezen 
mappájába.
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Felületek szerkesztése
Bélyegzőminta készítése, 
szerkesztése

Bélyegzőminta a Téglalap, Kör, Ív, Alakzat, 
Körvonal, Szöveg és Kézi körberajzoló eszközökkel 
létrehozott elemek belső felületein alkalmazható, 
amely felületeken kizárólag szatén (gobelin), kitöltő 
és programozható kitöltő öltés került beállításra. Az 
alkalmazáshoz jár néhány bélyegzőminta.

Bélyegzőminta alkalmazása

1. Kattintsunk az Eszköztárban a  ikonra.

→ Két gomb jelenik meg: .

2. Kattintsunk a  ikonra.

3. Az ablakban válasszuk ki a bélyegzőmintát 
(.pas fájl bélyegző beállítással).

4. A minta magasságának és szélességének 
állításához gépeljük be a kívánt méretet a 
Size (méret) mezőbe.

5. A bélyegzőminta irányának állításához vigyük 
a mutatót a Direction szakaszban lévő piros 
nyíl fölé, majd húzzuk a nyílat a kívánt irányba.

6. Kattintsunk az elemre a kijelöléshez.

→ Futó pontozott vonal jelenik meg a kijelölt 
elem körül.

7. Kattintsunk a kívánt helyre az elemen belül.

→ A bélyegzőminta pontozott vonalként 
jelenik meg az elemben.

Ne feledjük:
A Programmable Stitch Creator szoftverrel 
módosíthatjuk a mintákat vagy egyedi 
mintákat hozhatunk létre.

Lásd a 205. oldalon az Egyedi 
öltési minták létrehozása 
szakaszban.

Ne feledjük:
• A dombor és véset bélyegző beállítások 

pirossal és kékkel kitöltött területekként 
jelennek meg.

• Eltérő mappa kiválasztásához kattintsunk a 

 ikonra.

Ne feledjük:
• Az ablak továbbra is látható marad, így a 

méret és az irány bármikor állítható a 
későbbiek során.

• Az ablak bezárása után az újbóli 

megnyitáshoz kattintsunk a ikonra.

Ne feledjük:
• A teljes bélyegzőminta megjelenik, még ha 

a befoglaló elem kisebb is a mintánál, 
azonban csak az elemen belül eső részek 
kerülnek levarrásra.

• Ugyanazon elemen belül a bélyegzőminták 
ismétléséhez kattintsunk annyiszor az 
elemen belül, ahányszor csak szükséges.

• Amennyiben a mutató nem esik az elemen 
belülre, a bélyegzőminta nem jelenik meg.

• A Stamp Attribute Setting (bélyegző 
beállító) ablak csak a bélyegző eszköz 
kiválasztása után jelenik meg.
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Bélyegző szerkesztése

1. Kattintsunk a  ikonon az Eszköztárban.

→ Két ikon jelenik meg: .

2. Kattintsunk az  ikonon.

→ A felvitt bélyegzőminták rózsaszín 
pontozott vonalként jelennek meg.

3. Kattintsunk az elemen a bélyegzővel.

→ Futó pontozott vonal jelenik meg a kijelölt 
elem körül.

4. Kattintsunk a bélyegzővel.

→ A bélyegzőminta körül kerek fogantyúk 
jelennek meg, valamint a tetején kis 
forgatópont.

5. Módosítsuk a mintát.

• A minta cseréjéhez a Stamp Attribute 
Setting ablakban válasszunk egy másik 
mintát, majd kattintsunk az Apply gombra.

• A méret és az irány módosításához adjuk 
meg a kívánt értékeket a Stamp Attribute 
Setting ablak megfelelő mezőiben.

• A bélyegzőminta áthelyezéséhez húzzuk 
másik helyre az elemen belül.

• A bélyegzőminta törléséhez válasszuk ki 
az Edit – Delete pontot, vagy nyomjuk le a 

 gombot.

Átmenet, színátfutás 
létrehozása

Egy vagy két szín öltési sűrűségének 
módosításával egyedi színátmenetet hozhatunk 
létre.

1. Haladó (expert) módban nyissuk meg a 
Sewing Attribute Setting (varrási jellemzők) 
ablakot, majd pipáljuk ki a Gradation 
(átmenet) kapcsolót a Region sew pont alatt.

2. Kattintsunk a Pattern (minta) gombra.

3. A  ikonra kattintva módosítsuk a fonal 
színét. A Thread Color ablakban jelöljünk ki 
egy színt, majd kattintsunk az OK-ra.

4. Előre elmentett színátmenet kiválasztásához 
kattintsunk a tetszetős mintára a Select 
pattern (minta kiválasztása) pontra kattintást 
követően.

Megjegyzés:
Egyidőben csak egy bélyegzőmintát 
jelölhetünk ki. Másik bélyegzőminta 
kiválasztásakor a korábban kijelölt minta 
kiválasztása megszűnik.

forgató pont

méretező 
fogantyúk

Ne feledjük:
• Bélyegzőmintát tartalmazó elem 

forgatásakor, áthelyezésekor a minta is 
elfordul, elmozdul. Azonban az elem 
átméretezésekor a bélyegzőminta mérete 
nem változik.

• A bélyegzőmintának kizárólag a befoglaló 
elemen belüli része kerül levarrásra.

Delete
115



Hímzési tervek kezelése (Layout & Editing)
5. A csúszkát elhúzva a minta öltéssűrűségét 
állíthatjuk.

6. A két szín egymásba olvasztásához, pipáljuk 
ki a Use additional color kapcsolót, majd a 

kapcsoló alatt kattintsunk a  ikonra. 
Válasszunk egy színt, majd kattintsunk az 
OK-ra.

7. Kattintsunk az OK-ra.

Lásd a 95. oldalon a Színek szakaszt.

Ne feledjük:
A nézőképen láthatjuk a módosítások hatását.

Ne feledjük:
• Ha kivesszük a pipát a Use additional 

color (még egy szín bevonása) 
kapcsolóból, az átmenet beállításai csak a 
megmaradó egy színre fognak vonatkozni.

• Az átmenet első és második színe a Thread 
Color ablakon belül a Region1 és Region2 
mezőkben módosítható.
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Varrási sorrend ellenőrzése, módosítása
A hímzési minta varrási sorrendje bármikor ellenőrizhető, módosítható, ezenfelül ugyanabban az ablakban a 
szín és a színhez tartozó öltéstípus is módosítható, valamint a hímzési minta lezárható.

Eszköztár ikon: 

1. Kattintsunk a  ikonra, vagy kattintsunk 

a Sew > Sewing Order/Lock (varrási 
sorrend/lezárás) menüpontra.

 :A minta nagyítása a keretet kitöltő 
méretre.

 :Az azonos színű, egyszerre levarrandó 
mintákat jeleníti meg egy keretben.

Minta kijelölése

1. Válasszunk ki egy mintát a Sewing Order/
Lock (varrási sor/lezárás) ablakban.

→ A kiválasztott minta körül kék vonal jelenik 
meg, és a tervezőfelületen az adott minta 
körül futó pontozott vonal látható.

Ne feledjük:
• Amikor több mintát egy kereten belül 

jelenítünk meg, a keret bal oldalán a  
jelzés tűnik fel.

• A  jelzésre kattintva az alkotó minták 
külön keretben jelennek meg.. 

 jelzés jelenik meg az első szétbontott 
keret alatt, és mindegyik keret egy 
sorszámot kap, amely az adott színű minták 

varrási sorrendjét jelezve. A jelzésre 
kattintva újra összeállíthatjuk a mintákat 
egy keretbe.

• A Sewing Order/Lock ablak bezárásához 
kattintsunk a  ikonra az ablak jobb-felső 
sarkára.

Ne feledjük:
• Több minta kijelöléséhez tartsuk lenyomva 

a  vagy  gombokat, közben 
kattintsunk a kívánt mintákra. Emellett több 
keret a mutató húzásával is kiválasztható.

Shift Ctrl
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Varrási sorrend 
szerkesztése

A mintát tartalmazó keret kijelölésével és másik 
helyre húzásával módosíthatjuk a varrási sorrendet. 
Egy függőleges piros vonal jelzi a keret aktuális 
pozícióját.

A keretek mozgatásának másik módja a felső 
gombsor használata.

 :A kiválasztott minta a sor elejére ugrik.

 :A kiválasztott minta eggyel előrébb ugrik 
a sorban.

 :A kiválasztott minta eggyel hátrébb ugrik 
a sorban.

 :A kiválasztott minta a sor végére kerül.

Azonos színű minták 
összeállítása
Amennyiben a tervezőfelületen több mintából 
álló összeállítás található, a Sewing Order/Lock 
ablakban az azonos színű minták 
összekapcsolhatók, csoportba foglalhatók. 
Egyszerűen húzzuk az azonos színű mintákat 
egymás mellé.

Színek cseréje

Minden egyes elem színe módosítható. A teljes 
öltési mintára vonatkozóan is módosíthatjuk a 
fonalszínt. A hímzési mintában a színek módosítás 
a következőképp hajtható végre.

Lásd a 49. oldalon szereplő „Ne feledjük” 
blokkot.

1. Válasszuk ki a mintát a Sewing Order/Lock 
ablakban.

2. Kattintsunk a  ikonra a Varrási jellemzők 
sávban.

Lásd a 47. oldalon a Layout&Editing 
munkaterület szakaszban.

3. Kattintsunk a kívánt színre.

→ Az objektum új színben jelenik meg a 
Sewing Order/Lock ablakban a 
tervezőfelületen.

Lásd a 95. oldalon a Színek szakaszban.

Ne feledjük:
A varrási sorrend módosítása után 
ellenőrizzük a sorrendet, hogy az egymást 
átfedő minták nehogy rossz sorrendben 
kerüljenek levarrásra.
118



Hímzési tervek kezelése (Layout & Editing)
H

ím
zési tervek kezelése (Layout &

 Editing)
Varrási jellemzők 
módosítása

Az elemek öltéstípusa minden egyes színnél külön 
beállítható.

1. Válasszuk ki a mintát a Sewing Order/Lock 
(varrási sorrend/lezárás) ablakban.

2. Kattintsunk a Sew > Sewing Attribute 
Setting (varrási jellemzők) pontra.

Lásd a 47. oldalon a Layout&Editing 
munkaterület szakaszban.

→ A Sewing Attribute Setting ablak jelenik 
meg.

3. Módosítsuk az öltéstípust.

Lásd a 96. oldalon az Öltéstípus és 
Varrási jellemzők megadása szakaszt.

Hímzési minta lezárása

Hímzési minta lezárható, így véletlenül sem 
törölhetjük ki, helyezhetjük át. A lezárt mintát nem is 
tudjuk kiválasztani, nem tudjuk szerkeszteni sem.

1. Válasszuk ki a mintát a Sewing Order/Lock 
ablakban.

2. Kattintsunk a  ikonra.

→  szimbólum jelenik meg a keret alján

→ A mintát lezártuk.

A hímzési minta feloldásához válasszuk ki a 

keretet, majd kattintsunk újra a  ikonra.

Ne feledjük:

• A  jelzésű keretek több, azonos színű 
mintát is tartalmaznak. Ha ilyen keretet 
zárunk le, az összes, a kerethez tartozó 
minta lezárásra kerül.

• Egy körvonal vagy felület vonalas vagy 
felületi mintáját lezárva a teljes hímzési 
mintát lezárjuk.

• Az összekapcsolt minta bármely részét 
lezárva, pl. csoportba foglalt mintákon belül 
egy mintát, vagy görbére írt feliratot, esetleg 
lyukvarrásra állított mintát lezárva a teljes 
hímzési mintát lezárjuk.
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Képi adatok betöltése
Képi adat szolgálhat hímzési mintává való átalakításhoz, sablonként kézi körberajzoláshoz, vagy mintaként, 
melyet vasalható transzferfóliára nyomtathatunk.

Képet a következő négy módszer egyikével tölthetünk be.
1 Fájlból
2 Szkennerből, digitális kamerából
3 Arckép képből
4 Vágólapról

Kép/fotó betöltése fájlból

Többféle clip art és fotók tölthető be a szoftverbe 
hímzési minta kialakításához. Számos különböző 
fájlformátum tölthetők be.

Lásd a 19. oldalon a Képi fájlformátumok 
szakaszt.

1. Kattintsunk az Image > Input (bevitel) > from 
File (fájlból) menüpontra.

2. Válasszuk ki a meghajtót, a mappát és a 
kívánt fájlt.

3. Kattintsunk az Open gombra a fájl 
megnyitásához.

→ A kép megjelenik a munkaterületen.

Képi adatok betöltése 
szkennerből, kamerából

Képi adatok szkennerből vagy egyéb TWAIN 
kompatibilis eszközből is betölthetők, és hímzési 
mintákhoz ugyanúgy sablonként alkalmazhatók.

1. Csatlakoztassuk a szkennert vagy egyéb 
TWAIN-kompatibilis készüléket a 
számítógéphez. 

2. Kattintsunk az Image > Select TWAIN Device 
(TWAIN-készülék kiválasztása) pontra.

3. A Sources (adatforrás) listában kattintsunk a 
kívánt eszközre.

4. Kattintsunk a Select gombra a kiválasztás 
jóváhagyásához, majd zárjuk be az ablakot.

5. Kattintsunk az Image > Input > from TWAIN 
device készülékekre.

→ A kiválasztott készülék kezelőablak 
megjelenik.

Megjegyzés:
Egyetlen képet tölthetünk be a munkaterületre. Ha egy másik képet próbálunk megjeleníteni, az előző kép 
eltűnik.

Ne feledjük:
Amennyiben a Preview kapcsolót 
kiválasztjuk, a kiválasztott fájl tartalma 
megjelenik a Preview ablakban.

Ne feledjük:
A ClipArt mappában többféle clip art grafikát, 
ábrát találunk. Kattintsunk a meghajtóra, 
ahova a PE-DESIGN szoftvert telepítettük, 
majd a Program Files pontra, ezután a 
Brother > PE-DESIGN 8 > ClipArt 
mappákra.

Ne feledjük:
TWAIN egy szabványos csatlakozási felület 
(API), amely szoftverek számára szkennerek, 
egyéb eszközök kezelését teszik lehetővé.

Megjegyzés:
Ha nincs TWAIN-készülék telepítve, üres 
lesz a Sources lista. Először telepítsük a 
TWAIN-készülék driver szoftverét.
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6. Adjuk meg a szükséges beállításokat a kép 
beolvasásához, majd töltsük be a képet.

→ Amikor a szkenner és a driver között 
véget ér az adatátvitel, a beolvasott kép 
betöltésre kerül a tervezőfelületre az 
eredeti méretben.

Arkcép létrehozása

Az alkalmazás rendelkezik egy arckép alkotására 
szolgáló funkcióval.

1. Kattintsunk az Image > Input > from Portrait 
pontra.

2. A Facial Feature (arckép alkotó) ablakban 
válasszuk ki az arc kontúrvonalát: ez lehet 
keskeny, széles, gyerekes vonású stb.)

3. A Part (részlet) pont alatt az arcot részeként 
módosíthatjuk.

4. A Part Variation (variációk) csúszkával 
változtathunk az adott részleten.

5. Egy elem állításához (pl. normál méretű, 
kicsivel nagyobb, kicsivel kisebb, szélesebb, 
hosszabb stb.) húzzuk el a Part Feature 
(elem állítása) csúszkát, amennyiben a 
funkció elérhető.

6. Elem színének állításához kattintsunk a Color 
fülre, kattintsunk a szín kiválasztón, majd 
jelöljük ki a kívánt színt a megjelenő listából.

7. Kattintsunk az OK-n.

→ Az arckép megjelenik a tervezőfelületen.

Megjegyzés:
A készülék kezelőfelületének használatáról a 
készülék használati útmutatójából 
tájékozódjunk, vagy a kezelőfelület 
gyártójához forduljunk.

Ne feledjük:
A portré módosítani kívánt része a nézőképen 
kattintással is kijelölhető.

Ne feledjük:
• A két oldal együttes módosításához, pl. a 

szemeknél, kattintsunk a Change Left and 
Right (bal és jobb oldalt is módosít) 
kapcsolóra.

• Az összes variáció együttes megjele-

nítéséhez kattintsunk a  ikonra.

• A variációk teljes arccal történő 
kirajzolásához kattintsunk a Display 
With Other Parts (teljes arccal) 
kapcsolóra a Part Variations List 
(rész variációk) ablakban.

• Válasszuk ki a kívánt formát, majd 
kattintsunk az OK-ra.
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Kép betöltése a vágólapról

Képi adatok betöltése a tervezőfelületre a 
vágólapról. Így anélkül tölthetünk be képet, hogy 
először elmentenénk.

1. Kattintsunk az Image > Input > from 
Clipboard vágólapra.

→ A kép megjelenik a tervezőfelületen.

Megjegyzés:
Csak akkor működik a művelet, ha képi adat 
van a Vágólapra felmásolva.

Ne feledjük:
A kép 100 dpi-s függőleges és vízszintes 
felbontással jelenik meg.
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Képi beállítások módosítása
Háttérkép állítása

A munkafelületre töltött kép megjeleníthető, 
elrejthető, vagy egy kisebb fedettségű, halványított 
változata megjeleníthető.

1. Kattintsunk az Image > Display Image 
pontra, majd válasszuk ki a kívánt beállítást.

• A kép normál megjelenítéséhez kattintsunk az 
On (100%) pontra.

• A kép halványított megjelenítéséhez válasszunk 
a 75%, 50% vagy 25% pontok között.

• A kép elrejtéséhez kattintsunk az Off-ra.

Kép méretének, szögének, 
helyzetének állítása

A méret, szög és helyzet állítható.

1. Kattintsunk az Image > Modify (módosít) 
pontra.

→ Piros vonal és fogantyúk jelennek meg a 
kép körül.

Kép áthelyezése:

1. Vigyük a mutatót a kép fölé.

2. Húzzuk a képet a kívánt helyre.

Kép méretezése:

1. Vigyük a mutatót a fogantyúk fölé.

2. Húzzuk a fogantyút a kép méretezéséhez.

Kép forgatása:
A kép 90 fokonként forgatható el.

1. Kattintsunk az Image > Rotate pontra, majd 
válasszunk a 90 Degrees Clockwise (90 
fokkal az óramutató irányába) vagy 90 
Degrees Counterclockwise (90 fokkal az 
óramutatóval ellentétes irányba) pontra.

→ A kép a megadott irányba elfordul.

Kép törlése:

1. Nyomjuk le a  gombot, kattintsunk az 
Edit > Delete pontra.

→ A kép törlődik a tervezőfelületen.

Ne feledjük:
Nyomjuk le a  funkcióbillentyűt a normál 
(On) megjelenítés és a halványított változatok 
(75%, 50% és 25%), valamint az elrejtés (off) 
közötti váltáshoz.

Ne feledjük:
Az állapotsor mutatja a méreteket (szélesség 
és magasság).

F6

Ne feledjük:
A  gombot nyomva tartva a fogantyú 
húzása közben, a kép nagyítása, kicsinyítése 
a középpontból történik.

Shift

Delete
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Képi adat mentése

A kép fájlként is elmenthető vagy a Vágólapra 
kimásolható.

Fájl mentése
1. Kattintsunk az Image > Output > to File 

(fájlba mentés) pontra. 

2. Válasszuk ki a meghajtót, mappát, és a 
formátumot, melyben a képet menteni 
kívánjuk.

3. Gépeljük be a fájl nevét.

4. Kattintsunk a Save (mentés) pontra.

Kimásolás a Vágólapra
1. Kattintsunk az Image > Output > to 

Clipboard pontra.

→ A tervezőfelületen lévő képi adat 
vágólapra másolható.

Ne feledjük:
A képi adat a következő formátumokban 
menthető: Windows bitmap (.bmp), Exif (.jpg).
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Kép automatikus átalakítása hímzési 
mintává („Képből öltés” varázsló)
Az „Image to Stitch varázsló” lépésről lépésre vezet végig a hímzési minta képpé alakításához.

Eszköztár ikon: 

1. Ha nincs kép a tervezőfelületen, az Image 
menü Input almenüjében található valamely 
paranccsal nyissunk meg egy képet.

Lásd a 120. oldalon a Képi adatok 
betöltése szakaszt.

2. Kattintsunk az Image > Modify pontra, majd 
méretezzük és helyezzük át a képet tetszés 
szerint.

3. Kattintsunk a  ikonra, majd kattintsunk 

az Image > Image to Stitch Wizard pontra.

→ Az alábbi ablak jelenik meg:

1 Aktuális kép
2 Hímzési mintává átalakítás után
3 Létrehozandó hímzési minta típusa
4 Kiválasztott hímzéstípus leírása

4. Válasszuk ki a hímzés típusát, majd 
kattintsunk a Next (tovább) gombra.

Auto Punch:
Ez a funkció automatikusan leképezi a képben 
szereplő körvonalakat, és ezeket hímzési 

mintává alakítja, lásd lejjebb).

Photo Stitch 1:
Valósághű, képszerű hímzési mintát hoz létre. 
Színes (color), szépia vagy szürkeárnyalatos 
(sepia) vagy fekete-fehér (mono) hímzési 
mintát hozhatunk létre.
Lásd a Photo Stitch 1 (color) esetén, Photo 
Stitch 1 (sepia) esetén, Photo Stitch 1 
(mono) esetén szakaszokat.

Photo Stitch 2:
Négy (color) vagy egy (mono) színből álló 
fotórealisztikus hímzési mintát hoz létre. 
Lásd a Photo Stitch 2 (color) esetén, Photo 
Stitch 2 (mono) esetén szakaszokat.

Cross Stitch (keresztöltés):
Keresztöltéses mintát hoz létre. Színes 
(color), szépia vagy szürkeárnyalatos 
(grayscale) hímzési minta közül 
választhatunk.

Lásd a Cross Stitch (color) esetén, Cross 
Stitch (sepia) esetén szakaszokat.

Design Center:
A Design Center galériát indítjuk el.
(Lásd a Design Center esetén szakaszt.)

Megjegyzés:
Az ablak nem jelenik meg, amennyiben a 
tervezőfelületen nem szerepel kép. Ehelyett 
egy másik ablak jelenik meg, amelyben 
megnyithatjuk a képet.

3

4

1

2

Ne feledjük:
A következő jellegű képek alkalmasak 
hímzési mintává alakításhoz:

Auto Punch/Cross Stitch/Design Center
• Képek kevés és jól elváló színekkel

Photo Stitch
• Fotók, melyeken a hímzendő elem jól 

elkülönül, kiválik a háttérből
• Arcképeket úgy méretezzünk, hogy az 

legalább 100 × 100 mm legyen.
• Éles és világos felvételek
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Kép automatikus átalakítása hímzési 
mintává (Auto Punch)

Külön bemutatóanyag ismerteti az alapműveleteket.

Lásd a 20. oldalon az Auto Punch funkció 
szakaszt.

IAuto Punch funkció esetén
1. Adjuk meg a kívánt beállításokat.

A kép kielemzésével létrejövő forráskép a 
Result View (eredmény megtekintése) 
nézőkép ablakában látható. A hímzési minta 
ezen kép alapján fog elkészülni.

A nagyítási arányt a  és ikonok közötti 
csúszka mozgatásával állíthatjuk.

A következő csúszkákkal a képi elemzést 
szabályozhatjuk:

Noise reduction: A képen szereplő zajszint 
eltávolításának küszöbértéke.
Segmentation sensitivity: A képi elemzés 
érzékenysége.
Max. Number of Colors: A felhasználható 
színek száma.

A Thread Chart kiválasztóban adjuk meg a 
kívánt fonalszín készletet. Egyéni fonalszín 
készlet is kiválasztható,

Az eredeti kép megjelenítéséhez kattintsunk 
az Original View (eredeti nézet) fülre.

Tekintsük meg az eredményként létrejövő 
képet, ha ez megfelelő, folytassuk a 6. lépést.

Felületek vonalakká alakításához vagy a 
levarrandó felületek módosításához 
folytassuk a 2. lépéssel.

2. A felületek vonallá alakításához kattintsunk a 
Create Lines pontra.

3. Kattintsunk a vonalakká alakítani kívánt 
területekre.

4. Kattintsunk az OK-ra.

→ Az átalakított képek vékony vonalakként 
jelennek meg.

5. A Result View fülben kijelölhetjük, hogy mely 
területek kerüljenek levarrásra, és mely 
területek maradjanak ki a levarrásból.

Ezenfelül kiválaszthatjuk, hogy a vonalakká 
alakított felületek levarrásra kerüljenek, vagy 
kimaradjanak a varrásból.

Ne feledjük:
Beállítások módosítása után kattintsunk a 
Retry gombbal az új beállítások hatásának 
megtekintéséhez. Ha a Retry gombra nem 
kattintunk, az új beállítások nem kerülnek 
végrehajtásra.

Ne feledjük:
Adott színű felületek együttes 
kiválasztásához kattintsunk a Colors pont 
alatti színre: az „ ×” jelzés eltűnik.

Ne feledjük:
A levarrásra nem kerülő felületeket átlós 
rácsháló jelöli, a varrásból kimaradó 
vonalakat pontozott vonal jelöli.

Ezen felületek 
nem kerülnek 
levarrásra
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6. Miután megadtuk a kívánt beállításokat, 
kattintsunk a Finish (befejez) gombra.

→ Egy hímzési minta jön létre a kép 
kielemzése alapján, a megadott 
fonalszínekkel, öltéstípusokkal, amely 
megjelenik a tervezőfelületen.

→ A kép automatikusan eltűnik a 
képernyőről.

Kép automatikus átalakítása hímzési 
mintává (Photo Stitch 1/Photo Stitch 2)
Photo Stitch 1 (Color) esetén

Külön bemutatóanyag ismerteti az alapműveleteket.

Lásd a 24. oldalon a Photo Stitch funkció 
szakaszt.

1. Az ablak bal oldalán szereplő listában 
válasszuk ki a kívánt alakot, amelyre a képet 
vágni szeretnénk (maszkolás).

2. A kép nézőképén húzzuk a maszk körüli 
foganyúkat úgy, hogy a maszk körülfogja a 
kép megtartani kívánt részét.

A minta szerkesztése kör alakú maszkkal 
történik.

Ne feledjük:
• Ha szükséges, az Omit Region Colors 

(kihagyandó felületi színek) lista és az Omit 
Line Colors (kihagyandó vonalas színek) 
lista szolgál a kimaradó és levarrni kívánt 
színek kijelölésére.

• Egy adott szín kikapcsolásával az ezen 
színnel kitöltött felület levarrását is 
kiiktatjuk.

• Az áthúzott színek nem kerülnek levarrásra.

Ne feledjük:
A létrejövő hímzési minta a többi mintához 
hasonló módon utólag módosítható.

Ne feledjük:
• A kép állítására szolgáló Image Tune ablak 

megjelenítéséhez kattintsunk az Image 
Tune gombra.

• A kép nagyításához, kicsinyítéséhez 
húzzuk a mutatót a ZOOM csúszkán.

• Maszk alakjának szerkesztéséhez 

válasszuk ki a  ikont, majd helyezzük 
át, töröljük, bővítsük a maszkot alkotó 
pontokat. Pont hozzáadásához 
kattintsunk a maszk körvonalán kívül, 
törléshez jelöljük ki az adott pontot, majd 
nyomjuk le a  gombot. 

• Az Auto Generate pontra kattintva és az 

 ikonra a kép körvonalának 
leképzésével jön létre a maszk. 

• Egyszínű háttér esetén kattintsunk az Auto 
Generate pontra a kép körvonalának 
automatikus leképzéséhez. A körvonal 
állítható a pontok áthelyezésével, 
szerkesztésével.

Delete
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A minta szerkesztése tetszőleges alakítású 
maszkkal történik.

3. A Select Mask (maszk kiválasztó) ablakban 
kattintsunk a Next (tovább) gombra.

4. Állítsuk be a kép méretét, helyzetét.

• Húzzuk a képet kívánt helyre.

• Húzzuk a fogantyút a kép méretének 
állításához.

• A létrehozni kívánt hímzési minta mérete 
az ablak bal-alsó sarkában megtekinthető.

5. Kattintsunk a Next gombra.

6. Adjuk meg a hímzési minta beállításait.

Lásd a 131. oldalon a Varrási beállítások 
és Szín beállítások szakaszokat.

A variációk közüli választáshoz lásd a 26. 
oldalon a  lépést.

Megjegyzés:
Ha az eredeti kép túl kicsi, előfordulhat , 
hogy a maszk méretét nem tudjuk 
csökkenteni.

Ne feledjük:
Image Tune (kép hangolása)
• A Select Mask ablakban kattintsunk az 

Image Tune gombra az Image Tune 
(képhangoló) ablak megnyitásához.

• Húzzuk el az Original – Sharp (eredeti - 
élesebb) csúszkát az élesség növeléséhez: 
a világos és sötét részek közötti 
határvonalak felerősödnek.

• Húzzuk el a Dark – Bright (sötét - világos) 
csúszkát a kép fényerejének állításához.

• Húzzuk el a Low – High Contrast (kis - 
nagy kontraszt) csúszkát a kontraszt 
állításához.

Ne feledjük:
Kattintsunk a Fit to Page gombra a maszknak 
a tervezőfelület méretére igazításához.

Hímzési 
minta 
mérete

7
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7. A Photo Stitch 1 Parameters (photo stitch 1 
beállítások) ablakban kattintsunk az Update 
Preview pontra.

→ A nézőkép frissítésre kerül.

8. Kattintsunk a Finish (befejez) pontra.

→ A hímzési minta megjelenik a 
tervezőfelületen. 

→ A kép automatikus eltűnik a képernyőről.

Photo Stitch 1 (Sepia) esetén
A funkció használata alapvetően megegyezik a 
Photo Stitch 1 (Color) funkció használatával.

1. Az ablak bal oldalán szereplő listában 
válasszuk ki a kívánt alakot, amelyre a képet 
vágni szeretnénk (maszkolás)

2. A kép nézőképén húzzuk a maszk körüli 
foganyúkat úgy, hogy a maszk körülfogja a 
kép megtartani kívánt részét.

Lásd a 127. oldalon a 2. lépést.

3. Kattintsunk a Sepia (szépia) vagy Gray 
(szürkeárnyalatos) pontokra a színárnyalat 
kiválasztásához.

4. Kattintsunk a Next (tovább) gombra.

5. Állítsuk be a kép méretét, helyzetét.

Lásd a 128. oldalon a 4. lépést.

6. Kattintsunk a Next (tovább) gombra.

7. Adjuk meg a hímzési minta beállításait.

Lásd a 131. oldalon a Varrási beállítások 
és Szín beállítások szakaszokat.

8. Kattintsunk a Update Preview (nézőkép 
frissítése) pontra. 

→ A nézőkép frissítésre kerül.

9. Kattintsunk a Finish (befejez) pontra.

→ A hímzési minta létrejön és megjelenik a 
tervezőfelületen.

→ A kép automatikusan eltűnik a 
képernyőről.
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Photo Stitch 1 (Mono) esetén
A funkció használata alapvetően megegyezik a 
Photo Stitch 1 (Color) funkció használatával.

1. Az ablak bal oldalán szereplő listában 
válasszuk ki a kívánt alakot, amelyre a képet 
vágni szeretnénk (maszkolás).

2. A kép nézőképén húzzuk a maszk körüli 
foganyúkat úgy, hogy a maszk körülfogja a 
kép megtartani kívánt részét.

Lásd a 127. oldalon a 2. lépést.

3. Kattintsunk a Next (tovább) gombra.

4. Állítsuk be a kép méretét, helyzetét.

Lásd a 128. oldalon a 4. lépést.

5. A csúszkával határozzuk meg, hogy a kép 
mely részletei kerüljenek mintává alakításra.

6. Kattintsunk a Next (tovább) gombra.

7. Adjuk meg a hímzési minta beállításait.

Lásd a 131. oldalon a Varrási beállítások 
és Szín beállítások szakaszokat.

8. Kattintsunk a Update Preview (nézőkép 
frissítése) pontra. 

→ A nézőkép frissítésre kerül.

9. Kattintsunk a Finish (befejez) pontra.

→ A hímzési minta létrejön és megjelenik a 
tervezőfelületen.

→ A kép automatikusan eltűnik a 
képernyőről.
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Varrási beállítások Szín beállítások

Detail 
(részle-
tesség)

A minta részletességét szabályozza. 
A Fine beállítás nagyobb 
részletgazdagságot ad, és nagyobb 
öltésszámot (az öltések között átfedés 
lesz).

Run Pitch 
(öltéshossz)

Az öltés hosszát, nyújtását állítja. 
Kisebb érték esetén az öltés rövidül, 
szebb, finomabb képet ad.

Sew Page 
Color
(hordozó szn 
varrása - 
csak Color 
és Sepia 
módban)

Ha a kapcsoló kiválasztásra kerül, a 
minta azon részletei, melyek színe 
megegyezik a tervezőfelület színével, 
levarrásra kerülnek. Töröljük a 
kapcsolót, ha a tervezőfelület színét 
nem kívánjuk levarrni.

Conversion 
Priority 
(átalakítási 
sorrend)

Az átalakítás minőségi beállításai:
Stitch Quality (öltés minőség): A minta 
létrehozásakor az öltések minősége áll 
az első helyen. Azonban sok ugró öltés 
lesz a hímzésben.
Jump Stitch Reduction (ugró öltés 
csökkentése): A minta létrehozásakor a 
cél, hogy a legkevesebb ugró öltés 
szerepeljen a hímzés megkönnyítése 
érdekében. Ennek némileg a hímzés 
minősége láthatja kárát.

Image Type 
(kép típusa)

Ha a Photo (fotó) típust választjuk, a 
fonalszínek keveredni fognak, ez 
természetesebb hatást eredményez.
Ha a Cartoon (rajz) típust választjuk, a 
fonalszínek nem keverednek, 
egyszerűsített színvilággal jelenik meg 
a minta.
Photo-t fényképhez válasszuk, 
Cartoon ábrákhoz, grafikákhoz.

Color/Sepia (színes/szépia)

Auto Select 
(automatikus 
kiválasztás)

A fonalszínek kiválasztása 
automatikusan történik. Alapbeállítás 
szerint ez a kapcsoló van kijelölve. A 
pipa kivételekor kézzel kell megadnunk 
a színeket.

Manual 
Select (lásd 
alább)

Az Auto Select kapcsolóból a pipát 
kivéve jelenik meg. A Manual Select 
gombra kattintva megadhatjuk a 
használható fonalszíneket (lásd alább).

Thread Chart 
(fonal-lista)

Az Auto Select (lásd fent) funkció által 
felhasználható színkészletet adhatjuk 
meg. A funkció ezen készleből válogat a 
a leginkább megfelelő színek 
kikeresésekor. 
Egyedi fonal színkészlet is kijelölhető.

Max. Number 
of Colors 
(színek max. 
száma)

Adjuk meg az Auto Select funkció által 
kiválasztható színek maximális számát.

Mono

Change 
Color 
(színcsere)

A Change Color gombra kattintva a 
Thread Color (fonalszín) ablak jelenik 
meg, ahol a fotó öltés (photo stitching) 
színét állíthatjuk. A levarrni kívánt fonal 
márkáját, gyártóját is lecserélhetjük. 
Válasszuk ki a kívánt színt, és 
kattintsunk az OK-ra.

Color/Sepia/Mono (színes/szépia/egyszínű)

Fényerő / 
kontraszt

A fényerőt a legfelső csúszkával 
állíthatjuk. Húzzuk a csúszkát jobbra a 
fényerő növeléséhez, balra a 
csökkentéséhez. Az alsó csúszka a 
kontrasztot állítja, jobbra növeljük, balra 
csökkentjük az erősséget. Az Update 
Preview gombra kattintva láthatjuk a 
módosításokat.

Select from 
Candidates 
(variációk)

A Select from Candidates ablak eltérő 
fényerővel és kontraszt beállításokkal 
rendelkező variációkat jelenít meg. 
Kattintsunk a tetszetős variációra, majd 
az OK-ra a megfelelő beállítások 
végrehajtásához, és nézőkép 
megtekintéséhez.

Update 
Preview 
(nézőkép)

A módosított kép előzetes megtekintése 
a beállítások módosítását követően.
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Photo Stitch 2 (Color) esetén
1. Az ablak bal oldalán szereplő listában 

válasszuk ki a kívánt alakot, amelyre a képet 
vágni szeretnénk (maszkolás).

2. A kép nézőképén húzzuk a maszk körüli 
foganyúkat úgy, hogy a maszk körülfogja a 
kép megtartani kívánt részét.

Lásd a 127. oldalon a 2. lépést.

3. Kattintsunk a Next (tovább) gombra.

4. Méretezzük, igazítsuk helyére a mintát.

Lásd a 128. oldalon a 4. lépést.

5. Kattintsunk a Next (tovább) gombra.

6. Adjuk meg a hímzési minta beállításait.

Lásd a 133. és 134. oldalon a Varrási 
beállítások és Szín beállítások 
szakaszokat.

7. Kattintsunk az Update Preview gombra.

→ A nézőkép frissítésre kerül.

8. Kattintsunk a Finish (befejez) pontra.

→ A hímzési minta létrejön és megjelenik a 
tervezőfelületen.

→ A kép automatikusan eltűnik a 
képernyőről.

Ne feledjük:
A Manual Select (kézi kiválasztás) ablak 
tudnivalói:

• A Color List sorban kiválasztott szín 
hozzáadásához a Use Color List 
(felhasználható színek) sorba, kattintsunk 
az Add (hozzáad) gombra.

• Szín törléséhez a Use Color List 
(felhasználható színek) sorból, kattintsunk 
a Remove pontra.

• A listákban a színek a legvilágosabbtól 
indulnak. Ez a sorrend a levarrási sorrend, 
és nem módosítható.

• A Use Color List (felhasználható színek) 
sor legfeljebb 50 színt tartalmazhat.

• A Use Color List (felhasználható színek) 
sorban szereplő színek nem jelennek meg 
a Color List sorban.

• Több szín kijelöléséhez tartsuk lenyomva 
 gombot, (szomszédos színek 

kijelöléséhez), vagy nem egymás mellett 
álló színek esetében a gombot, majd 
kattintsunk a kívánt színekre.

Shift

Ctrl
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Photo Stitch 2 (Mono) esetén
1. Az ablak bal oldalán szereplő listában 

válasszuk ki a kívánt alakot, amelyre a képet 
vágni szeretnénk (maszkolás).

2. A kép nézőképén húzzuk a maszk körüli 
foganyúkat úgy, hogy a maszk körülfogja a 
kép megtartani kívánt részét.

Lásd a 127. oldalon a 2. lépést.

3. Kattintsunk a Next (tovább) gombra.

4. Méretezzük, igazítsuk helyére a mintát.

Lásd a 128. oldalon a 4. lépést.

5. Húzzuk el a csúszkát az átalakítandó 
részletek kiválasztásához.

6. Kattintsunk a Next (tovább) gombra.

7. Adjuk meg a hímzési minta beállításait.

Lásd a 133. és 134. oldalon a Varrási 
beállítások és Szín beállítások 
szakaszokat.

8. Kattintsunk a Update Preview gombra.

→ A nézőkép frissítésre kerül.

9. Kattintsunk a Finish (befejez) pontra.

→ A hímzési minta létrejön és megjelenik a 
tervezőfelületen.

→ A kép automatikusan eltűnik a 
képernyőről.

Varrási beállítások

Line interval 
(sorköz)

Megadhajtuk a párhuzamos sorok 
közötti távolságot . 

Max. Density
(max. 
sűrűség)

A cikkcakk öltéssel levarrt területek 
legnagyobb öltési sűrűsége. A minta az 
itt beállíott sűrűségnél kisebbel kerül 
levarrásra.

sorköz
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Szín beállítások
Kép automatikus átalakítása hímzési 
mintává keresztöltéssel(Cross Stitch)

Külön bemutatóanyag ismerteti az alapműveleteket.

Lásd a 27. oldalon a Cross Stitch funkció 
szakaszt.

Cross Stitch (Color) esetén
1. Az ablakban megjelenő képen kattintsunk az 

egyes területeken: eldönthetjük, hogy az adott 
terület levarrásra kerüljön, vagy kimaradjon a 
varrásból.

2. Ha szükséges, az Omit Colors listában minden 
egyes színnél megadhatjuk, hogy le kívánjuk-e 
varrni, vagy sem.

Color (színes)
Thread Chart 
(fonal 
készlet)

Kiválaszthatjuk a használni kívánt fonal 
márkákat, gyártókat. Egyéni fonal 
készletet is megadhatunk.

Color Set

Az Auto Select mód esetén a legjobb 
közelítést adó négy szín kerül 
automatikus kizárásra. Más beállítással 
befolyásolhatjuk a négy szín 
kiválasztását. A választási lehetőségek: 
cyan (C - cián), magenta (M - bíbor), 
yellow (Y - sárga), black (K - fekete), red 
(R - piros), green (G - zöld) és blue (B - 
kék). Az alábbi színkombinációk közül 
válasszuk a képet legjobban 
megközelítőt: CMYK, RGBK, CRYK, 
BMYK

Thread 
Colors Used 
(felhasznált 
fonalszín)

Megjeleníti a négy kiválasztott 
fonalszínt.

Change 
Color (szín- 
csere)

A Thread Colors Used (használt 
fonalszínek) listában kattintsunk a 
lecserélni kívánt színre, majd a Change 
Color gombra. A megjelenő ablakban 
válasszuk ki az új színt, majd OK. A 
Photo Stitch 2 Parameters ablakban a 
nézőképben láthatjuk, hogy a képen a 
korábbi szín eltűnik, helyette az új szín 
lesz látható.

Mono

Change 
Color 
(színcsere)

A Change Color gombbal 
lecserélhetjük az öltés színét. A fonal 
márkáját is lecserélhetjük. Válasszuk ki 
a színt, majd kattintsunk az OK-ra.

Color/Mono (színes/mono)

Brightness / 
Contrast 
(fényerő/
kontraszt)

A fényerőt a legfelső csúszkával 
állíthatjuk. Húzzuk a csúszkát jobbra a 
fényerő növeléséhez, balra a 
csökkentéséhez. Az alsó csúszka a 
kontrasztot állítja, jobbra növeljük, balra 
csökkentjük az erősséget. Az Update 
Preview gombra kattintva láthatjuk a 
módosításokat.

Update 
Preview

A módosított kép előzetes megtekintése 
a beállítások módosítását követően.

Ne feledjük:
• A le nem varrandó részeket keresztirányú 

rácsminta jelöli.

• A nagyításhoz, kicsinyítéshez húzzuk a 

csúszkát a  és  ikon között.

Nem levarrandó 
részek.
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3. Adjuk meg a hímzési minta tulajdonságait.

4. Kattintsunk a Next gombra.

→ A Keresztöltés ablak jelenik meg.

5. Ha szükséges, módosítsuk az öltéseket.

1) Válasszuk ki a hozzáadni/törölni kívánt 
öltésket: a  ikonra kattintva 
keresztöltést rendelünk az adott mezőhöz.

2)
 (fonáköltés): a mezőn belül (  vagy 

 ) vagy a mező szélén (  vagy ) 
fonáköltést hajt végre.

3) Fonalszín kijelölése
Az éppen kiválasztott fonalszín megjelenik 
a Color Option beállításnál.
A szín cseréjéhez kattintsunk a Change 
Color gombra: a megjelenő ablakban 
jelöljük ki az új színt. 
Az öltéshez használatos szín kijelöléséhez 
kattintsunk a  ikonra, majd 
kattintsunk az öltésre, amelyet ezzel a 
színnel kívánunk levarrni.

4) Kattintás/húzás öltés hozzáadásához, 
törléséhez:
♦ Keresztöltéshez

Kattintsunk egy mezőre: öltést 
rendelünk a mezőhöz.

♦ Fonáköltéshez
Kattintsunk a mező szélére: egy öltést 
rendel a széléhez.
Átlós vonal bekattintása a mezőbe: az 
átlón egy öltést visz fel.

♦ Fonáköltéshez és keresztöltéshez 
együtt:
Húzzuk a mutatót: Öltéssorozatot adunk 
a mezőkhöz.
Jobb oldali egérgombbal kattintás/húzás 
a jobb egérgombbal: törlünk egy öltést/
sorban töröljük az öltéseket.

6. A Cross Stitch Times (keresztöltések 
száma) és Backstitch Times (fonáköltések 
száma) pontok alatt adjuk meg, hogy az 
öltések hány alkalommal kerüljenek 
levarrásra.

7. Az egyes öltések levarrásának ismétlési 
száma: Single (1), Double (2), vagy Triple 
(3).

8. Miután megadtuk a kívánt beállításokat, 
kattintsunk a Befejez gombra.

→ A keresztöltéses minta megjelenik a 
tervezőfelületen.

→ A kép automatikusan elrejtésre kerül.

Ne feledjük:
Az áthúzott színek nem kerülnek levarrásra.

Kereszt 
mérete

Adjuk meg a minta vízszintes és 
függőleges méretét.

Thread Chart 
(fonal- 
készlet)

A keresztöltéseknél használt fonal 
márkájának megadása. Egyedi 
készletet is kiválaszthatunk. 
A készletből a legmegfelelőbb 
fonalszínek kerülnek kijelölésre.

Max. 
Number of 
Colors

Adjuk meg a mintában felhasználható 
színek maximális számát. 
A megadott értéknél több szín nem 
szerepel majd a létrejövő hímzési 
mintában.
A módosítások megtekintéséhez 
kattintsunk a Retry gombra. Megjegyzés:

Ha a Previous (előző) gombbal az előző 
ablakra ugrunk az öltések módosítása után, 
a módosított öltések visszaállnak korábbi 
állapotukba, a módosítások elvesznek.

Ne feledjük:
• A kép nagyított, kicsinyített 

megjelenítéséhez húzzuk el a csúszkát a 
ZOOM beállításnál.

• Sablon megjelenítéséhez kattintsunk a 
Display Template gombra.
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Cross Stitch (Sepia) esetén
1. Állítsuk be a kép fényerejét, kontrasztját.

A fényerőt a legfelső csúszkával állíthatjuk. 
Húzzuk a csúszkát jobbra a fényerő 
növeléséhez, balra a csökkentéséhez. Az 
alsó csúszka a kontrasztot állítja, jobbra 
növeljük, balra csökkentjük az erősséget. 

2. Kattintsunk a Sepia (szépia) vagy Gray 
(szürkeárnyalatos) gombra a színvilág 
kiválasztásához.

3. Kattintsunk a Next (tovább) gombra.

4. Adjuk meg a varrási jellemzőket és a hímzési 
minta beállításait.

5. Kattintsunk a Next (tovább) gombra.

6. Ha szükséges, módosítsuk az öltéseket.

7. Adjuk meg, hogy az öltések hány alkalommal 
kerüljenek levarrásra.

8. Miután megadtuk a kívánt beállításokat, 
kattintsunk a Finish (befejez) gombra.

→ A keresztöltéses minta megjelenik a 
tervezőfelületen.

A 4. lépéssel kezdődő műveletek 
megegyeznek a Cross Stitch (Color) mód 1. 
lépésével kezdődő műveletekkel.

Lásd a 134. oldalon a Cross Stitch (Color) 
opciónál.

Hímzési minták létrehozása kép 
alaján manuálisan (Design Center)

Design Center kijelölése
→ Design Center elindítását követően a 

tervezőfelületen megjelenik a betöltött 
kép.

Lásd a 153. oldalon a Hímzési minták 
létrehozása kép alapján manuálisan 
(Design Center) pontot.
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Appliqué - foltvarrás
(Applique varázsló)

Az Appliqué varázsló segítségével könnyedén 
készíthetünk foltvarrást.

Külön bemutatóanyag ismerteti az alapműveleteket.

Lásd a 174. oldalon az Appliqué 
létrehozása szakaszban.

1. Válasszunk egy zárt alakzatú mintát, pl. kört, 
négyzetet.

2. Kattintsunk a Sew > Applique Wizard 
(appliqué varázsló) pontra.

3. Az Applique Material (folt anyaga) a Yes 
(igen) és No (nem) gombokkal döntsük el, 
hogy a folt anyagára a folt körvonala 
levarrásra kerüljön-e a kivágás 
megkönnyítéséhez.

4. Az Applique Position a folt illesztéséhez 
varrja le a folt anyagát a hordozóra - ez mindig 
levarrásra kerül.

5. A Tack down pont alatt a Yes (igen) és No 
(nem) gombokkal döntsük el, hogy a folt 
fércelve legyen-e a hordozón. Amennyiben 
igen, válasszuk ki a fércelő öltést. 
Megadhatjuk, hogy szatén (gobelin), „E” vagy 
„V” öltés kerüljön-e alkalmazásra.

6. A Covering Stitch pont alatt megadhatjuk a 
befejező öltések típusát és egyéb jellemzőit.

7. Kattintsunk az OK-ra a varázsló bezárásához 
és a grafika megjelenítéséhez a 
tervezőfelületen.

Hímzési minta ellenőrzése

A hímzési jellemzők, méretek, tűszám, varrási idő, 
színek száma, minták színsorrendje mind-mind 
leellenőrizhető a Design Property ablakban.

1. Kattintsunk az Option > Design Property 
ablakban.

Ne feledjük:
• Egymást keresztező vonalú alakzatot nem 

választhatunk.
• Az appliqué készítésére kijelölt mint a 

varázsló használatát követően törlésre 
kerül.

Szatén E öltés V öltés

Megjegyzés:
A varrási idő csak becslés. A valós varrási 
idő a használt hímzőgép típusától és az 
egyéb beállításoktól is függ.

Ne feledjük:
• A hímzésen belül egy adott elemet ki is 

jelölhetünk az ablak megnyitása előtt. Ekkor 
csak a kijelölt elem adatait fogjuk látni.

• A hímzőgépen megjelenő formában is 
megjeleníthetjük a színeket: válasszuk a 
with Basic Color (alapszínekkel) 
kapcsolót.

• Ha a tervezőfelületen egyedi méretre 
(custom size) vagy keretméretre (hoop 
size) állítottuk több állású kerettel (100 x 
172 mm, 130 x 300 mm), és a tervező-
felületen nincs kijelölt elem, a varrási 
adatok is keretenként jelennek meg, és a 
Design Property ablak jelenik meg.
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Mentés és nyomtatás
Mentés

Felülírás
Amint elmentettük a képet és a grafikát, módosítást 
követően elmenthetjük az újabb változatot, hogy 
később ezt tudjuk újból behívni.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a File > Save 

pontra. 

→ Ha a képet vagy a tervet már egyszer 
korábban elmentettük, a fájl mentésre 
kerül.

→ Ha nem adtunk meg fájlnevet, vagy ez 
nem található, a Save As (mentés 
másképp) ablak jelenik meg.

Mentés új névvel
Az aktuális fájl másik néven is elmenthető, így az 
eredeti változtatás nélkül megőrizhető. Így különféle 
változatokat hozhatunk létre. A fájlok .pes 
kiterjesztés alatt jelennek meg.

1. Kattintsunk a File > Save As pontra.

2. Válasszuk ki a meghajtót és a mappát, majd 
gépeljük be a fájlnevet.

3. Kattintsunk a Save gombra az adatok 
mentéséhez.

→ Az új fájlnév megjelenik a Layout & 
Editing ablak címsorában.

Mentés eltérő fájlformátumban
A tervezőfelületen megjelenő adatok más 
szoftverek formátumaiban is elmenthetők: .dst, 
.hus, .exp, .pcs, .vip, .sew, .jef, .csd, .xxx, és .shv 
formátumokban.

1. Kattintsunk a File > Export pontokra.

2. Jelöljük ki a meghajtót és a mappát, majd 
gépeljük be a fájlnevet.

3. Válasszunk egy formátumot (.dst, .hus, .exp, 
.pcs, .vip, .sew, .jef, .csd, .xxx, vagy .shv 
formátumot) a fájl kimentéséhez.

Megjegyzés:
Ha előző szoftververziót választunk ki, mint 
fájl típus, a .pes fájlok a szoftver korábbi 
változataival is megnyithatók, azonban az 
összes mentett grafikából öltési minta lesz.

Ne feledjük:
DST formátum esetén kódok bevonásával 
szabályozatjuk, hogy az ugróöltések 
levarrásra kerüljenek-e vagy sem. Mivel a 
kódolásban alkalmazott számok hímző-
gépenként eltérhetnek, gépeljük be vagy 
válasszuk ki a megfelelő értéket a Number of 
jumps for trim mezőben. (A beállítás 
kizárólag .dst formátumban érhető el).

Megjegyzés:
• Egyes, hímzőkártyáról betöltött minták 

nem exportálhatók más formátumba.
• Egyedi méretű tervezőfelületen 

létrehozott minták sima fájlként 
mentődnek, nem kerülnek felosztásra 
blokkokra.
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Hímzési terv mentése 
adatkártyára

Az aktuális hímzési tervet adatkártyára is 
menthetjük, melyet a hímzőgépbe helyezve 
levarrhatjuk a tervet.

Eszközsáv ikon: 

1. Helyezzünk be egy adatkártyát az USB-
kártyaíró modulba.

Lásd a 17. oldalon, a Terv mentése 
adatkártyára szakaszban.

2. Kattintsunk a  ikonon vagy a File > 

Write to Card pontra.

→ A következő üzenet jelenik meg.

Ne feledjük:
Két vagy több fájl is menthető a kártyára, erről 
lásd a 194. oldalon a Hímzési tervek fájljainak 
mentése adatkártyara szakaszban.

Megjegyzés:
Fontos, hogy a terv keretmérete ne lépje túl 
a hímzőgépen majd valóban használatos 
keret méretét.

Megjegyzés:
Amennyiben az adatkártya már tartalmaz 
adatokat, ezek mind törlődnek a kártyáról. 
Mielőtt mentenénk a kártyára, mentsük ki az 
összes fontos adatot a merevlemezre vagy 
más adathordozóra, és ellenőrizzük, hogy 
csak felesleges, törölhető adat maradjon a 
kártyán. Lásd a Megnyitás adatkártyáról 
szakaszt a 49. oldalon.

Ne feledjük:
Az egyedi méretű tervezőfelületen létrehozott 
tervek a különböző blokkoknak megfelelő 
felosztásban kerülnek mentésre a kártyán.
Amennyiben a terv teljes mérete túllépi az 
adatkártya tárolókapacitását, vagy egyedi méretű 
tervezőfelületet alkalmaztunk (90 x 90 cm-es 
méretben), és több mint 80 blokkra van felosztva 
a grafika, fel kell osztanunk blokkokra a grafikát, 
és több kártyára kell kimentenünk. 
Ez esetben a Select Hoop Sections (blokkok 
kijelölése) ablak jelenik meg, amellyel 
kijelölhetjük, hogy mely blokkok kerüljenek az 
éppen behelyezett kártyára mentésre.

Az ablak tetején lévő jelzősáv mutatja a kártya 
szabad kapacitásának fogyását a blokkok 
kijelölése alatt. A kijelölt blokkok által felhasznált 
memóriaterület kék színnel jelenik meg. Ha a 
kijelölt blokkok már túllépik a kártya kapacitását, a 
sáv piros színre vált.
Kattintsunk az egyes blokkokra a kijelöléshez, 
majd kattintsunk a Write (ír) gombra a 
kiválasztott blokkok kártyára mentéséhez. (A 
Write gomb csak akkor jelenik meg, ha van 
kijelölt blokk és a kártyán lévő szabad tárhely 
elegendő a kijelölt blokk(ok) mentéséhez.
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3. Kattintsunk az OK-n.

→ A “Now transmitting” (adatátvitel 
folyamatban) üzenet látható, amikor terv 
a kártyára mentésre kerül, ezután a 
következő ablak lesz látható.

4. Kattintsunk az OK-ra az üzenet bezárásához.

A 138. oldalon olvashatunk a felülírásról 
és az új néven történő mentésről.

Megjegyzés hozzáfűzése a .pes 
fájlhoz

Megjegyzést, kiegészítő információt fűzhetünk a 
mentett .pes fájlhoz.

1. Kattintsunk a File > Property (tulajdonságok) 
pontra.

→ A File property ablak jelenik meg.

2. Gépeljük be az adatokat: design name - terv 
neve, category - kategória, author - szerző, 
keywords - kulcsszó, comment - megjegyzés.

3. Kattintsunk az OK-ra az adatok rögzítéséhez.

Varrási terület megadása

Varrás felület megadása.

1. Kattintsunk a Sew > Select Sewing Area 
(varrási felület kijelölése) pontra.

2. Válasszuk ki a kívánt varrási felületet (Design 
Page area - tervezőfelület vagy Use existing 
design area - maga a grafika).

3. Kattintsunk az OK-n.

→ A Design Page area (tervezőfelület) 
esetén a minták úgy kerülnek levarrásra, 
hogy a tű kezdeti állása a tervezőfelület 
középpontja lesz.

→ A Use existing design area esetén a 
minták úgy kerülnek levarrásra, hogy a tű 
állása a varrás kezdetekor az aktuális 
minták középpontjában lesz.

Megjegyzés:
• A megadott adatok a következő mentés 

alkalmával kerüljenek rögzítésre.
• A Design adatbázisban kereshetünk a 

megadott adatok után.

Ne feledjük:
A Design Page area kiválasztása esetén a 
minta mérete a teljes tervezőfelület méretével 
fog egyezni, emiatt a hímzőgép képernyőjén 
belül csak limitáltan mozoghatunk.

Ne feledjük:
A Use existing design area esetén a minta 
magára a grafikára szűkül, így a hímzőgépben 
történő igazításnál tágabbak a lehetőségek.
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Lásd a 68. oldalon a Tervezőfelület 
színének, méretének állítása.

Nyomtatás

Bemutatóanyag is segíti a nyomtatás és hímzés 
együttes alkalmazását.

Lásd a 42. oldalon a Nyomtatás és 
hímzés szakaszt.

Nyomtatási beállítások
Nyomtatás előtt a hímzési tervnek megfelelően 
módosítsuk a nyomtató beállításait.

1. Kattintsunk a File > Print Setup (nyomtató 
beállításai).

2. A Paper (papír) és Orientation (forgatás) 
pontok alatt adjuk meg a megfelelő 
beállításokat.

3. A hímzési minta kiválasztásához válasszuk a 
Embroidery print mode (hímzés nyomtatási 
mód) beállítást.

A Print type (nyomtatási típus), Print option 
(nyomtatási beállítás) és Stitch image 
(öltéskép) beállításoknál adjuk meg a 
nyomtatás módját.

Print type
Actual Size - valós méret: A terv valós 
méretben való nyomtatása, mellette külön 
oldalon az adatok: hímzési terv méretei, 
varrás színsorrendje, öltésszám, keret 
helyzete.

Reduced Size - csökkentett méret: A terv 
csökkentett méretben kerül nyomtatásra, a 
fenti adatok mind egy lapon megjelennek.

Design Page (tervezőfelület - a mi képernyőnkön)

Varrási felület = Design Page tervezőfelület

Varrási felület = Use existing design area - 
maga a grafika
141



Hímzési tervek kezelése (Layout & Editing)
Print option
Print image - kép nyomtatása: A tervező-
felületre betöltött kép nyomtatása a hímzési 
mintával együtt. A nyomtatási felületről lelógó 
képrészlet nem kerül nyomtatásra. 

Print sewing area box & center axes - 
varrási felület keret és középvonalak 
nyomtatása: Fekete vonalak jelölik a varrási 
felületet (lásd a 140. oldalon), és 
középvonalak segítik az igazítást. (Csak 
Actual Size - valós méret beállításnál aktív).

Print template grid - sablon rács 
nyomtatása: Zöld vonalak fogják jelezni a 
kerethez tartozó illesztőlapra nyomtatott 
rácsot. 

Print hoop section boundaries onto the 
first page - keret blokk határoló vonalainak 
nyomtatása az első lapra: Egyedi méretű 
vagy több állású keret méretre állított 
tervezőfelületnél a kinyomtatja a blokkok 
felosztását. A minta blokkjai piros színnel 
jelennek meg.

Divide embroidery image into 2 pages - 
hímzési terv felosztása két oldalra: A/4-nél 
nagyobb méretű terv valós méretű 
nyomtatásánál két lapra osztva nyomtatja ki a 
grafikát. (Csak Actual Size - valós méret - 
beállítás mellett és nagyobb méretű 
tervezőfelület esetén elérhető: 300 × 200 mm, 
200 × 300 mm, 180 × 300 mm keretméretnél, 
és 170 × 290 mm (180 × 300 mm), 290 × 190 
mm (300 × 200 mm) egyedi méretnél. A lapok 

alján a  /  vagy  / ikonok jelzik, 
hogy az adott lap melyik felét tartalmazza a 
grafikának.

Stitch image - Öltés kép
Normal: A terv vonalak és pontok formájában 
jelenik meg.

Realistic (valósághű): Valósághű képet 
nyomtat a tervről. Az Attributes gombbal 
módosíthatjuk a beállításokat.

Lásd a 65. oldalon a „Ne feledjük” 
szakaszt.

4. Amikor vasalható transzferfóliára vagy 
nyomtatható textíliára nyomtatunk, vagy 
amikor a hímzést a nyomtatott képre illesztő 
lapot nyomtatunk, válasszuk ki az Image print 
mode kapcsolót, és a Material pont alatt 
válasszuk ki a kívánt hordozót.

Material (anyag)
Print the image on printable fablic or an 
iron-on transfer sheet - kép nyomtatása 
transzferfóliára vagy nyomtatható 
textíliára - Kizárólag a kép kerül nyomtatásra.

Print a flipped image - tükrözött kép 
nyomtatása: Függőleges tengely mentén 
tükrözött kép nyomtatása. Transzferfóliára 
történő nyomtatáshoz a kép alapbeállítás 
szerint tükrözve kerül nyomtatásra.

Akkor válasszuk ezt a módot, ha a nyomtató 
nem rendelkezik tükrözött nyomtatás 
funkcióval. Részletesen lásd a nyomtatóhoz 
kapott dokumentációt.

Print a sheet of paper for aligning the 
printed image and the embroidery - 
illesztőlap nyomtatása a kép és a hímzés 
igazításához: Regiszterjelek és 
segédvonalak jelzik a képen a hímzés helyét.

Change Position- a papíron a kép 
helyzetének módosítása: A papírról lelógó 
képek nem kerülnek nyomtatásra. A gombra 
kattintva megjelenik egy ablak, melyben a 
lapon belül a kívánt helyre húzhatjuk a képet.

5. Kattintsunk az OK-ra.

Lásd a 65. oldalon a Hímzés 
nézőképének megtekintése szakaszt.

Megjegyzés:
Ha a Divide embroidery image into 2 pages 
kapcsolóból kivesszük a pipát, és nagyobb 
méretű papírra nyomtatunk, a terv nem két 
részletben fog kinyomtatódni. Ha kisebb 
méretű papírra nyomtatunk, a terv egy része 
lemaradhat.
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Nyomtatási kép ellenőrzése
A tervezőfelület tartalmának megtekintése.

1. Kattintsunk a File > Print Preview (nyomtatás 
nézőkép) pontra.

→ A nyomtatási kép ellenőrzése.

Lásd a 137. oldalon a Hímzési minta 
ellenőrzése szakaszt és a 143. oldalon 
a Nyomtatás szakaszt.

Nyomtatás
Tervezőfelület tartalmának nyomtatása varrási 
információkkal kiegészítve.

1. Kattintsunk a File > Print pontra.

2. Adjuk meg a szükséges beállításokat.

3. Kattintsunk az OK-ra a nyomtatás 
indításához.

4. Kövessük az utasításokat a nyomtatás 
befejezéséhez.
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Hímzési minta létrehozása kép alapján
A Design Center funkció kép hímzési mintává alakítására szolgál. A művelet során módosíthatjuk a képet, a 
körvonalat, felületet részleteiben szerkeszthetjük, valamint a varrási jellemzőket is megadhatjuk.

A legmegfelelőbb képek a kevés, homogén, egymástól jól elváló színekkel rendelkező képek. Összetett 
képek, fotók vagy átmenetes képeknél nehézkes a körvonalak leképzése.

Hímzési terv készítése az alábbi négy fázisból épül fel:

A fejezet ismerteti a Design Center alapvető műveleteit. Részletesen lásd a 153. oldalon a Hímzési minta 
kialakítása kép alapján manuálisan (Design Center) szakaszban.

1. fázis
Eredeti kép

2. fázis
Vonalas kép

3. fázis
Csomóponti ábra

4. fázis
Varrási jellemzők fázis

Nyissunk meg egy képfájlt, 
majd válasszuk ki a 
körvonalak létrehozásánál 
felhasználható színeket.

Az eredeti kép fekete-fehér 
vonalas ábrává való 
átalakítása. Új vonalakat 
rajzolhatunk, törölhetők.

A vonalas kép pontozott 
formában jelenik meg, 
melyek szerkeszthetők a 
terv átalakításához.

Megadhajtuk az öltéstípust 
és fonalszínt a hímzési terv 
befejezéséhez.

Példa:
A sálban szereplő sávok 
törlésre kerültek.
A sál vége csíkokkal került 
díszítésre.

Példa: 
A szemeket áthelyeztük, és 
az arckifejezést 
megváltoztattuk. Egy csillag 
került a gép hátuljára.

Példa: 
Az eredetitől eltérő színeket 
adtunk meg a felületeknek, 
a grafika más formátumban 
jelenik meg.

• Amennyiben elmentettük az adatokat, a munka bármely fázisban lezárható, majd később újrakezdhető.

• A vonalas kép .pel formátumban kerül mentésre, a pontozott szerkesztő ábra .pem formátumban.

• A hímzési minta .pem formátumban kerül mentésre. A Design Centerben létrehozott .pem adatokat a 
Layout & Editing szoftverbe betöltve majd adatkártyára mentve áttölthetjük a hímzőgépbe.

Lásd a 152. oldalon a Betöltés a Layout & Editing szoftverbe szakaszt és a 17. oldalon a Terv 
áttöltése az eredeti kártyára szakaszt.
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1. lépés Eredeti kép fázisa

Töltsük be a képet, és alakítsuk át képpé.

Kattintsunk a ikonra, majd válasszuk a 
Programok > PE-DESIGN 8 > Tools >
Design Center pontokat.

Kattintsunk a  ikonra.

Kattintsunk a  ikonra.

Válasszuk ki a kívánt fájlra, majd kattintsunk
az Open (megnyitás) gombra.

A Cut out to Line Image (kivágás vonalas
képpé) ablakban adjuk meg a körvonalként
használatos színeket (hímzési vonalakat).

→ A kiválasztott szín megjelenik a jobb oldali 
mezőben, mellette a  mutatja, hogy a 
szín felhasználásra kerül.

Lásd a 156. oldalon a Cut out to Line 
Image ablak beállításainak részletes 
leírását a Kép körvonalának leképezése 
szakaszban.

Miután kijelöltük a körvonalakhoz használatos
színeket, kattintsunk az OK-ra.

→ A vonalas kép megjelenik a 
tervezőfelületen.

1

2

3

4

5

A körvonalhoz rendelt színtől 
eltérő színeknél vegyük ki a 
pipát a kapcsolóból.

A kívánt szín egyszerűbb kiválasz-
tásához a Zoom csúszkával 
nagyítsunk, kicsinyítsünk.

6
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2. lépés Vonalas kép fázisa

A Vonalas kép fázisban szerkeszthetjük a 
vonalakat. A toll eszközökkel rajzolhatunk új 
vonalakat, illetve törölhetjük őket a radír eszközzel.

Vonal törléséhez kattintsunk egy toll eszköz-
zel jobb egérgombbal, vagy tartsuk lenyomva
a jobb egérgombot, és húzzuk el a mutatót.

Vonalak törölhetők a  ikonnal.

Vonalak rajzolásához kattintsunk a Toll
eszközre.

Válasszunk egy toll eszközt a kívánt 
vonalvastagsággal.

Húzzuk a mutatót a vonal rajzolásához.

A vonalas kép elkészülte után kattintsunk a
 ikonra vagy a Stage > To Figure Handle

(csomóponti ábrává) pontra.

Kattintsunk az OK-ra.

A Figure Object Conversion Setting 
(csomóponti ábrává átalakítás) ablak 
beállításairól a 158. oldalon olvashatunk.

→ A vonalas kép megjelenik a pontozott 
szerkeszthető formában.

Ne feledjük:
Vízszintes vagy függőleges vonal 
rajzolásához a mutató húzása közben tartsuk 
lenyomva a  gombot.

1

2

Shift

Ne feledjük:
• Ha hibát követünk el a törlés vagy rajzolás 

közben, kattintsunk az Edit majd az Undo 

pontra, vagy az  ikonra az utolsó 
művelet elvetéséhez.

• A kijelző méretének módosításához 

kattintsunk a ,  vagy ikonok 
valamelyikére.

Ne feledjük:
A vonalas képre még azután is 
visszatérhetünk és szerkeszthetjük, hogy 
pontozott szerkeszthető formává alakítottuk.

3

4
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3. lépés Csomóponti, 
szerkeszthető forma

A csomóponti ábrát alkotó pontokat áthelyezhetjük, 
törölhetjük, újakkal bővíthetjük.
Felületi varrási jellemzőket nem rendelhetünk a nem 
teljesen lezárt felületekhez a körvonalon belül. A 
felületek kitöltéséhez teljesen zárjuk le a 
körvonalakat még ebben a szakaszban.

Körvonal áthelyezése

Kattintsunk a  ikonra, majd kattintsunk az
áthelyezni kívánt körvonalra.

→ A fogantyúk megjelennek, és a körvonal 
piros színre vált.

Vigyük a mutatót a körvonal fölé, amíg a
mutató alakja -ra nem vált, majd húzzuk el
a körvonalat.

Pontozott képen új vonal 
rajzolása

Kattintsunk a  ikonra az Eszköztárban.

Kattintsunk a tervezőfelületre a kezdő pont
kijelöléséhez, majd kattintsunk újra a követ-
kező pont kijelölésére.

→ A két pontot összekötő vonal jelenik meg. 
Folytassuk a további vonalak 
rajzolásához.

Kattintsunk kétszer a záró pont kijelöléséhez.

1

2

Fogantyú

Ne feledjük:
• Az utolsó bevitt pont törléséhez kattintsunk 

a jobb egérgombbal.
• Függőleges vagy vízszintes vonal 

rajzolásához tartsuk lenyomva a  
gombot, közben húzzuk el a mutatót.

1

2

Shift

3
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Design Center alapműveletek
D

esign C
enter alapm

űveletek
Körvonalak átalakítása

Kattintsunk a  ikonra az Eszköztárban.

Kattintsunk a körvonalra.

→ A kiválasztott vonal rózsaszínre vált, és 
kis fekete négyzetek jelennek meg.

Pont hozzáadásához kattintsunk a körvonalra.

Sarok létrehozásához húzzuk el a pontot.

Ha a pont törlésre kerül, a sarok is eltűnik.
Kattintsunk a pontra, majd nyomjuk le a

 gombot, vagy kattintsunk az Edit >
Delete pontra.

A vonal alakjának szerkesztéséhez húzzuk el
a pontot.

Vonalak felosztása
Egy vonal bármely pontnál kettéosztható.

Hajtsuk végre a Körvonalak átalakítása
szakasz  és  pontjaiban foglaltakat.

Kattintsunk a pontra, majd kattintsunk az Edit
> Split pontokra a vonal felosztásához.

Pontok összekötése vonallal
Két pont összekötésével egy vonalat alkotunk.

Hajtsuk végre a Körvonalak átalakítása
szakasz  és  pontjaiban foglaltakat.

1

2

Pont
Pont a vonal vége

3

4

Delete

Ne feledjük:
Ha több pontot is kijelöltünk, az összes pont 
törlésre vagy áthelyezésre kerül. További 
pontok kijelöléséhez tartsuk lenyomva a 

 gombot, és kattintsunk a kívánt 
pontokon, vagy húzzuk el a mutatók felett.

5

Ctrl

1

1 2

2

1

1 2
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Design Center alapműveletek
Tartsuk lenyomva az  gombot, húzzuk a
kiválasztott pontot arra a pontra, amellyel
össze kívánjuk kötni.

→ A mutató alakra vált, és piros négyzet 
jelenik meg, amikor a két pont átfedi 
egymást.

Engedjük fel az egérgombot az össze-
kötéshez.

Folytassuk a varrási 
beállításokkal

Amikor a csomóponti ábra elkészült, folytassuk a 4. 
fázissal.

Kattintsunk a  ikonra, vagy kattintsunk a
Stage > To Sew Setting (varrási beállítások)
pontra.

1. lépés Varrási beállítások

Hímzési minta létrehozásához a körvonal egyes 
részeihez meg kell adnunk a varrási jellemzőket.

Áttekintő ablak használata
Színek kiválasztására alkalmas, úgy hogy közben 
láthatjuk az eredeti képen is a színeket.

Kattintsunk a  ikonra.

Kattintsunk az Image fülre.

→ Az 1. fázisban betöltött kép megjelenik.

Varrási jellemzők megadása
A varrási jellemzők megadásához először jelöljük ki 
a színt és az öltéstípust, majd kattintsunk a vonalra, 
felületre, amelyre a varrási jellemző vonatkozik.

Kattintsunk a ,  vagy  pontra.

 : A teljes körvonalra hajtjuk végre a 
varrási jellemzőt.

 : A körvonal egy részére vonatkozik a 
varrási jellemző beállítás.

 : Felületre vonatkozik a varrási jellemző 
beállítás.

→ A varrási jellemző sáv az alábbiaknak 
megfelelően jelenik meg.

 vagy  esetén 

2 Alt

3

1

Ne feledjük:
A varrási beállítások fázisban bármikor 
visszaléphetünk a pontozott, szabadon 
szerkeszthető fázisra.

Ne feledjük:
Ha a Reference pont aktív, akkor kattintsunk 
az Original pontra.

1

2

1

Vonal öltéstípus kiválasztó
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Design Center alapműveletek
D

esign C
enter alapm

űveletek
 ikon esetén

Kattintsunk az  ikonra.

Kattintsunk a kívánt színre.

Kattintsunk az öltéstípus kiválasztóra, majd
válasszuk ki a kívánt öltéstípust.

A  vagy  módok esetén kattintsunk
a körvonalra, amelynél a varrási jellemzőket
végrehajtottuk.

→ A varrási jellemzőket megadtuk.

Amikor az  ikonra kattintunk, kattintsunk
a felületre, amelyre a varrási jellemzőket meg-
adni kívánjuk.

→ A varrási jellemzőket megadtuk.

A varrási jellemzők további beállításához 
ismételjük meg az 1-6. lépéseket.

Felület öltéstípus kiválasztó

2

3

4

5

6
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Design Center alapműveletek
Betöltés a Layout & Editing 
szoftverbe

A Design Centerben létrehozott hímzési minta 
betölthető a Layout & Editing szoftverbe, ahol 
tovább szerkeszthetjük és más hímzési mintákkal 
kombinálhatjuk.

Kattintsunk a  ikonra, vagy kattintsunk a
Stage > To Layout & Editing pontra.

→ Layout & Editing szoftver elindul.

Adjuk meg a Magnification és Orientation 
pontok jellemzőit.

A terv legfeljebb a tervezőfelületet kitöltő 
méretre nagyítható. Az elméleti legnagyobb 
nagyítási arány 25%.

Kattintsunk az Import pontra.
→ A Design Centerben létrehozott hímzési 

mintát betölthetjük a Layout & Editing 
szoftverbe.

Megjegyzés:
A felületi varrási beállítás nyitott felületre 
nem hajtható végre (melyet körvonal zár 
teljesen körbe - lásd az alábbi ábrán).

Amennyiben a jellemzők felületre nem 
vonatkozhatnak, térjünk vissza a 
Csomóponti ábrára, és zárjuk le a felületet. 
A nyitott szakaszokat, szakadozott 
vonalakat zárjuk be a Pont szerkesztő 
eszközzel.

Lásd a 161. oldalon a 
Megszakadt vonal rajzolása 
szakaszban.

Ne feledjük:
A Sewing Attribute Setting (varrási 
jellemzők) ablakban részletesen állíthatjuk a 
varrási jellemzőket, pl. a szatén öltés 
szélességét, öltéshosszát stb.

Lásd a 165. oldalon a Varrási 
jellemzők megadása 
szakaszban.

Megjegyzés:
Ha egy körvonal vagy felület varrási 
jellemzői nincsenek megadva, a hímzési 
mintát nem tudjuk betölteni.

Megjegyzés:
A Design Centerben létrehozott hímzési minta 
(.pem formátum) adatkártyára nem menthető. 
Töltsük be a hímzési mintát a Layout & Editing 
szoftverbe, majd írjuk ki kártyára, amellyel a 
hímzőgépben is megnyithatjuk a mintát.

1

2

3
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Hímzési minta létrehozása kézzel kép alapján (Design Center)

H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
Design Center munkaablak

1 Eszközsáv
Menüparancsok gyors elérését lehetővé tevő ikonok.

2 Varrási jellemzők sáv
A mintában szereplő vonalak és felületek varrási jellemzőinek megadására szolgál (szín és öltéstípus – 
csak a Varrási jellemzők fázisban).

3 Eszköztár
A kép vagy minta kijelölésére, szerkesztésére szolgál. Az Eredeti kép fázisban az eszköztár nem 
használható, a többi fázisban is mindig más eszközöket tartalmaz a tár. A fenti példában a Varrási 
jellemzők fázisban érvényes eszköztár látható.

4 Áttekintő ablak
A munkaablakban szereplő összes körvonalat és mintát jeleníti meg, egy áttekintő képet ad a 
munkaterületről, miközben egy részletre ránagyítva dolgozunk.

Lásd a 161. oldalon a Körvonalak megtekintése az Áttekintő ablakban c. szakaszt.

5 Tervezőfelület
A munkaterület hasznos, menthető és levarrható részét jelenti a tervezőfelület.

6 Munkaterület

Megjegyzés:
A tervezőfelület alapértelmezett mérete jelen példában 100 x 100 mm.

5

3

6

4

2
1
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Eredeti kép fázisa
Varázsló használata

A varázsló lépésről lépésre vezet végig a hímzési 
minta létrehozásának menetén.

1. Kattintsunk a File > Wizard pontra.

→ A How do you want to produce 
embroidery? (hímzés létrehozásának 
módja) ablak jelenik meg.

1 Kép alapján
Kép átalakításához kattintsunk erre a gombra. 
A From Image (képből) ablak jelenik meg, amely 
lépésről lépésre végigvezet hímzési minta kép 
alapján történő létrehozásának menetén.
Lásd a 155. oldalon a Kép megnyitása szakaszt.

2 Új, vonalas kép
Erre a gombra kattintva egy új tervezőfelület 
jelenik meg a Vonalas kép fázisban.
Ilyenkor a fekete tollal és a radírral rajzot, 
szabadkézzel grafikát készíthetünk, melyet 
hímzési mintává alakíthatunk.

Lásd a 157. oldalon a Új, vonalas kép 
rajzolása szabadkézzel szakaszt.

3 Új ábra
Új, üres tervezőfelület jelenik meg, csomóponti 
szerkeszhető fázisban. 
A körvonalas szerkesztő eszközökkel 
rajzolhatunk grafikát, vagy korábban mentett 
.pem fájlban tárolt körvonal alapján hozhatunk 
létre mintát.

Lásd a 160. oldalon az Új, csomóponti 
szerkeszthető ábra rajzolása rajzolása 
szabadkézzel

4 PEM fájl megnyitása
Korábban .pem formátumban mentett fájlt 
nyithatunk meg, szerkeszthetünk (pontozott 
szerkeszthető vagy varrási jellemzők beállítási 
fázisban).

5 Legutóbb használt fájlok
A legutóbb szerkesztett fájlok listája jelenik meg.
A listából kattintsunk a fájl nevére, majd az 
Open (megnyitás) pontra.

6 Minden indításkor jelenjen meg a varázsló
A kapcsolót kipipálva minden indításkor 
megjelenik a varázsló1 2

5

43

6
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
Kép megnyitása

A From Image (képből) gombra kattintva a How do 
you want to produce embroidery? (hímzés 
létrehozásának módja) ablakban, a From Image 
(képből) ablak jelenik meg.

1 Kép megnyitása fájlból gomb
Korábban mentett kép megnyitása és betöltése 
a tervezőfelületre. Fájl betöltésének számos 
módja van.

Lásd a Képi fájlformátumok szakaszt a 
19. oldalon.

2 Vágólapról
A Vágólapra mentett kép beillesztése a 
tervezőfelületre. A funkció csak akkor 
használható, ha van kimentett kép a vágólapon.

3 TWAIN kompatibilis eszközből
A számítógéphez csatlakoztatott TWAIN 
kompatibilis eszközből tölthetünk le képeket 
(szkennerből, digitális kamerából), majd 
beilleszhetjük ezeket a tervezőfelületre.

4 Aktuális kép használata
Az Eredeti kép fázisban megnyitott kép 
felhasználása hímzési minta létrehozásához. 
Csak akkor elérhető, ha az Eredeti kép fázisban 
szerepel megnyitott kép.

Tippek szkennelt képek 
kezeléséhez a Design Centerben

• Amennyiben a körvonalak elmosódottak, 
pauszpapíron húzzuk ki kontúrvonalakat.

• A kép világosításával jobb eredményt 
érhetünk el.

Fájl megnyitása

Fájlt a varázsló nélkül, közvetlenül is 
megnyithatunk.

1. Kattintsunk a  ikonra, vagy a File > Open 
pontra. Válasszuk ki a meghajtót és a mappát.

2. A Files of type (fájltípus) mezőben válasszuk 
az Image file (képfájl) típust.

3. Fájl megnyitásához jelöljük ki, majd 
kattintsunk az Open (megnyitás) gombra, 
vagy a fájl ikonján kattintsunk kétszer.

Ne feledjük:
Kép betöltése TWAIN-eszközből:

• Csatlakoztassuk a TWAIN-eszközt a 
számítógéphez, kattintsunk a File 
pontra, majd Select TWAIN device 
pontra, vagy a From Image ablakban 
válasszuk a From TWAIN device 
pontot (3). A Select Source (forrás) 
ablakban válasszuk ki a készüléket. 
Ezután kattintsunk a File > Input from 
TWAIN device (bevitel TWAIN 
eszközből) pontra.

• Az eszköz kezelőablakának 
használatáról a kezelőszoftver 
útmutatójában tájékozódhatunk, vagy 
forduljunk annak gyártójához.

1

2

3

4

Ne feledjük:
• .pel formátumú fájl esetén a kép a Vonalas 

ábra fázisban jelenik meg.
• .pem formátumú fájl eseétn a kép a 

Pontozott szerkeszthető fázisban vagy a 
Varrási jellemzők fázisban jelenik meg.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Vonalas ábra fázis
A kép megnyitását követően a Vonalas ábra fázis következik, ahol a megadhatjuk a kontúrvonalas képhez 
felhasználható színeket. A Vonalas ábra fázisban a toll és radír eszközökkel szerkeszthetjük a képet. 
Ugyanezen eszközökkel szabadkézzel is rajzolhatunk kontúrvonalakat, többek között kézírásos feliratot is 
készíthetünk.

Körvonal rajzolásáról, törléséről a 147. oldalon, a 2. lépés: Vonalas ábra fázisa szakaszban olvashatunk.

Kép kontúrvonalainak 
kihúzása

Eszközsáv ikon: 

1. Kattintsunk a  pontra, vagy kattintsunk a 

a Stage > To Line Image (vonalas képpé) 
pontra.

→ A Cut out to Line Image (leképezés 
vonalas képpé) ablak jelenik meg.

1. Nagyítás/kicsinyítés csúszka
A csúszkával a kép megjelenítési méretét 
állíthatjuk.

2. Tone (árnyalat) csúszka
A képben szereplő színek 
változatosságát, az árnyalati 
gazdagságot csökkenthetjük a 
körvonalszínek kiemelésének 
megkönnyítéséhez.

3. Noise Reduction (zajszűrés) csúszka
A képi zaj, apró zavaró mintázat 
kiszűrésére szolgál, ahol ez nehezíti a 
körvonalak kihúzását.

2. Kattintsunk a vonalakra, körvonal színekre, 
melyeknek a vonalas ábrán fekete 
körvonalként kell szerepelniük.

A színhatárok automatikus felismeréséhez 
kattintsunk a Detect Outlines kapcsolóra.

3. Kattintsunk a Preview (nézőkép) gombra a 
kép tervezőfelületen való megtekintéséhez.Ne feledjük:

• 16 színes kép használatát javasoljuk, mivel 
256 színes vagy 16 milliós színmélységű 
képből nehéz a megfelelő színek kiemelése 
a Vonalas ábrává alakítás során. Utóbbi 
típusú képek esetén a Tone csúszkával 
csökkentsük az árnyalati gazdagságot.

1

2
3

Megjegyzés:
Ha a csomóponti fázisban egy .pem fájl 
megnyitásával kezdtük a műveletet, már 
nem léphetünk vissza a Vonalas kép fázisra.

Ne feledjük:
• A Detect Outlines funkcióval a színhatárok 

az alábbi ábrának megfelelő módon válnak 
kontúrvonalakká.

• Szín kiiktatásához töröljük az előtte lévő 
kapcsolóból a pipát.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
4. Kattintsunk az OK-ra.

Új vonalas kép létrehozása 
szabadkézi rajzzal

Eszközsáv gomb: 

1. Kattintsunk a  ikonra, vagy kattintsunk 

a File > New Line Image (új vonalas kép) 
pontra.

→ Egy üres tervezőfelület jelenik meg 
Vonalas kép fázisban.

A toll és radír eszközökkel készítsük el 
szabadkézzel a rajzot.

Lásd a 156. oldalon a Vonalas kép fázis 
szakaszt.

Lásd a 169. oldalon a Hímzési minták 
mentése szakaszt és a 160. oldalon a Új 
ábra szabadkézi rajzolása csomóponti 
fázisban szakaszt.

Ne feledjük:
Ha nem tetszik az eredmény, kattintsunk a 

 ikonra az Eredeti kép fázisra való 
visszalépéshez, majd hozzuk létre újra a 
vonalas ábrát.

Ne feledjük:
A Vonalas kép fázis .pel formátumban kerül 
mentésre.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Pontozott, szerkeszthető ábra fázis
A körvonalas ábra elkészülte után – amely gyakorlatilag pixelek, pontok halmaza –, a művelet a Pontozott, 
szerkeszthető ábra fázissal folytatódik, ahol pontok automatikus összekötésével képzett vonalak szabadon 
szerkeszthetők. A Pont szerkesztő eszközzel áthelyezhetünk, törölhetünk, beszúrhatunk pontokat, vagy a 
Vonal eszközzel rajzolhatunk vonalakat.

Vonalas ábrává alakítás 
beállításai

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy 

kattintsunk a Stage (fázis) > To Figure 
Handle (csomóponti ábrává alakítás) pontot.

2. Válasszuk ki a Resolution (felbontás) pontot.

A Normal beállítás általában jó eredményt 
mutat, a létrejövő fájl is kezelhető méretű.
Coarse (durva) beállítás bizonyos képeknél 
elfogadható képet ad, a lehető legkisebb 
fájlméret mellett. Fine (finom) beállítást a 
részletgazdag képeknél érdemes csak 
választani, ha a Normal beállítás nem hozott 
megfelelő minőséget.

3. A Thinning Process kapcsoló esetén a 
fekete, kontúrvonalas ábra átalakításakor a 
csomóponti, szerkeszthető görbék a 
körvonalak közepéhez igazodnak.

A Thinning Process kapcsolóból a pipát 
kivéve a fekete körvonalak átalakításakor a 
szerkeszthető vonalak a körvonalak külső 
éleit követik majd.

4. A SIZE csúszkával állítsuk be a méretet.

Ne feledjük:
A csúszkát a Much (sok) felé húzva, még a 
vastag vonalakat is csak a középvonal 
mentén húzódó sima vonalak váltják fel.

Megjegyzés:
A tervezőfelület méretein túl nem tudjuk 
nagyítani a képet. Ha szükséges, kattintsunk 
a Design Page Property pontra, majd 
módosítsunk a tervezőfelület méretén.

BE (ON)

OFF (ki)
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
5. Kattintsunk az OK-n.

Háttérkép módosítása

Háttérkép módosítása
1. Kattintsunk a Display > Display Template 

(sablont mutat) sablonra, majd válasszuk ki a 
kívánt beállítást.

• A vonalas kép megjelenítéséhez 
kattintsunk az On pontra.

• A kép halványított, alnyomatos 
változatához kattintsunk a Faded pontra.

• A vonalas kép elrejtéséhez kattintsunk az 
Off pontra.

A háttérkép méretezése, 
elhelyezése

1. Kattintsunk a Display > Modify Template 
(sablon módosítása) pontra.

2. Húzzuk a sablont a kívánt helyre.

Húzzuk a fogantyúkat a sablonkép 
nagyításához, kicsinyítéséhez.

Tervezőfelület méretének 
beállítása

1. Kattintsunk az Option > Design Page 
Property pontra.

2. Válasszuk ki tervezőfelület méretét.

A tervezőfelület keret méretéhez való 
igazításához válasszuk a Hoop Size opciót, 
majd válasszuk ki a kívánt méretet.

Egyedi méret megadásához válasszuk a 
Custom Size opciót, majd gépeljük be vagy 
válasszuk ki a kívánt szélességet (width), 
magasságot (height).

3. Kattintsunk az OK-n.

Megjegyzés:
A kép csak egy részletének átalakításához 
kattintsunk a Pick Area pontra, majd húzzuk 
a mutatót (+) az átalakítani kívánt terület felett.

Megjegyzés:
Ha a vonalas képből a pontozott, 
szerkeszthető ábra nem hozható létre, 
számos beállítási mód és változat után sem, 
akkor lépjünk vissza a vonalas kép fázisba, 
és javítsuk a körvonalakon, vagy magát a 
képet módosítsuk.

Megjegyzés:
A Default gombbal visszaállítjuk az 
alapértelmezett értéket (100 x 100 mm).

Megjegyzés:
A hímzőgépben tényleges használt keret 
méreténél nagyobb keretméretet ne adjunk 
meg.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Új pontozott, szerkeszthető 
ábra szabadkézi rajzolása

Üres tervezőfelület is megnyitható, amelyben új 
pontozott, szerkeszhető ábrát rajzolhatunk vagy 
korábban mentett .pem fájl vonalrajzából mintát 
hozhatunk létre.
1. Kattintsunk a File > New Figure Data (új 

csomópont ábra) pontra.
→ Új, üres tervezőfelület jelenik meg.

Körvonalak szerkesztése

Körvonalak kiválasztása
1. Kattintsunk a  pontra.

2. Kattintsunk a körvonalra. 
3. További körvonal kiválasztásához tartsuk 

nyomva a  gombot, majd kattintsunk az 
újabb körvonalra.

Körvonal formázása
Pontok áthelyezéséről, beszúrásáról, törléséről, 
szakaszok felosztásáról, pontok összekötéséről a 
148. oldalon olvashatunk a Csomóponti, szabadon 
szerkeszthető ábra szakaszban olvashatunk.

Körvonalak méretezése
Méretezés számszerűen
1. Válasszuk ki a körvonalat.

2. Kattintsunk az Edit > Numerical Setting 
(számszerű értékek) > Size (méret) beállítást.

3. A szélesség, magasság arányának 
megtartásához pipáljuk ki a Maintain aspect 
ratio (méretarány tartásával) kapcsolót.

4. A szélességet, magasságot százalékosan (%) 
illetve kiterjedés (milliméter, inch) formában is 
megadhatjuk.

5. Gépeljük be, válasszuk ki a szélességet, 
magasságot.

6. Kattintsunk az OK-ra.

Körvonal tükrözése vízszintesen, 
függőlegesen

1. Válasszuk ki a körvonalat.

2. Kattintsunk az Edit > Mirror (tükrözés) > 

Horizontal (vízszintes) pontra vagy 

kattintsunk az Eszközsávban a  ikonra.

Kattintsunk az Edit > Mirror > Vertical 

(függőleges) pontra vagy kattintsunk a  

ikonra az Eszköztárban.

Körvonal forgatása

Forgatás szabadon:

1. Válasszuk ki a körvonalat.
2. Kattintsunk az Edit > Rotate (forgat) 

pontra, vagy kattintsunk a ikonra az 

Eszközsávban.

3. Vigyük a mutatót valamelyik fogantyú fölé, 
majd húzzuk el a forgató pontot.

Forgatás megadott szöggel:
1. Válasszuk ki a körvonalat.

2. Kattintsunk az Edit > Numerical Setting > 
Rotate (forgatás) pontra.

3. Gépeljük be a kívánt forgatási szöget.

4. Kattintsunk az OK-ra.

Ne feledjük:
• A csomóponti ábra fázisban a fájl .pem 

formátumban kerül mentésre.
• A mentett .pem fájl megnyitásához 

kattintsunk a File > Import Figure pontra.

Ctrl

Ne feledjük:

• Irányszöget a  körben a piros nyílat 
elhúzva is beállíthatunk.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
Tört vonalas alakzat 
rajzolása

Rajzoló módban tört vonalas alakzattal bővíthetjük 
mintánkat. A tört vonalas alakzat egy vagy több 
egymáshoz kapcsolódó egyenes szakaszból áll, 
vagyis az egyik szakasz vége a következő szakasz 
eleje. Amennyiben a rajzolt tört vonal nem záródik 
be, nem alkot zárt alakzatot, egyszerű körvonal 
marad, és csakis vonalas varrási jellemzők 
rendelhetők hozzá a Varrási jellemzők fázisban.

Ha meglévő felületen át húzzuk a vonalat, és így két 
felületté osztjuk, eltérő varrási jellemzőket 
rendelhetünk a két szakaszhoz, ugyanígy a 
vonalakhoz.

Vonalak rajzolásáról lásd a 148. oldalon a 
csomóponti ábrán új vonal rajzolása szakaszt.

Szoftver beállításainak 
módosítása

Rács beállításainak módosítása
Az igazítást, méretezést segítő pontozott vagy 
folytonos vonalakból álló rács jeleníthető meg vagy 
rejthető el a képernyőn. A rácsköz állítható. (A 
funkció csak csomóponti ábra módban állítható.)

1. Kattintsunk a Display > Grid Setup (rács 
beállítás) pontra.

2. A rács megjelenítéséhez válasszuk ki a Show 
Grid (rácsot mutat) kapcsolót.

3. A rács elrejtéséhez vegyük ki a pipát a Show 
Grid kapcsolóból.

4. A rácsköz beállításához adjunk meg egy 
értéket a Grid interval mezőben.

5. A rács folytonos vonalként való 
megjelenítéséhez pipáljuk ki a with Axes 
kapcsolót. A pontozott vonalas 
megjelenítéshez (csak a metszéspontok 
látszódnak) vegyük ki a pipát a with Axes 
kapcsolóból.

6. Kattintsunk az OK-ra a módosítások 
végrehajtásához és az ablak bezárásához.

Mértékegység állítása
A mértékek kijelzése történet milliméterben vagy 
inchben.

1. Kattintsunk az Option > Select System Unit 
(mértékegység kiválasztása) pontra, majd 
válasszunk a mm és inch között.

Körvonalak megtekintése az 
Áttekintő ablakban

A tervezőfelületen látható összes körvonal 
megjelenik az Áttekintő ablakban, így míg egy 
kisebb részletre ránagyítva munkálkodunk, teljes 
rálátást kapunk a körvonalrajzról. Az éppen 
megjelenített területet piros téglalap mutatja az 
Áttekintő ablakban. Ezenfelül Csomóponti ábra és 
Varrási jellemzők fázisban a hímzési minta alapjául 
szolgáló képtől eltérő kép jeleníthető meg az 
Áttekintő ablakban.

Az Áttekintő ablakot a Display > Reference 

Window pontra vagy a ikonra kattintva 
kapcsolhatjuk ki és be, de ugyanezt érjük a  
funkciógomb lenyomásával.

tört vonal két felületet létrehozva

tört vonal felület nélkül tört vonal felülettel

záró pont

kezdő pont

F11
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Nagyítás/kicsinyítés
Az Áttekintő ablak beállítható a tervezőfelület teljes 
megjelenítéséhez vagy csak a hímzési minta 
megjelenítéséhez.

1. Kattintsunk a Pan/Zoom fülre, majd a  
ikonra a váltáshoz.

A megjelenített területet jelző 
(piros) keret mozgatása

A tervezőfelületen megjelenő ábra megtekinteni 
kívánt része az Áttekintő ablakban is kijelölhető.

1. Vigyük a mutatót a piros téglalap fölé.

2. Húzzuk a keretet úgy, hogy a megjeleníteni 
kívánt részt lefedje.

→ A körvonal kiválasztott része megjelenik a 
tervezőfelületen.

Piros keret újrarajzolása
A keret áthelyezése helyett teljesen újrarajzolhatjuk 
azt, új keretet húzva a kívánt részlet köré.

1. Kattintsunk a megtekinteni kívánt terület fölé, 
vagy húzzuk el a mutatót a körvonal kívánt 
rész fölé az Áttekintő ablakban.

Piros keret átméretezése
1. Vigyük a mutatót a keret egyik sarka fölé.

2. Húzzuk el a mutatót a téglalap kívánt méretre 
igazításához.

Eltérő kép megjelenítése az 
áttekintő ablakban

A létrehozni kívánt hímzési mintától eltérő kép is 
megjeleníthető az Áttekintő ablakban.

1. Kattintsunk az Image (kép) fülre.

2. Kattintsunk a Reference (viszonyítási) 

gombra, majd az  ikonra.

3. Válasszuk ki a viszonyítási képet, majd 
kattintsunk az Open (megnyitás) gombra.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
Varrási jellemzők gomb
A csomóponti ábra fázisban a körvonalas rajz szerkesztését követően továbbléphetünk a Varrási jellemzők 
fázisra, ahol az öltéstípust, fonalszínt adhatjuk meg. A minta nagyításához, kicsinyítéséhez használjuk a 
nagyító eszközöket.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a Stage > 

To Sew Setting (varrási beállítások) pontra.

→ A minta a Varrási jellemzők fázisban élő 
formában jelenik meg a tervezőfelületen.

Varrási jellemzők 
megadása vonalra, felületre

Felületi varrási jellemzők

Varrási jellemzők megadása felületre

1. Kattintsunk az  Eszköztárban.

2. Ha szükséges, módosítsuk a színt, 
öltéstípust.

Lásd a 164. oldalon a Varrási jellemzők 
sáv használata szakaszt.

3. Kattintsunk a zárt felületre a varrási jellemzők 
végrehajtásához.

→ Futó pontozott vonal jelenik meg a 
kiválasztott felület körül, és a Varrási 
jellemzők sávban megadott színt és 
öltéstípust veszi fel a kijelölt felület.

Ne feledjük:
• A varrási jellemzők megadása előtt és után is módosíthatjuk a színt vagy az öltéstípust. 

Lásd a 165. oldalon a Szín és Öltéstípus szakaszokat.

• A Sewing Attribute Setting ablakban is megadhatjuk ezen beállításokat.

Lásd a 165. oldalon a Varrási jellemzők megadása szakaszt.

Ne feledjük:
A Varrási jellemzők fázisban a tervezőfelület 
színe és háttere a Design Page Property 
ablakban állítható (az Option > Design Page 
Property menüponttal jeleníthetjük meg).

Megjegyzés:
Ha a beállítások nem hajthatók végre az 
adott felületen, lépjünk vissza a csomóponti 
ábra fázisra és ellenőrizzük, hogy a felületi 
alakzat zárt legyen. A Pont szerkesztő 
eszközzel szerkesszük a tört vonalakat, 
nyitott pontokat.
163



Hímzési minta létrehozása kézzel kép alapján (Design Center)
Vonal varrási jellemzői

1. Kattintsunk az Eszköztárban a  vagy 

 ikonra.

2. Ha szükséges, módosítsuk a színt, 
öltéstípust.

Lásd a túlsó hasábban a Varrási 
jellemzők sáv használata szakaszban.

3. Kattintsunk a beállítani kívánt körvonalra.

→ Futó pontozott vonal jelenik meg a 
kiválasztott körvonal körül, és a körvonal 
felveszi a Varrási jellemzők sávban 
megadott színt és öltéstípust.

Varrási jellemzők sáv 
használata

A Varrási jellemzők fázisban megjelenő Varrási 
jellemzők sávban a vonalak és felületek színét, 
öltéstípusát adhatjuk meg.

A varrási jellemzők az Eszköztárban kiválasztott 
eszköz függvényében eltérhetnek.

1. példa: Az Eszköztárból a  eszköz esetén

2. példa: Az Eszköztárból a  vagy  ikon 

kiválasztása esetén

Ne feledjük:
• Bár a felület zártnak tűnik, ha a varrási 

jellemzők nem hajthatók végre, az adott 
felületen valójában nyitott. A felület 
nyílásának megtalálásához a Csomóponti 
ábra fázisban a vonal rajzoló módban 
osszuk fel a felület több kisebb felületre, 
majd ellenőrizzük, hogy melyik felületen 
végrehajthatatlan a varrási jellemző 
beállítás.

• A pont szerkesztő mód a legmegfelelőbb a 
felületek bezárásához.

• Varrási jellemzők megadása után 
kattintsunk a jobb egérgombbal a 
módosított felületre: a Sewing Attribute 
Setting ablak jelenik meg, benne az adott 
felület varrási jellemzőivel.

Megjegyzés:

• Amikor a  ikonra kattintunk az 

Eszköztárban, a beállítások csak a kijelölt 
körvonal egy részére vonatkozik a beállítás.

• Varrási jellemzők megadása után 
kattintsunk a jobb egérgombbal a 
módosított vonalon: a Sewing Attribute 
Setting ablak jelenik meg, benne az adott 
vonal varrási jellemzőivel.

Felület varrás: Adott felület 
levarrásának ki- és 
bekapcsolása.
Vonal varrás: Adott vonal 
levarrásának ki- és 
bekapcsolása.
Felület, vonal színe: A felület, 
vonal fonalszínének 
megadása.
Felületi öltéstípus, Vonal 
öltéstípus: A felület, vonal 
öltéstípusának megadása.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
Felület  / Vonal varrás 

 felület varrásának ki- és bekapcsolása;

 vonal varrásának ki- és bekapcsolása.

1. Kattintsunk a gombokra a ki- és 
bekapcsoláshoz. Be: A Felület szín és Vonal 
szín gomb valamint a Felület szín és Vonal 
szín gomb megjelenik.

2. Kattintsunk a módosítani kívánt felületre, 
vonalra.

Ha a vonal varrást vagy felület varrást 
bekapcsoltuk, az adott vonal, felület a 
kiválasztott fonalszínben jelenik meg. Ha ezt 
kikapcsoltuk, a felület fehér színben látható, a 
vonal pedig pontozott vonal formájában.

Színválasztó 
Kattintsunk az ikonra a vonal vagy felület színének 
megadásához.

1. Kattintsunk a Color (szín) gombon.

2. A Thread Color (fonalkészlet) kiválasztóban 
adjuk meg a kívánt készletet.

3. A színek közül kattintsunk a megfelelőre.

→ Az új szín megjelenik a Felület szín vagy 
Vonal szín gombon.

4. Kattintsunk a vonalra vagy felületre a szín 
végrehajtásához.

Öltéstípus

Adjuk meg a vonal vagy felület öltéstípusát.

1. Kattintsunk az öltéstípus kiválasztóra.

2. Kattintsunk a kívánt öltéstípusra.

5. Kattintsunk a felületre, vonalra a kívánt 
öltéstípus végrehajtásához.

Varrási jellemzők megadása
Számos, felületre és vonalra vonatkozó varrási 
jellemző megadható a Sewing Attribute Setting 
ablakban.

Eszközsáv ikon: 

6. Kattintsunk a  ikonra.

Megjegyzés:
Amikor a vonal vagy felület varrást 
kikapcsoljuk, a vonal vagy felület kimarad a 
hímzésből.

Felület varrás
Felület szín

Felület öltéstípus

Vonal varrás
Vonal szín

Vonal öltéstípus

Megjegyzés:
A lista alján szereplő négy gomb ismertetését 
a 95. oldalon találjuk.

Megjegyzés:
A felületi varrási jellemzők jelennek meg a 
Sewing Attribute Setting ablakban az 

Eszköztárból a  eszköz kiválasztásakor, 

 vagy  eszközök kiválasztásakor a 
vonali beállítások jelennek meg.

Vonal öltéstípus Felületi öltéstípus

Vonal öltéstípus Felületi öltéstípus
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Kezdő mód (beginner):

Haladó (expert) mód:

 :

Kattintsunk az alapbeállítások visszaállításához.

To Expert mode (váltás haladó módba)/
To Beginner mode (váltás kezdő módba):
Kattintsunk valamelyikre a mód váltásához.

 :

Varrási jellemzők mentése, betöltése.

Lásd a 109. oldalon a Gyakran használt 
varrási jellemzők mentése szakaszt.

Hide Hint/Show Hint:
A nézőkép elrejtésére (hide hint) és megjelenítésére 
(show hint) szolgál. Minden egyes módosítást 
leellenőrizhetünk a nézőképen.

1. Az alapvető varrási jellemzők 
megjelenítéséhez kattintsunk a To Beginner 
mode (kezdő módba) gombra. Az összes 
beállítás, varrási jellemző megadásához 
kattintsunk a To Expert mode (haladó 
módba) gombra.

2. Ha szükséges, módosítsuk a vonali vagy 
felületi varrási jellemzőket.

A különféle varrási jellemzőkről, 
beállításokról vonalra vonatkozóan a 98. 
oldalon, felületre vonatkozóan a 101. és 
109. oldalon olvashatunk. A sűrűn 
használt varrási jellemzőket el is 
menthetjük, lásd a 109. oldalon.

3. Amikor a vonali varrási jellemzők 
megjelennek, kattintsunk a körvonalra a 
jellemzők végrehajtásához az adott 
körvonalon. A felületi varrási jellemzők 
megjelenésekor kattintsunk a felületre a 
jellemzők végrehajtásához az adott felületen.

Vonalhoz Felülethez

Vonalhoz Felülethez

Megjegyzés:
• Az ablakban megjelenő varrási beállítások 

függnek a kiválasztott öltéstípustól.

Megjegyzés:
• A kezdő módban nem látható beállítások a 

haladó módban megadott módosításokat 
őrzik meg.

Megjegyzés:
Az ablakban végrehajtott összes módosítás 
megmarad, és módtól függően 
végrehajtásra kerül, egészen addig, míg 
újból nem módosítjuk.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
H

ím
zési m

inta létrehozása kézzel kép alapján (D
esign C

enter)
Színátmenet létrehozása
Szatén, kitöltő vagy programozható kitöltő esetén a 
szín sűrűségének változtatásával egyedi átmenetes 
mintát hozhatunk létre.

1. A Sewing Attribute Setting ablakban haladó 
(expert) módban válasszuk a Gradation 
(átmenet) kapcsolót.

2. Kattintsunk a Pattern (minta) pontra.

3. Előre programozott színátmenet minta 
kiválasztásához kattintsunk a Select pattern 
gomb alatt a kívánt mintára.

4. Húzzuk el a csúszkát a kívánt öltéssűrűség 
eléréséhez.

5. Kattintsunk az OK-n.

Gyakran használt varrási 
jellemzők elmentése

A sűrűn használt varrási jellemzőket elmenthetjük, 
majd szükség esetén bármikor megnyithatjuk.

A Layout & Editing szoftvernél megismert módon 
kell végrehajtanunk a műveletet. Lásd a 109. 
oldalon a Gyakran használt varrási jellemzők 
mentése szakaszt.

Effektek a koncentrikus körös 
és sugaras öltésekhez

A hímzés látványosabbá tételéhez módosíthatjuk a 
koncentrikus körös és sugaras öltések 
középpontjának helyzetét.

1. Kattintsunk az Eszköztárban a  ikonra.

2. Válasszuk ki a kívánt színt és öltéstípust 
(Concentric Circle Stitch - koncentrikus 
körös - vagy Radial Stitch - sugaras öltés).

3. Kattintsunk a felületre.

→ A középpont ( ) eltűnik. 

4. Húzzuk a középpontot a kívánt helyre.
 

Megjegyzés:
Újabb szín (színátmenet egy másik színbe) 
nem adható meg a Design Center 
színátmenet állító menüjében.

Megjegyzés:
A középpont később is módosítható, ehhez 

kattintsunk a  ikonra, majd a jobb 
egérgombbal kattintsunk a koncentrikus körös 
vagy sugaras öltésű felületre. A középpont 
megjelenik, és szabadon áthelyezhető.
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Hímzési minta létrehozása kézzel kép alapján (Design Center)
Átfedő öltések kiiktatása 
(lyukvarrás)

A lyukvarrás beállításával az egymást átfedő 
felületek nem kerülnek kétszer levarrásra. 
Lyukvarrás csak abban az esetben állítható be, ha a 
kisebbik felületet teljesen körbefogja a nagyobbik 
felület.

1. Kattintsunk az Eszköztárban a  ikonra.

2. Kattintsunk a felületre, amely teljesen 
körbevesz egy másik felületet.

3. Kattintsunk az OK-ra a lyukvarráshoz.

Bélyegzőminta 
végrehajtása

A Programozható öltés tervezővel (Programmable 
Stitch Creator) készített bélyegzőminta a Design 
Center Varrási jellemzők fázisában végrehajtható 
felületeken. A programhoz jár néhány 
bélyegzőminta, de a Programozható öltés 
tervezővel módosíthatjuk ezeket, vagy teljesen új 
bélyegzőmintákat is létrehozhatunk.

Kattintsunk a  ikonra a bélyegzőminta 
végrehajtásához. A minta módosításához 

kattintsunk a  ikonra.

A bélyegzőminta beállításai megegyeznek a Layout 
& Editing programban ismertetett bélyegzőminta 
beállításokkal.

Lásd a 114. oldalon a Bélyegzőminta 
végrehajtása, szerkesztése szakaszt.

Varrási sorrend 
ellenőrzése, szerkesztése

A mintában szereplő színek varrási sorrendje és az 
azonos színű elemek varrási sorrendje ellenőrizhető 
és tetszés szerint módosítható.

1. Kattintsunk a  ikonra ,vagy kattintsunk a k 
Sew > Sewing Order pontra.

2. Egy adott varrási sorban való helyének 
módosításához válasszuk ki az adott szín 
keretét, majd húzzuk át a keretet a kívánt 
helyre.

→ Piros vonal jelzi a keret aktuális helyét a 
sorban.

Megjegyzés:
A lyukvarrás elvetéséhez kattintsunk a fehér 
belső felületre. A belső felület kétszer kerül 
levarrásra, amikor a külső nagy felülettel 
egyező színben jelenik meg.
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3. Azonos színű minták varrási sorrendjének 
megtekintéséhez válasszuk ki a kívánt 
keretet, majd kattintsunk a Part fülre.

→ A különálló, de azonos színű minták külön 
keretben jelennek meg.

4. A minták varrási sorrendjének módosításához 
válasszuk ki a kerethez, és húzzuk a kívánt 
pozícióba.

5. Kattintsunk az OK-ra a módosítások 
véglegesítéséhez és az ablak bezárásához.

Öltések ellenőrzése

A hímzőgép által tényleges levarrandó öltések képe 
ellenőrizhető az öltés szimulátor funkcióval.

Az öltés szimulátor funkciót a  ikonra kattintva 
vagy a Display > Stitch Simulator menüpontra 
kattintva érjük el.

Az öltés szimulátor a Layout & Editing szoftvernél 
megismert módon működik.

Lásd a 66. oldalon az Öltések ellenőrzése 
pontot.

Minták megtekintése az 
Áttekintő ablakban

A hímzési minták a Varrási jellemzők fázisban a 
Csomóponti ábra fázissal megegyező módon 
jeleníthetők meg az Áttekintő ablakban.

Lásd a 161. oldalon a Körvonal 
megtekintése az Áttekintő ablakban.

Hímzési minták mentése

A fájl bármelyik fázisban menthető.

Felülírás
1. Kattintsunk a  ikonra, vagy kattintsunk a 

File > Save pontra.
→ A fájl mentésre került.

Mentés új néven
Az aktuális terv új néven is elmenthető, így 
változatlan formában őrizzük meg az eredeti fájlt, 
illetve különféle változatokat hozhatunk létre 
ugyanarról a képről, mintáról.

1. Kattintsunk a File > Save As pontra.

2. Válasszuk ki a meghajtót, mappát, majd 
gépeljük be a fájlnevet.

3. Kattintsunk a Save (mentés) gombra az 
adatok mentéséhez.

Megjegyzés:
• További keretek kijelöléséhez tartsuk 

lenyomva a  vagy gombokat, 
majd jelöljük ki az egyes kereteket.

• A felületeket tartalmazó kereteket egy 
vastag függőleges vonal választja el a 
vonalakat tartalmazó keretektől. A keretek 
nem vihetők át az egyik oldalról a másikra.

• A minta nagyításához kattintsunk a  
ikonra.

Shift Ctrl

Megjegyzés:
• A megfelelő kiterjesztés automatikusan 

kiválasztásra kerül.
• Az Eredeti kép fázisban szereplő kép 

bitmap fájlként elmenthető (.bmp). A 
Vonalas kép fázis tartalma .pel 
formátumban menthető.
A Csomóponti ábra és a Varrási 
jellemzők fázisok tartalma .pem 
formátumban menthetők.

• .pem kiterjesztésű fájl csak a Layout & 
Editing programba betöltve menthető ki 
adatkártyára, és vihető át a hímzőgépbe.

Lásd a 152. oldalon a Betöltés 
Layout & Editing szoftverbe 
szakaszt.

Megjegyzés:
Ha a szoftver korábbi verzióival kompatibilis 
fájltípust választunk ki, a .pem fájl az adott 
verzióval is megnyitható, azonban 
előfordulhat, hogy bizonyos adatok 
elvesznek.
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Tudnivalók a használati útmutatóról
A használati útmutató további része ismerteti a Design Database, a Programmable Stitch Creator és Font 
Creator szoftverek használatát.

A PE-DESIGN műveleteinek hatékonyabb használatát segítik a bővített bemutatóanyag, trükkök, fogások 
leírása és a menürendszer, eszközök listaszerű ismertetése. Ezenfelül egy hibaelhárítás fejezetet is találunk, 
melyet akkor érdemes fellapoznunk, ha probléma merül fel a szoftver használata során.

Használati útmutató tartalma (PDF-formátum)

Bemutatóanyag (bővített) ....................... 171
Monogramok megadása ..................................171
Appliqué (foltvarrás) készítése.........................174
Osztott hímzési terv készítése.........................176
Hímzési terv több állású kerethez....................182

Hímzési tervet tartalmazó fájlok kezelése
(Design Database) ................................... 187

Alapvető Programozható öltés készítő 
műveletek 
(Programmable Stitch Creator) .............. 199

Egyedi öltési minta készítés 
(Programmable Stitch Creator) .............. 205

Alapvető Font Creator műveletek.......... 217

Egyedi fontok létrehozása
(Font Creator) .......................................... 225

Trükkök, technikák ..................................237
Öltési minta nagyítása, kicsinyítése ................ 237
Varrási irány .................................................... 237
Varrási sorrend................................................ 237
Széles felületek levarrása ............................... 238
Ugró öltés és ugró öltés levágása................... 238
Hímzéshez alkalmas fontok ............................ 239
Körvonalas karakterek létrehozása 
(szöveg átalakítása körvonalrajzzá)................ 240
Egyes karakterek (japán, koreai) 
átalakítása hímzési mintává ........................... 241

Menürendszer/Eszközök.........................243
Layout & Editing .............................................. 243
Design Center ................................................. 249
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Programmable Stitch Creator.......................... 256
Font Creator .................................................... 259
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utatóanyag (haladó)
Monogram készítése
A monogram funkcióval díszes karaktereket övezhetünk látványos mintákkal. A következő műveletsor 
végigvezet az összes főbb lépésen.

A bemutató fájlok a következő mappában találhatók: 
Documents(My Documents)\PE-DESIGN 8\Tutorial\Tutorial_7

1. lépés Monogram létrehozása

Indítsuk a Layout & Editing szoftvert.

Kattintsunk a  majd  ikonra.

A „diamond” és „script” betűtípusok kizárólag 
monogram készítésére szolgálnak. De egyéb 
beépített fontot és TrueType fontot is 
felhasználhatunk. A fenti ábrán látható 
állapotban módosíthatjuk a fontot, a 
betűméretet, öltéstípust.

Kattintsunk a tervezőfelület azon pontjára,
ahova a monogramot beilleszteni kívánjuk.

Gépeljük be az “ABC” karaktersort.

A monogramot dekorációval, díszítő mintával
tehetjük még látványosabbá: válasszuk az
Add Decorative Pattern (díszítő minta
hozzáadása) kapcsolót, majd kattintsunk
Select Pattern (minta kiválasztó) gombon.

1. lépés Monogram létrehozása
2. lépés Font és betűméret módosítása
3. lépés Fonalszín és öltéstípus módosítása
4. lépés Dekoráció, díszítő minta méretének, helyzetének beállítása

1

2

3

4

Megjegyzés:
• A karaktereket a karaktertáblából 

kijelölve is bevihetjük: jelöljük ki, majd 
kattintsunk az Insert gombra, vagy 
kattintsunk a karakterre kétszer.

• Több sorból álló szöveget nem adhatunk 
meg. Ha lenyomjuk az  gombot, az 
ablak bezáródik, és a monogram 
megjelenik a tervezőfelületen.

Enter

5
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Bemutatóanyag (haladó)
Kattintsunk a megfelelő díszítő mintán, majd
kattintsunk a Select (kiválaszt) gombra.

Kattintsunk az OK-n.

→ A monogram megjelenik a 
tervezőfelületen a kiválasztott 
dekorációval.

2. lépés Font és betűméret 
módosítása

Ezután módosítjuk a monogram betűtípusát 
(továbbiakban: font) és betűméretét.

Kattintsunk a  pontra, majd kattintsunk a
monogramra.

Módosítsuk a fontot a legördülő nyílra kat-
tintva, majd válasszuk ki a betűtípust.

Módosítsuk a betűméretet.

3. lépés Fonalszín, öltéstípus 
megadása

A monogram fonalszíne, öltéstípusa módosítható.

Kattintsunk a majd ikonra.

Kattintsunk a monogramra.

6

7

1

Megjegyzés:
Diamond és Script fontok kizárólag 
monogram készítésére szolgálnak. Emellett 
más, beépített és TrueType fontokat is 
használhatunk. Részletesen lásd a 
Monogramok készítése szakaszban lásd a 
90. oldalon.

2

Monogram font 
neve

Monogram font minta

3

1
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Egy adott karakter kijelöléséhez kattintsunk a
kijelölni kívánt karakterhez tartozó pontra.

Kattintsunk a  ikonra.

A színtárban kattintsunk a kívánt színre a 
kijelölt karakter színének módosításához.

Kattintsunk az Öltés kiválasztóra, majd
kattintsunk a jobb oldali legördülő nyílra, majd
válasszuk ki az öltéstípust.

→ A kijelölt karakter öltéstípusa módosításra 
került.

4. lépés A díszítő minta mérete, 
helyzete

A díszítő minta mérete és helyzete szabadon 
állítható.

Kattintsunk a  pontra, majd kattintsunk a
monogramra.

Vigyük a mutatót a kiválasztott minta valamely
fogantyúja fölé.

Húzzuk a mutatót a minta kívánt méretre 
igazításhoz.

Vigyük a mutatót a kiválasztott minta fölé: a
mutató  alakra vált, majd húzzuk a mintát a
kívánt helyre.

2

3

4

1

2

3
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Bemutatóanyag (haladó)
Appliqué (foltvarrás) készítése
Az Applique varázsló végigvezet a foltvarrás menetén.

A következő ismertetés lépésről lépésre végigvezet a szükséges műveleteken.

Appliqué létrehozásakor a következő sorrendben kell megadnunk az 
adatokat.

1 Applique Material (folt kivágása)

2 Applique Position (folt helye a hordozón)

3 Tack down (lefércelés)

4 Covering Stitch (körbevarrás)

Foltok hímzéséről a hímzőgép használati útmutatójából 
tájékozódhatunk.

A bemutató fájl az alábbi mappában találjuk: Documents(My Documents)\PE-DESIGN 8\Tutorial\Tutorial_8

1. lépés Folt minta létrehozása

Bármely alakzat szolgálhat minta kivágó 
sablonjaként. A következő lépésekben egy kört 
rajzolunk, és ebből hozunk létre foltot.

Indítsuk el a Layout & Editing szoftvert.

Kör rajzolásához kattintsunk a , majd
 ikonra.

Húzzuk a mutatót a tervezőfelületen a kívánt
méretű kör rajzolásához.

2 .lépés Appliqué varázsló 
használata

Kattintsunk a Sew > Applique Wizard (folt
varázsló) menüpontra.

Az Applique Material pont alatt a Yes (igen)
esetén a folt körvonala levarrásra kerül, No
(nem) esetén nem. A levarrt körvonal
sablonként szolgál a kivágáshoz.

1. lépés Folt minta létrehozása
2. lépés Appliqué varázsló használata

1

2

3

1

2
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Az Applique Position a folt körvonalát levarrja a
hordozó anyagra, segítve a folt igazítását. Mindig
levarrásra kerül.

A Tack down pont alatt a Yes (igen)
választása esetén a foltot fércelő öltésekkel
rögzítjük a hordozón. Válasszuk ki a kívánt
fércelő öltést: Satin (szatén - gobelin), „E” és
„V” öltés alkalmazható.

A Covering Stitch (fedő öltés) pont alatt a
befejező öltés jellemzőit adhatjuk meg.

Kattintsunk az OK-n az Appliqué varázsló
bezárásához és a tervezőfelület újbóli meg-
jelenítéséhez.

→ A folt minta megjelenik a tervezőfelületen.

3

4

Szatén öltés „E” öltés „V” öltés

5

6
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Bemutatóanyag (haladó)
Osztott hímzési terv létrehozása
Layout & Editing szoftver képes a hímzési mintát több részre osztva kezelni, amennyiben a minta nagyobb a 
hímzőkeretnél.

A bemutató fájl a következő mappában található: Documents(My Documents)\PE-DESIGN 
8\Tutorial\Tutorial_9

1. lépés Tervezőfelület 
méretezése

Első körben igazítsuk a tervezőfelület méretét a 
hímzési mintának méretéhez. 

Indítsuk el a Layout & Editing szoftvert.

Kattintsunk az Option > Design Page Pro-
perty (tervezőfelület tulajdonságai) pontra.

Válasszuk a Custom Size (egyedi méret)
pontot, majd gépeljük be vagy válasszuk ki a
tervezőfelület kívánt szélességét, magassá-
gát.

A szélesség (widht) és magasság (height) 
100 - 1000 mm-es tartományban mozoghat. 
A tervezőfelület pontosan a megadott méretet 
fogja felvenni.
A példában 230 mm-es szélességet, és 330 
mm-es magasságot adhatunk meg.

Kattintsunk a Section Size (for Hoop Size)
(osztott mező mérete - keret mérete) kiválasz-
tóra, majd adjuk meg egy osztás méretét:
jelen példában 120 × 170 mm (130 × 180
mm). 

1. lépés Tervezőfelület méretének megadása
2. lépés Hímzési terv létrehozása
3. lépés Hímzés sorrendjének megtekintése
4. lépés Stabilizátor rögzítése a textílián
5. lépés Hímzés helyének megjelölése
6. lépés Textília felfűzése a keretbe
7. lépés Hímzés

1

2

3

Megjegyzés:
• A Section Size (for Hoop Size) beállítás 

esetén a felosztott mezők 10-10 mm-rel 
kisebbek, mint a keret mérete, így marad a 
ráhagyás a pontos, finom igazításhoz. A 10 
mm-es ráhagyás átfedésként szolgál.

• A Section Size (for Hoop Size) pontnál 
megadott méretnek nem kell egyezni e 
tervezőfelület méretével. Adjuk meg a 
hímzőgépben alkalmazni kívánt hímzőkeret 
méretét.

4
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Kattinsunk az OK-ra.

2. lépés Hímzési terv létrehozása

Jelen példában a szoftver egyik előre elmentett 
csipke hímzési tervét fogjuk felhasználni.

Kattintsunk a File > Import pontra vagy a 
ikonra.

Kattintsunk a  gombra, majd a

 ikonra. Válasszuk ki a Dokumentumok
> PE-DESIGN 8 > Sample > Layout &
Editing mappára. Jelöljük ki a Largelace.pes
fájlt.

Lásd a 48. oldalon a Hímzési tervek 
betöltése szakaszt.

3. lépés Hímzési sorrend 
megtekintése

Mielőtt levarrjuk a hímzési mintát, ellenőrizzük az 
egyes mezők levarrásának sorrendjét, és döntsük 
el, hogy a textília mely részét kell befűzni a 
keretbe.
A mezők balról jobbra, fentről lefelé léptetéssel 
létrejövő sorrendben kerülnek levarrásra.

A menüsorban kattintsunk az Option >
Design Property menüpontra.

A hímzést alkotó másik mező adatainak
megtekintéséhez kattintsunk a Next (követ-
kező) és Previous (előző) pontokra a mezők
közötti léptetéshez. Kattintsunk a terven, majd
a Close (bezár) ponton.

5

1

2

Megjegyzés:
A hímzési sorrend a minta kiválasztása 
esetén nem tekinthető meg; a sorrend 
ellenőrzése előtt szüntessük meg a minta 
kijelölését.

1

2
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Bemutatóanyag (haladó)
4. lépés Stabilizátor rögzítése a 
hordozón

Stabilizátort mindig kell alkalmaznunk hímzés 
során az anyag fixálásához. Sokféle stabilizátor 
létezik; a textília dönti el, hogy melyiket kell 
használnunk. Nagy méretű tervek esetén, 
melyeket mezőkre kell felosztanunk, a 
stabilizátort fel kell ragasztani a textíliára, pl. 
vasalással, öntapadós megoldással, vagy spray-s 
ragasztóanyaggal.

Spray-s ragasztóanyag használatakor fújjuk a 
ragasztóanyagot a keretbe fűzőtt stabilizátorra, 
amely elég erős a hímzés teljes méretéhez. 
Egyes esetekben két stabilizátort is fel kell 
használnunk a hímzéshez.

5. lépés Hímzés helyének 
jelölése

A hímzőkeret méretének megfelelő sablon 
használatával jelöljük ki a hímzés helyét a 
textílián.

A sablonrajzon található nyílak hegyénél
lyukasszuk át a sablont.

Helyezzük a sablont a textíliára, majd egy
ceruza hegyét a sablonon lévő lyukakon
átdugva jelöljük át a lyukakat a textíliára.

Kösszük össze a pontokat a textílián az
osztási mezők kirajzolásához.

Megjegyzés:
Mielőtt az egyedi méretű tervezőfelületen 
létrehozott hímzési minta adatkártyára kerül 
mentésre, vagy átmásolásra, a mezők 
széléhez előöltés kerül hozzáadásra, így a 
minták hímzés során a mezők könnyedén 
igazíthatók. Ezek az illesztő öltések a NOT 
DEFINED (nincs megadva) szín alatt 
jelennek meg, és nem szerkeszthetők.

Lásd a 181. oldalon szereplő 
„Ne feledjük” szakaszt.

Megjegyzés:
• A legjobb eredmény érdekében rögzítsük 

a textílián (az itt leírt módon). Megfelelő 
stabilizátor nélkül a textília gyűrődése 
miatt a grafika elcsúszhat, széteshet.

• A stabilizátor csomagolásán 
tanulmányozzuk az ajánlásokat.

Megjegyzés:
• A sablonok a csomagban találhatók.
• A Template mappában is találunk 

sablonokat, ezeket kinyomtathatjuk.
• A sablont tartalmazó PDF-fájlok valós 

méretben, 1:1-es méretben tartalmazzák a 
sablont. Az Adobe® Reader® programban 
tekintsük át a nyomtatási beállításokat: a 
„Reduce/Enlarge to fit page” (papír 
méretéhez igazít) beállítás torzíthatja a 
sablon méretét. Nyomtatás előtt kapcsoljuk 
ki ezt a beállítást.

1

2

3
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Helyezzük a sablont a textíliára, és jelöljük fel
az „A”, „B”, „C” és „D” pontokat.

Az előzőleg feljelölt területtől jobbra lévő mező
kijelöléséhez igazítsuk a sablon „A” és „D”
pontjait a textílián lévő „B” és „C” pontokra.

Az előzőleg feljelölt terület alatti mező
kijelöléséhez igazítsuk a sablon „A” és „B”
pontjait a textílián lévő „C” és „D” pontokra.

Ismételjük a 4-6. lépéseket a sablon
áthelyezéséhez és az egyes osztási mezők
felrajzolásához.

6. lépés Textília felfűzése a 
hímzőkeretbe

A keret műanyag hímzőlapjának használatával 
igazítsuk a hímzőlapon lévő illesztővonalakat a textílián 
lévő jelekhez. Ezután rögzítsük a textíliát a keretben, 
közben gondoskodjunk róla, hogy a textília nem mozdul 
el helyéről.

Helyezzük a hímzőlapot a keret belső
gyűrűjébe, majd ennek tetejére helyezzük a
textíliát úgy, hogy a hímzőlapon lévő közép-
vonala az első levarrandó mező illesztő-
vonalaival (textíliára rajzolva) álljanak.

4

A B

D C

5

A B

D C

A B

D C

6

A B

D C

A B

D C

7

Megjegyzés:
• A vízszintes és függőleges vonalak 

metszéspontja a hímzőkeret 
középpontját jelölik.

• Alaposan gondoljuk végig a textília keretre 
fűzésének módját, ezután helyezzük a 
sablont a textíliára, és rajzoljuk át a 
vonalakat a hímzés illesztési pontjainak 
kijelöléséhez. Nagy hímzőkeret esetén a 
sablon nem tartalmazza a teljes hímzési 
területet, ezért ügyelnünk kell, hogy a 
hímzési felület ne lógjon túl a textílián jelölt 
területen.

1
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A hímzőlapon lévő illesztővonalakat igazítsuk
az első mező illesztővonalaihoz, közben
helyezzük a textíliát és a keret belső gyűrűjét
a külső gyűrűbe, majd húzzuk feszesre a
textíliát.

Miután befűztük a textíliát a keretbe, vegyük ki
a hímzőlapot.

7. lépés Hímzés

Ezután minden készen áll a hímzéshez.

Nagy méretű hímzési minta letöltésekor a
hímzőgépbe, a minták a hímzőgépben az
alábbi ábrának megfelelően jelennek meg.
Először jelöljük ki az első hímzési mintát (Aa).

A hímzőkeretet csatlakoztassuk a hímző-
gépben, majd a készülék igazítási funkcióval
illesszük a tűt a textílián rajzolt vonalak
metszéspontjára.

Hímezzük le a mintát.

Vegyük ki a hímzőkeretet a hímzőgépből,
majd vegyük ki a textíliát a keretből.

Fűzzük át a textíiát a következő mező
hímzéséhez.

Lásd a 179. oldalon a Textília befűzése 
szakaszt.

Megjegyzés:
• Helyezzük a textíliát és a keret sík 

felületre, majd ellenőrizzük, hogy a belső 
gyűrű elég mélyen rögzüljön a külső 
gyűrűben: a kettő felső éleinek egy síkban 
kell állniuk.

• Ha nem használunk illesztőlapot, a 
hímzőkereten szereplő jelek segíthetnek 
az igazításban.
Azonban egyes hímzőgépeken az 
igazítási pont nem pontosan középen van, 
az illesztőlap pontosabb eredményt ad.

• A textília keretbe fűzésének másik módja 
öntapadós stabilizátor használata: külön 
fűzzük be a stabilizátort, húzzuk le a 
védőfóliát, majd az illesztőlap 
segítségével óvatosan igazítsuk a textíliát 
az öntapadós felületre.

• Tipp: A textília könnyebben befűzhető, ha 
duplex ragasztószalagot viszünk fel a 
belső gyűrű hátára, majd a textíliát a belső 
és a külső gyűrű közé csíptetjük.

2

3

Ne feledjük:
Ha nincs „Aa” mezőben nem szerepel öltés, 
válasszuk az első öltést is tartalmazó mezőt. 
A Design > Design Property menüpont alatt 
ellenőrizhetjük a varrási sorrendet.

1

2

3

4

5
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Folytassuk a textília keretbe fűzését és a

hímzést a teljes minta elkészültéig.

Megjegyzés:
Egyedi méretű tervezőfelületen létrehozott 
minták adatkártyára történő mentésekor, 
másolásakor illesztő öltések (egyenes 
vonalak előöltéssel levarrva, NOT DEFINED - 
nem megadott - színnel, 7 mm-es 
öltéshosszal, 0,3 mm-es öltéssel kezdve) 
jelölik a mezők széleit. A illesztő öltések a 
nyomtatási nézőképen és a nyomaton piros 
színnel jelennek meg.
Példa az illesztő öltések használatára a 
Largelace.pes fájl felhasználásával
(A fájl a Dokumentumok\
PE-DESIGN8\Sample\Layout & Editing 
mappában található).

1) Hímezzük le a bal-felső mezőt.
→ Illesztő öltés kerül levarrásra a mező 

alsó élére és jobb oldalára.

2) Fűzzük be a textíliát a jobb-felső mező 
levarrásához úgy, hogy a keret bal oldala 
a jobb oldali illesztő öltéshez igazodjon, 
majd hímezzük le a mezőt.
→ Mielőtt a mező tartalma hímzésre 

kerülne, bal oldalra is levarrásra kerül 
az illesztő öltéssor. Ellenőrizzük, hogy 
ez a sor fedje az 1. lépésben levarrt 
jobb oldali illesztő öltéssort. A mező 
lehímzését követően a mező alá is 
levarrásra kerül az illesztő vonal.

3) Fűzzük be a textíliát a bal-alsó mező 
levarrásához úgy, hogy a keret felső éle 
az 1. lépésben levarrt bal-felső mező 
alsó illesztő öltéséhez igazodjon, majd 
hímezzük le a mezőt.
→ Mielőtt a mező tartalma hímzésre 

kerülne, felülre is levarrásra kerül az 
illesztő öltéssor. Ellenőrizzük, hogy ez 
a sor fedje az 1. lépésben levarrt alsó 
illesztő öltéssort. A mező lehímzését 
követően a mező jobb oldalára is 
levarrásra kerül az illesztő vonal.

4) Fűzzük be a textíliát a jobb-alsó mező 
levarrásához úgy, hogy a keret bal oldala 
az 3. lépésben levarrt bal-alsó mező jobb 
illesztő öltéséhez, és a keret felső éle a 
2. lépésben levarrt jobb-felső mező alsó 
illesztő öltéséhez igazodjon, majd 
hímezzük le a mezőt.
→ Mielőtt a mező tartalma hímzésre 

kerülne, bal oldalra és felülre is 
levarrásra kerül az illesztő öltéssor. 
Ellenőrizzük, hogy ez a sor fedje a 2. 
és 3. lépésben levarrt illesztő 
öltéssorokat.

6
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Több állású hímzési minta létrehozása
A programmal több állású hímzési mintát is létrehozhatunk, melyet bármely, a hímzőgéphez csatlakoztatható 
több állású hímzőkerettel lehímezhetünk.

Több állású keret használata esetén kizárólag 130 x 180 mm-es (vagy 100 x 100 mm-es, a hímzőgép varrás 
felületétől függően) hímezhető le, először döntsük el, hogy a három rögzítési állásból (lásd a fenti ábrán az 
„a”, „b” és „c” jelzésű illesztőpontokat) melyikben kívánjuk rögzíteni a keretet, ezután határozzuk meg a terv 
tájolását.

Amikor a terv elkészült, az egyes osztási mezők mérete meg kell egyezzen a hímzőgép varrási felületével.

A bemutató fájl a következő mappában található: Dokumentumok\PE-DESIGN 8\Tutorial\Tutorial_10

1. lépés Adjuk meg a tervezőfelület 
méretét

A Layout & Editing programban kattintsunk az
Option > Design Page Property pontra.

→ A Design Page Property (tervezőfelület 
tulajdonságai) ablak jelenik meg.

Válasszuk ki a Hoop Size (keret mérete)
beállítást, és válasszunk a 130 × 300 mm vagy
100 × 172 mm-es méret közül.

a
b
c

a
b

c

ABC

Példa több állású hímzőkeretre: 100 × 172 mm keret

1. lépés Adjuk meg a tervezőfelület méretét.
2. lépés Hozzuk létre a mintát.
3. lépés Hajtsuk végre a keretre vonatkozó beállításokat.
4. lépés Ellenőrizzük a mintát.

1 Ne feledjük:
• A több állású keretre vonatkozó 

beállításokat a „ ” jelölés mutatja.
• A hímzőgépben használatos keret mérete 

alapján válasszuk ki a megfelelő méretet.

Megjegyzés:
Több állású keret beállítás a Design Center 
szoftver Design Page Property (tervező-
felület tulajdonságai) ablakban nem 
találhatók.

2
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2. lépés Terv létrehozása

A tervezőfelületen az alábbi ábrának
megfelelő formában jelenik meg.

Hozzuk létre a mintát, ügyeljünk hogy az
teljesítse a következő feltételeket.

Ha a tervet adatkártyára mentjük, és a mintát 
a hímzőgépben ellenőrizzük, az az 
alábbiaknak megfelelően jelenik meg.

• Egy minta mérete ne legyen nagyobb 100 x 
100 mm-nél (vagy 130 x 180 mm-nél).

• Mindegyik minta mérete tökéletes férjen el 
egy területen belül (a, b vagy c).

3 .lépés Keret cserék 
optimalizálása funkció

A Optimize hoop change funkcióval a több 
állású kerethez igazított tervezőfelületen szereplő 
minták varrási sorrendje automatikusan 
optimalizálásra kerül, így csökkenthetjük annak 
veszélyét, hogy a keret állásának feleslegesen 
gyakori módosítása miatt a textília adagolása 
problematikussá válik.

Ne feledjük:
„a” terület: A keret „a” felső állásban való 
rögzítésekor levarrható terület.
„b” terület: A keret „b” középső állásban való 
rögzítésekor levarrható terület.
„c” terület: A keret „c” középső állásban való 
rögzítésekor levarrható terület.
A pontozott vonal választja el az egyes 
területeket.

1

a

b

c

2

a

b

c

Ne feledjük:

1: A minta helyzete megfelelő, mivel teljesen 
elfér az „a” területen belül.

2: A minta helyzete megfelelő, mivel teljesen 
elfér a „b” vagy „c” területen.

3: A minta mérete elfogadható, de a helyzetét 
korrigálni kell, mivel ez nem fér el teljesen 
egyik területen belül sem (módosítanunk 
kell helyzetén, hogy elférjen a „b” vagy „c” 
pozícióban).

4: A mintát módosítani kell, mivel túl nagy 
(mind méretét, mind helyzetét módosítani 
kell, hogy elférjen az „a”, „b” vagy „c” 
pontban).

Megjegyzés:
Ha a minta nem felel meg az előző 
követelményeknek, egy figyelmeztetés 
jelenik meg a következő lépésre ugráskor.

a

b

c

4
32

1
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Kattintsunk a Sew > Optimize hoop change
(keret módosítás optimalizálása). 4. lépés Minta ellenőrzése

Kattintsunk az Option > Design Property
(terv tulajdonságai) pontra.

→ A Design Property ablak megjelenésével 
egyidőben a tervezőfelület az ablakot 
kitöltő méretben jelenik meg.

Ne feledjük:
• Pipa jelenik meg a funkció aktiválásakor; a 

funkció kikapcsolásakor eltűnik a pipa.

• Az Optimize hoop change funkciót 
bekapcsolva a varrási sorrend úgy 
módosul, hogy a lehető legkevesebb 
alkalommal kell majd a keret állásán 
változtatni.
A fenti példa esetében a varrási sorrend: a 
(1. minta) → b (2. minta) → a (3 & 5. minta) 
→ c (4 & 6. minta). A funkció kikapcsolt 
állapota mellett az előre beállított sorban 
kerülnek levarrásra a minták. A fenti példa 
esetében a varrási sorrend: a (1. minta) → 
b (2. minta) → a (3. minta) → c (4. minta) → 
a (5. minta) → c (6. minta).
Így optimalizálás nélkül többször kell 
módosítanunk a keret állását, mint 
optimalizálást követően.

Megjegyzés:
Mivel a minta nem kerül megfelelően 
levarrásra vagy a textília adagolása 
nehézkessé válhat a keret állásának túl 
gyakori cserélje miatt, ajánlott az Optimize 
hoop change funkció használata. A funkciót 
bekapcsolva módosulni fog a varrási 
sorrend, ezért hímzés előtt ajánlott a 
hímzési sorrend ellenőrzése.

1

a

b

c

4

2

13

5

6

Megjegyzés:
Fontos hogy a parancs kiadása előtt ne 
legyen kijelölt minta. Ha van kijelölt minta, 
kizárólag a megjelenített mintára vonatkozó 
adatok jelennek meg.

Ne feledjük:
• Az ablak első sora mutatja az éppen 

megjelenített minta keret állítási sorban 
betöltött helyét.

• Kizárólag a keret állítási sor aktuális helyén 
hímzésre kerülő minták jelennek meg a 
tervezőfelületen, és az aktuális keret 
helyzetén jellemző hímzési terület piros 
körvonallal jelenik meg.

• A keret állítási sor eltérő helyén hímzésre 
kerülő mintákat a Next (következő) és 
Previous (előző) pontokra kattintva 
jeleníthetjük meg. Ekkor a keret állásának 
megfelelő minták a tervezőfelületen is 
megjelennek.

Megjegyzés:
Ha a minta a hímzési területnél nagyobb, 
vagy a hímzési területen nem fér el teljesen, 
a “Please change the object size or 
position.” (kérjük módosítsunk az elem 
méretén, helyzetén) üzenet figyelmeztet. 
A kijelölést követően módosítsuk a minta 
méretét, helyzetét.

1
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Terv mentése
A teljes terv egy fájlba (.pes) kerül mentésre.

Terv mentése adatkártyára
A több állású kerethez tervezett minta esetén 
az egyes keret állásokhoz tartozó minták egy 
mintát alkotnak, melyek összekapcsolásával 
jön létre a teljes terv.

Emiatt adatkártyára történő mentéskor egy 
több állású keretes terv több minta 
kombinációjaként kerül mentésre.

: A minta a keret felső állásba 
helyezésekor kerül levarrásra („a” állás).

: A minta a keret középső állásba 
helyezésekor kerül levarrásra („b” állás).

: A minta a keret alsó állásba helyezésekor 
kerül levarrásra („c” állás).

A példában a keret állás szerinti varrási 
sorrendje tehát: b, a majd c.

Kiegészítések a több állású keretet 
alkalmazó hímzésekhez

• Mielőtt lehímezzük a tervet, végezzünk egy 
próbavarrást egy darab textílián, egyező tű 
és fonal használata mellett.

• Rögzítsünk stabilizátort a textília hátuljára 
és szorosan fűzzük be a textíliát a keretbe. 
Amikor vékony vagy stretch anyagra 
hímzünk, két réteg stabilizátort 
használjunk. Ha nem használunk 
stabilizátort, a textília túlnyúlhat, gyűrődhet.

• Nagy méretű grafika hímzésekor a 178. 
oldalon találunk tippeket a stabilizátor 
rögzítésére.

• Cikkcakk öltést alkalmazzunk a körvonalak 
varrásához, hogy a körvonalon kívül ne 
hímezzünk.

• Több állású kerettel hímzendő minták 
esetén a tervezéskor hagyjunk átfedést a 
minta egyes részei között, így 
megelőzhetjük a pontatlan illesztésből 
eredő esztétikai problémákat.

Ne feledjük:
Ha a fájl mérete vagy a színek száma 
meghaladja a megengedett értéket, vagy ha 
az egyik mérete nem fér el teljesen a hímzési 
területen, a “Please change the object size or 
position. Do you want to save the data 
anyway?” (Kérjük módosítsa az elem méretét, 
helyét. Mindenképp menti az adatokat?) 
üzenet figyelmeztet.

Átfedés
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Több állású kerethez beállított 
tervezőfelület nyomtatása

Ilyen esetben a tervezőfelület teljes tartalma az első 
lapon jelenik meg a nyomtatásban, a következő 
lapokon az egyes keret állásokhoz tartozó részletek 
és ezek varrási jellemzői (méretek, keret állása, 
varrási színsorrend, öltésszám). A nyomtatott lapok 
száma a terv függvényében alakul.

• 130 × 300 mm-es tervezőfelület esetén a 
minta 130 x 180 mm-es mezőkre lesz 
felosztva; mindegyik minta külön lapon 
jelenik meg.

• 100 × 172 mm-es tervezőfelület esetén a 
minta 100 x 100 mm-es mezőkre kerül 
felosztásra; mindegyik minta külön lapon 
jelenik meg.

A tervezőfelület tartalma az alábbi beállítások 
szerint nyomtatható:

Actual Size (valós méret) mód kiválasztásakor:
Az első oldalon a tervezőfelület teljes tartalma 
jelenik meg 1:1-es méretben. (130 x 300 mm-es 
tervezőfelület esetén kicsinyített kép jelenik 
meg.) Ezután a mintát alkotó egyes mezők 
jelennek meg külön lapon, az első keret állású 
mezővel az élen, ezt követi külön lapon a hozzá 
tartozó varrási adatok.

Reduced Size (csökkentett méret) mód 
kiválasztásakor:

Az első oldalon a teljes tervezőfelület kerül 
nyomtatásra 1:1-es méretben. (130 x 300 mm-
es tervezőfelület esetén kicsinyített kép jelenik 
meg.) Ezután a mintát alkotó egyes mezők 
jelennek meg külön lapon, az első keret állású 
mezővel az élen, a minta mellett egy oldalon a 
varrási adatokkal.

Ne feledjük:
A File – Print Preview menüpontok 
kijelölését követően a terv a fentieknek 
megfelelően jelenik meg a képernyőn is.
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Hímzési terv fájlok kezelése (Design Database)

H

ím
zési terv fájlok kezelése (D

esign D
atabase)
Design Database ablak

1 Eszközsáv
A menüparancsok gyors elérését teszi lehetővé.

2 Mappák listája
A számítógépen szereplő mappákhoz biztosít 
hozzáférést, és a végrehajtott keresések 
eredményét mutatja.

3 Kártya olvasó gomb
A kártya tartalmát olvassa be.

4 Mappa tartalmának megjelenítése gomb
Mappa tartalma jelenik meg a megfelelő 
ablakban.

5 Hímzőkeret méretének megadása

Meg kell adnunk a hímzőkeret méretét, amikor a 
hímzési tervet adatkártyára mentjük.

6 Kártyán foglalt tárhely méretet jelző sáv
Mutatja, hogy a kijelölt terv (az Írás (writing) 
listában megjelenített terv) által a kártyán 
elfoglalt tárhelyet mutatja.

7 Írás gomb
A kiválasztott minta mentésre kerül a kártyán.

8 Törlés gomb
A kiválaszttot terv kijelölésést megszünteti (nem 
kerül mentésre a kártyán).

9 Írás lista
A kártyára írandó tervek listája.

10 Hozzaádás gomb
A felső ablakban kijelölt terv hozzáadása a 
kártyára írandó tervek listájához.

11 Írás lista megjelenítése/elrejtése gomb
Nyomjuk le amikor kártyára kívánunk menteni 
terveket. Újra a gombra kattintva elrejthetjük az 
Írás listát.

12 Tartalom ablak
A kiválasztott mappában tárolt hímzési tervek 
miniatűr nézőképeit jeleníti meg.

Design Database indítása
1. Kattintsunk a  ikonra, majd kattintsunk a 

MInden program (Programok) > PE-DESIGN 8 
> Tools > Design Database pontokra.

2. Kattintsunk a mappa listában a kívánt 
mappára.

→ Az adott mappában szereplő összes terv 
miniatűr nézőkép megjelenik a jobb oldali 
ablakban.

5
3

6
4

2

1

7
8

9

10
11

12

Ne feledjük:
• A következő kiterjesztésű fájlokat ismeri fel 

a program: 
.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, 
.jef, .sew, .csd, .xxx, .pen

• .pem kiterjesztésű fájlok nem jelennek meg, 
mivel ezeket hímzőgép nem tudja 
feldolgozni. Töltsük be a .pem fájlt a Layout & 
Editing szoftverbe, majd mentsük el .pes 
fájlként.

Lásd a 152. oldalon a Betöltés a 
Layout & Editing szoftverbe 
szakaszt.
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Hímzési tervek megtekintése
Fájlok nézőképének 
megtekintése

A hímzési tervet nézőképen tekinthetjük meg.

Eszközsáv ikon: 

1. A mappa listában válasszuk ki a kívánt tervet 
tartalmazó mappát.

2. A Tartalom ablakban válasszuk ki a kívánt 
tervet.

3. Kattintsunk a ikonra, vagy kattintsunk a 

Display > Preview (nézőkép) pontra.

Fájl adatainak 
megtekintése

A Property ablakban megjelennek a fájl adatai: név, 
méret, öltésszám, varrási idő, színek száma, 
módosítás dátuma stb. 

.pes fájl esetén a hímzési terv további adatai 
jelennek meg.

Eszközsáv ikon: 

1. A Tartalom ablakban jelöljük ki a kívánt 
hímzési tervet.

2. Kattintsunk a  ikonra vagy a Display > 

Property pontra.

→ Ha egyedi méretű vagy több állású 
kerethez igazított tervezőfelület került 
beállításra (100 x 172 mm, 130 x 300 
mm), az alábbi ablakhoz hasonló 
Property ablak jelenik meg.

Ne feledjük:
A .pen formátumú fájlok nem jelennek meg a 
nézőképen.

Megjegyzés:
• A megjelenő varrási idő csak becsült 

érték. A valós levarrási idő függ a 
készülék típusától és a beállításoktól.

• A varrási idő .pen formátumú fájlok 
esetében nem jelenik meg.

Megjegyzés:
• A piros keret mutatja a megjelenített minta 

mező helyzetét.
• A további keret állásokhoz tartozó minták 

megjelenítéséhez kattintsunk a  

vagy  ikonra.

Nem PES fájlok és 
PES-fájlok 
(3.0 vagy korábbi 
változat)

PES fájlok
(4.0 vagy későbbi 
változat)
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Hímzési terv megnyitása
Fájl megnyitása a Layout & 
Editing szoftverrel

A Layout & Editing szoftverrel könnyedén 
megnyithatjuk a .pes fájlokat.

1. A mappa listában válasszuk ki a kívánt tervet 
tartalmazó mappát.

2. A Tartalom ablakban válasszuk ki a .pes fájlt.

3. Kattintsunk a File > Open in Layout & 
Editing (megnyitás a Layout & Editing 
szoftverben) pontra.

→ A kiválasztott hímzési minta megjelenik 
az új tervezőfelületen.

Fájlok betöltése a Layout & 
Editing szoftverbe

Bármely kijelölt hímzési tervet betölthetjük a Layout 
& Editing szoftverbe. A következő formátumú 
fájlokat ismeri fel a szoftver: Layout & Editing:
.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, .jef, .sew, 
.csd, és .xxx.

1. A mappa listában válasszuk ki a kívánt tervet 
tartalmazó mappát.

2. A Tartalom ablakban válasszuk ki a hímzési 
tervet.

3. Kattintsunk a File > Import Into Layout & 
Editing (betöltés a Layout & Editing 
szoftverbe) pontra.

→ A kiválasztott hímzési terv megjelenik a 
Layout & Editing munkaterületen.

Megjegyzés:
Fontos hogy a .pes fájlt tartalmazó mappát 
megnyissuk.

Megjegyzés:
.pen formátumú fájlok nem tölthetők be a 
Layout & Editing szoftverbe.
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Hímzési tervek rendezése
Különböző mappákban menthetjük a hímzési terveket, így kategórizálhatjuk, szortírozhatjuk őket. A hímzési 
tervek megjeleníthetők miniatűr formátumban, vagy a minta kiegészítő adatai, „részletei” alapján.

Új mappa létrehozása

Új mappák létrehozása a tervek szétválogatását, 
kategórizálását szolgálják. 

1. A mappa listában jelöljük ki a kívánt mappát.

2. Kattintsunk a File > Create New Folder (új 
mappa létrehozása) pontra.

→ Egy Új mappa jön létre a kiválasztott 
mappán belül.

3. Adjuk meg az új mappa nevét, majd nyomjuk 
le az  gombot.

→ A mappa neve a begépelt névre változik.

Fájlok áthelyezése, 
másolás másik mappába

A Design Database szoftverben a kijelölt fájl 
könnyedén áthelyezhető az egyik mappából a 
másikba.

1. A mappa listában keressük ki a mappát, 
amelybe a tervet áthelyezni kívánjuk.

2. A mappa listában keressük ki a mappát, 
amelyik az áthelyezni kívánt tervet 
tartalmazza.

3. Húzzuk a Tartalom ablakban szereplő tervet a 
korábban kiválasztott célmappába.

→ Ha a két mappa ugyanazon meghajtón 
van, a kiválasztott mappa áthelyezésre 
kerül (törlődik az eredeti helyről).

→ Ha a két mappa eltérő meghajtón van, a 
kiválasztott terv átmásolásra kerül 
(megmarad az eredeti mappában is).

Fájl nevének módosítása

A Design Database szoftverben a fájl nevét is 
módosíthatjuk.

Enter

Ne feledjük:
• Ha ugyanazon meghajtón lévő két mappa 

között kívánunk másolni, tartsuk nyomva a 
 gombot a terv áthúzása alatt.

• A fájl áthelyezéséhez az egyik mappából a 
másikba eltérő meghajtók esetén, tartsuk 
lenyomva a  gombot a terv áthúzása 
alatt.

• A fájl az Edit - Cut (kivágás) és Edit - Copy 
(másolás) menüparancsokkal is 
áthelyezhető az egyik mappából a másikba. 
A célmappában adjuk ki az Edit - Paste 
(beillesztés) parancsot.

Megjegyzés:
A terv neve csak akkor módosítható, ha a 
varrási adatok kerültek megjelenítésre 
(Display – Details menüparancs).

Lásd a 191. oldalon.

Ctrl

Shift
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1. A mappa listában válasszuk ki a hímzési 
tervet tartalmazó mappát.

2. Válasszuk ki a hímzési tervet. Kattintsunk 
újra.

→ A név kiemelésre kerül a kereten belül.

3. Gépeljük be az új fájlnevet, majd nyomjuk le 
az  gombot.

Fájlok törlése

A Design Database szoftverben törölhetjük is a 
hímzési terveket.

1. A mappa listában válasszuk ki a törölni kívánt 
hímzési tervet tartalmazó mappát.

2. A Tartalom ablakban jelöljük ki az adott 
hímzési tervet.

3. Nyomjuk le a  gombot.

→ A fájl a Lomtárba kerül.

Fájlok megjelenítésének 
módosítása

A Tartalom ablak a hímzési terveket mutató miniatűr 
nézőképek mérete állítható, valamint jellemző 
adatikat (részletek) is megjeleníthetjük.

1. Kattintsunk a Display menüpontra, majd a 
megjelenő menüben válasszuk ki a kívánt 
megjelenítési módot.

Nagyobb nézőkép megjelenítéséhez válaszuk 

a Large Thumbnails-t vagy a  ikont.

Kisebb nézőkép megjelenítéséhez válaszuk a 

Small Thumbnails-t vagy a  ikont.

A tervek megjelenítéséhez kattintsunk a 

Részletek gombra vagy a  ikonra.

Ne feledjük:
A fájl átnevezésekor a fájl kiterjesztése nem 
módosítható.

Enter

Delete
191



Hímzési terv fájlok kezelése (Design Database)
Hímzési terv kikeresése
A Keresés funkcióval gyorsan kikereshetjük a kívánt hímzési tervet (.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, 
.jef, .sew, .csd, .xxx, vagy .pen) a kijelölt meghajtón, mappában, a megadott keresési feltételek szerint.

1. A mappa listában válasszuk ki a mappát.

2. Kattintsunk a File > Search (keresés) pontra.

3. Adjuk meg a keresési feltételeket. A kívánt 
keresési feltétel előtt pipáljuk ki a kapcsolót.

File Name (fájl neve)
Keresés adott név szerint. Gépeljük be a 
mezőbe a nevet.

Format (formátum)
Keresés adott fájl formátumra. A kívánt 
formátum mellett pipáljuk ki a kapcsolót.

Stitch Count (öltésszám)
Adott öltésszámot tároló fájlokra való keresés. 
A mezőkben adjuk meg az alsó és felső 
küszöbértéket (ezek között keres a program). 

Color Count (színek száma)
Adott számú színből álló grafikát tároló 
fájlokra való keresés. A mezőkben adjuk meg 
az alsó és felső küszöbértéket (ezek közötti 
fonalszíneket tartalmazó fájlra keres a 
készülék)

Width (szélesség)
Adott szélességű hímzési tervre kereshetünk. 
A mezőkben adjuk meg az alsó és felső 
küszöbértéket.

Height (magasság)
Adott szélességű hímzési tervre kereshetünk. 
A mezőkben adjuk meg az alsó és felső 
küszöbértéket.

Date Modified (módosítás dátuma)
Keresés adott időpontban módosított fájlra. 
A mezőkben adjuk meg a keresés időtartamát 
(-tól -ig).

.pes fájlra esetében további feltételek szerint 
is kereshetünk:

Design Name (terv neve)
Keresés a terv megnevezése alapján. 
Gépeljük be a mezőbe a terv nevét.

Category (kategória, téma)
Keresés kategória szerint. A mezőben adjuk 
meg a hímzés kategóriáját.

Author (szerző)
A fájlhoz rendelt szerző alapján történő 
keresés. A mezőben gépeljük be a szerző 
nevét.

Keywords (kulcsszó)
Adott kulcsszó alapján történő keresés. A 
mezőben gépeljük be a kulcsszót.

Comment (megjegyzés)
A fájlhoz tartozó kiegészítő megjegyzés alapján 
történő keresés. Gépeljük be a keresett 
szöveget.

4. Kattintsunk a Search pontra.

→ A keresési feltételeknek megfelelő fájlok 
listája jelenik meg.

Ne feledjük:
„Joker” karaktereket is használhatunk: a „?” 
egy (ismeretlen) karaktert helyettesít, a „ ” 
(ismeretlen) karaktersorozatot helyettesít.

Ne feledjük:
• Almappákban történő kereséshez pipáljuk 

ki a Search subfolders kapcsolót.
• A program a File Name felirat melleti 

mezőbe gépelt karakterek egy egységes 
karaktersorként kezeli. A név szerinti 
kereséskor több eltérő szóra is kereshetünk 
a Search Conditions (csak PES fájlok 
esetén) alatti mezőkbe begépelve a 
szöveget, a szavak szóközzel való 
elválasztása mellett.
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Hímzési tervek mentése eltérő fájl 
formátumban
A hímzési terveket a következő formátumokba menthetjük át: .pes, .dst, .exp, .pcs, .hus, .vip, .shv, .jef, .sew, 
.csd, vagy .xxx.

1. A mappa listában válasszuk ki az átalakítani 
kívánt fájlt tartalmazó mappát.

2. A Tartalom mappában válasszuk ki a hímzési 
terv fájlt.

3. Kattintsunk a File > Convert Format pontra.

4. A Format Type mezőben adjuk meg a kívánt 
formátumot.

5. Output To pont alatt:, adjuk meg, hogy az új 
fájl az eredetivel egyező mappába kerüljön 
mentésre (Same folder) vagy másik, eltérő 
mappába (Following folder - adjuk meg a 
mappát).

6. Kattintsunk a Convert (átalakít) gombra.

→ A fájl az új formátumban kerül mentésre a 
megadott célmappába.

Ne feledjük:
DST formátum esetén megadhatjuk, hogy az 
ugró öltések az ugró kódok száma alapján 
elvágásra kerüljenek vagy sem. Mivel a kódok 
száma az alkalmazott varrógéptől függően 
változhat, gépeljük be vagy válasszuk ki a 
megfelelő értéket a Number of jumps for 
trim (ugrások száma vágáshoz) mezőben. Ez 
a beállítás kizárólag DST formátum esetén 
jelenik meg.

Ne feledjük:
• Same folder (ugyanoda) beállítással több 

fájlt eltérő formátumban mentünk le, egy új 
fájl formátumával egyező formátumú fájl 
már nem kerül mentésre. 
Ha a fájl az eredetitől eltérő mappába kerül 
mentésre, bármely fájl, amelyik az újjal 
megegyező formátumú, másik mappán 
mentésre kerül.

• A célmappa módosításához kattintsunk a 

 ikonra.

Ne feledjük:
• Ha a fájlt .pes formátumban mentjük el, a 

fonal színek olyan módon kerülnek men-
tésre, mintha betöltöttük volna a Layout & 
Editing szoftverbe.

Megjegyzés:
.phc és .pen formátumba nem menthetők a 
fájlok.
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Hímzési terv fájlok mentése adatkártyára
A fájlokat adatkártyára is írhatjuk. A kártyát a 
hímzőgépbe helyezve a rajta tárolt hímzési terv 
levarrható.

1. Helyezzük be az adatkártyát az USB-s 
kártyaíró egységbe. PHC kiterjesztésű fájlon 
kívül bármilyen fájlt írhatunk kártyára.

Terv lementése adatkártyára a 17. 
oldalon.

2. Kattintsunk a  ikonra.

→ Card writing list (kártyára írás) ablak 
jelenik meg.

3. A Hoop size (keret méret) kiválasztóban 
adjuk meg a hímzőkeret méretét.

4. Kattintsunk a  ikonra, majd 
válasszuk ki a mappát, ahol a kívánt terv 
található.

→ Az adott mappában található összes 
hímzési terv megjelenik a Tartalom 
ablakban.

5. Válasszuk ki a kívánt tervet.

6. Kattintsunk a  ikonra, vagy a jobb-
egérgombbal a fájlra, és válasszuk az Add to 
Writing List (hozzáadás az Írás listához).

→ A kiválasztott fájl megjelenik az Írás 
listában.

Ne feledjük:
• Az írás lista elrejtéséhez kattintsunk a 

ikonra.

Tartalom ablak 
(választható minták)

Írás lista
(kiválasztott minták)

Megjegyzés:
Ne válasszunk a hímzőgépben ténylegesen 
alkalmazott hímzőkeret méreténél nagyobb 
méretet. Ellenkező esetben az adatkártya 
nem fog megfelelően együttműködni a 
hímzőgéppel.

Ne feledjük:
Egy adott fájlt úgy is kijelölhetünk írásra, hogy 
kiválasztjuk a fájlt, majd áthúzzuk az Írás 
listába.

Megjegyzés:
Ha a minta nagyobb a 3. lépésben megadott 
hímzőkeret méretnél, vagy az öltések 
száma, színek száma túllépi a hímző-
keretnél megengedett értéket, a fájl nem 
adható hozzá az Írás listához.
Csak az Írás listában megjelenő tervek 
kerülnek mentésre az adatkártyán.
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7. Mindezt addig folytassuk, amíg az összes 
kártyára írni kívánt fájlt kijelöltük.

8. Miután a kártyára írni kívánt tervek 
megjelennek az Írás listában, kattintsunk a 

 ikonra a tervek kártyára írásához.

9. Kattintsunk az OK-ra.

→ A hímzési tervek a kártyára íródnak.

10. A kártyára írt hímzési tervek ellenőrzéséhez 

kattintsunk a  ikonra.

→  ikon jelenik meg a Mappa 
listában, és az összes terv megjelenik a 
Tartalom ablakban.

Ne feledjük:
• Terv törléséhez a listából, válasszuk ki az 

adott tervet, majd kattintsunk a  
ikonra, vagy jobb egérgombbal kattintsunk, 
majd válasszuk a Remove from Writing 
List (törlés az Írás listából) pontot.

• Egyedi méretű tervezőfelületen létrehozott 
mintákat mezőnként felosztva írhatjuk 
kártyákra.

Lásd a 139. oldalon a „Ne 
feledjük” keretes részt.

Ne feledjük:
• A művelet közben a kártyán folgalt tárhelyet 

jelző sáv segít az adott kártyára írható 
tervek összeállításában. A kártyák által 
elfoglalt tárhely kék színben látható.

• A hímzési fájlok újraírásához kattintsunk a 
 gombra, majd válasszuk ki ezen 

fájlokat, és húzzuk az Írás listába.

Megjegyzés:
Ne vegyük ki a kártyát, vagy húzzuk ki az 
USB-kábelt, amíg a tervek kártyára írása 
folyamatban van (a LED-lámpa villog).

Ne feledjük:
• A Tartalom ablakban az adatkártyára írt 

fájlok „Card Data” megnevezéssel láthatók.
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Levonat készítése a hímzési tervekről
Nyomtatás

A kiválasztott mappában szereplő hímzési tervekről 
indexlap, katalógus nyomtatható.

1. A Mappa listában jelöljük ki a hímzési terveket 
tartalmazó mappát.

2. Kattintsunk a File > Print Setup (beállítás 
nyomtatása) pontra.

3. A Print Layout (oldalterv kialakítása) 
beállításnál megadhatjuk, hogy minden terv 
egy különálló lapon jelenjen meg, 4 terv 
jelenjen meg egy lapon vagy 12 terv jelenjen 
meg egy lapon.

4. A Color Description (szín leírása) 
beállításnál megadhatjuk, hogy a fonalszínek 
a szín megnevezésével jelenjenek meg, vagy 
a fonal márkájának és számának 
megjelölésével.

5. Kattintsunk a Print gombra.

Exportálás HTML fájlként

Nyomtatás helyett a katalógus HTML fájlként is 
elmenthető.

1. A Mappa listában jelöljük ki a hímzési terveket 
tartalmazó mappát.

2. Kattintsunk a File > Create HTML (HTML 
létrehozása) pontra.

3. Válasszuk ki a meghajtót, a mappát, majd 
gépeljük be a HTML fájl nevét.

4. A Page Title mezőben címet adhatunk a 
HTML oldalnak.

5. A Page Layout (oldalterv kialakítás) 
beállításnál megadhatjuk, hogy hány terv 
szerepeljen az oldalon.

6. Kattintsunk a Save (mentés) gombra.
Ne feledjük:

Ha a márka neve és a fonal száma túl hosszú 
volna, a szöveg vége lemarad a 
nyomtatásból.

Ne feledjük:
• Ha a Tartalom ablakban egy vagy több 

hímzési terv kiválasztásra került, kizárólag 
a kiválasztott tervek kerülnek nyomtatásra.

• A levonatok a File > Print menüpontra 
kattintva nyomtathatók ki. A tervek a Print 
Setup ablakban megadott beállításoknak 
megfelelően kerülnek nyomtatásra.
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Hímzési terv fájlok kezelése (Design Database)
H

ím
zési terv fájlok kezelése (D

esign D
atabase)
Exportálás a CSV 
formátumban

A .csv fájlban kimenthetjük a hímzési terv jellemző 
adatait (fájl neve, méretek, öltések száma, színek 
száma, elérési út, fájl tulajdonságok (.pes fájlok), 
fonalszínek megnevezése, fonalak száma).

1. A Mappa listában válasszuk ki a kívánt tervet 
tartalmazó mappát.

2. Kattintsunk a File > Create CSV (CSV 
létrehozása) pontra.

3. Válasszuk ki a meghajtót, a mappát, majd 
gépeljük be a .csv fájl nevét.

4. Kattintsunk a Save (mentés) gombra.
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 Programmable Stitch Creator alapműveletek

Program

m
able Stitch C

reator alapm
űveletek
A Programmable Stitch Creator szoftverrel egyedi kitöltő és bélyegzőminta öltést készíthetünk, melyet mind a 
Layout & Editing, mind a Design Center szoftverben felhasználhatunk. A kitöltő/bélyegzőminta öltések 
programozható kitöltő öltésként és bélyegzőmintaként alkalmazható a szoftverekben. További látványos 
öltésmintákat hozhatunk létre ezen a öltések felhasználásával.

Programmable Stitch Creator munkaablak
1 Eszközsáv

Billentyűparancsok a főbb menüparancsokhoz.

2 Eszköztár
Motívum, kitöltő és bélyegzőminta öltési minták 
kiválasztására és létrehozására szolgál.
(Az alsó négy gomb nem jelenik meg motívum 
módban.)

3 Preview (nézőkép) ablak
A minta levarrását jeleníti meg.

4 Tervezőfelület
A munkaterület menthető, ténylegesen 
felhasználható része.

5 Munkaterület

Kitöltő/bélyegzőminta öltések készítése
Meglévő programozható öltési minták felhasználásával hozhatunk létre új mintákat.

4

2

1

5

3

1. lépés Kitöltő/bélyegzőminta öltési minta megnyitása
2. lépés Vonalrajz készítése a kitöltő/bélyegzőminta öltési mintához
3. lépés Dombor/véset effekt végrehajtása a kitöltő/bélyegzőminta öltési mintán 
4. lépés Módosított kitöltő/bélyegzőminta öltési minta mentése
5. lépés A kitöltő/bélyegzőminta öltési minta mentése a Layout & Editing szoftverben
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Programmable Stitch Creator alapműveletek
1. lépés Kitöltő/bélyegzőminta 
megnyitása

Első lépésként megnyitjuk a kiindulási alapként 
szolgáló kitöltő/öltési mintát: a wave1.pas mintát 
fogjuk felhasználni.

Kattintsunk a  ikont, majd válasszuk a
Programok > PE-DESIGN 8 > Tools > 
Programmable Stitch Creator pontot.

Kattintsunk a File > Open (megnyitás) pontra.

Válasszuk a wave1.pas fájlt a Pattern 
mappában a PE-DESIGN telepítési helyén 
belül. (Például: Program Files > Brother > 
PE-DEISGN 8 > Pattern mappa.) Kattintsunk 
az Open parancsra vagy kétszer a fájlon.

1. lépés Vonalak rajzolása a kitöltő/
bélyegzőminta öltéshez 

Az Eszköztárból a Vonal eszközzel rajzolhatunk 
vonalakat.

Kattintsunk a  pontra.

Kattintsunk a tervezőfelületen a 1-4. pontokra.

Kattintsunk kétszer a tervezőfelültere az 5-ös
pont kijelöléséhez (vég pont).

Ismételjük az előző műveleteket egy újabb
rajzolásához jobb oldali két hullám közé.

Ne feledjük:
A következő példában Medium (közepes) 
rácsbeállítást alkalmazunk. Részletesen lásd 
a 215. oldalon a „Rácsbeállítás módosítása” 
pontot.

1

2

3

1

2

1

2

3

4

Ne feledjük:
• A vízszintes és függőleges mindig a 

rácshoz igazodnak. A létrehozott pontok 
mindig a függőleges és vízszintes vonalak 
metszésébe kerülnek, így 45 fokos átlós 
vonalat is könnyen rajzolhatunk. Tehát 
bárhova is kattintunk, a pont automatikusan 
legközelebbi metszéspontba kerül.

• Az utolsó megadott pont törléséhez 
kattintsunk a jobb egérgombbal.

A 208. oldalon kattintsunk a Minta 
létrehozása Kitöltő/
bélyegzőminta módban 
szakaszra.

3

5

4
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3. lépés Dombor/véset hatás a 
kitöltő/bélyegző mintán

A kitöltő mintán vagy a bélyegzőmintán dombor 
vagy véset effekt végrehajtásával később a 
mintákat alkalmaző hímzés egésze kap egy 
dombor- vagy véset hatást.
A minta vonalainak zárt felületeket kell alkotnia az 
effekt végrehajtásához. Példánkan a vonalak 
nem alkotnak zárt felületeket, így záró vonalakkal 
még ki kell egészítenünk a mintát.

Kattintsunk a  ikontra, majd kattintsunk
egyszer a tervezőfelületen az 1-es, kétszer a
2-es pont kijelöléséhez.

Ezután kattintsunk a tervezőfelületre a 3-as 
pont kijelöléséhez, kétszer a 4-es ponthoz.

→ A tervezőfelület alsó és felső szélén 
futnak majd a vonalak.

Kattintsunk a (Felül (véset)) ikonra,
majd az 1. és 4. hullám felületre. 

→ Ezek a felületek piros színben jelennek 
meg, és rövid öltésekkel kerülnek 
levarrásra a véset hatás eléréséhez.

Kattintsunk a ikonra, (Felület (dom-
bor)), majd a második és ötödik felületre.

→ A felületek kék színben és folytonos 
öltéssel kerül levarrásra, domborhatást 
keltve.

4. lépés Kitöltő/bélyegzőminta 
öltés mentése

A módosított mintát elmenthetjük. A kitöltő/
bélyegzőminta .pas formátumban kerül mentésre.

Kattintsunk a File > Save As (mentés mint)
pontra.

Válasszuk ki a meghajtót és a mappát, majd
gépeljük a fájl nevét.

Kattintsunk a Save (ment) pontra.

Kattintsunk a File > Exit (kilépés) pontra.

1

1 2

4 3

2

3

1

2

3
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Programmable Stitch Creator alapműveletek
5. lépés Az elkészült kitöltő/bélyegőzminta 
használata a Layout & Editingben

Indítsuk el a Layout & Editing szoftvert.
Válasszunk egy hímzési tervet.
A Region sew type (felület öltéstípus)
legördülő listában válasszuk a Prog. Fill
Stitch (programozható kitöltő öltés) pontot.

Kattintsunk a Sew > Sewing Attribute Setting
(varrási jellemzők) menüpontra.

Lásd a 47. oldalon a Layout & Editing 
munkaablak szakaszt.

Kattintsunk a  ikonra a Programmable
fill (programozható kitöltő öltés) pont mellett.

Válasszuk ki a meghajtót és a mappát, ahova
a 4. lépésben mentettük a mintát.

Kattintsunk a kitöltő/bélyegzőminta mintára,
majd kattintsunk az OK-ra.
→ A minta végrehajtásra kerül a teljes minta 

belső felületein.

Ha szükséges, módosítsuk a varrási 
jellemzőket.

1

2

3

4

5

6

7

Ne feledjük:
• A kitöltő/bélyegzőminta bélyegzőmintaként 

is felhasználható a  ikon 
használatával.

A 114. oldalon Bélyegzőminta 
használata, módosítása 
szakaszt.

• A szebb hímzés érdekében olvassuk a 109. 
oldalon a „Tudnivalók a programozható 
kitöltő öltésekről és bélyegzőmintákról” 
szakaszt.

8
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Motívum öltési minta létrehozása
Egy teljesen új motívum öltési mintát hozunk létre. Ehhez a motívum módba kell váltanunk.

1. lépés Belépés motívum módba

Indítsuk el a Programmable Stitch Creator
programot.

Kattintsunk a Mode > Motif (motívum) pontra.

→ A program motívum módba vált.

2. lépés Vonal átalakítása motívum 
mintává

Motívum módban teljesen új mintát fogunk 
létrehozni egyetlen vonal alakjának módosításával. 
Ezen minták felhasználhatók a vonal és felület 
hímzéséhez a Layout & Editing programban, és 
felület varrásához a Design Center programban.

Kattintsunk a ikonra, majd húzzuk meg
az alapvonalat a kezdő pontra (kék négyzet)
és a záró pontra (piros négyzet) kattintva.

→ Négyzet fogópont jelenik meg.

Húzzuk el a pontot.
A pont elhúzásakor a vonal zöldre vált.

1. lépés Motívum módba történő belépés
2. lépés Egyetlen vonal átalakítása motívum öltési mintává
3. lépés Az új motívum minta mentése
4. lépés Az új motívum öltés alkalmazása a Layout & Editing szoftverben

1

2

1

2
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Programmable Stitch Creator alapműveletek
3. lépés A motívum öltési minta 
mentése

Az öltési mintát el is menthetjük. A motívum öltési 
minta .pmf formátumban is menthető.

A minták a kitöltő/bélyegzőminta öltési mintákkal 
egyező módon menthetők.

Lásd a 201. oldalon a Kitöltő/
bélyegzőminta öltési minta mentése 
szakaszt.

4. lépés Az új öltési minta alkalma-
zása a Layout & Editingben 

Indítsuk el a Layout & Editing szoftvert.

Válasszunk egy öltési mintát.

A Line sew type (vonal öltéstípus) legördülő
menüből válasszuk a Motif Stitch pontot.

Kattintsunk a Sew > Sewing Attribute Setting
(varrási jellemző beállítása) pontra.

Lásd a 47. oldalon a Layout & Editing 
munkaablak pontot.

Kattintsunk a pontra a Pattern (minta)
mellett.

Válasszuk ki a meghajtót és a mappát, ahova
a 4. lépésben a mintát mentettük.

Kattintsunk az új motívum öltési mintára, majd
az OK-ra.

→ A minta végigfut a hímzési minta 
körvonalán.

Igény esetén módosítsuk a varrási 
jellemzőket.

Ne feledjük:
• A pont vízszintes vagy függőleges 

mozgatásához a húzás közben tartsuk 
lenyomva a  gombot.

• A nyíl gombok lenyomásával a kijelölt 
pontot egy rácsközzel arrébb ugratjuk a 
lenyomott nyíl irányában. Ha a rács nem 
látható, a minta a legkisebb rácsköznél 
kisebb mértékben mozdul el a nyíl 
irányában.

• A kijelölt pont törléséhez nyomjuk le a 
 gombot.

Shift

Delete

1

2

3

4

Ne feledjük:
Motívum öltési minta alkalmazásához a felület 
öltéstípus beállításnál a motívum (motif), a 
sarkos (piping) vagy quilt (steppelő - stippling) 
öltést választjuk.

5

6

7
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)

Egyedi öltési m

inta létrehozása (Program
m

able Stitch C
reator)
A fejezet Programmable Stitch Creator program különféle műveleteit, beállításait ismerteti. A programmal 
létrehozott, szerkesztett és elmentett öltési mintákat programozható kitöltő öltésként vagy motívum öltésként 
alkalmazhatjuk. A kétféle minta kezeléséhez be kell lépnünk a megfelelő módba.

Kitöltő/bélyegzőminta öltési minta

• Ezen minták a Layout & Editing és Design Center programokban bélyegzőmintaként és 
programozható öltési mintaként használhatók.

• A minták egyetlen vagy több vonal bevonásával is készülhetnek. A levarrt felületet dombor- és 
vésethatással tehetjük még látványosabbá.

• A mintákat Kitöltő/bélyegzőminta (Fill/Stamp) módban hozhatjuk létre.

Motívum öltési minták

• Ezen minták a Layout & Editing és Design Center programokban vonal varrásához motívum (motif) 
öltéstípus, vagy felület varrásához a motívum (motif), sarkos (piping) és pontozott (stippling) 
öltéstípusok kiválasztásával használhatók.

• A minták egyetlen vonalból állnak, így egyetlen vonással meghúzott rajz hatását keltik, és díszítő gépi 
varrásra szolgálnak.

• A mintákat motívum (motif) módban hozhatjuk létre.

véset dombor
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Minta fájl megnyitása
A korábban elmentet fájl bármikor megnyitható.

Eszközsáv ikon: 

1. Kattintsunk a ikonra, vagy a File > 

Open pontra.

2. Válasszuk ki a meghajtót és a mappát.

3. Fájl megnyitásához jelöljük ki a fájlt, majd 
kattintsunk az Open (megnyitás) parancsra, 
vagy kattintsunk kétszer a fájl ikonján.

→ A kiválasztott fájl tartalma megjelenik a 
munkaterületen.

Háttérkép megnyitása 

Megnyithatunk egy képet, amely a háttérben 
sablonként, kézvezetőként szolgálhat a kitöltő/
bélyegzőminta és a motívum minta vonalainak 
megrajzolásához. Számos formátumú fájlt 
megnyithatunk.

Lásd a 19. oldalon a Kompatibilis képi 
formátumok szakaszt.

1. Kattintsunk a File > Template Open (sablon 
megnyitása) pontra.

2. Válasszuk ki a meghajtót, a mappát és a 
kívánt fájlt.

3. Kattintsunk az Open (megnyitás) pontra a fájl 
megnyitásához.

→ A kép kitölti a teljes munkaterületet.

Megjegyzés:
Kitöltő/bélyegzőminta öltési minta 
megnyitásához a .pas formátumú fájlt 
tartalmazó mappát válasszuk ki. Motívum 
öltési minta megnyitásához a .pmf 
formátumú fájlt tartalmazó mappát 
válasszuk ki.

Ne feledjük:
• A fáljok miniatűr nézőképes 

megjelenítéséhez kattintsunk az Open 
ablakban a Browse (tallóz) gombra.

• A minta közepén átfutó zöld nyíl motívum 
öltést jelez (.pmf), ha ez nem jelenik meg, 
kitöltő/bélyegzőminta öltési mintát látunk 
(.pas).

• A bélyegzőmintákat piros (véset hatású 
kitöltő - fill - öltéssel levarrásnál) és kék 
(dombor hatású satin öltéssel levarrásnál) 
területek jelzik.

Ne feledjük:
A program a kiválasztott mintának 
megfelelően automatikusan vált a megfelelő 
módra (kitöltő/bélyegzőminta módba .pas fájl 
és motívum módba .pmf fájl esetén).

Megjegyzés:
Kizárólag egy képet tölthetünk be a 
munkaterületre. Ha másik képet töltünk be, 
az előző kép eltűnik.
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Egyedi öltési m
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Új minta létrehozása
Üres munkaterület megnyitásával teljesen új mintát 
hozhatunk létre.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a File > New 

(új) pontra.

→ Új munkaterület megnyitása.

A létrehozandó minta 
típusának mentése

Adjuk meg a kívánt típusnak megfelelő módot.

1. Kitöltő/bélyegzőminta módba váltáshoz 
kattintsunk a Mode > Fill/Stamp pontra.
Motívum módba történő belépéshez 
kattintsunk a Mode > Motif pontra.

→ A kiválasztott módban üres munkaterület 
jelenik meg.

Kitöltő/bélyegzőminta mód
Ebben a módban egy vagy több vonalból is 
létrehozhatunk mintákat, ezután dombor vagy véset 
hatás kialakításához kitölthetjük a vonalak által 
közrezárt felületeket.

Az Eszköztárban a vonal eszközzel rajzolhatjuk 
meg a kitöltő vagy bélyegzőminta vonalait, és a 
Felület (véset) és Felület (dombor) és a Felület 
(nulláz) eszközökkel szerkeszthetjük, tölthetjük ki a 
közrezárt területeket.

A programozható kitöltő öltés varrási módja eltér a 
normál kitöltő öltésekétől, mivel az utóbbiaknál a 
fonal mindig egy adott irányba kerül levarrásra. 
Ehelyett az előbbinél minta olyan módon kerül 
levarrásra, hogy a tű közvetlen a létrehozott mintán 
fut túl.

Motívum mód
Motívum módban egyetlen vonal átalakításával 
hozhatunk létre sormintát alkotó öltést.

Zöld nyíl jelenik meg a munkaterület jobb oldalán, 
mutatva a sorminta levarrásának irányát.

Egyetlen rózsaszín vonal jelenik meg a zöld nyíl 
mentén: a motívum öltés alapvonalát jelzi, amely a 
Pont szerkesztő eszközzel új pontok beszúrásával 
és tetszőleges elmozdításával módosítható.

A munkaterület bal oldalán lévő kék négyzet jelzi a 
vonal kiinduló pontját, és a jobb szélen a piros 
négyzet mutatja az öltés záró pontját.
A kezdő és záró pontok nem törölhetők, és egy 
magasságba kell essenek. Így ha az egyiket fel 
vagy le mozgatjuk, a másik pont is automatikusan 
elmozdul ugyanabba az irányba.

Példa programozható kitöltő 
öltéssel kialakított mintára

Példa sormintára:
vonal varrás

felület varrás
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Minta megtekintése szerkesztés közben
A Preview (nézőkép) ablakban ismétlődő sorminta formájában láthatjuk a szerkesztett mintát.

1. A Preview ablak megjelenítéséhez 
kattintsunk a Display > Preview pontra.

A Preview ablak a kiválasztott módnak 
megfelelő beállításokkal jelenik meg.

A Preview ablakban megjelenő kép a 
munkaterületen végzett változtatásoknak 
megfelelően azonnal módosul.

2. A Preview nézőkép ablak bezárásához 
kattintsunk a  gombra, vagy kattintsunk a 
Display > Preview gombra a pipa kivételéhez 
a kapcsolóból.

Minta létrehozása kitöltő/bélyegzőminta 
módban
A Vonal eszközzel tört vonalakat rajzolhatunk a kitöltő/bélyegzőminta szerkesztésekor.

A vízszintes és függőleges vonalak követni fogják a rácsot. A munkaterületre kattintással kijelölt pontok a rács 
függőleges és vízszintes vonalainak metszéspontjához fognak igazodni, így 45 fokos átlós vonalakat is 
húzhatunk. Függetlenül attól, hogy hova kattintunk, a pont automatikusan a legközelebbi metszéspontra ugrik.

A rajzolni kívánt mintától függően eltérő rácsközt is kiválaszthatunk. A None (nincs) kiválasztását követően a 
jelölt pont már nem fog a metszéspontokhoz igazodni, így görbéket is létrehozhatunk. A rács állításáról 
részletesen lásd 215. oldalon a Rács beállításai szakaszt.

1. Kattintsunk az  ikonra.

2. Kattintsunk az 1-es kezdőpontra a 
munkaterületen. Kattintsunk újra a következő 
2-es pont kijelöléséhez.

3. Folytassuk a következő pontok kijelölésével, 
majd kattintsunk kétszer a záró pont 
kijelöléséhez, vagy kattintsunk az utolsó 
pontra, majd nyomjuk le az  gombot.

4. Ismételjük a teljes műveletsort a kitöltő/
bélyegzőminta öltési minta elkészültéig.

Kitöltő/bélyegzőminta 
mód

Motívum mód

Ne feledjük:
Az utolsó megadott pont törléséhez 
kattintsunk a jobb egérgombra, vagy nyomjuk 
le a  gombot.

2

1

BackSpace

Enter
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Egyedi öltési m

inta létrehozása (Program
m

able Stitch C
reator)
Minta szerkesztése kitöltő/bélyegzőminta 
módban

Minták kiválasztása

1. Kattintsunk a  ikonra.

2. Kattintsunk a kijelölni kívánt mintára.

→ Az alakzat körül fogantyúk jelennek meg, ez 
mutatja hogy a minta ki van jelölve.

3. További minták kijelöléséhez tartsuk 
lenyomva a  gombot, majd kattintsunk a 
további mintákra.

Minták áthelyezése

1. Vigyük a mutatót a kiválasztott minta fölé.

2. Húzzuk a mintát a kívánt helyre.

Minta méretezése

1. Vigyük a mutatót a kiválasztott minta valamely 
fogantyúja fölé.

2. Húzzuk a fogantyút a kijelölt minta kívánt 
méretre igazításához.

Kitöltő/bélyegzőminta 
öltési minta átalakítása

Az elmozdított vagy beszúrt pontok a rács 
vízszintes és függőleges vonalainak 
metszéspontjaiba kerülnek. Függetlenül attól, hogy 
hova húzzuk a pontot, vagy a vonalon hova szúrjuk 
be a pontot, az automatikusan a legközelebbi 
metszéspontba kerül beszúrásra.
A létrehozni kívánt öltéstől függően eltérő rácsközt 
is beállíthatunk. A rács beállításáról részletesen a 
215. oldalon, a Rács beállítások szakaszban 
olvashatunk.

1. Kattintsunk a  ikonra.

Ne feledjük:
• Mintákat a mutató húzásával is 

kijelölhetünk.
• Ha kijelöltünk olyan mintát is, amelyet nem 

állt szándékunkban, kattintsunk a 
munkaterület egy üres pontjára, és kezdjük 
újra a folyamatot.

Ne feledjük:
• A minták függőleges vagy vízszintes 

mozgatásához a húzás közben tartsuk 
lenyomva a  gombot.

• A nyíl gombokkal vigyük a kiválasztott 
mintát egy rácsköznyivel arrébb a 
lenyomott nyílgomb irányába.

Ctrl

Shift

Ne feledjük:
• Ha a fogantyú húzása alatt nyomva tartjuk a 

 gombot, a minta nagyítása, 
kicsinyítése a középpontból kiindulva 
történik.

• A minta tükrözéséhez vízszintes tengely 
mentén, kattintsunk a  ikonra, vagy az 
Edit > Mirror > Horizontal (vízszintes) 
pontra.
A kiválasztott minta függőleges tengely 
mentén történő tükrözéséhez kattintsunk a 

 ikonra, vagy kattintsunk az Edit > 
Mirror > Vertical pontra.

• A kiválasztott minta forgatásához 
kattintsunk a  ikonra, vagy kattintsunk 
az Edit > Rotate pontra, vagy húzzuk el a 
fogantyút.

• Az eszköztár gombok és a menüparancsok 
révén egyéb műveletekre is lehetőség van: 
pl. duplikálásra, törlésre.

Lásd a 256. oldalon a 
Programmable Stitch Creator 
pont alatt a Menürendszer/
Eszközök szakaszt.

Shift
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
2. Kattintsunk a tört vonalra.

→ A tört vonal csomópontjai kis fehér 
négyzetek formájában jelennek meg.

3. Pont szerkesztéséhez kattintsunk a kívánt 
pontra.

→ A kiválasztott pont kis fekete négyzetként 
jelenik meg.

• A pont áthelyezéséhez húzzuk azt egy új 
helyre.

→ Az összes kijelölt pont egy irányba, 
együttesen mozdul el.

• Pont beszúrásához kattintsunk a vonalra.

→ Egy új pont jelenik meg kiválasztott 
állapotban (kis fekete négyzet).

• Pont törlésélhez kattintsunk az Edit > 
Delete pontra vagy nyomjuk le a  
gombot.

Ne feledjük:
Egyszerre csak vonalat jelölhetünk ki.

Ne feledjük:
Ha egy vonal két pontból áll, és valamelyiket 
töröljük, a teljes vonal eltűnik.

Ne feledjük:
• Több pont egyidejű kijelöléséhez miközben 

a pontokra kattintunk vagy húzzuk a 
mutatót, tartsuk nyomva a  gombot.

• A  gomb lenyomása közben nyomjuk 

le a  vagy gombot. A kijelölés 
az első és az utolsó pontra ugrik.

• A pontok vízszintes vagy függőleges 
mozgatásához húzás közben tartsuk 
lenyomva a  gombot.

• Nyomjuk le a nyíl gombot. A pontok a 
lenyomott nyíl gomb irányába folytonos 
mozgást fognak végezni.

Delete

Ctrl

Ctrl

Shift
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Egyedi öltési m

inta létrehozása (Program
m

able Stitch C
reator)
Dombor/véset hatás létrehozása kitöltő/
bélyegzőminta módban
Kitöltő/bélyegzőminta módban dombor vagy véset hatást érhetünk el a zárt felülethez öltéstípust rendelve.

1. Nyissuk meg a meglévő kitöltő/bélyegzőminta 
fájlt (.pas fájlt) vagy rajzoljunk egy új mintát a 
vonal eszközzel.

2. Véset hatás létrehozásához kattintsunk a 

 (Felület (véset)) ikonra.

3. Kattintsunk az egyes felületekre.

→ A felületek piros színben jelennek meg, 
amely az eszköz saját színe.

4. Domborhatás létrehozásához kattintsunk a 

 ikonra.

5. Kattintsunk a kívánt felületre.

→ A felületek kék színben jelennek meg, 
amely az eszköz saját színe, és gobelin 
(satin) öltéshez hasonló öltésekkel kerül 
levarrásra.

6. Az adott felületen a dombor/véset hatás 

megszüntetéséhez kattintsunk a  (felület 
(törlés) ikonra. 

7. Kattintsunk azon felületekre, ahol törölni 
kívánjuk a dombor, véset beállítást.

→ A felület fehér színben jelenik, amely az 
eszköz saját színe, és az alapöltéshez 
beállított irányba kerül levarrásra a felület.

Megjegyzés:
A felületi hatás végrehajtásához (dombor/
véset hatás) a mintának zárt felületeket kell 
tartalmaznia.
A munkaterület széle zárhat felületeket. Ezt 
vonalak szélre rajzolásával érhetjük el.

Ne feledjük:
Az ilyen típusú felület 2,0 mm-es 
öltéshosszúságú kitöltő öltéssel, és 30%-os 
sűrűséggel kerül levarrásra, és a tű kifutási 
pontja a körvonalra fog esni.

Megjegyzés:
• Ha a felület kitöltése után az öltési 

vonalakat szerkeszteni kívánjuk, fontos 
hogy a vonalak egy felületet zárjanak be, 
egyébként a dombor, véset hatás eltűnik.

• Felületi beállításokkal rendelkező .pas 
fájlok a program 6.0-s verziónál korábbi 
verzióival nem használhatók, valamint a 
korábbi verziókkal létrehozott .pas fájlok 
bélyegzőminta létrehozására 
forrásanyagként nem használhatók.
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Minta létrehozása motívum módban
Motívum módban a motívum öltés alapvonalára szúrjuk be a kívánt pontot, majd húzzuk el a pontot az öltés 
formázásához: a minta egyetlen vonással megrajzolt öltés képét fogja mutatni.

A beszúrt vagy áthelyezett pontok a rács vízszintes és függőleges vonalak metszéspontjaihoz fognak 
igazodni. Függetlenül attól, hogy hogy a vonal hova szúrjuk be a pontot, vagy húzzuk a pontot, az a 
legközelebbi metszéspontra fog kerülni.

A létrehozni kívánt öltéstől függően ki kell választanunk a megfelelő rácsközt. A 215. oldalon olvashatunk a 
rácsról és állításáról.

1. Kattintsunk a  ikonra.

2. Kattintsunk a kezdő pont (kék négyzet) és a 
záró pont (piros négyzet) között az 
alapvonalra.

→ Egy új pont jelenik meg, kijelölt állapotban 
(kis fekete négyzet). Az új pont szabadon 
szerkeszthető.

3. Húzzuk el a pontot.

→ A vonal együtt mozdul el az új ponttal.

4. Ismételjük meg a 2-3. lépéseket, amíg a 
motívum öltési minta el nem készül.

Ne feledjük:
• A pont vízszintes és függőleges 

mozdításához húzás közben tartsuk 
nyomva a  gombot.

• A nyíl gombokkal egy rácsköznyivel 
ugratjuk arrébb a kijelölt pontot a lenyomott 
nyíl irányába.

• A kijelölt pont törléséhez nyomjuk le a 
gombot.

Ne feledjük:
• Ha elmozdítjuk a kezdő pontot (kék 

négyzet) vagy a záró pontot (piros négyzet) 
a másik pont automatikusan követi és a két 
pont egy síkban marad.

• A kezdő és záró pontok nem hozhatók 
közelebb egymáshoz, a köztük lévő 
távolság adott.

Shift

Delete
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Egyedi öltési m

inta létrehozása (Program
m

able Stitch C
reator)
Minta szerkesztése motívum módban
Minta létrehozása után vagy meglévő motívum fájl megnyitását követően módosíthatjuk a motívum formáját, 
elhelyezését. Ezt az előző oldalon ismertetett műveletekkel tehetjük meg, de ezenfelül egyidőben jelölhetünk 
ki, helyezhetünk át vagy törölhetünk több pontot.

Több pont egyidejű 
áthelyezése, törlése

1. Kattintsunk a  ikonra az Eszköztárban.

2. Kattintsunk a pontra.

→ A kijelölt pont kis fekete négyzetként 
jelenik meg. A kezdő pont és a záró pont 
teli négyzetként látható, saját színeikben.

Több pont kijelöléséhez tartsuk lenyomva a 
 gombot a pontokra kattintás alatt, vagy 

miközben húzzuk a mutatót a pontok felett.

3. Szerkesszük a pontokat.

• A pont mozgatásához vigyük a kívánt 
helyre.

→ Az összes kijelölt pont ugyanabban az 
irányban együtt indul el.

• A kijelölt pontok törléséhez nyomjuk le a 
 gombot.

→ Az összes kijelölt pont törlésre kerül.

Minták méretezése

1. Kattintsunk a  ikonra az Eszköztárban.

→ A motívum öltés kijelölésre kerül.

2. Vigyük a mutatót minta valamelyik fogantyú 
fölé.

3. Húzzuk a fogantyút a minta kívánt méretre 
igazításához.

Ne feledjük:

Tartsuk lenyomva a  gombot a  

vagy gombok lenyomása alatt. A 

kiválasztás iránya változik a kezdő pont és a 
záró pont közötti irányok között.

Megjegyzés:
A kezdő pont (kék négyzet) és a záró pont 
(piros négyzet) nem törölhetők.

Ctrl

Ctrl

Delete

Ne feledjük:
Ha a fogantyú húzása közben nyomva tartjuk 
a  gombot, a minta nagyítása, 
kicsinyítése a középpontból kiindulva történik.

Ne feledjük:
A minta vízszintes tengely mentén történő 
tükrözéséhez kattintsunk a  ikonra, vagy 
kattintsunk az Edit > Mirror > Horizontal 
pontra.
A függőleges tengely mentén történő 
tükrözéshez kattintsunk a  ikonra, vagy 
kattintsunk az Edit > Mirror > Vertical pontra.

Shift
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Minták mentése
Felülírás

Ha egyszer elmentettük a mintát, a módosítást 
elmenthetjük, így a legújabb változat bármikor 
megnyitható.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a File > 

Save (mentés) pontra.

→ A fájl mentésre került.

Mentés másik néven

Az aktuális fájl eltérő fájlnévvel is menthető, így az 
eredetit változatlan formában megőrizzük, és a 
módosítást egy külön fájlban tároljuk. Ugyanarról a 
mintáról, képről különféle változatok hozhatunk így 
létre. Kitöltő/bélyegzőminta módban a .pas 
formátumban tároljuk az adatokat, .pmf 
formátumban motívum módban.

1. Kattintsunk a File > Save As (mentés 
másként) menüpontra.

2. Válasszuk ki a meghajtót és a mappát, majd 
gépeljük be a fájl nevét.

3. Kattintsunk a Save (pontra) a minta 
mentéséhez.
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Egyedi öltési minta létrehozása (Programmable Stitch Creator)
Egyedi öltési m

inta létrehozása (Program
m

able Stitch C
reator)
Beállítások
Rács beállítása

A rács vonalai közötti távolságot (rácsköz) 
állíthatjuk.

1. Kattintsunk a Display > Grid (rács) pontra.

→ Egy almenü mutatja a rácsköz aktuális 
beállításait.

2. Kattintsunk az öltési minta szerkesztéséhez, 
létrehozásához szükséges beállításra.

A munkaterületen rajzolt vízszintes és függőleges 
vonalak mindig a rács vonalaira fognak esni. A 
munkaterületre kattintással kijelölt pontok mindig a 
rács függőleges és vízszintes vonalainak 
metszéspontjára fognak esni, így 45 fokos átlós 
vonalat is húzhatunk. Mindegy hogy hova 
kattintunk, a pont automatikusan a legközelebbi 
metszéspontban kerül beszúrásra. Az öltés 
típusának megfelelő rácsközt állítsunk be: az öltés 
vonalainak íves megjelenés kölcsönzéséhez vagy 
részletgazdag grafikához válasszunk kisebb 
rácsközt, egyszerűbb mintához válasszunk 
nagyobb rácsközt.

Háttérkép megjelenésének 
módosítása

A munkaterületen hagyott, sablonként szolgáló kép 
elrejthető, megjeleníthető, illetve halványított, 
alnyomatszerű változatot is létrehozhatunk.

1. Kattintsunk a Display > Template pontra, 
majd válasszuk ki a kívánt beállítást.

• A sablonos kép normál megjelenítéséhez 
kattintsunk az On (100%) pontra.

• Halvány, alnyomatos megjelenítéshez 
válasszunk a 75%, 50% vagy 25% formák 
között.

• A sablonos kép elrejtéséhez kattintsunk az 
Off gombra.

Ne feledjük:
• A funkció nem elérhető ha nem töltöttünk be 

a munkaterületre sablon képet.
• Nyomjuk le a funkciógombot a 

megjelenítési módok (On (100%), 75%, 
50%, 25%, Off - ki) közötti váltáshoz.

F6
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 Font Creator alapműveletek

Font C

reator alapm
űveletek
Font Creator munkaablak

1 Eszközsáv
Az ikonok gyors elérést biztosítanak a menüparancsokhoz.

2 Karakter kiválasztó sáv
A betűkészleten belül a tervezni kívánt betű, karakter kijelölése.

3 Eszköztár
A font tervezésére, kijelölésére szolgáló eszközök.

4 Preview (nézőkép) ablak
Mutatja az öltési minta levarrt képét.

5 Tervezőfelület 
A munkaterület ténylegesen menthető, levarrásra kerülő része.

6 Segédvonalak (nem mozdíthatók)
A két segédvonal közötti távolság a tervezett betűtípus magassága.

7 Segédvonalak (mozgathatók)
A tervezett betű formájának megfelelően a segédvonalak áthelyezhetők. A két piros segédvonal közötti 
távolság a betű szélességét adja. A három kék segédvonal illesztővonalak az ékezet igazításához, a 
kisbetű magasságának beállításához, és a kisbetű alsó élének kijelöléséhez.

8 Munkaterület

6

3
8

4

2
1

5

7

7
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Font Creator alapműveletek
Segédvonalak a 
tervezőfelületen

A betűtervezésnél szokásos segédvonalak 
megjelennek a tervezőfelületen. Az egyes 
segédvonalak feladatát az alábbi ábrán találjuk:

(A) Alapvonal
A betű írási vonala, a betű „húsának” alja erre 
ül. Normál esetben ez a vonal és a nagybetű 
felső vonala adják a betű magasságot. Nem 
mozdítható.

(B) Nagybetű felső vonala
A betű normál magassága az alapvonal és a 
nagybetű felső vonala közötti távolság. A 
vonal nem mozdítható.

(C) Középvonal
Kisbetű (kurrens) normál magassága a 
középvonal és az alapvonal távolsága. A jobb 
oldali háromszög szimbólumnál kattintva 
elhúzhatjuk a vonalat.

(D) Lenyúló szár alsó vonala
A lenyúló szárú betűk (pl. a „g”, „j”) 
túlnyúlásának alsó határát jelöli. A jobb oldali 
háromszög szimbólumnál kattintva 
elhúzhatjuk a vonalat.

(E) Felső szár vonala
A felnyúló szárú betűk, és az ékezetek (pl. a 
„f”, „k”, „É”, „Á”) túlnyúlásának felső határát 
jelöli. A jobb oldali háromszög szimbólumnál 
kattintva elhúzhatjuk a vonalat.

(F/G) Állítóvonalak
A betű szélességét állítjuk az alsó háromszög 
szimbólumnál fogva a vonal elhúzásával.

(E) felső szár vonala

(B) nagybetű teteje

(C) középvonal

(A) alapvonal

(D) lenyúló szár v.

(G) állítóvonal(F) állítóvonal
háromszög 
szimbólum

Ne feledjük:
• Az alapvonalra, nagybetű felső vonalára, 

állítóvonalakra vonatkozó szélességi és 
magassági beállítások a betű tervezésének 
sablonját adják.

• A Font Creatorral készített betűtípusokat a 
Layout & Editing programba betöltve a 
betűk szélességét és magasságát a 
következő területek jelentik majd:

• Betű magassága: az alapvonaltól (A) a 
nagybetű felső vonaláig(B).

• Betű szélessége:az (F) állítóvonaltól a 
(G) állítóvonalig.

• A betűk egységes méretezéséhez a felső 
szár vonala, a középvonal és az alapvonal 
minden karakternél egyformán jelenik meg. 
Így még ha elmozdítjuk valamely fenti 
vonalat, a módosítás érvényben marad 
eltérő karakter kiválasztásakor is. 

• Az állítóvonalak külön állíthatók minden 
egyes karakternél.
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Font Creator alapműveletek
Font C

reator alapm
űveletek
Egyedi betűtípus tervezése kézi rajzzal
A Font Creator programmal egyedi betűtípusokat hozhatunk létre, melyeket használhatunk a Layout & Editing 
programban. Így teljesen egyedi hímzési feliratokat hozhatunk létre.

1. lépés Háttérkép megnyitása

Egyedi betűkép tervezéséhez segítséget 
jelenthet egy sablonként szolgáló kép. A 
következő példában a „T” betű tervezéséhez egy 
„T” betűt formázó képet nyitunk meg.

Kattintsunk a  ikonra, majd a Minden
program (Programok) > PE-DESIGN 8 >
Tools > Font Creator pontot.

Kattintsunk a File > Template Open > from
File pontra.

Tölsük be a Capital_T.bmp fájlt.
Válasszuk ki a Capital_T.bmp fájlt a
Dokumentok > PE-DESIGN8 > Sample >
Font Creator > Font Template mappában.

Helyezzük úgy a betűt, hogy teteje a nagybetű
felső vonalával álljon. A betű magasságának
állításához húzzuk el valamelyik fogantyút a
nagybetű felső vonala és az alapvonal közötti
területen.

1. lépés Háttérkép megnyitása
2. lépés Betűkép tervezése
3. lépés Többi betűkép megtervezése
4. lépés A betűkészlet elmentése
5. lépés Hímzési minta létrehozása az egyedi font használatával

1

2

3

Ne feledjük:
Az alapvonal, a nagybetű felső vonala és az 
állítóvonalak a sablonként szolgáló képen 
piros segédvonalak formájában jelennek 
meg, így a háttérkép igazítása nem jelenthet 
problémát.

4

nagybetű felső 
vonala

fogantyú

alapvonal
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2. lépés Betűkép tervezése

Válasszuk ki a tervezni kívánt betűt.

Kattintsunk a Karakter kiválasztó gombra, 
majd válasszuk ki a létrehozni kívánt 
karaktert. Jelen példában a „T” betűt.

Kattintsunk a  ikonra , majd a

pontra.

Kattintsunk a tervezőfelületre sorban az 1-4. 
pontok kijelöléséhez.

Kattintsunk a ikonra, majd a  

ikonra.

Ezután kattintsunk az 5-7. pontok 

kijelöléséhez.

Ne feledjük:
Ha a fogantyúk eltűnnének, kattintsunk jobb 
egérgombbal a képre, majd a legördülő 
menüben válasszuk a Modify Template 
(sablon módosítása) pontot.

Ne feledjük:
A karakternek szerepelnie kell a 
karaktertáblában (Select Character 
táblázatban), csak ez esetben alkalmazhatjuk 
a Layout&Editing szoftverben.

Lásd a 80. oldalon a Felirat/
kisbetűs szöveg bevitele 
szakaszban.

Ne feledjük:
A sablonkép elrejthető, megjeleníthető, 
halványított, alnyomatszerű másolata is 
megjeleníthető. A példa követéséhez 
kattintsunk a Display > Display Template 
pontra, majd válasszuk a 25% opciót.

1

Ne feledjük:

Öt gomb jelenik meg a  ikonra kattintva.

: Egyenesekkel határolt tömbös minta

: Görbékkel határolt tömbös minta

: Fél-automatikus átalakítású 
egyenesekkel határolt tömbös minta

: Előöltéses (running-type) minta 

: Feed-type minta

2

2 4

31

3

6

7
5
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reator alapm
űveletek
Kattintsunk a  ikonra, majd a 

ikonra. Ezután kattintsunk a 8-10. pontok

kijelöléséhez.

Kattintsunk a  majd a  ikonra.

Kattintsunk a  majd  ikonra.

Ezután kattintsunk a 11-12. pontok 
kijelöléséhez.

Kattintsunk kétszer a 13. pontra (a teljes minta
utolsó pontja), vagy kattintsunk a 13. ponton
és nyomjuk le a  gombot.

Kattintsunk a  ikonra, majd húzzuk az
állítóvonalakat a betű szélességének meg-
adásához.

1. lépés Többi betűkép 
megtervezése

Ezután hozzuk létre a többi betűképet. 
A példában a „g” betűvel folytatjuk.

Töltsük be a Small_g.bmp fájlt a „T” sablont
tartalmazó kép betöltésével egyező módon.

Kattintsunk a Karakterkiválasztó gombot,
majd válasszuk ki a létrehozni kívánt karak-
tert. Jelen példában a „g”-t.

Ne feledjük:

Ezen a ponton a ikonra kattintva 
elkerülhetjük az átfedő öltéseket.

4

9

810

5

6

11

12

7

Enter

13

Ne feledjük:
Az utolsó megadott pont törléséhez 
kattintsunk a jobb egérgombbal, vagy 
nyomjuk le a  gombot.BackSpace

8

állítóvonal állítóvonal

1

2
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Állítsuk be a betű helyét, méretét a „T” betűnél
megismert módon.

A kék illesztővonalak áthelyezéséhez húzzuk 
el a háromszög szimbólumokat: a vonalak 
igazodjanak a betű aljához, tetejéhez.

Kattintsunk a  majd  ikonra.

Ezután kattintsunk az 1-7. pontok kijelölé-

séhez.

Kattintsunk a  majd  ikonra.

Ezután kattintsunk a 8-24. pontok kijelölé-

séhez.

Kattintsunk a  majd  ikonra.

Ezután kattintsunk a 25-26. pont kijelölésé-

hez.

Kattintsunk a  majd  ikonra.

Ezután kattintsunk a 27-29. pontok kijelölé-

séhez.

3

lenyúló szár 
vonala

középvonal

4

1 2

3
4

5
6

7

5

8

9

10

11

12

13

14

1516

18

17

20

19

22

21
23

24

6

25

26

7

27

28
29
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reator alapm
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Kattintsunk a  majd  ikonra.

Ezután kattintsunk a 30-34. pontokra.

Kattintsunk a  majd  ikonra.

Ezután kattintsunk a 35-44. pontok 
kijelöléséhez, majd kétszer kattintsunk a 45. 
ponton, vagy kattintsunk a 45. pontra, és 
nyomjuk le az gombot.

Húzzuk az állítóvonalakat a karakterszéles-
ség megadásához.

4. lépés Betűkép mentése

Kattintsunk a File > Save (mentés) pontra.

Válasszuk ki a MyFont mappát: ezt a PE-
DESIGN telepítési mappáján belül találjuk.
(Például Program Files > Brother > PE-
DESIGN 8 > MyFont. Ezután gépeljük be a
fájl nevét. Például: „My font1”.

Kattintsunk a Save pontra.

8

34
33

32
31

30

9

Enter

35

37
36

39

38

41

40
43

4544
42

10

állítóvonalak

Megjegyzés:
Mentsük a fontot az alábbi helyre (másik 
mappába mentve, a font nem lesz 
használható a Layout & Editing 
szotverben): Program Files\Brother\
PE-DESIGN 8\MyFont.

1

2
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5. lépés Hímzési minta létrehozása az 
újonnan tervezett betűkészlettel

Az imént tervezett fontot felhasználhatjuk a 
Layout & Editing programban feliratok 
készítéséhez.

Indítsuk a Layout & Editing programot.

Kattintsunk a  majd  ikonra.

Kattintsunk a Font legördülő menüre, majd
válasszuk ki a „Myfont1” betűtípust.

Kattintsunk a tervezőfelületre.

Gépeljük be a szöveget, majd kattintsunk az 
OK-ra.

→ A felirat megjelenik a tervezőfelületen.

Lásd a 80. oldalon a Felirat hozzáadása 
c. szakaszt.

Ne feledjük:
Ha a Layout & Editing progam már fut, lépjünk 
ki, és indítsuk újra. Az új font csak a program 
indításakor kerül felismerésre.

1

2

3

A font neve előtt a  jelzés 
mutatja, hogy saját készítésű fontról 
van szó.

4
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Egyedi fontok létrehozása (Font C

reator)
A következőkben a Font Creator különféle műveleteinek, beállításainak részletes ismertetését találjuk. 
Ezenfelül számos extra funkció is ismertetésre kerül.

Fájl megnyitása
Új betűtípus létrehozása

Üres munkaterületből kiindulva is készíthetünk új 
betűkészletet.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a File > New 

(új) pontra.

→ Új munkaterület jelenik meg.

Font fájl megnyitása

Korábban létrehozott és mentett font fájl bármikor 
megnyitható.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy a File > 

Open (megnyitás) pontra.

2. Válasszuk ki a MyFont mappát, ahova a PE-
DESIGN mappát telepítettük. (Például: 
Program Files > Brother > PE-DESIGN 8 > 
MyFont mappát.

3. A fájl megnyitásához válasszuk ki, majd 
kattintsunk az Open parancsra, vagy 
kattintsunk kétszer a fájl ikonján.

→ A kiválasztott fájl tartalma megjelenik a 
munkaterületen.
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Betűkép kiválasztása és a sablon 
előkészítése

A tervezni kívánt betű 
kiválasztása

Válasszuk ki a tervezni kívánt karaktert.

1. Kattintsunk a Karakter kiválasztó gombra a 
betű kiválasztására.

2. A karaktertáblában kattintsunk a kívánt 
betűre.

Ha a kívánt karakter nem jelenik meg a 
táblázatban, a karaktert begépelhetjük az 
ablak alján lévő mezőbe. Ezután nyomjuk le 
az  gombot.

Karaktertáblában szereplő betűk 
hozzáadása, törlése

Alapértelmezés szerint a szóköz, számok (0-9), 
nagybetűk (A-Z), és kisbetűk (a-z) megjelennek a 
karaktertáblában. A „?” és „!” hasonló karakterekkel 
bővíthető a betűkészlet, ugyanakkor a felesleges 
karakterek törölhetők. Egy font legfeljebb 1024 
karaktert tartalmazhat. 

1. Kattintsunk a File > Add/Remove Letters 
(betűk hozzáadása/törlése) pontra.

2. A billentyűzeten gépeljük be a hozzáadni 
kívánt karaktert.

→ A megadott karakter megjelenik a 
Directly type in text (gépeljük be 
közvetlen) felirat alatt.

3. Kattintsunk az Add (hozzáadás) pontra.
→ A megadott karakter hozzáadóik a 

karaktertáblához.

Ha a karakter már szerepel a táblázatban, 
vagy korábban már hozzáadásra került, 
hibaüzenet jelenik meg. Kizárólag olyan 
betűvel bővíthetjük a táblázatot, amelyet 
korábban még nem vittünk fel.

4. Egy már a táblázatban szereplő karakter 
törléséhez kattintsunk a kiválasztott betűre, 
aztán kattintsunk a Remove (törlés) pontra.

A cella piros színben jelenik meg. Minden 
egyes kattintással váltunk a kijelölt és ki nem 
jelölt állapot között.

Ne feledjük:
• Azon karakterekhez, melyeket már 

megterveztünk, kék háttérrel jelennek meg.
• A bal-felső sarokban megjelenő üres cella a 

szóköz karakter. Erre a cellára kattintva a 
szóközt választjuk ki.

Megjegyzés:
Ha a tervezett betűkép valamelyik része 
lelóg a tervezőfelületről, egy másik karakter 
kiválasztásakor egy üzenet jelenik meg. 
Módosítsuk a betűképet úgy, hogy ne lógjon 
túl a tervezőfelületen, és csak ezután jelöljük 
ki az új karaktert.

Enter
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Egyedi fontok létrehozása (Font C

reator)
5. Amikor a beállításokat végrahajtottuk, 
kattintsunk az OK-ra.

Háttérkép megnyitása

A tervezőfelületen megjelenített kép vagy a 
TrueType font sablonként szolgálhat a betűkép 
tervezésekor. Nyissunk meg a kiválasztott 
karakterhez mintául szolgáló képet.

Sablon megnyitása (kép fájl)
A program számos képformátumot képes 
kezelni, megnyitni.

Lásd a 19. oldalon az „Kép fájlformátum” 
pontot.

1. Kattintsunk a File > Template Open (sablon 
megnyitása) > from File (fájlból) pontra.

2. Kattintsunk a meghajtóra, a mappára és a 
kiválasztott fájlra.

3. Kattintsunk az Open (megnyitás) gombra a 
fájl megnyitásához.

→ A kép kitölti a munkaterületet.

Sablon megnyitása (TrueType font)
A számítógépre telepített TrueType fontok 
sablonként is felhasználhatók.

1. Kattintsunk a File > Template Open (sablon 
megnyitása) > Select TrueType Font 
(TrueType Font megnyitása).

2. A Font kiválasztóban válasszunk egy 
betűtípust. A Style (változat) kiválasztóban 
adjuk meg a betűváltozatot.

3. Kattintsunk az OK-ra.

→ A karaktertáblában kijelölt betű 
megjelenik a munkaterületen.

Ne feledjük:
• A módosítások elvetéséhez kattintsunk a 

Cancel (elvet) gombra.
• Ha a készletet egy új karakterrel bővítettük, 

de a fontot még nem hoztuk létre, az új 
karakter adatai a font fájlban kerül 
mentésre.

Ne feledjük:
• Kizárólag egy képet nyithatunk meg a 

munkaterületen. Ha másik képet jelenítünk 
meg, az fel fogja váltani az előzőt.

• A háttérkép erőssége állítható, egy halvány, 
alnyomatos változatot is megjeleníthetünk.

Lásd a 235. oldalon a „Háttérkép 
megjelenítésének állítása”.

• Ha a kép a háttérben marad, a font fájlban 
a kép adatai is mentésre kerülnek. A 
következő alkalommal a fájtl megnyitva a 
háttérkép is megjelenik.

Ne feledjük:
A háttérképet elhúzhatjuk, vagy a fogantyúkat 
elhúzva átméretezhetjük. Ha a fogantyúk 
eltűnnének, kattintsunk a jobb egérgombbal, 
majd kattintsunk a legördülő menüben a 
Modify Template pontra.
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• Egy betű tervezése közben ugyanaz a 
TrueType font jelenik meg, amíg egy másik 
sablont ki nem választunk háttérként. 
Minden alkalommal, amikor egy eltérő 
karaktert kiválasztunk a karaktertáblából, a 
karakter sablon ugyanabban a TrueType 
betűtípusban jelenik meg.

• Ha a karaktertáblában kijelölt betű nem 
található meg a TrueType betűkészletben, 
a sablon helyén „?” látható.

Ne feledjük:
• Ha sablonként egy TrueType betűtípust 

választottunk, az nem méretezhető, nem 
helyezhető át. Ilyen esetben a betű 
automatikusan karakter hímzési mintává 
alakítható.

Lásd a 229. oldalon a TrueType 
font automatikus átalakítása 
szakaszt.

• Ezenfelül a betű nem rajzolható körbe a fél-
automatikus tömbös körberajzoló 
eszközzel.
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reator)
Karakter hímzési minta létrehozása
Minta létrehozása a Kézi 
körbrajzoló eszközökkel

A Kézi körberajzoló eszközökkel hozzuk létre a 
karakter mintát.

Háttérkép is megjeleníthető, így a karakter minta 
még egyszerűbben létrehozható.

Lásd a 227. oldalon a Háttérkép 
megnyitása szakaszt.

Az Eszköztárban a  ikon szolgál a minta félig 

automatikus létrehozására.

Amikor a  gombra kattintunk, a következő öt 

gomb jelenik meg.

: A betűkép leképzése egyenesekkel határolt 
tömbös mintával (felület varrás).

(Billentyűparancs: )

: A betűkép leképzése íves tömbös mintával 

(felület varrás).

(Billentyűparancs: )

: A betűkép félig automatikus leképzése 

egyenesekkel határolt tömbös mintával.

A félig automatikus körberajzolás (tracing) a 
sablon vonalait fogja leképezni.
(Billentyűparancs: )

: Előöltéses leképzési minta létrehozása 

(vonal varrás).

(Billentyűparancs: )

: Feed-type öltéses leképzési minta 

létrehozása.
(Billentyűparancs: )

Lásd a 219. oldalon az Egyedi betűtípus 
tervezése kézi rajzzal szakaszt.

TrueType fontok 
automtikus átalakítása

Ha a TrueType fontot használunk sablonként, 
egyszerűen átalakíthatjuk karakter mintává.

1. Nyissuk meg a sablonként használni kívánt 
TrueType fontot.

Lásd a 227. oldalon a Sablon megnyitása 
(TrueType font) szakaszt.

2. Kattintsunk a Sew > Convert TrueType Font 
to Data (TrueType font átalakítása hímzési 
adattát) pontra.

→ A háttérkép alapján létrejön a karakter 
hímzési minta.

Z

X

C

V

B

Ne feledjük:
• A pontok felvitele során sokféle eszköz 

közül választhatunk. Ez nagyban 
megkönnyítik a billentyűparancsok. 

• A félig automatikus tömbös körberajzoló 
eszközök csak sablon kép alapján tudnak 
működni. Kép nélkül olyan alakzat jön létre, 
mint amilyet a sima egyenesekkel határolt 
tömbös körberajzoló eszköz hoz létre. 
Emellett az eszköz akkor sem funkcionál, 
ha sablonként TrueType fontot 
alkalmazunk.

• Miután a minta elkészült, az egyenesekkel 
határolt tömböket gond nélkül átalakíthatjuk 
íves tömbökké és fordítva. Részletesen 
lásd a 231. oldalon a „Pontok szerkesztése” 
szakaszban.
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Karakter hímzési minta szerkesztése
Minták kiválasztása

1. Kattintsunk a ikonra az  Eszköztárban. 

2. Kattintsunk a mintára.

→ Fogantyúk jelennek meg a minta körül, 
jelezve hogy ez kiválasztásra került.

3. További minta kijelöléséhez tartsuk lenyomva 
a  gombot és kattintsunk a másik 
mintára.

Minták mozgatása

1. Vigyük a mutatót a kiválasztott minták fölé.

2. Húzzuk a mintákat a kívánt helyre.

Minták méretezése

1. Vigyük a mutatót a kiválasztott minták körüli 
valamelyik fogantyú fölé.

2. Húzzuk el a fogantyút a minta kívánt méretre 
igazításához.

Ne feledjük:
• Kiválaszthatunk mintákat a mutató 

elhúzásával a minták felett is.
• Ha kiválasztottunk egy nem kívánt mintát is, 

kattintsunk a munkafelület üres részére az 
összes minta kijelölésének megszün-
tetéséhez, majd kezdjük újra a műveletsort.

Ctrl

Ne feledjük:
• A minta függőleges vagy vízszintes 

mozgatásához az egér húzása közben 
tartsuk lenyomva a  gombot.

• A nyíl gomb lenyomásával a kiválasztott 
minták egy rácsköznyit ugranak arrébb a 
lenyomott nyíl irányába. Ha a rács nem 
látható, a minta a legkisebb rácsköznél is 
kisebb távolsággal ugrik arrébb a lenyomott 
nyíl irányába.

• A nyíl gombot nyomva tartva a minta 
folytonosan mozog a lenyomott gomb 
irányába.

Ne feledjük:
• Ha a fogantyú húzása közben nyomva 

tartjuk a  gombot, a nagyítás, 
kicsinyítés a minta középpontjától történik.

• A minta függőleges tengely mentén történő 
tükrözéséhez kattintsunk az Edit > Mirror > 
Horizontal (vízszintes) pontra.
A minta vízszintes tengely mentén történő 
tükrözéséhez kattintsunk az Edit > Mirror > 
Vertical (függőleges) pontra.

• A kiválasztott minta forgatásához 
kattintsunk az Edit > Rotate (forgatás) 
pontot, majd kezdjük el húzni a fogantyúkat.

• Az eszközsáv további ikonjaival és 
menüparancsokkal további műveleteket 
hajthatunk végre, pl. duplikálhatunk, 
törölhetünk. Lásd a 259. oldalon a 
Menürendszer, eszközök fejezetben a Font 
Creator pontot.

Shift

Shift
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Font karakter minta csomópontjainak 
szerkesztése

Pontok szerkesztése és 
minták átalakítása

1. Kattintsunk a  ikonra az Eszköztárban. 

2. Kattintsunk a szerkeszteni kívánt mintára.

→ A mintát alkotó pontok kis fehér 
négyzetek vagy körök formájában 
jelennek meg.

3. Pont szerkesztéséhez kattintsunk a pontra a 
kijelöléséhez.

→ A kiválasztott pont kis fekete négyzet 
vagy kör formájában jelenik meg.

• A pontot húzzuk az új helyre.

→ Az összes kijelölt pont ugyanabba az 
irányba indul el.

• Pont beszúrásához kattintsunk a vonalra.

→ Az új pont kijelölt állapotban jelenik (kis 
fekete négyzet).

• Pont törléséhez kattintsunk az Edit > 
Delete pontra, vagy nyomjuk le a  
gombot a pont törléséhez.

Csomópont szerkesztése

A csomópontok közé eső vonalszakasz egyenessé 
vagy görbévé is alakítható. A csomópontnál az íves 
találkozás lehet sima, de lehet csúcsos is.

1. Jelöljük ki a kívánt pontot.

2. Kattintsunk az Edit > Point (pont).

3. Kattintsunk a kívánt parancsra.
• Kattintsunk a To Straight (egyenes) parancsra a 

szakasz egyenessé tételéhez.
• Kattintsunk a To Curve (görbévé) parancsra a 

szakasz ívessé alakításához.
• Kattintsunk a To Smooth (simává) parancsra a 

két ív törésmentes találkozásához. 
• Kattintsunk a To Symmetry parancsra a pontnál 

összefutó két ív szimmetrikus igazításához.
• Kattintsunk a To Cusp (csúcsos) parancsra a 

pontnál az ívek csúcsos, szabad állítású 
összefutásához.

Ne feledjük:
Egyszerre csak egy mintát választhatunk ki.

Delete

Ne feledjük:
• Több pont kijelöléséhez tartsuk lenyomva a 

 gombot, miközben a pontokon 
kattintunk, vagy miközben elhúzzuk a 
mutatót.

• Tartsuk lenyomva a  gombot a 

vagy gombok lenyomása 

közben. A kiválasztás iránya a két végpont 
között váltakozik.

• Tartsuk lenyomva a  gombot a pontok 
húzása alatt. A pontok vízszintesen vagy 
függőlegesen mozdulnak el.

• Nyomjunk le egy nyíl gombot. A pontok a 
lenyomott nyíl gomb irányába mozdulnak 
el.

Ctrl

Ctrl

Shift
231



Egyedi fontok létrehozása (Font Creator)
A tervezett font minta megtekintése
A karakter minta varrási sorrendje és a létrehozott karakterek listája nézőképen ellenőrizhető, megtekinthető.

Varrási sorrend ellenőrzése

A font minta varrási sorrendje megtekinthető, 
módosítható.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy kattintsunk a 

Sew > Sewing Order (varrási sorrend) 
pontra.

→ A Sewing Order (varrási sorrend) ablak 
jelenik meg.

 : Az ikonra kattintva az egyes mintákat 
a keretet kitöltő méretre nagyítjuk.

Minta kiválasztása
2. Válasszunk egy mintát a Sewing Order 

ablakban.

→ A kiválasztott minta körül rózsaszín vonal 
jelenik meg és a tervezőfelületen a hozzá 
tartozó mintát futó pontozott vonal jelzi.

Varrási sorrend szerkesztése
A varrási sorrend módosításához jelöljük az 
áthelyezni kívánt keretet, majd húzzuk át az új 
helyre. Függőleges piros vonal jelzi a keret aktuális 
helyzetét.

Az ablak alján lévő gombokkal is áthelyezhetjük a 
kereteket.

 : A kijelölt minta a varrási sor elejére kerül.

 : A kijelölt minta a varrási sorban egy 
hellyel előre ugrik.

 : A kiválasztott minta eggyel hátra ugrik a 
varrási sorban.

 : A kiválasztott minta a varrási sor végére 
kerül.

A varrási sorrend módosításához kattintsunk az OK 
gombra.

Hímzési minta 
megtekintése

A Font minta nézőképe megjelenik a Preview 
(nézőkép) ablakban.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy kattintsunk a 

Display > Preview Window (nézőkép ablak) 
pontra.

→ A Preview (nézőkép) ablak megjelenik.
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Egyedi fontok létrehozása (Font C

reator)
A megtervezett betűk 
kilistázása

Az újonnan tervezett font betűkészletének 
kilistázása.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy kattintsunk a 

Display > Browse Window (ablak keresése) 
pontra.

→ A Browse (tallóz) ablak jelenik meg.

Betűk kiválasztása
A Browse ablakban kiválasztott betű megjelenik a 
tervezőfelületen.

1. Kattintsunk a  ikonra, vagy kattintsunk a 

Display > Browse Window (ablak keresése) 
pontra.

2. Kattintsunk az adott betűre, majd a Select 
(kiválasztás) gombra.

→ A Browse ablak eltűnik, és a kiválasztott 
betű tervezési anyaga megjelenik a 
tervezőfelületen.
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Egyedi fontok létrehozása (Font Creator)
Betűtervek mentése
Felülírás

Az eredeti font betűkészletét felülírjuk, ha azonos 
font fájlba mentjük a módosított karaktereket.

Eszközsáv ikon: 

1. Kattintsunk a  ikonon, vagy kattintsunk a 

a File > Save (mentés) pontra.

→ A fájl mentésre került.

→ Ha nem adtunk meg fájlnevet, vagy ez 
nem található, a Mentés másképp ablak 
jelenik meg.

Mentés új név alatt

Eltérő fájlnévvel is elmenthetjük a megnyitott 
betűkészletet, így az eredeti változatlan formában 
megmarad. Ezzel a módszerrel többféle változatot 
készíthetünk a betűtípusról.

A font betűmintái .pef formátumban kerülnek 
mentésre.

1. Kattintsunk a File > Save As (mentés 
másként) pontra.

2. Válasszuk a PE-DESIGN mappák alatt a 
MyFont mappára. (Például:Program Files > 
Brother > PE-DESIGN 8 > MyFont.) 
Gépeljük be a fájl nevét.

3. Kattintsunk a Save (mentés) pontra a 
betűkészlet mentéséhez a megadott font 
fájlba.

Megjegyzés:
Ha a tervezett betűkép valamelyik része 
lelóg a tervezőfelületről, a mentéskor egy 
üzenet jelenik meg. Módosítsuk a betűképet 
úgy, hogy ne lógjon túl a tervezőfelületen, 
ezután ismételjük meg a mentési műveletet.

Megjegyzés:
• A fontot a MyFont mappába mentsük.

(Például kattintsunk a PE-DESIGN 
telepítési meghajtójára majd a Program 
Files > Brother > PE-DESIGN 8 > 
MyFont mappába. A font nem nyitható 
meg a Layout & Editing szoftverben, ha 
eltérő mappába mentjük.

• A Layout & Editing programban csak úgy 
jelenik meg az új font, ha a programot a 
font mentése után indítjuk. Ezért ha már 
fut a Layout & Editing program a font 
mentésekor, zárjuk be és indítsuk újra.
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Egyedi fontok létrehozása (Font Creator)
Egyedi fontok létrehozása (Font C

reator)
Beállítások módosítása
Rajzoló mód váltása

Két rajzoló mód van a Font Creator programban.
• Kitöltő mód

A tömbök kitöltő módban jelennek meg. Ebben a 
módban az egymást átfedő minták jobban 
kivehetők, átláthatók.

• Körvonal mód (Kitöltő mód kikapcsolva)
A tömbök belül üresek, csak körvonal jelzi őket. 
Ebben a módban a csomópontok könnyebben 
szerkeszthetők.

Hajtsuk végre az alábbi műveletet a két mód közötti 
váltáshoz.

Eszközsáv ikon: 

1. Kattintsunk a  ikonra, vagy kattintsunk 

a Display > Fill Mode (kitöltő mód) pontra.

→ Váltunk a kitöltő és a körvonal módok 
között.

Háttérkép megjelení-
tésének módosítása
Háttérkép halvány, alnyomatos 
megjelenítése

A sablonként szolgáló kép megjeleníthető, 
elrejthető, illetve egy halványított, alnyomatszerű 
változat is létrehozható.

1. Kattintsunk a Display > Display Template 
(sablon megjelenítése) pontra, majd 
válasszuk ki a kívánt megjelenítést.

• A háttérkép megjelenítéséhez kattintsunk 
az On (100%) pontra.

• A kép halványított változatának 
megjelenítéséhez válasszunk a 75%, 50% 
vagy 25% beállítások között.

• A kép elrejtéséhez kattintsunk az Off 
pontra.

Háttérkép mozgatása, méretezése
1. Kattintsunk a Display > Modify Template 

(sablon módosítása) pontra.

→ A háttérkép kijelölésre kerül.

A háttérkép a betűtervekkel egyező módon 
szerkeszthetők, méretezhetők.

Lásd a 230. oldalon a Betűterv 
szerkesztése szakaszt.

Ne feledjük:
• A funkció nem él, ha nincs kép betöltve a 

munkaterületre.
• Az  funkciógombbal válthatunk a 

megjelenítési módok között (On (be), 75%, 
50%, 25%, Off (ki)).

Ne feledjük:
A háttérkép nem méretezhető, nem 
mozgatható, ha sablonként TrueType 
betűtípust alkalmazunk.

F6
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Egyedi fontok létrehozása (Font Creator)
Rács beállítása

A munkaterületen megjelenített rácsot alkotó 
vonalak távolságát állíthatjuk.

1. Kattintsunk a Display > Grid Setup (rács 
beállítás) pontra.

2. A rács megjelenítéséhez pipáljuk ki a 
Show Grid kapcsolót, az elrejtéséhez vegyük 
ki a pipát a kapcsolóból.

3. Ha a betűkészletet egységes vastagsággal, 
egyező vízszintes és függőleges 
elhelyezéssel kívánjuk szerkeszteni, pipáljuk 
ki a Snap to Grid (rácsra igazít) kapcsolót.

4. A Grid Interval mezőben válasszuk ki a 
rácsköz mértékét.

5. A rács csak a vonalak nélkül, csak a 
metszéspontok formájában is megjeleníthető, 
ehhez vegyük ki a kapcsolót a with Axes 
kapcsolóból.

6. Kattintsunk az OK-ra a beállítások 
végrehajtásához és az ablak bezárásához.

Ne feledjük:
A mutató a Grid Interval mezőben beállított 
távolságnak megfelelően fog elmozdulni. 
A rácsra igazító funkció akkor is működik, ha 
a rács rejtve van.
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Trükkök, technikák
Minták nagyítása, kicsinyítése
A betöltött öltési minták a következő három módon nagyíthatók, kicsinyíthetők a Layout & Editing programban.

1 Egyszerűen nagyítjuk, kicsinyítjük a mintát.

2 Öltési minták nagyíthatók, kicsinyíthetők a  gomb nyomvatartása mellett.

3 Az Öltésből tömb (Stitch to Block) funkcióval az öltési minta azután méretezhető, hogy kézi körberajzolású 
mintát alakítottunk belőle.

Az 1. módszerrel az öltés sűrűbbé vagy riktábbá válik anélkül, hogy az öltések száma változna. Vagyis a 
nagyítással, méretezéssel az öltési sűrűség változatása miatt a hímzési mint minősége is változik. Kizárólag 
akkor alkalmazzuk a módszert, ha az öltési mintát finoman kívánjuk nagyítani, kicsinyíteni.

A 2. módszernél a minta úgy módosul, hogy az öltési sűrűség és a tű kifutási pontja változatlan marad. 
Azonban ha az öltési mintában az eredeti öltési sűrűség és tű kifutási pont nem egységesek, lehet hogy 
módosulni fognak a művelet során. A nagyítás, kicsinyítés során kövessük az eredményt a nézőképen. 
Minimális nagyításnál, kicsinyítésnél ne alkalmazzuk a műveletet.

A 3. módszernél az öltési sűrűség megmarad, miközben a minta nagyításra, kicsinyítésre kerül. Azonban a tű 
kifutási pontja enyhén változhat. Akkor alkalmazzuk, ha az öltést vagy az alakot kívánjuk módosítani. 
Minimális nagyításnál, kicsinyítésnél ne alkalmazzuk a műveletet.

Varrási irány
Az anyag zsugorodását elkerülendő az anyag nagyobbik méretére merőleges irányú varrási irányt 
válasszunk.

Varrási sorrend
Mivel több különböző részből létrehoztuk a kész hímzési mintát (a Layout & Editing vagy Design Center 
programban), fontos hogy ellenőrizzük a varrási sorrendet és szükség esetén korrigáljuk.

Layout & Editing programmal az alapértelmezett varrási sorrend az elemek levarrásának tényleges sorrendje.

A Design Center esetében az alapértelmezett varrási sorrend az varrási jellemzők végrehajtásának sorrendje.

A programmal számos hímzési mintát előállíthatunk és varrási jellemzők széles skáláját alkalmazhatjuk 
(öltési sűrűség, öltéshossz stb.). Azonban a végeredmény nagyban függ az alkalmazott hímzőgép 
típusától. Mindenképp ajánlott egy próbavarrás elvégzése mielőtt a végleges anyagra varrnánk. Fontos 
hogy a próbavarrást a kész varrással egyező anyagra, egyező tűvel és fonallal végezzük.

Ctrl

Valószínűbb zsugorodás Kevésbé valószínű zsugorodás
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Nagyobb felületek levarrása
• Szebb eredmény érdekében széles anyag varrásakor az Under sewing (alávarrás) funkciót kapcsoljuk be 

(On beállítás).

Részletesen lásd a 98. oldalon az Alávarrás szakaszban.

• A Sewing Direction (varrási irány) beállítással megelőzhetjük az anyag zsugorodását, összeugrását.

• Hímzéshez mindig alkalmazzunk stabilizátort. Könnyű, vékony anyag és stretch textília hímzésekor mindig 
használjunk stabilizátort, enélkül a tű elhajolhat, eltörhet, az öltés összeugorhat, vagy a minta elcsúszhat, 
rendezetlenné válhat.

• Amikor a szatén (gobelin) öltést széles felületen alkalmazzuk, az anyagtól és a fonal típusától függően a 
lehímzett terület összeugorhat. Ez esetben a következő megoldással élhetünk: válasszuk a kitöltő (fill) 
öltést és használjunk a textília fonák oldalán stabilizátort.

Ugró öltés és ugró öltés elvágása
Ha a hímzőgép rendelkezik az ugró öltést vágó funkcióval, és a funkciót aktiváljuk, a fonal automatikusan 
vágásra kell az ugró öltéseknél.
A hímzőgéptől függően az ugró öltés egy adott hossznál rövidebb ugró öltések nem vághatók el.
Az ugró öltés vágási funkcióról részletesen a hímzőgép használati útmutatójában olvashatunk.

Minta Varrás után

Megjegyzés:
Amikor a szatén (gobelin) apró öltést széles felületen alkalmazzuk, a tű egyes készülékeknél akár 10 mm-
rel is elmozdulhat helyéből. Ezt elkerülendő, válasszuk a fenti alternatív módszert.

Öltés ÖltésUgró öltés
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Hímzésre alkalmas fontok
Kisbetűs szöveg hímzése

Kis betűméretű szöveg hímzésekor az alábbi 
ajánlásokat érdemes betartanunk:

1. Alkalmazzunk a hímzésnél megszokottnál 
kisebb fonal feszességét.

2. Varrjunk kisebb sebességgel, mint a hímzés 
során általában szoktunk.
(A fonalfeszesség és varrási sebesség 
állításáról részletesen a hímzőgéphez kapott 
használati útmutatóban tájékozódhatunk.)

3. Ne vágjuk át az ugró öltéseket a karakterek 
között.
(A készüléken a fonal vágásának beállításáról 
a hímzőgéphez kapott használati útmutatóban 
tájékozódhatunk.)

TrueType font átalakítása hímzési 
mintává

A szebb eredmény érdekében amikor TrueType 
fontot hímzési mintává alakítunk, válasszunk minél 
vastagabb vonalakból felépített fontot, amilyen pl. a 
Gothic.
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Körvonalas betűkép létrehozása
(Text Converted to Outline Object 
funkcióval)
A Convert to Outline Object parancs a TrueType font betűit körvonalas alakzatokká alakítja át. 

1. A Shape (Alakzat) eszközzel rajzoljunk egy 
alakzatot.

A részletesen lásd a 70. oldalon az 
Alakzatok rajzolás szakaszban.

2. Válasszunk ki egy karatkert TrueType fontos 
betűképpel.

3. Kattintsunk a jobb egérgombbal a karakteren, 
majd válasszuk a Convert to Outline Object 
(átalakítás körvonalas elemmé) parancsot a 
legördülő menüből.

Részletesen lásd a 89. oldalon a „Szöveg 
átalakítása körvonalas mintává” 
szakaszt.

4. Helyezzük az alakzaton belülre a karaktert.

5. Miután kiválasztottuk a körvonalas karaktert, 
tartsuk lenyomva a  gombot, majd 
válasszuk ki az alakzatot. Kattintsunk a Sew > 
Set hole sewing (lyukvarrás beállítás) pontra.

Részletesen lásd a 75. oldalon az Átfedő 
öltések kiiktatása (lyukvarrás) 
szakaszban.

6. Válasszuk ki a körvonalas mintát a karakteren 

belül, majd kattintsunk a  (Felület varrás) 
ikonra. (Mivel a háttér színe a példában 

fekete, a felületi szín  fekete lesz.)

→ A körvonalas karakter elkészült.

Ctrl
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Karakter átalakítása hímzési mintává (japán, 
kínai, koreai írás stb.)
A hímzési minta TrueType fontok esetén többféle speciális karakterből is létrehozható, pl. japán, kínai, koreai 
írásokból.

Jelen példában japán feliratból hozunk létre hímzési mintát.

1. Válasszuk a Felirat eszközt, majd válasszunk 
egy japán TrueType fontot (pl. MS Gothic). 

2. Kattintsunk a tervezőfelületen, ahova 
begépelni kívánjuk a szöveget. Az Edit Text 
Letters ablak megjelenik.

3. Jelenítsük meg a 2. lépésben megjelenő 
karaktertáblától eltérő karaktertáblát (Start – 
Programok – Kiegészítők – Rendszer-
eszközök– Karaktertábla).

4. A Betűtípus mezőben válasszuk az MS 
Gothic fontot, majd válasszuk a Speciális 
nézet kapcsolót alul. Válasszuk a Windows: 
Japán betűkészletet, majd jelöljük ki a kívánt 
karaktert, és kattintsunk a Kijelölés gombra.
(Jelen példában a japán hiragana szót írtuk le, 
amely „jó estét” jelent.)

5. Miután az összes kívánt karaktert kijelöltük, 
kattintsunk a Copy parancsra a karakterek 
másolásához.

6. Töltsük be a karaktereket az Edit Text 
Letters ablakba, majd kattintsunk az OK-ra.

Ne feledjük:
• A következő műveletsor ismerteti a japán, 

kínai, koreai fontok telepítését a Windows® 
XP szoftverre.

1) Kattintsunk a Start > Vezérlőpult > 
Területi és nyelvi beállítások pontra.

2) Itt válasszuk a Nyelvek fület.
3) Pipáljuk ki a Kelet-ázsiai nyelvek 

fájljainak telepítése kapcsolót, majd 
kattintsunk az OK-ra.

4) A megjelenő utasításokat követve 
végezzük el a telepítési műveletet.
Amennyiben a japán vagy koreai 
karakterek közvetlenül a billentyűzetről 
begépelhetők, az Edit Text Letters 
ablakban is megadhatjuk a szöveget.
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Menürendszer/Eszközök

M

enürendszer/Eszközök
Layout & Editing
Eszköztár elemek ismertetése

Menürendszer

File menü

Eszköz Funkció Oldalsz. Eszköz Funkció Oldalsz.

Mutató kiválasztó módba vált. 52. o. A mutató körvonal rajzoló 
módba vált. 73. o.

Mutató pont szerkesztő 
módba vált.

56. o., 
60.o., 
62. o.

A mutató kézi körberajzoló 
módba vált. 78. o.

Mutató nagyító módba vált. 51. o. A mutató vonalzó módba vált. 51. o.

A mutató felirat, kisbetűs 
szöveg, monogram beviteli 
módba vált.

80. o. A mutató öltést daraboló 
módba vált. 64. o.

A mutató téglalap, kör, körív, 
körszelet és íves körszelet 
rajzoló módba vált.

70. o.
A mutató bélyegzőminta és 
bélyegzőminta szerkesztő 
módba vált.

114. o.

A mutató különféle alakzat 
rajzoló módba vált. 72. o.

Menüpont Ikon Funkció Bill.parancs Oldalszám

New (új) Új, üres tervezőfelületet nyit meg. Ctrl + N 47. oldal

Open (megnyitás) Korábban mentett hímzési terv megnyitása. Ctrl + O 48. o.

Import (betöltés) Hímzési tervek betöltése a Design Library-ből, 
mappából, adatkártyáról. F8 48. o.

Import from Design 
Center (betöltés a 
Design Centerből)

Hímzési terv betöltése a Design Centerből. F7 50. o.

Save (mentés) A hímzési terv mentése a számítógép merevlemezén 
a fájl legutolsó változataként. Ctrl + S 138. o.

Save As (mentés 
másképp)

A hímzési terv mentése a számítógép merevlemezére 
új néven. 138. o.
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Export (kivitel) Tervezőfelületen lévő terv kivitele: .dst, .exp, .pcs, 
.hus, .vip, .shv, .jef, .sew, .csd and .xxx formátumban. 138. o.

Write to Card 
(kártyára írás) Hímzési terv mentése adatkártyára. F4 17.o., 

139. o.

Property 
(tulajdonságok) A .pes fájlhoz megjegyzés fűzése. 140. o.

Print Setup 
(nyomtatási beállítás)

A megjelenített hímzési terv és kép nyomtatási 
beállításainak módosítása.

43. o., 
143. o.

Print Preview 
(nyomtatási kép) A hímzési terv nyomtatás előtti megtekintése. 143. o.

Print (nyomtatás) Hímzési terv és kép nyomtatása. Ctrl + P 143. o.

Exit Kilépés az alkalmazásból. Alt + F4

Menüpont Ikon Funkció Bill.parancs Oldalszám

Undo (mégse) Elveti az utolsó műveletet. Ctrl + Z

Redo (mégis) Az utolsó elvettett (Undo) műveletet állítja vissza. Ctrl + Shift + Z

Group (csoportba 
foglalás)

A kijelölt mintákat egy elemként fogja kezelni a 
program. Ctrl + G

55. o.
Ungroup 
(csoportbontás)

A csoportba foglalt elemek különálló elemekké válnak 
újra. Shift+ G

Cut (vágás) A kiválasztott mintákat törli a képernyőről, miközben 
egy másolat a Vágólapra kerül. Ctrl + X

Copy (másolás) A kiválasztott minta másolata a Vágólapra kerül, 
közben az eredeti megmarad a képernyőn. Ctrl + C

Duplicate 
(megkettőz) A kiválasztott mintákról másolat készül. Ctrl + D

Paste (beillesztés) A Vágólap tartalmát betölti a tervezőfelületre. Ctrl + V

Delete (törlés) A kiválasztott mintát törli a képernyőről, anélkül hogy 
másolat maradna a Vágólapra. Delete p. 123

Point 
(pont)

To 
Straight 
(egyenes)

A pontnál összefutó két íves szakaszt egyenes 
szakasszá alakítja. 58. o.

To Curve 
(görbe)

A sarokpontnál összefutó két egyenes szakaszt görbe 
ívekké alakítja. 58. o.

To 
Smooth 
(kisimít)

A pontnál összetalálkozó két ív törés nélkül fut 
egymásba. 59. o.

To 
Symmetry

A pont érintői szimmetrikus pozíciót vesznek fel. A 
pontból kifutó görbék szimmetrikus ívet vesznek fel. 59. o.

To Cusp 
(csúcsos) A pontban a görbék sarkosan, csúcsosan találkoznak. 59. o.

Delete 
(töröl) A kiválasztott pont(ok) törlése. 58. o.

Menüpont Ikon Funkció Bill.parancs Oldalszám
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Image (kép) menü

Mirror

Horizontal 
(vízszint.)

Vízszintes tengely mentén, fejjel lefelé tükrözi a 
mintát. Ctrl + H

54. o.
Vertical Függőleges tengely mentén, balról jobbra tükrözi a 

mintát. Ctrl + J

Rotate (forgatás) Tetszőleges szögben kézzel forgathatjuk el a mintát. Ctrl + Y 54. o.

Numerical
Setting 
(számsz. 
művelet)

Size 
(méret)

A kiválasztott mintát átméretezését számszerűen 
vezérelhetjük. 53. o.

Rotate 
(forgatás) A kiválasztott mintát számszerűen forgathatjuk el. 55. o.

Center (középre) A kiválasztott mintát a tervezőfelület közepére 
helyezi. Ctrl + M 52. o.

Align

Left 
(balra) A kiválasztott mintákat bal oldalukhoz igazítja.

53. o.

Center 
(középre)

A kiválasztott minták vízszintes középvonalait igazítja 
össze egymáshoz.

Right 
(jobbra) A kiválasztott mintákat jobbra igazítja.

Top 
(felülre) A kiválasztott minták felső szélét igazítja egymáshoz.

Middle 
(közép)

A kiválasztott minták függőleges középvonalait 
igazítja össze egymáshoz.

Bottom 
(alulra) A kiválasztott minták alsó szélét igazítja egymáshoz.

Select All (mindet 
kijelöl) Az összes mintát kijelöli. Ctrl + A 52. o.

Menüopont Ikon Funkció Bill.parancs Oldalsz.

Input 
(betöltés)

from File 
(fájlból) Képi adatok betöltése meglévő fájlból. 120. o.

from 
TWAIN 
device

A TWAIN szabványos szkennerből vagy egyéb 
eszközből tölti be a képi adatokat. 120. o.

from 
Portrait

Az arckép rajzoló funkció által készített arcképet tölti 
be. 121. o.

from 
Clipboard Képi adatok betöltése a vágólapról. 122. o.

Output 
(kivitel)

to File Kép, képi adat mentése fájlba. 124. o.

to 
Clipboard Képi adatok felmásolása a vágólapra. 124. o.

Select TWAIN Device 
(TWAIN eszk. kivál.)

Kiválaszthatjuk, hogy a telepített TWAIN eszközök 
közül melyiket kívánjuk felhasználni. 120. o.

Modify (módosít) Állítsuk a méretet, irányt és a képi adatok pozícióját. 123. o.

Rotate 
(forgatás)

90 Degrees 
Clockwise

Forgassuk el a képi adatokat 90 fokkal az óramutató 
járásával egyező irányba. 123. o.

90 Degrees 
Counter-
clockwise

Forgassuk el a képi adatokat 90 fokkal az óramutató 
járásával ellentétes irányba. 123. o.

Menüpont Ikon Funkció Bill.parancs Oldalszám
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Sew (varrás) menü

Image to Stitch 
Wizard (képből 
hímzés varázsló)

Lépésről lépésre végigvezető utasítások kép hímzési 
mintává átalakításához. 125. o.

Display 
Image 
(kép 
megjele-
nítése)

On (be) 
(100%) A sablon kép megjelenítése (100%-os fedettség). F6

123. o.

75% A kép halványabb, alnyomatos megjelenítése 
(75%-os fedettség). F6

50% A kép halványabb, alnyomatos megjelenítése 
(50%-os fedettség). F6

25% A kép halványabb, alnyomatos megjelenítése 
(25%-os fedettség). F6

Off (ki) Kép elrejtése. F6

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Edit Letters (szöveg 
szerkesztő) Szöveg bevitele, szerkesztése. Ctrl + L 91. o.

Text Attribute Setting 
(szöveg formázás) A felirat formázása. Ctrl + K 83. o.

Fit Text to Path 
Setting (görbére ig.) A szöveget egy görbe mentén helyezi el. Ctrl + T 87. o.

Release Text from 
Path (görbére írás 
megszüntetése)

A felirat görbére írását megszünteti. Ctrl + Q 88. o.

TrueType Font 
Attribute Setting

Hímzési mintává alakított TrueType fontból álló 
szöveg formázása. 89. o.

Convert to Outline 
Object 

A TrueType fontból hímzési mintává alakított feliratból 
körvonalas szerkeszhető görbét hoz létre. 89. o.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Sewing Attribute 
Setting (varrási 
jellemzők)

A minta felületeinek, körvonalainak varrási jellemzőit 
adhatjuk meg. Ctrl + W 96. o.

Sewing Order/Lock 
(varrási sorrend)

A minták színeinek és az egyes minták levarrásának 
sorrendjét ellenőrizhetjük, módosíthatjuk, valamint 
zárolhatjuk.

F10 118. o.

Set hole sewing 
(lyukvarrás 
beállítása)

A nagyobb mintából kimarad a kisebbik, lyuk 
képződik, így az átfedő részeken kiiktatjuk a 
kétszeres levarrást.

75. o.

Cancel hole sewing 
(lyukvarrás elvetése) Elveti a lyukvarrást. 75. o.

Remove Overlaps 
(átfedések kiiktatása)

Amikor több hímzési minta átfedi egymást, az alsó 
minta átfedő területét törli. 75. o.

Merge (összevonás) Az átfedő öltési mintákat összeolvasztja egy mintává. 76. o.

Divide Stitches by 
Color (színenkénti 
bontás)

Színenként bontja szét az öltési adatokat. 64. o.

Menüopont Ikon Funkció Bill.parancs Oldalsz.
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Display menü

Stitch to Block (öltés 
tömbbé)

Az öltési adatokat tömbökké alakítja (kézi 
körberajzolás funkció) így méretezés során 
átállíthatjuk a varrási jellemzőket a minőség 
megőrzéséhez.

63. o.

Convert to Stitches 
(öltések átalakítása) Az alakzatot öltési mintává alakítja. 62. o.

Applique Wizard Lépésről lépésre vezet végig foltvarrás készítésén. 137. o.

Select Sewing Area A varrási terület kijelölése. 140. o.

Optimize hoop 
change

A tervezőfelületen szereplő minták varrási sorrendjét 
több állású hímzőkerethez igazítjuk (100 x 172 mm 
vagy 130 x 300 mm).

183. o.

Optimize Entry/
Exit points

A hímzési minta belépő és kilépő pontjainak 
automatikus elhelyezése optimális struktúrába. 60. o.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Grid Setup (rács 
beállítás) A rács megjelenítésének, jellemzőinek beállítása. 69. o.

Preview (nézőkép) A mintát megtekinthetjük a levarrásra kerülő 
öltésekből álló formában vagy normál nézetben. F9 65. o.

Realistic Preview 
(valósághű nézőkép)

Valósághű kép szemlélteti, hogy a minta hímzés után 
milyen látványt fog nyújtani. Shift + F9 65. o.

Realistic Preview 
Attribute Setting A valósághű nézőkép funkció beállítása. 65. o.

Refresh Window 
(ablak frissítése) Képernyő frissítése. Ctrl + R

Stitch Simulator 
(öltés szimulátor) A gépi öltések szimulált megjelenítése. 66. o.

Reference Window 
(áttekintő ablak) Áttekintő ablak megjelenítése, elrejtése. F11 66. o.

Ruler (vonalzó) Vonalzó elrejtése, megjelenítése. 69. o.

Toolbar (eszközsáv) Eszközsáv elrejtése, megjelenítése. 47. o.

Status Bar 
(állapotsor) Állapotsor elrejtése, megjelenítése.

Menüpont Ikon Funkció Bill.parancs Oldalsz.
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Menüpont Ikon Funkció Bill.parancs Oldalsz.

Design Center Design Center indítása. F5 145. o. 
153. o.

Programmable Stitch 
Creator A Programmable Stitch Creator indítása.

199. o.
205. o.

Design Database A Design Database indítása. F12 187. o.

Font Creator A Font Creater indítása.
217. o.
225. o.

Design Property (terv 
adatai)

A kiválasztott minta varrási adatait tartalmaz ablak 
megjelenítése. 137. o.

Design Page Property 
(tervezőfelület adatai)

A tervezőfelület méretét, színét, hátterét 
módosíthatjuk. 68. o.

Edit User Thread 
Chart Egyedi fonalkészlet összeállítása, szerkesztése. 110. o.

Select 
System 
Unit

mm Milliméter lesz a mértékegység.
69. o.

inch Inch (hüvelyk, col) lesz a mértékegység.

Menüpont Ikon Funkció Bill. parancs Oldalsz.

Instruction Manual 
(használati útm.) Használati útmutató indítása. F1 13. o.

Check for Updates 
(frissítések keresése) Az interneten keres rá az elérhető frissítésekre. 14. o.

Customer Support 
(terméktámogatás)

A vásárlói terméktámogatási oldal megnyitása a 
Brother honlapján. 14. o.

Online Registration 
(online regisztráció)

Nyissuk meg a honlapon az internetes regisztráció 
honlapját. 14. o.

About (névjegy) A program verziószámának megjelenítése.
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Design Center
Eszköztár elemei

Vonalas kép fázis

Csomóponti ábra fázis

Eszköztár Funkció Oldalsz. Eszköztár Funkció Oldalsz.

Az első öt gömb tollként és 
radírként használatos (a jobb 
egérgomb lenyomásával) 
eltérő vonalvastagság 
mellett.

147. o.

Radír eszköz.

147. o.

Nagyítás.

A tervezőfelület nagyítása az 
ablakot kitöltő méretre.

Kicsinyítés.

Eszköztár Funkció Oldalsz. Eszköztár Funkció Oldalsz.

A mutató kiválasztó módba 
váltása. 148. o. Nagyítás.

A mutató pont szerkesztő 
módba váltása. 149. o. A tervezőfelület nagyítása az 

ablakot kitöltő méretre.

A mutató vonal rajzoló 
módba váltása. 148. o. Kicsinyítés.

A kiválasztott elem(ek) 
nagyítása az ablakot kitöltő 
méretre.
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Varrási jellemzők fázisa

Menürendszer

File menü

Eszköztár Funkció Oldalsz. Eszköztár Funkció Oldalsz.

A mutató beállítása felületi 
varrás módba. 163. o. Nagyítás.

A mutató állítása teljes 
körvonalat levarró módba.

164. o.

A tervezőfelület nagyítása az 
ablakot kitöltő méretre.

A mutató állítása körvonalat 
(részben) levarró módba. Kicsinyítés.

A mutató beállítása lyukvarró 
módba. 168. o. A mutató bélyegzőminta 

módba állítása.
168. o.A mutató beállítása 

bélyegzőminta szerkesztő 
módba állítása.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

New Line Image (új 
vonalas kép)

Üres tervezőfelület megnyitása Vonalas kép (Line 
Image) fázisban. Ctrl + N 157. o.

New Figure Data (új 
csomóponti ábra)

Üres tervezőfelület megnyitása Csomóponti ábra 
(Figure Handle) fázisban. 160. o.

Wizard (varázsló) Lépésről lépésre vezet végig minta készítésén, a 
létrehozni kívánt adattípustól függő módon. F3 154. o.

Open (megnyitás) Korábban mentett fájl megnyitása (.pem, .pel vagy 
képfájl). Ctrl + O 155. o.

Select TWAIN Device Válasszuk ki, melyik TWAIN-eszközt kívánjuk 
használni.

155. o.Input from TWAIN 
device (bevitel 
TWAIN-eszközből)

TWAIN-kompatibilis szkenner vagy egyéb eszköz 
betöltése képként.

Input from Clipboard 
(vágólapról betöltés)

Üres tervezőfelület megnyitása Eredeti kép (Original 
Image) fázisban, és képi adatokt betöltése a 
vágólapról.

Output to Clipboard 
(kivitel vágólapra)

Az Eredeti kép fázisban szereplő képi adatok 
bemásolása a vágólapra.

Import Figure (ábra 
betöltése)

.pem fájl betöltése a tervezőfelületre (kizárólag 
csomóponti ábra fázisban). F8

Save (mentés) Tervezőfelület tartalmának mentése lemezre legutolsó 
változatként (alapértelmezett). Ctrl + S 169. o.

Save As (mentés 
mint) Aktuális minta mentése új fájlnév alatt. 169. o.

Exit (kilépés) Kilépés az alkalmazásból. Alt + F4
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Edit menü

Sew (varrás) menü

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Undo (mégse) Utolsó művelet elvetése. Ctrl + Z

Redo (mégis) Utolsó elvetett (undo) művelet visszaállítása. Ctrl + Shift + Z

Cut (kivágás) A kiválasztott mintákat törli a képernyőről, miközben 
egy másolat a Vágólapra kerül. Ctrl + X

Copy (másolás) A kiválasztott minta másolata a Vágólapra kerül, 
közben az eredeti megmarad a képernyőn. Ctrl + C

Duplicate (kettőzés) A kiválasztott mintákról másolat készül. Ctrl + D

Paste (beillesztés) A Vágólap tartalmát törli a tervezőfelületre. Ctrl + V

Delete (törlés) A kiválasztott mintát törli a képernyőről, anélkül hogy 
másolat maradna a Vágólapra. Delete

Split (felosztás) A vonalat az adott pontnál két vonallá osztja fel. 149. o.

Mirror 
(tük-
rözés)

Horizontal 
(vízszint.)

Vízszintes tengely mentén, fejjel lefelé tükrözi a 
mintát. Ctrl + H

160. o.
Vertical 
(függől.)

Függőleges tengely mentén, balról jobbra tükrözi a 
mintát. Ctrl + J

Rotate (forgatás) Tetszőleges szögben kézzel forgathatjuk el a mintát. Ctrl + Y 160. o.

Numerical
Setting 
(számsz. 
művelet)

Size 
(méret)

A kiválasztott mintát átméretezését számszerűen 
vezérelhetjük. 160. o.

Rotate 
(forgatás)

A kiválasztott mintát a szög megadásával forgathatjuk 
el. 160. o.

Select All 
(mindet kijelöl) Az összes minta kijelölése. Ctrl + A

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Sewing Attribute 
Setting (varr. jell.)

A minta felületeinek, körvonalainak varrási jellemzőit 
adhatjuk meg. Ctrl + W 165. o.

Sewing Order (varrási 
sorrend)

A minták színeinek és az adott színű minták 
levarrásának sorrendjét ellenőrizhetjük, 
módosíthatjuk.

F10 168. o.
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Option menü

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Grid Setup (rács 
beállítás)

Elrejthetjük, megjeleníthetjük a rácsot, beállíthatjuk a 
rácsközt és választhatunk a csak pontokból álló, vagy 
rácsvonalas megjelenítési módok között.

161. o.

Modify Template 
(sablon módosítása) Állítsuk be a háttérkép méretét, helyzetét. 159. o.

Display
Template 
(sablon 
megjele-
nítése)

On (be) A sablon kép megjelenítése. F6

159. o.Faded 
(halvány) A sablon kép alnyomatos változatának megjelenítése. F6

Off (ki) Sablon kép elrejtése. F6

Preview (nézőkép) A mintát megtekinthetjük a levarrásra kerülő 
öltésekből álló formában vagy normál nézetben. F9

Realistic Preview 
(valósághű nézőkép)

Valósághű kép szemlélteti, hogy a minta hímzés után 
milyen látványt fog nyújtani. Shift + F9

Realistic Preview 
Attribute Setting A valósághű nézőkép funkció beállítása.

Refresh Window 
(frissítés) Képernyő frissítése. Ctrl + R

Stitch Simulator 
(öltés szimulátor) A gépi öltések szimulált megjelenítése. p. 169

Reference Window 
(áttekintő ablak) Áttekintő ablak megjelenítése, elrejtése. F11 p. 161

Toolbar (eszközsáv) Eszközsáv elrejtése, megjelenítése. p. 153

Status Bar 
(állapotsor) Állapotsor elrejtése, megjelenítése.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Layout & Editing Elindítja a Layout & Editing ablakot. F5 47. o.

Programmable Stitch 
Creator Elindítja a Programmable Stitch Creator programot.

199. o., 
205. o.

Design Page Property 
(tervezőfelület adatai)

A tervezőfelület méretét, színét, hátterét 
módosíthatjuk. 159. o.

Select 
System 
Unit

mm Milliméter lesz a mértékegység.
161. o.

inch Inch (hüvelyk, col) lesz a mértékegység.
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Stage menü

Help menü

Menüpont Ikon Funkció Bill.parancs Oldalsz.

To Original Image 
(eredeti képhez) Visszalépés az Eredeti kép fázisba. 146. o.

To Line Image 
(vonalas képhez) Visszalépés a Vonalas kép fázisba. 156. o.

To Figure Handle 
(csomóponti ábra) Visszalépés Csomóponti ábra fázisba. 158. o.

To Sew Setting 
(varrási beállítások)

Lépés Csomóponti ábra fázisból Varrási beállítások 
fázisba. 163. o.

To Layout & Editing Hímzési terv kivitele a Varrási beállítások fázisból a 
Layout & Editing szoftverbe. 152. o.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Használati útmutató Használati útmutató indítása. F1 13. o.

Customer Support 
(terméktámogatás)

A vásárlói terméktámogatási oldal megnyitása a 
Brother honlapján. 14. o.

About (névjegy) A program verziószámának megjelenítése.
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Menürendszer/Eszközök
Design Database
Menürendszer

File menü

Edit menü

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Megnyitás a Layout & 
Editing programban

A hímzési terv megnyitása a Layout & Editing 
programban. 189. o.

Betöltés Layout & 
Editing programba Hímzési terv betöltées a Layout & Editing programba. 189. o.

Create New Folder (új 
mappa) A kiválasztott mappában új mappát nyit meg. 190. o.

Convert Format Hímzési terv fájl átalakítása másik formátumba. 193. o.

Delete (törlés) Kiválasztott hímzési terv fájl kiválasztása. Delete 191. o.

Search (keresés) Hímzési terv fájl kikeresése. Ctrl + F 192. o.

Print Setup 
(nyomtatási beállítás) A hímzési tervek kivonatának nyomtatási beállításai. 196. o.

Print Preview 
(nyomt. nézőkép)

A hímzési terv kivonatának nézőképen való 
megtekintése a nyomtatást megelőzően.

Print (nyomtatás) A hímzési terv fájlok kivonatának nyomtatása. Ctrl + P 196. o.

Create HTML A hímzési terv fájl kimentése HTML fájlként. 196. o.

Create CSV (CSV fájl 
létrehozása)

A hímzési tev fájlok varrási adatainak kimentése CSV 
fájlként. 197. o.

Exit (kilépés) Kilépés a programból. Alt + F4

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Cut (kivágás) Törli a kiválasztott hímzési tervet a mappából, 
miközben eltárol egy másolatot a Vágólapon. Ctrl + X

190. o.Copy (másolás) A kiválasztott hímzési terv elmentése a Vágólapra, 
anélkül hogy az eredeti törlődne a mappából. Ctrl + C

Paste (beillesztés) A hímzési terv fájl beillesztése a Vágólapról a kijelölt 
mappába. Ctrl + V

Select All (mindet 
kijelöli) Az összes fájl kijelölése a Tartalom ablakban. Ctrl + A
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Menürendszer/Eszközök
M

enürendszer/Eszközök
Display menü

Option menü

Help menu

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Large Thumbnails 
(nagy nézőképek)

A hímzési terv fájlok kilistázása nagy nézőképek 
formájában.

191. o.Small Thumbnails 
(kis nézőképek)

A hímzési terv fájlok kilistázása kis miniatűr 
nézőképek formájában.

Details (részletek) A hímzési terv fájlok kilistázása a varrási jellemzők 
szerint.

Preview (nézőkép) A kiválasztott hímzési terv fájlok nézőképének 
megtekintése. 188. o.

Property (jellemzők) A kijelölt hímzési terv varrási jellemzőinek 
megjelenítése. 188. o.

Refresh (frissítése) A hímzési terv fájlok frissítése a Tartalom képernyőn. Ctrl + R

Toolbar (eszközsáv) Eszközsáv megjelenítése/elrejtése. 187. o.

Status Bar 
(állapotsor) Állapotsor megjelenítése/elrejtése.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Select 
System 
Unit

mm Milliméter lesz a mértékegység.
69. o.

inch Inch (hüvelyk, col) lesz a mértékegység.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Használati útmutató Használati útmutató indítása. F1 13. o.

Customer Support 
(terméktámogatás)

A vásárlói terméktámogatási oldal megnyitása a 
Brother honlapján. 14. o.

About (névjegy) A program verziószámának megjelenítése.
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Menürendszer/Eszközök
Programmable Stitch Creator
Eszköztár elemek

Menürendszer

File menü

Mode menü

Eszköz Funkció Oldalsz. Eszköz Funkció Oldalsz.

Mutató kiválasztó módba vált.
209. o., 
213. o.

Mutató felület (nincs effekt) 
módba vált. 211. o.

Mutató pont szerkesztő 
módba vált.

203. o. 
209. o.
212. o.

Mutató felület (véset) módba 
vált. 201. o.

211. o.
Mutató rajzoló módba vált.

200. o. 
208. o.

Mutató felület (dombor) 
módba vált.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

New (új) Új, üres munkaterület megnyitása. Ctrl + N 207. o.

Open (megnyitás) Korábban mentett öltési minta fájl megnyitása. Ctrl + O 206. o.

Template Open 
(sablon megnyitása)

Háttérkép megnyitása, amely sablonként szolgálhat a 
programozható öltés vagy motívum öltés 
megtervezéséhez.

206. o.

Save (mentés) Munkaterület mentése a merevlemezre. Ctrl + S 214. o.

Save As (mentés 
másként) Új fájlnéven menti az aktuális öltési mintát. 214. o.

Exit ( Kilépés a programból. Alt + F4

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Fill/Stamp (kitöltő/
bélyegzőminta)

Kitöltő/bélyegzőminta módba lépünk programozható 
kitöltő öltés és bélyegzőminta öltések létrehozásához.

207. o.
Motif (motívum) Motívum módba lépünk motívum öltési minták 

létrehozásához.
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Menürendszer/Eszközök
M

enürendszer/Eszközök
Edit menü
Menu Toolbar Purpose Shortcut key Reference

Undo (mégse) Elveti az utolsó műveletet. Ctrl + Z

Redo (mégis) Az utolsó elvettett (Undo) műveletet állítja vissza. Ctrl + Shift + Z

Cut (vágás) A kiválasztott sort törli a képernyőről, miközben egy 
másolat a Vágólapra kerül. Ctrl + X

Copy (másolás) A kiválasztott sor másolata a Vágólapra kerül, közben 
az eredeti megmarad a képernyőn. Ctrl + C

Duplicate (kettőz) A kiválasztott sorról másolat készül. Ctrl + D

Paste (beillesztés) A Vágólapon tárolt sorokat betölti a tervezőfelületre. Ctrl + V

Delete (törlés) A kijelölt feliratot törli a képernyőről, anélkül hogy 
másolatot készítene a Vágólapról. Delete

Mirror
(tükröz.))

Horizontal 
(vízszint.)

Vízszintes tengely mentén, fejjel lefelé tükrözi a 
mintát. Ctrl + H

p. 213
Vertical 
(függől.)

Függőleges tengely mentén, balról jobbra tükrözi a 
mintát. Ctrl + J

Rotate (forgatás) Tetszőleges szögben kézzel forgathatjuk el a feliratot. Ctrl + Y

Select All (mindent 
kijelöl) Az összes sor kijelölése egyszerre. Ctrl + A
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Menürendszer/Eszközök
Display menü

Help menü

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Grid 
(rács)

Wide 
(széles)

A rács a munkaterületet nyolc egyenlő részre osztja 
fel.

215. o.

Medium 
(közepes) A rács a munkaterületet 16 egyenlő részre osztja fel.

Narrow 
(keskeny) A rács a munkaterületet 32 egyenlő részre osztja fel.

None 
(nincs) A rács elrejti.

Template 
(sablon 
kép)

On 
(100%) Sablon kép megjelenítése (100%-os fedettség). F6

215. o.

75% Sablon kép alnyomatos megjelenítése (75%-os 
fedettség). F6

50% Sablon kép alnyomatos megjelenítése (50%-os 
fedettség). F6

25% Sablon kép alnyomatos megjelenítése (25%-os 
fedettség). F6

Off (ki) Sablon kép elrejtése. F6

Preview (nézőkép) A létrehozott minta ismételt, sormintaszerű 
megjelenítés, elrejtés. 208. o.

Toolbar Eszköztár megjelenítés, elrejtés. 199. o.

Status Bar Állapotsor elrejtés, megjelenítés.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Instruction Manual Használati útmutató indítása. F1 13. o.

Customer support A vásárlói terméktámogatási oldal megnyitása a 
Brother honlapján. 14. o.

About Programmable 
Stitch Creator A program verziószámának megjelenítése.
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Menürendszer/Eszközök
M

enürendszer/Eszközök
Font Creator
Eszköztár elemek

Menülista

File menu

Eszköz Funkció Oldalsz. Eszköz Funkció Oldalsz.

A mutató kiválasztó módba 
vált. 230. o. A mutató nagyító módba vált.

A mutató pont szerkesztő 
módba vált. 231. o. A mutató kézi körberajzoló 

módba vált. 229. o.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

New (új) Új, üres munkaterület megnyitása. Ctrl + N 225 .o.

Open (megnyitás) Korábban mentett font fájl megnyitása. Ctrl + O 225. o.

Template 
Open 
(sablon 
megnyit.)

from File 
(fájlból)

Háttérkép megnyitása, amely a betűtervezéshez mintaként 
szolgálhat. 227. o.

Select 
TrueType 
Font

TrueType font, amely sablonként szolgál vagy átalakíthatjuk 
öltési mintának. 227. o.

Save (mentés) A betűterv mentése a merevlemezre. Ctrl + S 234. o.

Save As (mentés 
másként) A betűterv mentése új fájlnév alatt a merevlemezre. 234. o.

Add/Remove Letters 
(betűk törlése, 
hozzáad.)

A karaktertábla bővítése új karakterekkel, meglévők 
törlése. 226. o.

Exit (kilépés) Kilépés az alkalmazásból. Alt + F4
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Menürendszer/Eszközök
Edit menü
Menüpont Ikon Funkció Bill.parancs Oldalsz.

Undo (mégse) Elveti az utolsó műveletet. Ctrl + Z

Redo (mégis) Az utolsó elvettett (Undo) műveletet állítja vissza. Ctrl + Shift + Z

Cut (kivágás) A kiválasztott mintát törli a képernyőről, miközben egy 
másolat a Vágólapra kerül. Ctrl + X

Copy (másolás) A kiválasztott minta másolata a Vágólapra kerül, 
közben az eredeti megmarad a képernyőn. Ctrl + C

Duplicate (kettőzés) A kiválasztott mintáról másolat készül. Ctrl + D

Paste (beillesztés) A Vágólapon tárolt mintát betölti a tervezőfelületre. Ctrl + V

Delete (törllés) A kiválasztott mintát törli a képernyőről anélkül hogy 
másolatot mentene a vágólapról. Delete

Point

To 
Straight 
(egyenes)

A pontnál összefutó két íves szakaszt egyenes 
szakasszá alakítja.

p. 231

To Curve 
(görbévé)

A sarokpontnál összefutó két egyenes szakaszt görbe 
ívekké alakítja.

To 
Smooth 
(simává)

A pontnál összetalálkozó két ív törés nélkül fut 
egymásba.

To 
Symmetry

A pont érintői szimmetrikus pozíciót vesznek fel. A 
pontból kifutó görbék szimmetrikus ívet vesznek fel.

To Cusp 
(csúcsos) A pontban a görbék sarkosan, csúcsosan találkoznak.

Delete 
(törlés) Törli a kijelölt pontot/pontokat.

Mirror 
(tükör)

Horizontal 
(vízszint.) A kiválasztott mintát fejjel lefelé tükrözi. Ctrl + H

230. o.
Vertical 
(függől.) A kiválasztott mintát balról jobbra tükrözi. Ctrl + J

Rotate (forgatás) A kiválasztott mintát tetszőleges szögben 
elforgathatjuk. Ctrl + Y p. 230

Align 
(igazítás)

Left (bal) A kiválasztott mintákat bal oldalukhoz igazítja.

Center 
(közép)

A kiválasztott minták vízszintes középvonalait igazítja 
össze egymáshoz.

Right 
(jobbra) A kiválasztott mintákat jobbra igazítja.

Top 
(felülre) A kiválasztott minták felső szélét igazítja egymáshoz.

Middle 
(középre)

A kiválasztott minták függőleges középvonalait 
igazítja össze egymáshoz.

Bottom 
(alulra) A kiválasztott minták alsó szélét igazítja egymáshoz.

Select All (mindet 
kijelöli) Az összes minta kijelölése. Ctrl + A
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Menürendszer/Eszközök
M

enürendszer/Eszközök
Sew menü

Display menü

Help menü

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Sewing Order (varrási 
sorrend)

Az egyes minták varrási sorrendjének megtekintése, 
módosítása. F10 232. o.

Convert TrueType 
Font to Data 

TrueType fontból készített sablon átalakítása hímzési 
mintáva. 229. o.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Grid Setup (rács 
beállítás)

Megjeleníthetjük, elrejthetjük a rácsot, átállíthatjuk, ki 
és bekapcsolhatjuk a függőleges és vízszintes 
rácsvonalakat.

236. o.

Fill Mode (kitöltő 
mód)

Kitöltő (blokkok telik) és körvonal (blokkok üresek) 
megjelenítési módok között válthatunk. F9 235. o.

Preview Window 
(ablak nézőkép) Preview (nézőkép) ablak megjelenítése. F11 232. o.

Browse Window 
(kiválasztó) Kiválasztó ablak megjelenítése. 233. o.

Modify Template 
(sablon módosítása) A háttérkép méretezése, elhelyezése. 235. o.

Display 
Template 
(sablon 
megjele-
nítése

On (be) 
(100%) A sablon kép megjelenítése (100%-os fedettség). F6

235. o.

75% Sablon kép alnyomatos megjelenítése (75%-os 
fedettség). F6

50% Sablon kép alnyomatos megjelenítése (50%-os 
fedettség). F6

25% Sablon kép alnyomatos megjelenítése (25%-os 
fedettség). F6

Off Sablon kép elrejtése. F6

Toolbar (eszközsáv) Eszközsáv elrejtése, megjelenítése. 217. o.

Status Bar 
(állapotsor) Állapotsor, megjelenítése, elrejtése.

Menüpont Ikon Funkció Bill.parancs Oldalsz.

Instruction Manual Használati útmutató indítása. F1 13. o.

Customer Support A vásárlói terméktámogatási oldal megnyitása a 
Brother honlapján. 14. o.

About Font Creator A program verziószámának megjelenítése.
261



Hibaelhárítás
Ha probléma merülne fel, kattintsunk a Help > Customer Support pontra: a Brother terméktámogatási 
holnapja jelenik meg, ahol válaszokat találunk a leggyakrabban felmerülő kérdésekre.

Ha probléma merülne fel a program használata során, tekintsük át az alábbi táblázatot. Ha nem találunk 
megoldást a problémára, forduljunk a hivatalos Brother ügyfélszolgálathoz.

Hibajelentés Valószínűsíthető ok Elhárítás Oldalszám

A szoftver telepítése 
sikertelen.

Nem az útmutatóban 
foglaltaknak megfelelően 
hajtottuk végre a 
telepítést. (Például a 
Cancel-re kattintunk, vagy 
a CD-ROMot kivettük a 
meghajtóból még a 
telepítés vége előtt.

Kövessük az utasításokat és hajtsuk 
végre a megfelelő műveleteket.

A telepítő nem indul el 
automatikusan.

Lásd a „Ha a telepítő nem indul el 
automatikusan.” megjegyzés blokkot.

A “No card writer module is 
connected. Please connect 
card writer module.” (kártyaíró 
egység nincs csatlakoztatva, 
csatlakoztassuk az egységet) 
üzenet jelenik meg.

Az USB-kártyaíró 
egység csatlakoztatása 
nem megfelelő.

Amikor az USB-csatlakozót bedugjuk 
az USB-portba, a kártyaíró driverének 
telepítője elindul.

Ha bal oldali 
művelet nem 
oldaná meg a 
hibát, lépjünk a 
14. oldalon, a 
Terméktámo-
gatás szakasz-
ban leírt 
honlapra.

Egy korábbi verzió 
frissítésekor a „Cannot connect 
to the Internet.” (internet nem 
elérhető) vagy “The server 
could not be connected to. 
Wait a while, and then try 
connecting again.” (A szerver 
nem tud csatlakozni. Várjunk, 
majd próbálkozzunk újra.) 
jelenik meg, és az USB-
kártyaíró nem frissíthető.

A számítógép, amelyre 
az USB-porton keresztül 
az USB-kártyaíró 
egységet 
csatlakoztattuk, nem tud 
az internetre csatlakozni.

Az USB-kártyaíró egység frissítéséhez 
a számítógépnek, amelyhez az 
egységet csatlakoztattuk, csatlakoznia 
kell az internethez. Ha tűzfal szoftvert 
használunk, ideiglenesen kapcsoljuk ki 
a frissítés alatt. Ha az internet 
kapcsolat így sem jön létre, forduljunk 
a hivatalos forgalmazóhoz.

Az USB-kártyaíró egység nem 
működik megfelelően.

Nem elegendő a 
tápfeszültség.

Csatlakoztassuk az USB-kártyaíró 
egységet az USB-portra, vagy egy 
saját táppal rendelkező USB-
elosztóra, amely megfelelő 
tápfeszültséget nyújt az egységnek.
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A
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arckép .......................................................................121
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körök ...................................................................70
zárt görbék ..........................................................74
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C
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cikkcakk öltés ..........................................................6, 98
csomóponti ábra fázis
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D
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E
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F
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szerkesztés .......................................................113
készlet szerkesztése .........................................111
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Font Creator ......................................................217, 259
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frissítési ablak ...................................................247, 252
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